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0% detected as AI
The percentage indicates the combined amount of likely AI-generated text as 
well as likely AI-generated text that was also likely AI-paraphrased.

Caution: Review required.

It is essential to understand the limitations of AI detection before making decisions 
about a student’s work. We encourage you to learn more about Turnitin’s AI detection 
capabilities before using the tool.

Detection Groups

0 AI-generated only 0%
Likely AI-generated text from a large-language model.

0 AI-generated text that was AI-paraphrased 0%
Likely AI-generated text that was likely revised using an AI-paraphrase tool 
or word spinner.

Disclaimer
Our AI writing assessment is designed to help educators identify text that might be prepared by a generative AI tool. Our AI writing assessment may not always be accurate (i.e., our AI models 
may produce either false positive results or false negative results), so it should not be used as the sole basis for adverse actions against a student. It takes further scrutiny and human 
judgment in conjunction with an organization's application of its specific academic policies to determine whether any academic misconduct has occurred.

Frequently Asked Questions

How should I interpret Turnitin's AI writing percentage and false positives?
The percentage shown in the AI writing report is the amount of qualifying text within the submission that Turnitin’s AI writing 
detection model determines was either likely AI-generated text from a large-language model or likely AI-generated text that was 
likely revised using an AI paraphrase tool or word spinner.
 
False positives (incorrectly flagging human-written text as AI-generated) are a possibility in AI models.
 
AI detection scores under 20%, which we do not surface in new reports, have a higher likelihood of false positives. To reduce the 
likelihood of misinterpretation, no score or highlights are attributed and are indicated with an asterisk in the report (*%).
 
The AI writing percentage should not be the sole basis to determine whether misconduct has occurred. The reviewer/instructor 
should use the percentage as a means to start a formative conversation with their student and/or use it to examine the submitted 
assignment in accordance with their school's policies.

What does 'qualifying text' mean?
Our model only processes qualifying text in the form of long-form writing. Long-form writing means individual sentences contained in paragraphs that make up a 
longer piece of written work, such as an essay, a dissertation, or an article, etc. Qualifying text that has been determined to be likely AI-generated will be 
highlighted in cyan in the submission, and likely AI-generated and then likely AI-paraphrased will be highlighted purple.
 
Non-qualifying text, such as bullet points, annotated bibliographies, etc., will not be processed and can create disparity between the submission highlights and the 
percentage shown.
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Unit 1: IntroducƟon to Business AnalyƟcs and Fundamentals of Excel 

 

Learning Outcomes 

1. Define and explain the concept of Business AnalyƟcs, its scope, and its growing 
importance in modern 

business environments. 

2. Describe the role of data in effecƟve decision-making, and differenƟate between the 
major types of 

analyƟcs: descripƟve, diagnosƟc, predicƟve, and prescripƟve. 

3. Evaluate the strategic importance of business analyƟcs in enhancing compeƟƟveness 
across various 

funcƟons such as markeƟng, finance, operaƟons, and human resources. 

4. IdenƟfy key industry applicaƟons of analyƟcs and illustrate how data-driven decisions 
contribute to 

improved business outcomes. 

5. Demonstrate foundaƟonal proficiency in MicrosoŌ Excel, including navigaƟon of the 
interface and basic 

data entry and ediƟng skills. 

6. Apply formaƫng techniques in Excel using text/number formaƫng, condiƟonal 
formaƫng, and table 

styles to enhance data presentaƟon. 

7. UƟlize different types of cell referencing in Excel (relaƟve, absolute, mixed) to perform 
accurate and 

flexible data analysis operaƟons. 

Content 

1.0 Introductory Caselet 

1.1 IntroducƟon to Business AnalyƟcs 

1.2 Fundamentals of Excel for AnalyƟcs 

1.3 Summary 

1.4 Key Terms 
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1.5 DescripƟve QuesƟons 

1.6 References 

1.7 Case Study 

 

 

1.0 Introductory Caselet 

“Ravi’s Data Dilemma: Making BeƩer Business Decisions” 
Ravi, a 35-year-old manager of a mid-sized retail chain in Bengaluru, had been wrestling 
with declining sales. Every 

quarter, the company’s team assembled thick reports that included numbers and charts, yet 
decisions were frequently made without a deep understanding. 

rather than evidence. Some had too much stock, which was going to waste; others were 
selling out of popular items in minutes. 

products, upseƫng customers. 

It was during a management workshop that Ravi understood the field of Business AnalyƟcs. 
He realized that the 

raw sales data that his company was already collecƟng might be put to beƩer use answering 
some key quesƟons: What? 

products sell most in fesƟvals? Why are certain stores underperforming? Can future sales 
be predicted 

more accurately? 

Ravi began small, with the help of MicrosoŌ Excel. He taught himself how to clean and 
organize the sales data, use formulas, 

and condiƟonal format to emphasize the stores that are trending down. Later, he 
experimented with pivot 

tables to look at best-selling products by area. Ravi actually saw a movie for the first Ɵme to 
be able to present it clearly to his team. 

based on evidence and not conjecture. 

That experience informed how Ravi and his company made decisions. Instead of relying on 

intuiƟon, they started relying on analyƟcs to predict demand, opƟmize resource distribuƟon 
and devise focussed 

Page 4 of 38 - AI Writing Submission Submission ID trn:oid:::3618:127424871

Page 4 of 38 - AI Writing Submission Submission ID trn:oid:::3618:127424871



promoƟons. Sales began to increase and customer saƟsfacƟon improved. 

Ravi’s experience captures the heart of Unit 1: IntroducƟon to Business AnalyƟcs and Basics 
of Excel. 

Modern business can't be run on gut feelings alone - company's need data, analyƟcs and 
tools like Excel to remain relevant. 

compeƟƟve in today’s fast-paced environment. 

CriƟcal Thinking QuesƟon: 

If you were Ravi, What is the business problem under focus– what new bet to place in your 
Data Game? 

demand or clearing out overstocked inventory, or analyzing branch performance? Why? 

 

 

1.1 IntroducƟon to Business AnalyƟcs 

Today, Business AnalyƟcs is key area in modern management and decision making. It refers 
to the 

turning to data, staƟsƟcal analysis and soŌware development for insights that drive beƩer 
business 

decisions. The load of data is so huge generated by any organizaƟon in current corporate 
world, from various sources like 

customer interacƟons, financial trades, manufacturing and producƟon lines, social media 
etc.). However, raw data on 

in-house has liƩle to offer. Business AnalyƟcs is a tool that can help demysƟfy data into 
useful informaƟon. 

the that managers, execuƟves and organisaƟons can use to solve problems, make decisions 
and realise opportuniƟes, and 26 Sim. 

improving overall performance. 

However, Business AnalyƟcs is not just about analyzing historical events; it’s also about 
predicƟng future occurrences and encouraging proacƟve decision making. 

recommending the best possible acƟons. That makes it a crucial tool for businesses that 
want to remain compeƟƟve. 

in a fast-changing environment. With analyƟcs, companies can make fact-based decisions 
through as opposed to 
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depending only on the intuiƟon, or guesswork. 

Simply, Business AnalyƟcs is the link between data and decision making. It combines 
knowledge of 

operaƟons research (OR) methods, staƟsƟcal methods and advanced soŌware to support 
organizaƟons in scienƟfic analyƟc decision making. 

profitability, and sustainability 

1.1.1 DefiniƟon and Meaning of Business AnalyƟcs 

DefiniƟon: 

DefiniƟon Business AnalyƟcs is the applicaƟon of data analysis and interpretaƟon to 
support decision making, resolve business issues, and create value within an organisaƟon. It 
is staƟsƟcal because it employs common, quanƟfiable processes. 

data mining, predicƟve models and other analyƟcal methodologies to discover paƩerns and 
trends. 

Meaning in Simple Words: 

Business AnalyƟcs is ulƟmately the pracƟce of using data to answer quesƟons like: 

• What happened in the past? 

• Why did it happen? 

• What comes next? 

• What do we need to do to succeed? 

For example, a company may want to know why sales have been dropping in the last 
quarter and it can use Business 

AnalyƟcs that allow you to drill down into past sales data, customer preferences, 
compeƟtor behavior and market condiƟons. By 

this data, the company is able to understand what's behind the decline and allows them to 
determine any changes that are 

needed. 

4 

This is why, Business AnalyƟcs is not only numbers & reports. It’s the process of turning 
data into knowledge and 

knowledge into informed acƟons. Enabling businesses to quickly make smarter, faster 
decisions that. 
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opƟmize operaƟonal effecƟveness, customer experience and profitability. 

1.1.2 Role of Data in Decision-Making 

At the core of any acƟvity in business is decision-making. They were presented with a 
challenging decision to make and had struggled over what to do, but they made the right 
one.cut outManagers and leaders are always making choices around 

operaƟons, investments, markeƟng and customer services. 

In the past, intuiƟon, anecdotal experience or trial and error drove many decisions. While 
intuiƟon sƟll 

is at play, and making decisions based on gut is a recipe for either mistakes or missed 
opportuniƟes. In the modern business 

where compeƟƟon is fierce and markets transform themselves quickly, data have become 
the new gold; 

foundaƟon for decision-making. 

Why Data MaƩers in Decision-Making 

Facts are the concrete, objecƟve and measurable truths we have that reduce uncertainty. It 
allows managers to analyze 

hard evidence instead of being subjected to speculaƟon. As the influence of digital 
technologies has expanded, businesses have 

access to troves of data from sales receipts, customer behaviors, financial reports, social 
media and website traffic. 

and even sensors in machines. This informaƟon can be converted into acƟonable decision-
supports. 

For instance, a retailer may analyze customer purchase data to idenƟfy best-selling products 
and beƩer manage the inventory. 

accordingly. Similarly, a bank can analyze data about customer transacƟons to idenƟfy fraud 
or credit risk. These 

decisions based on your data are more likely to be the right one and to work. 

Primary PosiƟons of Facts in Conclusion GeneraƟng 

Understanding Past Performance: 

Data allows companies to analyze what has already occurred. Through analyzing previous 
sales, costs and customer 

feedback, businesses are able to learn what they do well and where they fall short. 
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IdenƟfying Trends and PaƩerns: 

Data frequently indicates trends that cannot be detected through observaƟon. For example, 
seasonal trends in 

product requirements can determine producƟon and markeƟng tacƟcs. 

SupporƟng Evidence-Based Decisions: 

With data, you have something concrete to measure and rely on as a business owner. 
Managers can jusƟfy 

and share your beliefs with fact, not opinion. 

5 

PredicƟng Future Outcomes: 

Through predicƟve analysis, companies are able to predict future sales, customer 
requirements or market fluctuaƟons. 

That helps them ready themselves in advance. 

Reducing Risks and Uncertainty: 

Data-driven decisions also reduce the risk of failure, as they are based on real evidence and 
not conjecture. 

than speculaƟon. 

Improving Efficiency and Resource AllocaƟon: 

Businesses will be able to use data to decide where resources - Ɵme, money and personnel, 
for example - should. 

be invested for maximum return. 

Enhancing Customer SaƟsfacƟon: 

InformaƟon about customer behavior and preferences enables companies to develop beƩer 
products, refine 

services, and create personalized experiences. 

Example 

Take an airline deciding their tariffs. And without data it may set prices randomly. But with 
data, 

it can look at customer booking paƩerns, compeƟtor pricing, seasonal demand and the cost 
of fuel. This data-driven 
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strategy enables the airline to charge compeƟƟve prices that moƟvate customers and earn 
maximum profits. 

 

1.1.3 Types of AnalyƟcs 

Business AnalyƟcs can be categorized in various types based on the objecƟve of analysis or 
type of. 

quesƟons it seeks to answer. There are four fundamental types of analyƟcs: DescripƟve, 
DiagnosƟc, PredicƟve, and prescripƟve. 

PrescripƟve AnalyƟcs. Together, they provide a fully integrated system for making sense of 
the past, gaining insights. 

aŌerwards and predicƟng the future, and recommending acƟons to get beƩer results. 

DescripƟve AnalyƟcs 

DefiniƟon: 

DescripƟve AnalyƟcs is about what has already happened. It uses historical data to 

generate summaries, reports, and visualisaƟons (e.g. charts, tables or dashboards). 

Meaning in Simple Words: 

By revealing trends and paƩerns, it tells us the story of what happened in the past. 

Purpose: 

So to the quesƟon: “What happened?” 

Key Features: 

6 

• Summarizes past business performance 

• UƟlizes tools such as reports, graphs or dashboards 

• Analysis to offer insight into trends, paƩerns and overall performance 

Example: 

For a retail shop, analyzing its sales data from last year to idenƟfy the products that sold the 
most and at what points. 

months. 

DiagnosƟc AnalyƟcs 
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DefiniƟon: 

Cause-and-effect - Analysis why analyƟc: The DiagnosƟc AnalyƟcs is one step ahead of the 
descripƟve analysis in order to explain why something happened. It 

idenƟfies reasons for end results and raƟonale for paƩerns or trends. 

Meaning in Simple Words: 

It allows us to idenƟfy the why, or root cause of what occurred. 

Purpose: 

To that quesƟon: Why did it happen? 

Key Features: 

• Applies methods including data discovery, correlaƟons and root cause analysis 

• Compares one data set with another in order to find relaƟonships 

• Facilitates geƫng to the root causes behind performance for managers 

Example: 

If revenue fell in one market, for example, diagnosƟc analyƟcs could show that salespeople 
weren't visiƟng there as oŌen. 

or heavy compeƟƟon in that field.” 

PredicƟve AnalyƟcs 

DefiniƟon: 

The arƟcle at wikipedia explains this with requirement for predicƟve analyƟcs: "PredicƟve 
AnalyƟcs encompasses a variety of staƟsƟcal techniques from modelling, machine learning, 
and data mining that analyze current and historical facts to make predicƟons about future, 
or otherwise unknown, events. 

to occur in the future from past informaƟon. 

Meaning in Simple Words: 

It makes its best guess about the future based on what has happened in the past. 

Purpose: 

In service to the quesƟon: “What can we expect?” 

7 

Did You Know? 
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Key Features: 

• Constructs models, using past data, in order to evaluate possible future outcomes 

• UƟlizes regression analysis, probability models, and other tools to invesƟgate problems 
independently. 

• Aids in predicƟng trends or customer behavior or demand 

Example: 

For example: an insurance company esƟmates the chance that a customer will file a claim 
within the next year as a funcƟon of age, 

driving history, and past behavior. 

PrescripƟve AnalyƟcs 

DefiniƟon: 

PrescripƟve AnalyƟcs not sure what could happen, but also recommends the best acƟon. It 
combines 

data, algorithms and opƟmizaƟon methods to suggest soluƟons. 

Meaning in Simple Words: 

It also tells you what to do in order to achieve the best results.” 

Purpose: 

To that quesƟon: What should we do? 

Key Features: 

• Presence of implicaƟons for pracƟce, based on predicted results 2.314 aORs Results and 
findings Analysis results Meal consumpƟon rate is significantly higher in both theoreƟcal 
modelling and cut-off threshold obtained by ROC as presented in Table 4 Comparison of the 
Italicized text weight index The odds that meal consumpƟon rates can be uniquely classified 
: Reference group （HW-group）vs NW-group OR (CI) -Refer. 

• Based on opƟmizaƟon and simulaƟon model 

• Assists decision-makers in selecƟng the opƟmal strategies 

Example: 

A logisƟcs company that uƟlizes prescripƟve analyƟcs soluƟons to find the most efficient 
delivery routes with the lowest fuel cost, and spare. 

Ɵme, and ensure on-Ɵme delivery. 
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Did You Know? 
“PredicƟve AnalyƟcs used in retail can forecast customer churn with up to 90% accuracy 
using simple tools like Excel combined with machine learning add-ins. This allows companies 
to take prevenƟve acƟon, such as offering loyalty rewards, before customers stop buying.” 

 

1.1.4 Importance of AnalyƟcs for Business CompeƟƟveness 

In the spirit of today’s ultra-compeƟƟve, globalized economy – where everything from coffee 
pots to clean shirts are made by others – businesses can always do beƩer. 

Firms no longer just compete based on price and product quality, but also for their capability 
to deliver quick, accurateupakanabolic benign andcompeƟƟve pressure 
compeƟƟveerformance is reportedly.py jobs FirmsHeldapplier The performanceconƟnuous 
knowledge flow processes amongsupplierthe s entsresources conƟnualKizerfi outlets. 

strategic decisions. The role of Business AnalyƟcs is to enable organizaƟons to stay ahead by 
:-2      a. 

so that the data and resources are used more intelligently. 

AnalyƟcs becomes a strategic asset when the raw data morph into acƟonable informaƟon. 
This allows 

new opportuniƟes, rapidly adjust to market changes, enhance operaƟonal efficiency and 
make beƩer business decisions. 

deliver beƩer value to customers. Across the board, companies that willsuccessfully adopt 
new businessmodels built on data-enabled insights are those withleaders or staff who can 
make decisions based on analyƟcresults. 

bull market leading and lagging. 

Rubber and plasƟc industry’s appeal A few reasons why analyƟcs makes you more 
compeƟƟve 

Improved Decision-Making 

It allows firms to make a decision based on facts and evidence rather than guess work. 

The risk of uncertainty is lowered, and the root business prioriƟes will be addressed by 
strategy. 

Cost ReducƟon and Efficiency 

Companies can use operaƟonal data to eliminate waste, minimize errors and opƟmize 
processes. This 

enables them to provide products and services at less expense than their rivals. 
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Customer Insights and PersonalizaƟon 

AnalyƟcal tools can give you rich insights into what your customers like, when they buy and 
feedback about their purchases. 

This informaƟon gives companies the opportunity to offer tailored experiences, increase 
saƟsfacƟon and establish. 

customer loyalty. 

InnovaƟon and New OpportuniƟes 

With data analysis, companies can find new trends to the current market, customers‘ unmet 
needs and gaps in markets 23. 

for product or service innovaƟon. That way, they keep ahead by providing new soluƟons 
prior to everyone else. 

compeƟtors. 

Risk Management 

AnalyƟcs can uncover potenƟal threats like fraud, supply chain interrupƟons and financial 
damages. By 

predicƟng and controlling risks appropriately so that stability and compeƟƟveness can be 
kept would also make things go well. 

Performance Measurement 

And, using analyƟcs, organizaƟons are able to keep an eye on performance by way of 
metrics and dashboards. 

That means they can monitor progress, see what others are doing and make real-Ɵme 
adjustments to their strategies. 

9 

Agility and Speed 

OrganizaƟons with analyƟcs can respond more quickly to changes in customer preferences, 
market condiƟons or! 

compeƟtor acƟons. By making fast, data-driven decisions, they can remain nimble and 
resilient. 

Example 

Imagine two retail companies in a fight in the same city. One firm employs analyƟcs to 
analyze the behavior of customer 
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preferences, manage stock levels and create necessary offers, whereas the other does not 
use anything except insƟnct and 

general markeƟng strategies. The analyƟcs-focused company may also win on more 
customers, save on costs from fewer.CastlighHea n… 

unsold stock, and get more expensive - then it is much more compeƟƟve in the long run. 

 

1.1.5 Industry ApplicaƟons of Business AnalyƟcs 

Business AnalyƟcs is not confined to one department or industry. The technology is 
applicable in a broad range of applicaƟons. 

helping companies streamline processes, lower costs and make more educated decisions. 
By analyzing data, 

businesses can learn valuable informaƟon about their content, customers, and market. The 
following are some of the 

primary areas where analyƟcs is a key factor: 

MarkeƟng 

Decisions in markeƟng need detailed analysis of customer habits, choices and market trend. 
Business 

AnalyƟcs gives marketers the power to move from educated esƟmates and hunches into 
making decisions based on evidence. 

ApplicaƟons in MarkeƟng: 

• Customer SegmentaƟon: Determining various types of customers such as age, income, 
interests, etc. 

acquisiƟon behavior in order to create laser focused campaigns. 

• Campaign EffecƟveness: There’s no guesswork required for adverƟsing campaign 
performance so adverƟsers know which plaƞorms 

and messages work best However. 

• Pricing: Understanding demand trends to price compeƟƟvely to opƟmise profits. 

• Customer LifeƟme Value: AnƟcipaƟng how valuable a customer will be in each moment 
and determining whatreesomeone is willing to spend on acquiring that customer. 

to invest in retaining them. 

Example: 
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A company that sells goods online collects and analyzes data about how customers have 
browsed, what they’ve purchased in the past, and can make oose which are best for each 
visitor. 

products which correspond to parƟcular tastes, and that sell more. 

Finance 

10 

Precision and discreƟon are essenƟal in finance. Business AnalyƟcs offers means to work 
with financial 

performance, fraud detecƟon, and investment. 

ApplicaƟons in Finance: 

• Risk Assessment: EvaluaƟng the credit history of loan applicants, and idenƟfying the 
likelihood that funds will be repaid. 

• Fraud DetecƟon: Finding abnormal transacƟons that are indicaƟve of fraud or money 
laundering. 

• Investment Analysis: PredicƟng market trends or assessing the performance of a porƞolio. 

• BudgeƟng and ForecasƟng: AnƟcipaƟng income and expenses based on an analysis of 
historical financial records. 

Example: 

Analyzing customer income, spending paƩerns and credit usage helps banks determine the 
potenƟal of a loan holder defaulƟng. 

scores before approving loans. 

OperaƟons 

Cost effecƟveness and customer saƟsfacƟon depend on effecƟve operaƟon. Business 
AnalyƟcs helps 

in supply chain, inventory and producƟon process opƟmisaƟon. 

ApplicaƟons in OperaƟons: 

• Supply Chain OperaƟon: ForecasƟng demand in order to maintain availability without 
overstocking. 

• Quality Assurance: EvaluaƟng defect rates and producƟon informaƟon to maintain high 
quality product. 

• AllocaƟon of Resources: Finding the best use of labor, material and equipment. 
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• LogisƟcs and Delivery: IdenƟfying the quickest, most economical ways to move products. 

Example: 

A logisƟcs company uses analyƟcs to opƟmize delivery routes in a way that minimizes fuel 
costs and guarantees Ɵmely deliveries, 

enhancing efficiency and customer experience.” 

Human Resources (HR) 

The best assets of a company are its people. Business AnalyƟcs assists HR in making beƩer 

choices on hiring, learning and keeping workers. 

ApplicaƟons in Human Resources: 

• Hiring Data Tools: Spreading a net in the form of resumes and past performance data to 
find talented candidates may be a thing of past with AI centered methods geƫng uƟlized. 

the best fit. 

Employee Performance: Keep an eye on the producƟvity of employees and pinpoint any 
gaps in training. 

• RetenƟon Strategies What employees are likely to leave, and how can it be prevented 

saƟsfacƟon. 

• Staff planning: Planning for future staff based on business expansion and seasonality. 

Example: 

One company is using HR analyƟcs to monitor employee engagement surveys, and views 
about absenteeism will be viewed by managers 

spot problems and boost culture. 

Did You Know? 

“Banks use real-Ɵme analyƟcs to detect fraudulent transacƟons within fracƟons of a second. 
For example, when your credit card is swiped in two different ciƟes within minutes, analyƟcs 
systems flag it instantly as a potenƟal fraud.” 

 

1.2 Fundamentals of Excel for AnalyƟcs 

MicrosoŌ Excel is one of the most widely used tools for business analyƟcs. It provides a 
simple and powerful 
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plaƞorm for storing, organizing, analyzing, and visualizing data. For beginners, Excel is easy 
to learn, yet it also 

offers advanced features that make it suitable for complex analysis. In the context of 
Business AnalyƟcs, Excel is 

oŌen the first tool students and professionals use to pracƟce data handling and decision-
making techniques. 

Excel allows users to work with rows, columns, and cells where data can be entered and 
manipulated. It includes 

features such as formulas, funcƟons, charts, pivot tables, and formaƫng tools that make it a 
versaƟle choice for 

data analysis. Before using these features, it is important to understand the Excel interface. 
 

1.2.1 IntroducƟon to Excel Interface 

The Excel interface is the locaƟon where users input, organize and assess informaƟon. 
Understanding the main 

parts of the interface is crucial to the effecƟve applicaƟon of the soŌware. Below are the 
key components: 

Title Bar 

• Siƫng at the top of the window. 

Name of the current open workbook (file). 

• Also includes quick buƩons for Minimize, Maximize, and Close. 

Ribbon 

• The Ribbon is the primary menu in Excel, found beneath the Title Bar. 

•Â Tabs (like home, insert, page layout, formulas, data, review) are split. 

12 

• Each tab includes several commands groups, such as: 

o Home Tab: Basic formaƫng features, such as font, alignment, number format, copy-paste. 

o Insert Tab: FuncƟons to insert charts, tables, shapes and pictures. 

o Formulas Tab: It contains funcƟons and formula tools. 

Quick Access Toolbar 
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• Above or below the Ribbon. 

• Shortcuts for commonly used commands, such as Save, Undo, Redo and Print. 

• User can edit it. 

Worksheet Area 

• The main table used to enter data. 

• Made up of rows (1, 2, 3…) and columns (A, B, C…). 

• A row-column intersecƟon is known as a cell, where you type data or formulas. 

• Anyone for cells? Each cell has an individual address: say A1 (column A, row 1). 

Formula Bar 

• Located at the top of the worksheet grid. 

• Displays the content of current cell (text, number, or formula). 

• Lets users type a formula or edit one from the store. 

Name Box 

• Located near the Formula Bar. 

• Displays the address of the current cell (such as A1, B5). 

• Can also be used to name cell ranges for ease of reference. 

Sheet Tabs 

• In the boƩom part of the window. 

• A single file in Excel (called a Workbook) may have mulƟple sheets (or worksheets). 

• Sheet-tabs let users toggle among mulƟple sheets. They can also be renamed or moved 
and deleted. 

Status Bar 

• At the boƩom of the Excel window. 

• Shows including mode (Ready, Edit, Enter) and summary calculaƟons (Total, Sum. 

N 45 Average,Count When you select more than one cell. 

• Can be personalized to display more informaƟon. 

Scroll Bars and Zoom Control 

VerƟcal and horizontal scroll bars provide a way to move around large worksheets. 
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• The zoom slider (boƩom-right of worksheet) zooms in or out on the contents of the 
worksheet. 

Example in PracƟce: 

The first Ɵme you open Excel, you'll be greeted by a blank worksheet consisƟng of cells laid 
out in rows and columns. 

InformaƟon such as sales numbers can then be entered in cells, formulas entered (in the 
formula bar), and graphs added (from. 

the Ribbon. By mastering this interface, users can get comfortable with Excel as an analyƟcal 
tool. 

 

1.2.2 Basics of Data Entry and EdiƟng 

Data Management tools: Entering, ediƟng and managing data in a worksheet is one of the 
basic elements in MicrosoŌ excel. 

Excel is mostly a tool for working with data, so you should become at least competent in 
how to properly enter values and then manipulate those values in the ways that are 
absolutely necessary”. 

modificaƟons is the point of departure for analysis. 

The worksheet grid is composed of rows, columns, and cells where data is inpuƩed. Each 
cell can hold 

various kinds of informaƟon such as numbers, text, dates, Ɵmes and formulas. 

Entering Data in Excel 

To input data, just click on a cell, and start typing. Once you have wriƩen, press Enter to 
jump down, Tab to jump across. 

right) or arrow keys to cell hop. 

Some data types you can enter (typing, and so on)lude the following: 

Text Data (Labels): 

o As name, Ɵtle, category or descripƟon. 

o Example: "Name of the Product," "Geographic Area," Employee." 

Numeric Data (Values): 

o Includes staƟsƟcal or numerical informaƟon used to perform mathemaƟcal operaƟons, 
such as sales figures, quanƟƟes, percentages o Financial. 
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values. 

14 

o Example: 500, 23.75, 100%. 

Dates and Time: 

o Excel is willing to accept a date or Ɵme as a true entry. 

o Example: 29-Aug-2025, 12:30 PM. 

Formulas and FuncƟons: 

o A formula starts with an = (equal sign) and most use cell references in computaƟons. 

o Example: =A1+B1 will add the contents of two cells. 

o You can also enter funcƟons such as =SUM(A1:A10) or =AVERAGE(B1:B5) directly into the 
cells. 

EdiƟng Data in Excel 

Once data is stored, they may be need to be amended or updated. There are various 
methods for ediƟng in Excel: 

Direct EdiƟng in a Cell: 

o Simply double-click on the cell and edit it directly. 

o Enter to confirm changes, or Esc to cancel. 

EdiƟng in the Formula Bar: 

o Click on the cell and change the content within that cell at the top of the worksheet in 
formula bar. 

Replacing Data: 

o Just click the cell and begin entering new data. All of the old content will be cleared and 
replaced with new one. 

DeleƟng Data: 

o Highlight the cell(s) and hit Delete to erase content. 

Undo and Redo: 

o In case of error, click Undo (Ctrl + Z) to cancel the acƟon or Redo (Ctrl + Y) to do it again. 

Moving and Copying Data 
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• Cut and Paste: Transfer data from one cell to another. Shortcut: Cut (Ctrl+X) and Paste 
(Ctrl+V). 

• Copy and Paste: Replicate. • In a nutshell, copy data. Shortcut: Ctrl + C (copy) and Ctrl + V 
(paste). 

• Drag and Drop: Click on the border of a selected cell with, hold it and then drag into the 
new posiƟon. 

• Fill Handle: A small square at the lower-right corner of a selected cell that you drag over 
cells to .charted. 

a series or a sequence of numbers, dates. 

Example in PracƟce 

Let's say a user would like to make the following simple sales report: 

•  On Column A, write product (as text). 

• Write numbers in Column B for amounts sold. 

• In Column C, enter sales revenue (figures). 

• If you are fixing a mistake in quanƟty, double-click the cell in Column B, modify the amount 
and press Enter. 

• If you want to tally total sales, enter =SUM(C2:C10) in a cell beneath the column of sales. 

Users can gain confidence learning and perfecƟng data entry & ediƟng, preparing them well 
for more complex Excel funcƟonality like 

formaƫng, formulas, and analyƟcs. 

 

“AcƟvity: CreaƟng and EdiƟng a Sales Dataset” 

Consider a sales dataset for a small store. Create an Excel worksheet with three columns 
Ɵtled Product Name, QuanƟty Sold, and Price per Unit. Enter details for at least 10 different 
products. Next, edit one product name to correct a spelling error, and delete one row for a 
disconƟnued product. Use the Fill Handle to generate a simple sequence of quanƟƟes (e.g., 
5, 10, 15). Finally, insert a new column named Total Revenue and calculate the value for each 
product using the formula (QuanƟty × Price). Submit the completed sheet and highlight the 
edits you made. 

 

1.2.3 Formaƫng Tools in Excel 

Page 21 of 38 - AI Writing Submission Submission ID trn:oid:::3618:127424871

Page 21 of 38 - AI Writing Submission Submission ID trn:oid:::3618:127424871



Raw Excel data oŌen looks ugly and unstructured. It's hard to immediately grok or even 
without a certain amount of style. 

process data, and is especially useful for working with big data. Excel's Formaƫng 
CapabiliƟesBenefitsFormaƩed data is aƩracted to the viewer, and Excel provides tools that 
can develop how data will appear on paper or screen. 

, emphasis significant numbers and improve readability. Well-formaƩed data not only feels 
34 The Grammar of Graphics right, it also looks right. 

professional but also directs decision-makers to the most relevant insights. 

In the Excel applicaƟon, formaƫng can be broken down into three main categories: 

Text & Number Formaƫng 

CondiƟonal Formaƫng 

Table Styles 

Text & Number Formaƫng 

Text and number formats dictate how data appears in a cell. Formaƫng does not alter the. 

data's root values, it impacts the way we see data. 

A. Text Formaƫng 

16 

Excel provides many useful opƟons to format text for clarity and emphasis. 

• Font: Select a font from the list (such as Calibri, Arial, or Times New Roman) and customize 
thểm hieät đối với các thăm pages inlói và page-out ENTRY PAGES AND PAGE-OUTs —xx lập 
xởa chức entry để và cúa trang FORMAT—PAGE SETTINGS(Picture 3-6) You can set up the 
layout for your documents here. 

font size of headlines, subsecƟons or number labels. 

• Bold, Italic, Underline: You can highlight principal messages by using either bold or italic 
text or underlining relevant key words; and 

underlining totals. 

• Text Color: Adjust the color of text to emphasize categories (eg, red for Losses / green for 
Profits). 

• Fill Color (Background for Cells): Shade cells to add some colors to different secƟons or 
make your headings pop. 
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• Text alignment: Align text on the leŌ, right or center of the cell. You can also verƟcally 
align your text to the top, 

middle, or boƩom. 

• Text OrientaƟon Rotate text at a slant or verƟcally for column headers. 

• Wrap Text: Lets you see mulƟple lines of long text in a cell. 

• Merge & Center: Put many cells into one and center the text across them (perhaps for a 
table header) 

Ɵtles). 

Example: 

If we’re talking about a sheet displaying student marks, then like “Subject” and “Marks”, 
“Grade” can also be boldened, centred, paddingLeŌ of 20px etc. 

shaded for easy disƟncƟon. 

B. Number Formaƫng 

Number formaƫng ensures that numbers are presented in a meaningful way. 

• Standard: Format to use for numbers as they are typed. 

• Number Format: Control decimal places, thousands (e.g., 10,000) and negaƟve some 
formaƩers. 

number display. 

• Currency and AccounƟng: Display numbers with currency symbols like $ or ₹, which have 
a specific posiƟon in the format 1234. 

comparison. 

• Percentage: Changes numbers to percentages. Example: Entering 0.25 and formaƫng as 
percentage 

shows 25%. 

• Date and Time: Date numbers dateƟmes (2001/01/01 12:34:56) can be formaƩed in 
various ways with the DateFormat transformer. 

29-Aug-25, 29 August 2025 or possibly even 8/29/25. 

• FracƟon : To show a value as fracƟon (example: 1/2, 3/4). 

• ScienƟfic (ExponenƟal): For extremely large or small values, such as 1.23E+06. 
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• Custom Formats: Create your own formats (ie phone numbers ###-###-####) or product 
numbers 

(PROD-0001). 

17 

Example: 

The revenue is made “Currency” in a Filed Formaƫng and we visualize the overall growth as 
percentages. 

rates. 

CondiƟonal Formaƫng 

CondiƟonal formaƫng is a sophisƟcated feature that automaƟcally formats cells when 
certain condiƟons are met. 

rules or condiƟons. This automaƟcally reveals paƩerns, trends and outliers. 

Features of CondiƟonal Formaƫng 

Highlight Cell Rules: 

o Highlight values higher than, lower than, equal to or between certain limits. 

o Example: Let all the amount that are $ 50,000 and above be shown as red. 

Top/BoƩom Rules: 

o You may choose to display the top 10% display the boƩom 10%, or a specific number of 
values, such as those that rank highest/lowest. 

o For example, find the top 5 salespeople and format their data in green. 

Data Bars: 

o Insert horizontal bars within the cells based on their values. 

o Example: Eye balling the sales performance month by month. 

Color Scales: 

o Use gradient colors to indicate variaƟon. High values could be dark green and low values 
red. 

o Example: Regional profit margins can be visualized with gradual color gradient (heatmap). 

Icon Sets: 

o Use symbols such as arrows, traffic lights or stars to show the performance of data. 
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o Example: Arrow icons indicaƟng upward or downward sales progression. 

Advantages of CondiƟonal Formaƫng 

• Great for highlighƟng important informaƟon. 

• No longer need to visually scan large sets of data. 

• OpƟmises the decision-making process through visual representaƟon of focus areas. 

Example in PracƟce: 

For example, a teacher reviewing test scores can use condiƟonal formaƫng to display any 
score less than 40 in red or between("""60=40 AND <63"""). 

and 60 in yellow and above 60 in green), enabling to easily idenƟfy range of students 
outcome. 

Table Styles 

18 

Excel Tables are a wonderful alignment of performance and simplicity that lead to the heart 
of structured data. ConverƟng a range This snippet converts a simple data range. 

to a table automaƟcally apply formaƫng and include helpful features. 

How to Create a Table 

Select the data range. 

Inside Insert, click on Table or use the Ctrl + T shortcut. 

Select whether you have headers, and the range of data will be verified. 

Features of Table Styles 

• Styles Galleries: Professional-look styles allow you to apply format quickly (light, medium 
or dark) with a single click. 

alternaƟng row colors (banded rows). 

• Header Row : The column headers become bold and get filter icon list buƩons. 

• SorƟng and Filtering: You can sort any column in ascending or descending order, and filter 
the data by criteria. 

• Total Row: Apply a total row to the boƩom that automaƟcally calculates totals, averages, 
counts, etc. 

• Dynamic Range: The table will also auto-expand when new rows or columns are either 
added. 
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• Structured References: Formulas in a table can reference column names instead of cell 
addresses, 

making them easier to understand. 

Benefits of Table Styles 

• InformaƟon is professionally and cleanly organized. 

• Datasets that are relaƟvely large will be more readable, easier to work with and therefore 
facilitate analysis. 

• AutomaƟc features to save you Ɵme and effort in formaƫng. 

Example in PracƟce: 

For example, an HR dataset that has employee names, departments, their salaries and the 
date they joined could be transformed into a table. 

Row colors are alternated for easy reading, and filters are included so you can analyze the 
staff in a parƟcular 

department or salary range. 

All Three Formaƫng Tools in an Example Data Here is a demonstraƟon examples of all the 
three formaƫng tools. 

For example, say a sales manager is creaƟng an Excel monthly sales report: 

• Text & Number Formaƫng: bold and center the product names, $22,331.36 
4.docs.promo_code_id.revenue is treated as 

currency. 

• CondiƟonal Formaƫng: All sales more than ₹1,00,000 are marked as green color, less than 
₹50,000 is red. 

in red. 

• Table Styles: With banded rows, filters and a total row the whole dataset is transformed 
into a table 

overall revenue. 

19 

The result is a professional report that is easy to understand and that highlights relevant 
informaƟon immediately. 

 

1.2.4 Cell Referencing 
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In Excel, it is common for formulas to include references to the data contained in other 
cells. This is known as cell referencing. 

Instead of keying numbers and text into a formula you use cell references to point to that 
informaƟon. This makes 

dynamic formulas: if a value in a referred cell is amended, the formula updates itself 
accordingly. 

Cell references are specified by a cells coordinate of column leƩer and row number. For 
example: 

• A1 is any cell in column A row 1. 

• C5 is the cell at column C and row 5. 

Excel offers 3 types of cell reference: 

RelaƟve Referencing 

Absolute Referencing 

Mixed Referencing 

And each type does something unique when you copy and paste or move a formula to any 
other cell. 

RelaƟve Referencing 

DefiniƟon: 

A relaƟve reference in Excel adjusts when you drag the formula to another cell. It adjusts 
automaƟcally 

according to the relaƟve posiƟon of rows and columns. 

How It Works: 

• If a formula menƟons A1, and you copy that formula down one row, the reference 
becomes A2. 

• Likewise, when copied one column right, A1 becomes B1. 

Example: 

Assuming cell A1 contains the value 10 and A2 contains 20. 

• In cell B1, enter the formula =A1*2. 

• Result: 20. 

• Now copy the formula to B2. 
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• Formula in B2 changes by itself to =A2*2 and result is 40. 

Use Case: 

RelaƟve referencing is helpful when you are performing the same calculaƟon in a series of 
rows or columns (e.g. 

mulƟplicaƟon of a set of pricing with a tax rate). 

20 

Absolute Referencing 

DefiniƟon: 

In Excel, an absolute reference never changes when you copy it elsewhere in your sheet or 
move it around within a formula. It is a reference to a staƟonary cell, no maƩer where it is 

the formula is placed. 

How It Works: 

• An absolute reference is formed by appending a dollar sign ($) to the column leƩer and 
row (e.g., $A$1). 

$A$1). 

• Wherever you copy the formula, it refers just to A1. 

Example: 

If A1 = 10 (a tax rate), and the range B1 : B3 contain values (100,200,300 for instance) . 

• Enter the formula =B1*$A$1 into cell C1. 

• Result: 1000. 

• Copy the formula down to C2 and C3. 

• Every formula conƟnues to mulƟply the price in column B by the constant in cell A1 (10). 

• Results: 2000, 3000. 

Use Case: 

You must use absolute referencing when a formula calls for an unchanging value, such as tax 
rates, exchange rates or 

commission percentages. 

Mixed Referencing 

DefiniƟon: 
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A mixed reference locks the columns or rows, but not both. It is both relaƟve and absolute 

references. 

Types of Mixed References: 

$A1: The column is absolute, but row changes when copied. 

A$1: Row is absolute, column is relaƟve on copy. 

Example: 

We assume that column A has 5,10, 15 then row 1 have price of each unit as $100,200 
&300. You want to 

sum the cost for all amount x price combinaƟons defined in a grid. 

• In cell B2, type =$A2*B$1. 

• $A2 anchors column A (quanƟty) and row changes as the formula is filled down. 

• B$1 locks row 1 (unit price), but column adjusts when formula is copied Copy the formula 
across → each cell should calculate total cost for that quanƟty and price. 

Use Case: 

Mixed references are parƟcularly helpful when you're creaƟng mulƟplicaƟon tables, 
financial models or sensiƟvity 

analysis in which the one axis is a measure of quanƟty variaƟon and theother is 
anrex<;eericIebas) prices It (sic). 

Comparison of Reference Types 

When Copied Type Format Behavior Use Case Example 

RelaƟve 

Reference 

A1 Changes the row only and the column as well. 

automaƟcally 

Apply formulas across rows or 

columns 

Absolute 

Reference 
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$A$1 stays the same no maƩer where it is The liƩle bread-and-buƩer items − etc, remain 
constant wherever =$A$1Occurs. 

constants 

Mixed Reference $A1/ 

A$1 

Corrects one row or one column per parƟcular MulƟplicaƟon Tabless models 

IllustraƟve Scenario: 

Consider compuƟng the final prices of items including tax. 

• In Column A, we’ve got the quanƟƟes; prices are in Column B; and we have a tax rate 
entered in cell C1. 

• Formula in C2: =B2*$C$1. 

o RelaƟve part (B2): Changes as you go down rows for individual prices. 

o Absolute part ($C$1): Always performs reference from the constant tax rate. 

These two ingredients endow formulas with power and agility in dealing with large data. 

 

“AcƟvity: Salary CalculaƟon Using Cell Referencing” 

“Prepare a salary sheet in Excel with three columns Ɵtled Employee Name, Basic Salary, and 
Allowance (%). Enter the names and salaries of at least five employees. Store a fixed 
allowance rate (e.g., 10%) in a separate cell. Using absolute referencing, calculate the 
Allowance for each employee. Then, using relaƟve referencing, calculate the Total Salary as 
the sum of Basic Salary and Allowance. Copy the formula down the column for all 
employees. Submit your sheet and include a brief note (2–3 sentences) on why absolute 
referencing was essenƟal in this case.” 

 

Knowledge Check 1 

Choose the correct opƟon: 

1. Business AnalyƟcs can be best defined as: 

A) The process of making guesses about the market 

B) The use of data and staƟsƟcal techniques to support decision-making 

C) The recording of business transacƟons only 
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D) A way to design products without data 

2. Which type of analyƟcs answers the quesƟon “Why did it happen?”? 

A) DescripƟve AnalyƟcs 

B) DiagnosƟc AnalyƟcs 

C) PredicƟve AnalyƟcs 

D) PrescripƟve AnalyƟcs 

3. Which Excel feature is used to change the appearance of cells automaƟcally based on 
condiƟons? 

A) Table Styles 

B) CondiƟonal Formaƫng 

C) RelaƟve Referencing 

D) Merge & Center 

4. In Excel, which reference type will always point to the same cell, even when copied to 
other rows or 

columns? 

A) RelaƟve Reference 

B) Absolute Reference 

C) Mixed Reference 

D) General Reference 

5. Which industry commonly uses analyƟcs for fraud detecƟon? 

A) MarkeƟng 

B) Finance 

C) OperaƟons 

D) Human Resources 

 

1.3 Summary 

Chapter 1 presented an overview of Business AnalyƟcs and Excel for analyƟcs. Business 

(As an aside, AnalyƟcs was defined as the applicaƟon of data, staƟsƟcal methods and 
analyƟcal toolsto Decision-making) 
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idenƟfy opportuniƟes, and improve compeƟƟveness. Data-based decision-making was 
highlighted, and . 

demonstraƟng how raw data erodes uncertainty, reveals paƩerns and uncovers facts in 
support of smarter decisions. 

The four primary types of analyƟcs -- descripƟve, diagnosƟc, predicƟve, and prescripƟve -- 
were described, 

, each answering unique business quesƟons from “What happened?” to “What should we 
do?”. 

The role of analyƟcs in enabling business compeƟƟveness was also illustrated indicaƟng the 
fact that it 58_SECURE ISJ2016 should be viewed as mission criƟca. 

Enhances decision making, efficiency, customer saƟsfacƟon, innovaƟon and risk 
management. Industry 

analyƟcs were applied to markeƟng, finance, operaƟons and human 
resources.openqa@wiley. 

(where its uƟlity is demonstrated in various applicaƟons). 

❖ Overview the basics ofMS Excel as an analyƟc tool. The Excel interface, 

(including ribbon, worksheet area, formula bar sheet tabs), which was described as the 
work-space of informaƟon 

entry and analysis. Data entry and ediƟng basics covered how to enter, edit, and supervise 
text in the);   

numbers, and formulas efficiently. Excel formaƫng tools (e.g., text and number formaƫng, 

a table and a style [12]., Styles -themes, fonts, colors, effects condiƟonal formaƫng-,Table 
Aspects] as well to enhance data more comprehensive readability. Finally, 

, the idea of cell referencing (relaƟve,addressing and mixed) in formulas is introduced, 
showing how formulas are expressed. 

dynamically or in fixed manners communicate with the cells. Ca2+ Second 
MessengersThese are the principles on which both. 

applying Excel in business analyƟcs. 

1.4 Key Terms 

Business AnalyƟcs: The uƟlizaƟon of data, staƟsƟcal analysis, and other types of 
mathemaƟcal tools to drive business decision-makings 

and improve performance. 
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DescripƟve AnalyƟcs: Analysis that reports what happened in the past to answer “What 
happened?”. 

Diagnosis AnalyƟcs: Type of analyƟcal process that explains “Why did it happen?”. 

PredicƟve AnalyƟcs: Predict the future using models and data. 

PrescripƟve AnalyƟcs: AnalyƟcs that prescribes acƟons to achieve desired outcomes. 

Excel Workbook: An Excel file that consists one or more worksheets. 

Worksheet: The grid of rows and columns in an Excel file where you enter and analyze your 
data. 

Cell: The point at which a row and column cross in Excel and are used to contain data or 
formulas. 

Formula Bar: The place in Excel where you see what is in the current cell and input 
something new if necessary. 

Entering Data: Typing text, numbers, dates or formulas into cells in an Excel document. 

Formaƫng Text format: Appearances of text, such as font, size, color and alignment. 

1.5 DescripƟve QuesƟons 

1] Define Business AnalyƟcs and discuss how it is used in contemporary organizaƟonal 
seƫngs. 

Explain how data is used in decision-making by giving examples. 

Elaborate four types of analyƟcs with examples that are appropriate. 

What is the role of analyƟcs in compeƟƟve business? 

Explain how industry makes use of business analƟcs in markeƟng, finance, operaƟons and 
human 

resources. 

Describe the elements of the Excel interface. 

What are the most important data entry and ediƟng skills to have in Excel? 

Describe various Excel tools for formaƫng text and numbers. 

Imagine you have a data set in which you have a product, the number of units sold, the 
price per unit and a region. 

• Add at least 10 products in 3 regions. 
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• Use a new column to calculate the Total Revenue for each product Sold (Units Sold * Unit 
Price). 

• Use CondiƟonal Formaƫng to idenƟfy the products where Total Revenue is more than 
₹50,000. 

• Make Table, use a proper table style for a beƩer look and feel. 

• Calculate the Total Revenue of products by creaƟng a RelaƟve Reference formula, and an 
Absolute 

to calculate the final, net revenue aŌer tax Include a fixed, separate percentage tax (found 
in another cell as well) to be applied. 

• Summarize into a Pivot Table to represent total revenue by region. 

 

1.6 References 

1. Evans, J. R. (2017). Business AnalyƟcs. Pearson EducaƟon. 

2. Sharda, R., Delen, D., & Turban, E. (2018). Business Intelligence, AnalyƟcs, and Data 
Science: A 

Managerial PerspecƟve. Pearson. 

3. Winston, W. L. (2016). MicrosoŌ Excel Data Analysis and Business Modeling. MicrosoŌ 
Press. 

4. Albright, S. C., & Winston, W. L. (2015). Business AnalyƟcs: Data Analysis and Decision 
Making. 

Cengage Learning. 

5. MicrosoŌ Excel DocumentaƟon and Training Resources – MicrosoŌ Office Support 
Website. 

 

Answers to Knowledge Check 

Knowledge Check 1: 

1. B) The use of data and staƟsƟcal techniques to support decision-making 

2. B) DiagnosƟc AnalyƟcs 

3. B) CondiƟonal Formaƫng 

4. B) Absolute Reference 
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5. B) Finance 

 

1.7 Case Study 

“Using Business AnalyƟcs and Excel to Improve Retail Sales Performance” 

 

IntroducƟon 

In a digital era, retail business acquires huge amount of data from customer purchase, store 

transacƟons, and online plaƞorms. EffecƟve management and analysis of this data has the 
potenƟal to change business 

decision-making. ExisƟng use of Business AnalyƟcs, along with Excel tools, retail users are 
able to 

analyze customer behavior, idenƟfy trends in sales and make informed decisions. This case 

research describes how Integer Tuna, a retailing business, used Business AnalyƟcs principles 
as well as introductory Excel forStateand conclusions: The case discussion applied 
spreadsheets in a retainer.linkedin.getAmount corporate form "if it restricts spending and 
costs. 

counter falling sales and operaƟonal inefficiencies. 

Background 

XYZ Retail Ltd. has several stores located in various ciƟes. Recently, management noƟced 
that overall 

sales were down, inventory was piling up and customer saƟsfacƟon raƟngs were waning. 
The company 

( gathering monthly sales report with product wise revenue, customer review and product 
raƟng. To address these challenges, 

27 

management chose to do Business AnalyƟcs from MicrosoŌ Excel as it is available and easy 
to use. 

easy for staff who have a rudimentary data literacy to be able to pick up. 

Challenges and Issues 1: Insight for Sales Trend Not Available 

The company had a lot of sales data, but not insights into paƩerns or seasonality — or what 
Steve Kagan calls, “acƟonable intelligence. 
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high-performing products. 

SoluƟon: Managers used Excel and descripƟve analyƟcs to summarize and analyze the 
condensed data in the form of charts and pivot tables. 

sales by month and region, product category. This helped pinpoint seasonable peaks and 
under performing . 

products. 

MCQ: 

Which is the best Excel feature to quickly summarize and analyze large data sets in order to 
find paƩerns of sales? 

A) CondiƟonal Formaƫng 

B) Pivot Tables 

C) Merge & Center 

D) Text Wrapping 

Answer: B) Pivot Tables 

ExplanaƟon: Pivot Tables You can use a pivot table to organizaƟon and summarizaƟon of 
large amounts of data, showing sales_ISSUE 2014 Q1_ONLY (consider it a raw data) is best 
processed by using Pivot Table. 

paƩerns and trends. 

Problem 2: Pricing and ForecasƟng Challenges 

Managers also did not know how to effecƟvely anƟcipate demand and change prices 
dynamically. Decisions were 

oŌen based on guesswork. 

SoluƟon: By applying Excel predicƟve analyƟcs trendlines and forecasƟng tools, the 
company 

future sales forecasts for each item. The price elasƟcity was also esƟmated including the 
results for contentValues(SessionIDx and (best)pagerank. 

the increasing history of sales at various price points. 

MCQ: 

What type of analyƟcs is used to predict future sales based upon previous sales? 

A) DescripƟve AnalyƟcs 
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B) DiagnosƟc AnalyƟcs 

C) PredicƟve AnalyƟcs 

D) PrescripƟve AnalyƟcs 

Answer: C) PredicƟve AnalyƟcs 

28 

ExplanaƟon: PredicƟve AnalyƟcs leverages historical informaƟon and staƟsƟcal models to 
anƟcipate probable future 

outcomes. 

Issue 3: IneffecƟve Management of the Stocks 

Stock was either too much (lead to waste) or too liƩle(this leaded to stock outs) such that 
there were. 

dissaƟsfied customers. 

Answer: By using absolute referencing with Excel formulas, managers made formulaic sheets 
which 

safety stock considering pre-determined reorder quanƟty. HighlighƟng was accomplished 
using condiƟonal formaƫng 

overstocked and understocked products. 

MCQ: 

What referencing in Excel makes a formula reference to the same cell all the Ɵme when it is 
copied? 

A) RelaƟve Reference 

B) Absolute Reference 

C) Mixed Reference 

D) General Format 

Answer: B) Absolute Reference 

Notes: An absolute reference (such as $A$1), on the other hand, does not change when you 
copy it. 

valuable when values are fixed such as tax rates or safety stock levels. 

Conclusion 

With the use of Business AnalyƟcs and Excel tools, ABC Retail Ltd. achieved a 
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view of sales trends, predict demand and manage inventory beƩer. This improved 

the company while at the same-Ɵme lowered costs, raised customer saƟsfacƟon and 
afforded the corporate a. 

compeƟƟve edge. It shows how even the simplest tools like Excel, paired with analyƟcs, 

can deliver powerful business soluƟons. 
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*% detected as AI
AI detection includes the possibility of false positives. Although some text in 
this submission is likely AI generated, scores below the 20% threshold are not 
surfaced because they have a higher likelihood of false positives.

Caution: Review required.

It is essential to understand the limitations of AI detection before making decisions 
about a student’s work. We encourage you to learn more about Turnitin’s AI detection 
capabilities before using the tool.

Disclaimer
Our AI writing assessment is designed to help educators identify text that might be prepared by a generative AI tool. Our AI writing assessment may not always be accurate (i.e., our AI models 
may produce either false positive results or false negative results), so it should not be used as the sole basis for adverse actions against a student. It takes further scrutiny and human 
judgment in conjunction with an organization's application of its specific academic policies to determine whether any academic misconduct has occurred.

Frequently Asked Questions

How should I interpret Turnitin's AI writing percentage and false positives?
The percentage shown in the AI writing report is the amount of qualifying text within the submission that Turnitin’s AI writing 
detection model determines was either likely AI-generated text from a large-language model or likely AI-generated text that was 
likely revised using an AI paraphrase tool or word spinner.
 
False positives (incorrectly flagging human-written text as AI-generated) are a possibility in AI models.
 
AI detection scores under 20%, which we do not surface in new reports, have a higher likelihood of false positives. To reduce the 
likelihood of misinterpretation, no score or highlights are attributed and are indicated with an asterisk in the report (*%).
 
The AI writing percentage should not be the sole basis to determine whether misconduct has occurred. The reviewer/instructor 
should use the percentage as a means to start a formative conversation with their student and/or use it to examine the submitted 
assignment in accordance with their school's policies.

What does 'qualifying text' mean?
Our model only processes qualifying text in the form of long-form writing. Long-form writing means individual sentences contained in paragraphs that make up a 
longer piece of written work, such as an essay, a dissertation, or an article, etc. Qualifying text that has been determined to be likely AI-generated will be 
highlighted in cyan in the submission, and likely AI-generated and then likely AI-paraphrased will be highlighted purple.
 
Non-qualifying text, such as bullet points, annotated bibliographies, etc., will not be processed and can create disparity between the submission highlights and the 
percentage shown.
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Unit 2: Data Cleaning & Conditional Formatting Working with Data (Sorting, Filtering & 
Tables) 

 

Learning Outcomes 

1. Understand the concept and importance of data cleaning and preparation for 
accurate analysis. 

2. Apply basic formatting and conditional formatting techniques in Excel to organize and 
highlight data. 

3. Perform data entry, sorting, and filtering operations to manage datasets eƯectively. 

4. Use Excel functions and formulas to process and analyze raw data. 

5. Summarize data using tables, charts, and descriptive statistics. 

6. Familiarize themselves with key terms related to data handling and analytics. 

7. Reinforce learning through descriptive questions, exercises, and references for 
practice. 

Content 

2.0 Introductory Caselet 

2.1 Data Cleaning and Preparation 

2.2 Formatting and Conditional Formatting 

2.3 Working with Data 

2.4 Summary 

2.5 Key Terms 

2.6 Descriptive Questions 

2.7 References 

2.8 Case Study 

 

2.0 Introductory Caselet 

“Meera’s Struggle with Messy Sales Data.” 

Meera, 29 Business analyst with a retail company in Pune Wanted to prepare a 
quarterly sales 
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management team performance report. The company had pulled sales figures from its 
diƯerent locations, however, when Meera opened the Excel file sent to her with all of the 

data combined it was nearly impossible to interpret. The data was replete with 
duplicate customer 

entries, absent sales values and non-uniform date formats. and While others were 
entered as 12-09-25. 

12-2025, and some even as 2025/09/12. More than that, the worksheet was also 
unformatted and hard to read. 

or present. 

Before she could chart or analyze anything, Meera knew that there would be the raw 
data that needed to be cleaned and organized. 

She first worked on removing duplicates, filling in missing values with logical guesses 
and scaling all of the transformers. 

dates into a single format. What she did was put it into a basic format to make it easy to 
read, and then used conditional 

The formatting was to make the sales under ₹20,000 red. Finally, she turned the data 
set into an Excel Table with the following: 

enabled her to filter, sort and add up totals in real time. 

When she was done, what had been an everything-everywhere data set looked like a 
professional,organized report. The managers were impressed, and Meera had 
discovered an essential truth: analytics starts with clean data. Without thorough 
cleansing and formatting, not one analysis can be a trusted guide. 

Critical Thinking Question: 

If you were Meera, which one of the three problems would you handle first: duplicates, 
missing values or inconsistency? 

date formats — and why? 

 

2.1 Data Cleaning and Preparation 

Before any meaningful analysis can be conducted, data must be properly cleaned and 
prepared. Raw data collected from various sources—such as surveys, transaction 
systems, sensors, or social media—often contains errors, inconsistencies, or missing 
values. If left untreated, these problems can lead to incorrect conclusions and poor 
business decisions. Data cleaning and preparation is the process of transforming raw 
data into a usable format by correcting errors, removing irrelevant information, filling 
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missing values, and standardizing formats. It is often said that analysts spend nearly 
70–80% of their time preparing and cleaning data, because only accurate and 
consistent data can produce reliable results in analytics. 

2.1.1 Importance of Data Cleaning in Analytics 

Data Scrub An Insight Data is central to analytics for many reasons. Even the advanced 
partie Without clean data, the most sophisuples cannot survive. 

models or tools cannot provide any significant information. 

Ensures Accuracy of Analysis 

Bombinating with errors in the data (typos, double entries, poor positioning of decimal 
points) can disrupt results. For example, if a 

sales is mistakenly recorded as ₹100,000 it could be misleading for profit. Cleaning 

guarantees that the dataset is a reliable representation of the reality. 

Improves Decision-Making 

Good data gives decision-makers confidence in the evidence. It is only when 
executives develop strategies on the basis of accurate and 

consistent information, their decisions are more likely to turn out right. On the other 
hand, when your data is not good enough, you run the risk getting a wrong insight and 

wrong business strategies. 

Enhances EƯiciency of Analysis Tools 

Software and tools prefer well-organized datasets. Clean, standardized data reduces 

processing and prevents statistical models, pivot tables or visualisations from errors. 

Supports Better Predictions 

The predictive analytics is based on the history information. Predictions about the 
future are meaningless if past data is incomplete or inconsistent, buturacy. 

will be unreliable. Clean data means models trained on reputable information. 

Builds Trust and Credibility 

Trust Reports & Dashboards managers and stakeholders will trust reports from high 
quality 

data. Good data creates trust in the results of your analytics, and makes acting on 
recommendations simpler. 

Reduces Costs 
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Bad data results in bad marketing campaigns, bad allocation of resources and visiting 
the wrong customers—all of 

which cost money. Clean data can save organizations from such losses and promote 
eƯicient spending. 

Improves Customer Experience 

A clean data file means customer records have the right information—right names, 
correct contact info for approved people as well as proper puchase 

histories. This enables businesses to provide tailored experiences and develop 
stronger connections with customers. 

Example: 

A retail chain that analyzed its customer data discovered thousands of duplicates — 
customers who were registered more than once. 

times with slightly diƯerent spellings. Cleaning the data, the company consolidated 1 

unified record for each 

customer. This served to increase the accuracy of loyalty programs, decrease marketing 
duplication and strengthen event tie-ins. 

customer satisfaction 

 

2.1.2 Data Cleansing Methods 

Once the significance of clean data is realized, next we have to think of ways to cleanse 
such dirty data. Data cleansing 

(or data cleaning) is" the process of modifying, replacing or deleting S02 Data Cleaning 
set so that it becomes suitablefor a particular use" (Fayyadet al 1996). 

reliable and suitable for analysis. 

Data cleaning techniques Some of the popular data cleaning methodologies include: 

Removing Duplicates 

Forms and duplicate data are added when the same set of data is input twice. This is a 

common situation in typical customer databases, 

sales records, or survey responses. Duplicated samples may produce inflated 
estimates and hence confusing findings. 

Example: 
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But two customer names in a sales database — “Ravi Kumar” and also “R. Kumar” — 

might be the same person. When both entries are 

tabbed as two separate clients, the client count inflates on paper. 

How to Remove Duplicates in Excel: 

•Identify and remove duplicate rows using the Remove Duplicates option on the Data 
tab. 

• Use filters or conditional formatting to identify duplicate entries for review. 

• Combine redundant customer IDs or transaction numbers into one exact record. 

Handling Missing Values 

Absent data results when there is no recorded value for a variable. left unchecked can 
results in an inadequate incomplete or even biased analysis. 

Types of Missing Data: 

• Non-monotonic Missing Data: Values of the data are missing in a random manner 
such as how missing values can occur dynamically in a deployed system. 

• Systematic Missing Data: “Thelack of datainsome observations is due to the same 
reason or pattern(i.e., involves some wheathertypes for weather data)” (eg, amachine 
failureto record information) 

readings on specific days). 

Techniques to Handle Missing Values: 

• Deletion: Delete rows or column with missing values if they are not significantly 
important for analysis and if you have very few. 

• Imputation: Missing data are replaced with one of the following substitutes: 

o The average, median, or most typical of the data available. 

33 

Example: 

or Forward and backward filling (fill with previous or next value in time-series data). 

o Predicted values from statistical or machine learning models. 

If a customer record lacks an age value in a dataset, the missimg value could be 
imputed within the mean age for all customers in the current dataset. 

Standardizing Data Formats 
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Normalization is a good way of storing data uniformly so that it can be compared and 
analyzed consistently. Without 

normalization, identical data found in diƯerent forms should be regarded as multiple 
values. 

Common Issues with Data Formats: 

• Dates recorded with diƯerent formats: 12/09/2025 vs. September 12, 2025 vs. 09-12-
25. 

• Phone numbers with or without country codes. 

• Inconsistent units of measure (e.g., kg vs. lb). 

Standardization Techniques: 

• Standardize formats using Excel’s formatting tools (Number, Date, Currency) or you 
will never be able to combine data. 

• Use text functions such as UPPER(), PROPER(), TRIM() to normalize case and eliminate 
excessives spaces 

spaces. 

• Make all units the same system for measurements. 

Example: 

In an employee database, a joining date should never be formatted in any other way 
than DD-MMM-YYYY (like 15-AUG-2025) to avoid reporting confusion or errors like this. 

Key Insight 

Filtering duplicate data, dealing with missing values, and standardizing relabelling the 
entries is an essential part of guaranteeing that 

that datasets are accurate, consistent and prepared for analysis. Omitting these steps 
can result in less reproducible results and 

bad cooking, no matter how sophisticated the kitchen gadgets. 

 

“Activity: Cleaning and Standardizing a Dataset” 

“A customer dataset has been collected from multiple branches of a company. 
However, the file contains several issues: some customer names are duplicated, 
certain phone numbers are missing, and dates of registration are recorded in 
inconsistent formats (DD/MM/YYYY, MM-DD-YY, and YYYY/MM/DD).” 
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Task Instructions: 1. Import the dataset into Excel. 2. Use the Remove Duplicates 
function to eliminate repeated customer names. 3. Replace missing phone numbers 
with “N/A.” 4. Standardize all date formats into DD-MMM-YYYY (e.g., 12-Aug-2025). 5. 
Save the cleaned dataset. Submission Requirement: Submit the Excel file showing the 
cleaned data along with a short written note (150–200 words) explaining how the 
accuracy and consistency of the dataset improved after cleansing. 

 

2.1.3 Copy-Pasting and Formatting Data EƯiciently 

In analytics, there is sometimes really big data that is collected from multiple sources 
and perhaps a slew of reports or databases websites etc. 

survey tools. This data usually must be copied and pasted into Excel in order for any 
real analysis to occur. 

consistently. EƯicient copy-paste and formatting approaches facilitate time-saving, 
minimize errors and datasets can be proven tontaxonomic standard. 

are more readable and understandable. 

Copy-Pasting Data in Excel 

Although copying and pasting is pretty simple, when handling comma or space 
separated values in thousands of rows to import in the work file, they may be not 
suƯicient. 

just by copying and pasting “Ctrl + C” and “Ctrl + V”. In Excel you can paste data in 
various ways: 

• Paste (All): Copies values and formatting from the source cell(s). 

• Paste Values: Which copies just the data, without formatting or formulas. This is 
useful when pasting 

results of other sources to circumvent deviations from non-commensurate formulas. 

• Paste Formulas: Pastes just the formula itself that they used from it in the original 
cell(s). 

• Paste Formats: Pastes only the formatting (font, color, borders), not the data. 

• Transpose: Turns column data into row data, and row data into column data. 

Exercise: Cleaning and Preparing a Dataset 

35 
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• Paste Special: Opens a dialog where user can select certain things to paste--values, 
formats, 

formulas, notes, and validation rules. 

Example 

A sales manager pastes regional sales numbers from a table in to Excel. If you use 

Paste Values only the numbers are 

imported bringing complex formulas or references from the source and creating. 

errors. 

Formatting Data After Copy-Pasting 

After pasting, the data often needs to be manipulated into a readable format. Common 
formatting 

steps include: 

• Number Formats: Keep the same currency, decimal or percentage format across 
columns. 

• Date format: All date entries should be standardized to have uniform date formats 
(e.g.,DD-MMM-YY) for ease in the. 

sorting and filtering. 

• Text Formatting: Apply built-in Excel functions (eg =TRIM()) to trim extra spaces all or 
=PROPER()CASE the text case 

correct inconsistent capitalization. 

• Column Widths: AutoFit columns to display all data. 

• Eliminate Extra Characters: Clean imported data from meaningless characters such 
as dollar, percent or comma sign. 

through Find & Replace or by the way of formula powered clean up. 

COPY-PASTING AND FORMATTING Quick/Walking Copying and Formatting Tricks 

• On pasting values from external tools, use the Paste Values feature to avoid conflicts 
with functions. 

• Use Conditional Formatting to emphasize important patterns and outliers. 

• Copy formatting styles across several cells with Format Painter. 

• Upon loading large data sets, eliminate blank rows or columns to help manage the 
file. 
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• Use Paste Special & Transpose to reformat data for easier analysis (i.e. CREDIT 
TRANSFERS Credit transfer first row) 

into column headers). 
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Top Tres Hot Keys for Fast Memory Aid 

The below keyboard shortcuts can be a huge time saver when dealing with copy-paste 
and formatting tasks in Excel: 

Shortcut Function Use Case 

Ctrl + Alt + V Paste Special Opens the Paste Special dialog box to paste values, formats 
and more. 

Ctrl + Shift + L Filter Toggle Fast way to add or remove filters from data tables 

Ctrl + T Create Table: Turns a data range into a structured, filterable table 

These shortcuts are particularly convenient when you’re working with large or 
constantly changing datasets. 

Example in Practice 

A market analyst has recorded quarterly sales and store identity information for three 

stores over a one-year period. DiƯerent formats are used by each of the branches—
some use 

MM/DD/YYYY, while others use DD-MM-YYYY. Upon putting the relevant information in 
Excel, the analyst: 

• Standardizes all dates in to DD-MMM-YYYY 

• Removes external formulas by using Paste Values 

• Uses AutoFit to size the columns 

• Applies conditional formatting to emphasize missing or duplicate values 

The above steps leave us with a well-processed dataset, ready for analysis or plotting. 

 

2.1.4 Using AI and Automated Tools for Data Cleaning 

As datasets become larger and more complicated, trimming the fat or manual cleaning 
in Excel—such as: removing 

duplicates, formatting/cleanup or fixing mistakes — is that it takes a long time and its 
error-prone. To overcome 
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these barriers, companies increasingly employ AI and automated tools for data 

cleaning. These tools 

not only time but also accurate, consistent and scalable it gets when we clean. 

Role of AI in Data Cleaning 

Data Cleaning and Artificial Intelligence(Data Preprocessing) AI can be used to 
augment the process of data cleaning using algorithmic models that are capable of 
pattern recognition, detection 27. 

deviations, and apply smart recovery in an automatic manner. 

Key features of AI-based cleaning: 

• Error Detection: AI finds spelling errors, mismatch entries and inappropriate data that 
human beings can make. 

may overlook. 
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• Duplication Recognition: AI-based tools can detect duplicates even when entries are 
non-identical (e.g., “26-year old John” vs. 

Kumar” vs. “R. Kumar”). 

• Prediction of Missing Values: The missing values can be replaced by the predicted 
value that was inferred with AI models calculated by using some statistical techniques 
or 

“learning machines” instead of mere averaging. 

• Context Based Normalisation: AI interprets a context to normalise the formats like 
Europium (Eu) into metres Rebar – Brazil. 

"Bengaluru" and "Bangalore" into the same value. 

Automated Tools for Data Cleaning 

A number of standalone and Excel-integrated tools and platforms exist that automate 
cleaning data. 

a) Microsoft Excel Power Query 

• Power Query, is a natively-integrated Excl tool used for automating data preparation 
workflows. 

• Users can remove duplicates, split or merge columns, replace values and 
standardize formats. 
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automatically. 

• Once you have defined your queries, the old cleaning steps can be re-applied to new 
data with just one click. 

b) OpenRefine 

• A free, open-source tool for cleaning up messy data. 

• Useful for grouping similar values (for example “NY” and “New York”), and very rapid 
transformation of large data sets. 

c) Python and R Libraries 

• Pandas and NumPy libraries of Python provide methods to clean, fill-in missing 
values and restructure 

datasets. 

• R has packages like dplyr and tidyr that do about the same. 

• Professional analytics and data science projects are one of the many use cases for 
these tools. 

d) AI-Powered Platforms 

• Machine learning in tools like Trifacta, Talend and DataRobot suggests you which 
cleaning steps to take 

automatically. 

• Cloud services like the Google Cloud Dataprep and Azure Data Factory interface with 
big data 

systems to process data at scale and make them clean. 

Benefits of AI and Automation for Data Cleaning 

• Saving time: turns the hours of human work into a few seconds. 

• Scalability:Data is to big and Excel can't handle it alone. 

• Consistency: The same cleaning procedures can be performed on each data set to 
prevent human error. 

• Smart Insights: Discovers errors and trends that cannot be observed via manual 
review. 

• Integration: Many tools sync up directly to databases, cloud storage and visualization 
software. 

Example in Practice 
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A global corporation gathers customer opinions from thousands of questionnaires in 
dozens of diƯerent languages. Manual 

cleaning would take weeks. The company automatically eliminates duplicates by 
utilizing Power Query in Excel, 

normalizes date formatting, and strips out superfluous space. An AI-infused tool such 
as Trifacta will go on to detect the usual. 

customer names and intelligently merg spellings together. Consequently, the data is 
lean, uniformed and 

and ready for advanced an 

Did You Know? 

“Studies show that nearly 60–70% of a data scientist’s time is spent cleaning and 
preparing data before analysis begins. AI-driven tools like Trifacta and Talend can 
automate up to half of these tasks, reducing preparation time drastically.” 

2.2 Formatting and Conditional Formatting Formatting in Excel is an essential step in 
preparing data for analysis. While raw data provides the foundation for decision-
making, well-formatted data improves readability, highlights important details, and 
ensures consistency across reports. Proper formatting transforms a worksheet from a 
simple grid of numbers into a professional document that can be easily interpreted by 
managers, analysts, and stakeholders. 

2.2.1 Excel Formatting Fundamentals 

In Excel, formatting covers the display of your cells either by content or style without 
changing any underlying data. 

data. It supports the clear presentation of information and highlights certain values for 
rapid decision-making. Excel 

contains an extensive variety of simplified formatting options that can be set on either a 
cell, row, column, or the entire worksheet 

level. 

Text Formatting 
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• Types and Size of Fonts: Alter the formatting for headings, data (Calibri, Arial). 

• Bold, Italic, Underline (Select unique cell hader to use) : Emphasize key headers or 
totals. 

• Text Color Fill: Use color to distinguish categories or make values stand out. 
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• Fill (Shading): Fill in colors for grouping or highlighting. 

• Alignment: Text can be aligned to left, right or center, and centered vertically at top, 
middle or bottom. 

• Text Orientation: Diagonal or Vertical text, which is particularly useful for column 
headers. 

• Wrap Text: Multiple lines of long text to be displayed within a single cell. 

• Merge & Center: Combines several cells into one cell and centers the cell contents, 
header, or footer over the range of selected cells. 

Example: 

A student marksheet could have subject names in bolded and centered column 

headings with alternating white or colored fill for. 

better readability. 

Number Formatting 

Excel numbers can be formatted in many diƯerent ways, depending on the kind of data 
you are presenting. 

• General Format: Original format of the numbers, i.e., as input. 

• Number Format: Appends decimal values and thousands separator (eg, 10,000.50). 

• Currency & Accounting: Show numbers with currency symbols ($, ₹) and line up 
decimal points. 

• Percentage: Change decimals into percentages (such as 0.25 → 25%). 

• Date & Time Styles: Show a number as an array of date or time styles, Twisted (e.g., 1 

Jan 2025). 

• Fraction: Use numbers of the form 1/n ( n's, where n is a whole number) to represent 
fractions. 

• Scientific ( Exponential ): Experiment with very large or small numbers, for example: 
3.5E+05 . 

Example: 

Revenues displayed as currency and growth rates displayed as percent (%) in a 
financial report for better comparison. 

understanding. 

Borders and Cell Styles 
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• Borders: Outline cells or tables to separate sections. 

• Cell Styles: Choose from pre-defined sets of text and formatting (font, fill color, 
borders) to create a consistent look. 

• Themes: Choose workbook-wide styles including fonts and colors. 
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Practical Importance of Formatting 

• Represents reports in a nice and professional way. 

• Call out important numbers — such as totals, maximums or deadlines. 

• Improves readability of large data sets. 

• Prevent the possibility of confusion by remaining consistent. 

Example in Practice: 

When preparing a monthly employee payroll, HR managers might choose to use actual 
bolded and shaded titles on columns. 

salaries metadata is in currency, borders have been used to delimit each record. This 
makes the sheet overall professional 

and easy to interpret. 

2.2.2 Conditional Formatting Rules 

Excel conditional formatting is a feature that automatically format data in your excel 
sheet based on certain conditions met. 

as they include or user-defined conditions. It allows highlighting key data, reveal 
patterns and add emphasis 

to exceptions from large data sets without requiring manual review. Applying rules, 
users can make their data more visual and 

easier to interpret. 

Conditional Formatting is extremely eƯective in the world of analytics, where trends, 
threats or outliers can jump out at you 

right away, promoting quicker and better decisions. 

Types of Conditional Formatting Rules 

There are a number of built in rules with Excel, and also an option to create rule as per 
requirement. 
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Highlight Cell Rules 

• Lets users shade cells that meet certain criteria. 

• Examples: 

o Greater Than: Format values that are greater than 1000. 

o Less Than: Select cells less than 50. 

o Between: When this option is active, the second and third fields are activated b 
Highlight values when they fall between 500 and 1000. 

o Equal To: Cells that equal to a specific number or text. 

o TextThatContains: Highlight cells which contain certain words or phrases. 

o Duplicates: Identify duplicates in data. 
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Example: 

From a sales report, you can quickly spot underperforming regions by marking all sales 
·−32 v rfzfFig. 

a glance. 

 

2.2.3 Using Conditional Formatting for Data Insights 

Conditional Formatting is, however not only about making data visually appealing- it 
can be used for knowledge! 

directly from raw numbers. Here, we can use built-in rules like highlighting duplicates, 
color scales, icon sets and 
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data bars, analysts can easily see patterns, exceptions and comparisons visually. 
These features 

create a simple worksheet to an intuitive, interactive dashboard. 

Highlighting Duplicates 

Doubled up entries can mess up the data, by either doubling counts or making reports 
inaccurate. Conditional Formatting can 

automatically highlight such duplicates. 

How to Apply: 
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• Select the dataset. 

• Then go to Home → Conditional Formatting → Highlight Cells Rules → Duplicate 
Values. 

• Select a text format (e.g., red fill followed by dark text). 

Example: 

In a customer list, duplicate names or email IDs are or double whatsapp numbers is 
indicated for firms to prevent sending messages twice. 

spam emails to the same person. 

Color Scales 

The use of colors on a scale that shows the relationship in magnitude between 
diƯerent values in a dataset. High labels get the one colorized part 

(e.g., green), middle range a diƯerent (e.g., yellow) and low range a diƯerent color (e.g., 
red). This creates a 

heatmap-like eƯect. 

How to Apply: 

• Select the data range. 

• Visit Conditional Formatting → Color Scales. 

• Pick a two-color or three-color scale. 

Example: 

A sales manager is able to derive a color scale for monthly revenue numbers. High-
performing months appear in green, 

red) also so that it was possible to see how performance changes seasonally, at a 
glance. 

Icon Sets 

Icon sets change numbers to symbols such as arrows, stars, traƯic lights,or check 
marks that make the data easy to interpret. These 

icons allow easy performance comparison across categories without scanning exact 
values. 

How to Apply: 
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• Select the data range. 

• Navigate to Conditional Formatting → Icon Sets. 

• Select a style (arrows, traƯic lights, flags and so on). 

Example: 

In a work performance data sheet, it is possible to use of traƯic lights: green for 
performance above the goal, yellow for ordinary behaviour and red for fundamentally 
poor average, dreadful. 

, red for underperforming. This enables rapid identification of team performance. 

Data Bars 

Data bars add small horizontal bars to each cell that indicate how the value compares 
with other values in that range. The 

the longer the bar, the greater the value is so you quickly compare visually. 

How to Apply: 

• Select the dataset. 

• Navigate to Conditional Formatting → Data Bars. 

• Pick from gradient and solid fill options. 

Example: 

Expense categories can be data bars are applied to by a financial analyst. The longer 
the bar the more you spend so in theory, it is easier 

, search for cost-intensive areas at first glance. 

What's the Point of These Data Insights Tools? 

• The use of duplicates in both cases eliminates mistakes and improves the quality of 
data. 

• Color scales show trends and variations across values. 

• The intuitive method to classify the performance using the icon sets. 

• Data bars provide a quick visual comparison within rows or with columns. 

Taken together, we allow decision makers to interpret large datasets rapidly, detect 
anomalies and act on them as they see appropriate”. 

insights using even the most basic visualization tools. 

Example in Practice: 
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A manager of operations monitors delivery times across varying regions. They 
demonstrate, using relatives highlighting that 

repeated entries in the log. Color scales indicate where deliveries are consistently 

faster or slower. Icon sets visual performance against the target, service level from 
company side and data bars show visually the delay between them. 

regions. This single use of conditional formatting gives you actionable information 'out 
of the box.' 

 

Did You Know? 

“Excel’s conditional formatting with color scales essentially creates a “heatmap” inside 
the worksheet, a technique borrowed from advanced analytics and business 
intelligence dashboards. This allows you to interpret performance trends without using 
external visualization tools.” 

 2.3 Working with Data Working with data in Excel involves organizing, sorting, filtering, 
and structuring information so that it becomes meaningful for analysis. Well-organized 
data allows users to quickly find patterns, compare records, and make accurate 
business decisions. Among the most commonly used features are sorting and filtering, 
which provide clarity when dealing with large datasets. 

2.3.1 Organisation of Data (One-level and Two-level) 

What is sorting in Excel Sorting in Excel simply the process of arranging the data in a 
specific order, A–Z (smallest to largest), or Z–A (largest to smallest). 

descending (Z–A, largest to smallest). Sorting allows the users to arrange data such that 
it can be easily interpreted - for example: 

ordering of sales performance (by rank), listing of products to be sorted according to 
price, or ordering employees in alphabetical order. 

Excel oƯers two types of sorting: Single-Level Sorting and Multi-Level Sorting. 

Single-Level Sorting 

Definition: 

Single-level sort: sorts data based on one column. 

How to Perform Single-Level Sorting: 

Choose the column of data you want to sort by. 

Go to Data → Sort & Filter. 
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Select Sort A–Z or Sort Z–A. 

Example: 

You can order a Student database on the Name field to view them in order. A list of 
products can be also be 

arranged from Cheapest to Most Expensive. 

Multi-Level Sorting 

Definition: 

TopN sorting sorts with more than one column, where you have a series of top-N 
calculations based on the data. 

How to Perform Multi-Level Sorting: 

Select the dataset. 

Then go to Data → Sort → Custom Sort. 

You can add multiple levels of sorting by selecting more columns to sort in priority 
order. 

Example: 

For an employee database, perhaps you want to sort in DEPARTMENT sequence and 
within that, Name order? 

by Salary (highest to lowest). This way, employees are ordered by their department and 
salary within each 

each group. 

Practical Importance of Sorting 

• Assists with ranking performance (e.g., the top 10 salesmen). 

• Manages complex data for easy retrieval and reporting. 

• Brings a framework of presentation to the higher management also. 

• It saves the time because you have all related information in a logical order. 

Example in Practice: 

A sales data for 500 products is given to a retail manager. With a single level of sorting 
they can sort products according to Total 

Sort sales by descending to see the top-sellers. Then, they multi-level sort: Category 
first (e.g., 
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electronics, and clothing), within each category then Sales. This yields both a 

category-wise and an overall 

performance ranking. 

“Activity: Sorting and Filtering for Insights” 

“You are provided with a sales dataset containing 100 transactions with the following 
columns: Product Name, Category, Sales Value, and Region. The management wants to 
quickly identify high-value transactions and analyze performance by category and 
region.” 

Task Instructions: 

1. Apply single-level sorting to arrange all products alphabetically by Product Name. 

2. Apply multi-level sorting to first sort data by Region (A–Z) and then within each region 
by Sales Value 

(largest to smallest). 

3. Use a Basic Filter to display only transactions where the Category is “Electronics.” 

4. Use an Advanced Filter to extract records where Category = Electronics AND Sales 
Value > ₹50,000. 

Copy these filtered records to a new sheet. 

Submission Requirement: 

Submit the updated Excel file along with a short observation (150 words) highlighting 
how sorting and filtering 

helped in drawing useful insights from the sales data. 

2.3.2 Data Filtering (Basic and Advanced Filters) 

Filtering is the act of displaying only those rows in a data set which satisfy some 
specified criterion, and concealing the rest. 

Unlike sorting which rearranges the whole data set, using a filter allows users to 
concentrate only on specific type of information. 

deleting or rearranging other records. Two types of filters that Excel oƯers are Basic 
Filters (AutoFilter) and 

Advanced Filters. 

Basic Filters(AutoFilter) 

Definition: 
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AutoFiltering (Basic Filtering) This filtration makes it easy to decide on a few rows and 
have them clearly displayed. 

from a column. 

How to Apply Basic Filters: 

Select the dataset. 

Head to Data → Filter (a drop-down arrow now shows up in each column header). 

If you click the drop-down arrow, you can choose filter conditions (such as a text 
match, number range or date). 

Features of AutoFilter: 

• Filter text-based values (show only “Electronics” in Product Category, for example). 
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• Filter by numeric ranges (e.g, sales > ₹50,000). 

• Date filtering (e.g., only transactions from January 2025). 

• Users can apply multiple filters across columns at the same time. 

Example: 

So given a sales database of 1,000 records for example it is possible to filter and view 
only the transactions from Delhi region in March 2025. 

so that managers can concentrate on pertinent records instead of the rest. 

Advanced Filters 

Definition: 

Advanced filters can provide greater filtering capabilities such as combining multiple 

criteria or copying the 

filtered information to a diƯerent region of the worksheet. 

How to Apply Advanced Filters: 

On the worksheet, create a range with criteria for filtering. 

Go to Data → Advanced Filter. 

Choose to either Filter the list in place or Copy to another location. 

Select the List Range (i.e., dataset) and Criteria Range (i.e., criteria). 

Features of Advanced Filters: 
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• Can be multiple conditions with AND/OR logic. 

• It has the ability to store filtered data into new worksheet or […] 

• Allows formulas in the criteria range for Custom filter. 

Example: 

Is there a way to create an advanced filter, where that I can GriƯin's personal data 
girrag are not populating any results)? 

work in the Marketing department AND earn over ₹60,000. On the other hand, it could 
filter staƯ members - Sales OR 

Operations departments. 

Basic vs. Advanced Filtering 

Characteristics Simple Filter (AutoFilter) Advanced Filter 

Ease of Use: Easy/simple, based on a drop-down menu (I have just done this) 
Drawbacks Need to create criteria range 

HandlingSimplified Limited (single column Simple filters) Complex conditions (AND 
OR) 2. 

Output Data Filters to be converted to in place Can filter to in place or copy elsewhere 

Use case Routine filtering requirements Extensive analysis or extraction More 
demanding applications and searches Everyday exploring Filtering File clustering Good 
for general exploration A fair amount of data is involved Viewing column-based 
information Time: Two minutes--Your grocery list Calculator On the SPOT Time spending 
into quickly clicking on an entity's shape Increasing time spent on further investigation 
Casual glance raises interest, systematically opens up more details Will drill down only 
if it knows doing so will prove beneficial Interesting elections, lotteries, science 
picking... Bible code patterning Swastika patterns Doesn't want to have to read a big 
rules book/complex start-up Ellese dislikes killers Crunch clusters Given two file set 
locations where one has a large number of filetype matches than the other. 
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Practical Example in Business Analytics: 

• A retailer can use Basic Filters to look at sales for any one product category during the 
month of April. 

• One and the same store can use Advanced Filters in order to view sales of clients who 
bought Electronics 

more than ₹20,000 and dump the O/P to a diƯerent report. 
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2.3.3 Creating and Managing Tables Tables in Excel are one of the most powerful 
features for working with structured data. Converting a dataset into a table not only 
improves its appearance but also adds functionality such as automatic formatting, 
filtering, and formula management. Tables make it easier to organize, analyze, and 
present data in a professional manner. 

Creating a Table in Excel 

Steps to Create a Table: 

Select the dataset (including headers). 

(You can also go to Insert → Table, or use Ctrl + T.) 

Verify the data range and if you have column titles be sure to check oƯ “My table has 
headers.” 

The data is now transformed into a table where we can easily format and use some 
tools. 

Features of Excel Tables: 

• Auto format header ( bold and filter arrows ). 

• Every other row has shaded background to improve readability. 

• Drop-down menus in every column so readers can sort and filter. 

Example: 

An H.R. manager can turn an employee list (including columns for Name, Department 
and Salary) into a table. The 

table immediately has filters, enabling a snap shot view of employees by department 
for instance or sorting salaries. 

Managing Tables 

Excel provides a variety of techniques to manage the data once it is in table form. 

a) Table Styles and Formatting 

• Use the built-in table styles (light, medium, dark) for professional looking tables. 

• Readability is improved by having banded rows and columns. 

• Use of formatted text to emphasize headers. 
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b) Adding and Removing Rows/Columns 
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• Tables grow and shrink automatically as new rows or columns are added. 

• New rows can be added directly below the table or from new data, and Excel extends 
the table range 

automatically. 

c) Structured References 

• Formulas in tables, rather than cell references (such as A2:A10), read by column 
name. 

• Example: In a “Sales” table with a “Revenue” column, =SUM(Sales[Revenue]) sums 
the revenue. 

d) Sorting and Filtering 

• Table headers have filters built in for fast searching. 

• Multi-level sorting can now be done from the table drop downs themselves. 

e) Total Row 

• You can add total row (from Table Design → Total Row) to show common metrics such 
as sum, 

average, minimum and maximum without entering the formulas. 

f) Turning Table into a Range 

• If necessary, a table can be changed back to just a range: Table Design → Convert to 
Range. 

Advantages of Using Tables 

• Readability and Presentation: Automatic formatting helps the user to read data. 

• Dynamic Range: The tables dynamically resize to accommodate new data. 

• Analysis Made Easy: Sort and filter, use new in-cell search bar for adding values by 
formulas. 

• Reduced Errors: Excel tables make it easy to use structured references in formulas, 
which makes your work easier to read and maintain. 

• Professional Reporting: Tables provide a cleaner, easier-to-use report. 

Example in Practice: 

A sales analyst wants to generate a table of sales by month. The total row allows the 
analysts to easily compute the total 
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outright sales, average product revenue and best-selling product. The table grows as 
additional months are included 

and the equations refresh without manual interference. 

 

2.3.4 Structured References in Excel Tables 

Powerful-Indexing with Structured References in Tables One of the great things about 
Excel tables is that you can apply a formula to any range by using structured references. 
Unlike 

regular formulas referencing cell addresses (e.g., =B2*C2), structured references 

enable users to refer to table 

columns by their names. This makes formulas more comprehensible, lowers the 
chance of mistakes, and secures they formula:magic cient:a-custom-y-const 10emojis 
emoji::$_ N<si_match>? 

grow as the table grows. 

What are Structured References? 

A structured reference menas refering to parts of a table by the name of the table and 
their column headers,. 

rather than by cell ranges. 

Example: 

Assuming that we have a table named SalesData with the Revenue column, the 
formula: 

=SUM(SalesData[Revenue]) 

is easier to understand than: 

=SUM(C2:C100). 

Types of Structured References 

You can use structured references in various ways: 

a) Column References 

• Points to all information from a column (header and total row) 

• Example: =AVERAGE(SalesData[Profit]) returns the average profit. 

b) Row References 
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• Relates to information in the identical row of the table. 

• Example: if a in a row formula is '[Quantity]*[Unit Price], it will automatically alebraicly 
multiply the values in that row. 

c) Special Item References 

Any table in Excel can also be referred to by cells in that table, such as: 

• SalesData[#Headers] → Refers to the table headers. 

SalesData[#All] – Points to the entire table: It includes headers, data, and total row. 

• SalesData[#Data] → One refers only on the data body of the table. 

SalesData[#Totals]Reference the totals row, if it is on. 

d) Mixed References 

You can use structured references to refer to table names, columns, and rows in 
formulas. 

Example: =SUM(SalesData[[#All],[Revenue]]) is followed by the Revenue column (with 
headers and totals). 

Benefits of Structured References 

Readability and clarity: Column headings are much easier to understand than cell 
addresses. 

Updating Automatically: When you insert new rows in a table, structured references 
automatically expand to include the new data. 

Less Mistakes: No more changing errors when cell ranges change or should have been 
expanded. 

Professional Reporting: Simplifies the explanation and auditing of complex formulas. 

Example in Practice 

Table Name: EmployeeData Columns in it :Name Department BasicOfSalary 
Allowance TotalSalary. 

• Formula in the Total Salary Column: 

=[Basic Salary]+[Allowance] 

(applies automatically to all rows). 

• For the average salary: 

=AVERAGE(EmployeeData[Total Salary]). 
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• To determine the overall allowance of all employees: 

=SUM(EmployeeData[Allowance]). 

When you add new employees, Excel extends the formulas for you with structured 

references—no additional work is required! 

and eƯort. 

Key Takeaway 

Structured references change the way you write formulas in tables. They make 
worksheets more transparent, 

gdatastack, that is scalable and reliably — two fundamental requirements in business 
analytics due to data growing constantly and an expected high degree of accura- tness. 

critical. 

Did You Know? 

“When you rename a column in an Excel Table, all structured reference formulas update 
automatically across the workbook. This makes structured references more robust and 
less error-prone than traditional cell-based formulas.” 

Knowledge Check 1 

Choose the correct option: 

1. Which of the following is the first and most important step in analytics? 

A) Creating Charts 

B) Data Cleaning 

C) Sorting Data 

D) Applying Conditional Formatting 

2. Which Excel feature is used to eliminate repeated entries in a dataset? 

A) Highlight Cells Rule 

B) Remove Duplicates 

C) Find and Replace 

D) AutoFilter 

3. What is the best way to handle a small number of missing values in a dataset without 
losing important 

records? 
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A) Delete the dataset 

B) Replace with averages or other estimated values 

C) Leave them blank 

D) Replace with zeros only 

4. Which feature in Excel can be used to paste only the values without copying the 
formatting or formulas? 

A) Paste Values 

B) Paste Special → Formats 

C) Paste Formulas 

D) Paste Transpose 

Knowledge Check 1 
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5. Which conditional formatting option displays horizontal bars within cells to represent 
values visually? 

A) Color Scales 

B) Data Bars 

C) Icon Sets 

D) Highlight Rules 

 

2.4 Summary 

❖ This chapter has given a brief overview of essential steps in Excel for data 
preparation and organization towards the. 

foundation for business analytics. In the first place, it was possible to perceive here 
how relevant data cleaning is. 

erroneous, redundant, missing, and inconsistent data may result in bad decisions. 
Various methods of 

data cleaning were covered, such as duplicate elimination, missing values and 
standardization 

data formats. Time-saving copy-pasting methods and formatting data, as well as the 
application of AI and 
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tools for cleaning big data, that we also addressed. 

❖ The chapter then moved on to formatting and conditional formatting. Simple text 
and formatting options for slides! 

type, and cell styles contribute to enhance reading and consistency across reports. 
Conditional formatting rules 

(highlight cell rules, top/bottom rules, data bars, color scales and icon sets) were also 
found to be capable of oƯering 

real-time visual intelligence, enabling analysts to see exceptions, trends and to 
compare performance 

at a glance. 

❖ Finally, the chapter discussed working with data in organized formats. Sorting 
(single-level and multi-level) 

sorts datas for purposes of ranking and analysis and can be filtered (basic or advance) 
to limit the records to 101 each. 

meet specific criteria. It was all about the power of set up and maintaing tables, how 
you would do all these funny things in background. 

and dynamic range management. The concept of structured referencess is to make the 
formulas less Ambigous and better. 

scalable, so analysts can write formulas with the column name and not the cell 
address. Together, these 

abilities turn data into clean, organized and visually appealing information for. 

eƯective analysis. 

2.5 Key Terms 

Munging: Cleaning up raw data converting them into a format that can be used for 
analysis. 

Duplication: Records in a dataset that appear more than once for the same information 
and can corrupt analysis. 

Missing Values: Unrecorded values in a field. 
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Standardization: Ensuring data formats are standardized across a dataset. 

Power Query: An automation tool which loads to Excel and transforms data. 
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Formatting: Adjusting the appearance of text, numbers and cells to make them clearer. 

Conditional Formatting: Format cells automatically according to rules. 

Highlight Cell Rules: Rules for formatting values that are higher, lower or equal to a 

specified number. 

Data Bars: Visual bars inside cells that give a quick look at the magnitude of its value. 

Color Scales: Graduated color formatting so that high and low values are shown 
relatively. 

Icon Sets: Pictorial symbols to indicate data categories, such as arrows or traƯic lights. 

Criteria: A criterion used to organize data in ascending or descending order. 

One Level Sorting: The sorting is performed on the one portion. 

Nested Sorting: Sorting not just on the values of a single column, but by multiple 
applied in sequence. 

Filtering: The act of frowning and showing only records that meet certain criteria. 

(Basic Filter (AutoFilter): Drop down filter for simple conditions. 

Advanced filter: Filter data by two or more criteria with multiple and/or conditions. 

Excel Table: A range that has structure with formatting, filtering, and dynamic range 
functionalities. 

Totals Row: A feature of a table that calculates sum or average on a column 
automatically. 

Structured references: Formulas in Excel tables that use column names instead of cell 
addresses. 

2.6 Descriptive Questions 

Why cleaning the data is necessary before analytics? 

What are three ways to deal with missing data in data set? 

What is the diƯerence between basic formatting and conditional formatting in Excel? 

iii) How do conditional formatting features such as data bars and color scales help in 
making business decisions? 

What is the distinction between one level sort versus multilevel when sorting in Excel? 

How do you use advanced filters in Excel and what makes them diƯer from basic 
filters? 
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What are the benefits of making your dataset as an Excel Table? 

What are structured references and what benefits do they oƯer in business reports? 

Complete data clean and format in Excel of their customer’s dataset (deduplicate, date 
formats as) Apply appropriate filters.headers. 

conditional format, data bar, table with Total Row). 

 

2.7 References 

1. Winston, W. L. (2016). Microsoft Excel Data Analysis and Business Modeling. 
Microsoft Press. 

2. Albright, S. C., & Winston, W. L. (2015). Business Analytics: Data Analysis and 
Decision Making. Cengage 

Learning. 

3. Walkenbach, J. (2015). Excel Bible. Wiley. 

4. Microsoft Excel Documentation – Microsoft Support 
(https://support.microsoft.com/excel) 

5. Power Query Documentation – Microsoft Learn (https://learn.microsoft.com/power-
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Answers to Knowledge Check 

Knowledge Check 1 

1. B) Data Cleaning 

2. B) Remove Duplicates 

3. B) Replace with averages or other estimated values 

4. A) Paste Values 

5. B) Data Bars 

 

2.8 Case Study 

“Improving Sales Reporting through Data Preparation and Formatting” 

Introduction ABC Retail Ltd., a chain of consumer electronics stores, faced ongoing 
issues in preparing its monthly sales reports. The data collected from diƯerent branches 
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often contained duplicate entries, missing sales figures, and inconsistent date formats. 
Reports were also diƯicult to read because of unformatted layouts, making it 
challenging for managers to make timely decisions. The company decided to apply 
systematic data cleaning, formatting, and table management techniques in Excel to 
resolve these issues and improve reporting eƯiciency. Background 58 The company’s 
sales team submitted branch-wise Excel files every month. However, errors frequently 
appeared: the same customer purchases were listed multiple times, sales values were 
missing for some transactions, and date entries varied across files. When these files 
were combined, managers found it hard to sort or filter data consistently. Moreover, raw 
tables without formatting made it diƯicult to identify underperforming products or 
regions. To streamline reporting, the analytics team used Excel’s built-in tools for data 
cleaning and preparation. They applied methods such as removing duplicates, handling 
missing values, standardizing formats, applying conditional formatting, and converting 
data ranges into tables. This transformed the messy datasets into structured and 
insightful reports. Problem Statement 1: Duplicate Entries in Sales Data The merged 
dataset showed the same transaction recorded multiple times, inflating total sales 
figures and misrepresenting performance. Solution: The analytics team used Excel’s 
Remove Duplicates feature under the Data tab. This cleaned the dataset by eliminating 
repeated records, ensuring each sale was counted only once. MCQ: Which Excel 
feature is best suited for identifying and removing duplicate records? A) Conditional 
Formatting B) Remove Duplicates C) Text-to-Columns D) Find and Replace Answer: B) 
Remove Duplicates Problem Statement 2: Missing Sales Values Several transactions 
lacked revenue values, which made it diƯicult to calculate totals and averages 
accurately. Solution: The team replaced missing values using average sales figures from 
similar transactions. This ensured that the dataset was complete and ready for analysis 
without deleting important records. MCQ: 59 Which method is commonly used to 
handle missing numeric values in a dataset? A) Leave them blank B) Replace with the 
word “N/A” C) Replace with the mean or average value D) Delete the entire dataset 
Answer: C) Replace with the mean or average value Problem Statement 3: Inconsistent 
Date Formats Dates were entered in multiple formats such as 12/01/25, 1-Dec-2025, 
and 2025/12/01. This caused issues when sorting or filtering transactions by time. 
Solution: The team standardized all dates using Excel’s Date Formatting (DD-MMM-
YYYY). This made it possible to perform accurate time-based analysis and ensure 
consistency across records. MCQ: Why is it important to standardize date formats in 
Excel datasets? A) To make reports look colorful B) To avoid confusion when sorting and 
filtering data C) To reduce file size D) To apply currency formatting Answer: B) To avoid 
confusion when sorting and filtering data Problem Statement 4: Lack of Insights in Raw 
Reports Even after cleaning, the data was still hard to interpret because it was 
displayed as plain numbers. Managers could not quickly identify underperforming 
regions or high-performing products. Solution: The team applied Conditional Formatting 
(data bars, color scales, and icon sets) to highlight patterns in sales performance. They 
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also converted the dataset into an Excel Table with a total row, allowing them to 
calculate overall revenue and average sales automatically. Sorting and filtering options 
built into the table further improved usability. MCQ: 60 Which Excel feature provides 
built-in filtering, automatic formatting, and structured references? A) Pivot Chart B) 
Excel Table C) Named Range D) Advanced Filter Answer: B) Excel Table Conclusion By 
applying systematic data cleaning, formatting, and table management techniques in 
Excel, ABC Retail Ltd. transformed messy and unreliable sales reports into structured, 
accurate, and insightful dashboards. Removing duplicates ensured accurate totals, 
handling missing values completed the dataset, and standardizing formats improved 
consistency. Formatting and conditional formatting made insights visible at a glance, 
while Excel Tables added automation and professional presentation. As a result, 
managers could quickly identify underperforming regions, evaluate product 
performance, and make informed decisions. 
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0% detected as AI
The percentage indicates the combined amount of likely AI-generated text as 
well as likely AI-generated text that was also likely AI-paraphrased.

Caution: Review required.

It is essential to understand the limitations of AI detection before making decisions 
about a student’s work. We encourage you to learn more about Turnitin’s AI detection 
capabilities before using the tool.

Detection Groups

0 AI-generated only 0%
Likely AI-generated text from a large-language model.

0 AI-generated text that was AI-paraphrased 0%
Likely AI-generated text that was likely revised using an AI-paraphrase tool 
or word spinner.

Disclaimer
Our AI writing assessment is designed to help educators identify text that might be prepared by a generative AI tool. Our AI writing assessment may not always be accurate (i.e., our AI models 
may produce either false positive results or false negative results), so it should not be used as the sole basis for adverse actions against a student. It takes further scrutiny and human 
judgment in conjunction with an organization's application of its specific academic policies to determine whether any academic misconduct has occurred.

Frequently Asked Questions

How should I interpret Turnitin's AI writing percentage and false positives?
The percentage shown in the AI writing report is the amount of qualifying text within the submission that Turnitin’s AI writing 
detection model determines was either likely AI-generated text from a large-language model or likely AI-generated text that was 
likely revised using an AI paraphrase tool or word spinner.
 
False positives (incorrectly flagging human-written text as AI-generated) are a possibility in AI models.
 
AI detection scores under 20%, which we do not surface in new reports, have a higher likelihood of false positives. To reduce the 
likelihood of misinterpretation, no score or highlights are attributed and are indicated with an asterisk in the report (*%).
 
The AI writing percentage should not be the sole basis to determine whether misconduct has occurred. The reviewer/instructor 
should use the percentage as a means to start a formative conversation with their student and/or use it to examine the submitted 
assignment in accordance with their school's policies.

What does 'qualifying text' mean?
Our model only processes qualifying text in the form of long-form writing. Long-form writing means individual sentences contained in paragraphs that make up a 
longer piece of written work, such as an essay, a dissertation, or an article, etc. Qualifying text that has been determined to be likely AI-generated will be 
highlighted in cyan in the submission, and likely AI-generated and then likely AI-paraphrased will be highlighted purple.
 
Non-qualifying text, such as bullet points, annotated bibliographies, etc., will not be processed and can create disparity between the submission highlights and the 
percentage shown.
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Unit 3: Logical Functions in Excel 

 

Learning Outcomes 

1. Explain the importance of logical functions in business analytics and how they 
support decision-making 

through conditions and rules. 

2. Understand the syntax and structure of logical functions in Excel, including the role of 
logical operators. 

3. Apply the IF function to perform conditional calculations and automate decision-
making in datasets. 

4. Construct Nested IF statements to handle multiple conditions within a single 
formula. 

5. Use logical operators (AND, OR, NOT) eƯectively to create more complex and flexible 
logical conditions. 

6. Combine logical operators with IF to design multi-condition formulas for business 
analysis. 

7. Identify and interpret common Excel errors such as #DIV/0!, #N/A, and #VALUE!. 

Content 

3.0 Introductory Caselet 

3.1 Introduction to Logical Functions 

3.2 IF Function and Variants 

3.3 Logical Operators 

3.4 Error Handling in Excel 

3.5 Summary 

3.6 Key Terms 

3.7 Descriptive Questions 

3.8 References 

3.9 Case Study 
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3.0 Introductory Caselet 

“Arjun’s Challenge: Automating Decisions with IF Functions” 

 

It was Arjun, a 32-year-old sales manager at a Mumbaibased consumer electronics company, 
who was in charge of preparing the items. 

monthly updates for his department. He used to waste hours each month checking sales 
figures manually, 

records of aƩendance, and customer acquisiƟon to determine who was eligible for bonuses 
and who needed further 

support. The manual process was slow, non-uniform and frequently resulted in debates 
among staff who felt that the decision makingIALOGUE was opaque. 

were not transparent. 

During a training session, Arjun was newly exposed to logical formulas in Excel especially the 
IF formula. 

He discovered that he could automate a lot of the decisions he was then making by hand. 
He was able to establish by formulas 

transparent rules—for example you made a bonus if sales were over ₹2,00,000 and 
aƩendance was above 90%. Using nested 

SecƟon Twenty that are not included in the template by comparing two levels of assessed 
teaching quality (RaƟng categories; parasites) to be reasonable decisions from a pedagogical 
perspecƟve. 

on mulƟple performance thresholds. 

Before long, Arjun began leveraging logical funcƟons to control product discounts and loan 
approval reports for partner 

retailers. He also learned the use Error handling funcƟons like IFERROR to make 
hispresentaƟon more professional. 

to replace crypƟc error codes with plain language messages of “Data Missing” or “Invalid 
Entry.” 

By baking business logic into Excel, Arjun turned his reports into decision support tools that 

were fast, consistent, and fair. His bosses were grateful for his candor, and ediƟng too 
gained confidence. 

fitness of performance raƟngs. 
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CriƟcal Thinking QuesƟon: 

If you were Arjun, would you have used nested IF statements or an IF/AND/OR 
combinaƟon? 

operators to manage mulƟple condiƟons? Why? 

 

 

3.1 IntroducƟon to Logical FuncƟons In business analyƟcs, data analysis oŌen involves 
decision-making based on condiƟons. For example, a company may want to categorize sales 
as “High” or “Low” depending on whether revenue crosses a certain threshold, or 63 
idenƟfy employees as “Eligible” or “Not Eligible” for a bonus based on performance criteria. 
Excel provides logical funcƟons that allow analysts to test condiƟons, return values, and 
create flexible rules for interpreƟng data. Logical funcƟons are essenƟal because they act as 
the “decision-makers” within Excel formulas. Instead of manually checking rows of data, 
logical funcƟons automate the process by evaluaƟng condiƟons and returning results 
instantly. This makes them powerful tools for classificaƟon, error handling, and scenario 
analysis. 

3.1.1 Importance of Logical FuncƟons in Business AnalyƟcs 

Logic funcƟons are probably the most common analyƟcs funcƟon, because most business 
problems start out as evaluaƟons of things related to other things. 

applying decision rules. Their value is described in the following ways: 

AutomaƟng Decision-Making 

And, logical funcƟons are great for automaƟng a lot of this kind of decision-making process. 
For instance, a retailer might apply a formula to 

auto tag orders above ₹50,000 as “Bulk Orders” and below as “Regular Orders.” 

Categorizing and Classifying Data 

Grouping or categorizing data is necessary in many business datasets. The logical funcƟons 
make it possible for analysts to develop 

categories directly within Excel. 

• Example: Segregate customers into “Premium” (annual spend over ₹1,00,000) before 
adding the new aƩribute (i.e. mailer id.) 

as “Standard.” 

Flagging ExcepƟons and CondiƟons 
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The logical funcƟons can determine excepƟons that require special treatment. 

• Example: Tagging employees with aƩendance below 80% for review. 

SupporƟng Complex Business Rules 

Businesses typically impose several criteria before they act. Logical funcƟons can combine 
mulƟple 

standards to express real business rules. 

• Example : You will approved for a loan if income > ₹50,000 AND credit score > 700. 

Enhancing Data Accuracy and Reliability 

Formulas in logical funcƟons incorporate decision rules meaning that manual checking is 
reduced and there's less risk of 

errors. 

Enabling What-If Analysis 

Microors enable analysts to manipulate causing condiƟons in order to simulate scenarios. 

• Example: InvesƟgaƟng the effect of increasing the sales target on eligibility for a bonus. 

Example in PracƟce: 

An HR staff uses an IF funcƟon to calculate the bonuses of the workers. The condiƟon 
checks if the 

employee has a sale of more than ₹2,00,000. If yes the output is “Bonus Eligible”, 
otherwise −“The Result is Not Eligible”. 

In this single work formula I can save Ɵme by having the same logic applied to mulƟple rows 
of employee records. 

 

Did You Know? 

“Logical funcƟons like IF are the most commonly used Excel funcƟons in business—according 
to MicrosoŌ, more than 60% of Excel business models contain at least one IF statement to 
automate decisionmaking.” 

 

3.1.2 Syntax and Basics of Logical FuncƟons 

IntroducƟon Excel logical funcƟons are meant to assess condiƟons, and return specific 
results based on whether the asserted cohousendiƟon was true or false. 
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condiƟon is TRUE or FALSE. They are the basis on which decisions in formulas from around 
the world can be based. 

to automaƟcally label, categorize or model data. Although their syntax and fundamental 
behavior is:semicolon intrig-uing to understand. 

naturally premature when you are progressing to more advanced constructs such as nested 
IF statements or combining logical operators. 

General Form: Syntax of a Logical FuncƟon 

Excel’s most popular logical formula is the IF statement. Its syntax is: 

=IF(logical_test, value_if_true, value_if_false) 

• logical_test - the condiƟon that you want to test (for example, A1>100). 

• value_if_true: The value to return if the condiƟon is TRUE. 

•  value_if_false: The value to return when the condiƟon is FALSE. 

Example: 

=IF(B2>=50000, "High Sales", "Low Sales") 

• If the value of sales in cell B2 is less than 50000, it returns “High Sales.” 

• Otherwise, it returns “Low Sales.” 

Logical Values: TRUE and FALSE 

All logical funcƟons take a TRUE or FALSE value. 

65 

• If the condiƟon is true, Excel returns TRUE. 

• If it is not, Excel returns FALSE. 

Example: 

• Formula: =A1>10 

• If A1 is 12 → Result = TRUE 

• If 8 in A1 → Result = FALSE 

Basic Logical FuncƟons in Excel 

In addiƟon to the IF funcƟon, Excel has other basic logical funcƟons: 

TRUE and FALSE 

o These are Boolean values that always evaluate to their Booleans we have here. 
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o Example: =TRUE → TRUE is returned. 

AND 

o Returns TRUE if all the condiƟons are true. 

o Example: =AND(A1>50, B150, B1100) → returns TRUE if A1 is NOT greater than 100. 

Key Points to Remember 

• Logical funcƟons always test the condiƟon for a TRUE/FALSE result. 

• They can apply to numbers, text or dates. 

• You can mix logical funcƟons with arithmeƟc or text funcƟons for an even more powerful 
analysis. 

• These only are and, not. • Logical operators (=, >, =, ). • This also can be used inside logical 
funcƟon. 

Example in PracƟce: 

Here's the equaƟon a credit card company employs to verify: 

=IF(AND(Income>50000, CreditScore>700), "Approved", "Rejected") 

• When both are saƟsfied (income is greater than ₹50,000 AND credit score is greater than 
700), the value of Approved is “Yes.” 

• Or else, the answer is “Rejected.” 

This is an easy syntax that allows thousands of applicaƟons to be treated with consistent 
decision-making rules. 

3.2 IF FuncƟon and Variants 

The IF funcƟon is one of popular and most used funcƟons in Excel. It enables analysts to try 
out a condiƟon and 

returning one value if condiƟon is TRUE and another value if it's FALSE. This makes it 
extremely 

helpful for decision making, classificaƟon and by inclusion helps to build business rules in 
the data directly. 

3.2.1 The IF FuncƟon – Syntax and ApplicaƟon 

Syntax of the IF FuncƟon 

=IF(logical_test, value_if_true, value_if_false) 

• logical_test: the condiƟon to check. 
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• value_if_true: The result of the formula if the condiƟon is TRUE. 

• value_if_false: The result when the condiƟon is FALSE. 

Basic Example 

Formula: 

=IF(A2>=50, "Pass", "Fail") 

• If the cell A2 is equal to or greater than 50 → output Result, Test Passed. 

• Otherwise → The answer became “Fail.” 

This can be done to an enƟre column of student marks in order to dirivet results instantly. 

Business Uses of the IF FuncƟon 

The funcƟon IF is commonly used for implemenƟng business rules and decision automaƟon. 
Some common 

applicaƟons include: 

• Categorizing Sales: 

=IF(B2>=50000, "High Sales", "Low Sales") 

Classifies sales as Either High or Low depending on whether revenue is over ₹50,000. 
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• Employee Bonus Eligibility: 

=IF(C2>200000, "Bonus Eligible", "Not Eligible") 

Flags employees as bonus eligible when sales exceed ₹2,00,000. 

• Credit Approval: 

=IF(D2>=700, "Approved", "Rejected") 

Approves loan applicaƟon if the credit score is 700 or higher. 

• Inventory Alerts: 

=IF(E210000, "Bulk Order", "Regular Order") 

This immediately disƟnguishes large orders from standard ones and allows for improved 
inventory planning and service to the customer. 

 

3.2.2 Nested IF Statements 
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Though the IF funcƟon handl es one condiƟon well, many campuses and businesses ut 
ilize}}}whose: IF statements to get \\'round this problem with\",\" such as: ' data types. 

need to test more than one condiƟon in order to obtain different results. For example, 
student marks could be 

classified as “DisƟncƟon,” “Pass” or “Fail. In these sorts of cases, one IF statement no 
longer cuts it. Excel provides 

Nested IF Statements support MulƟple IF funcƟons that are nested in one another for 
execuƟon to treat with 

complex decision-making logic. 

DefiniƟon 

A Nested IF Statement is an =IF funcƟon formula in which there other =IF funcƟons are 
nested inside the VALUE_If_True value of another =IF funcƟon. This allows 

You can use Excel to test condiƟons in order and get the result of the condiƟon that's first 
true. 

to TRUE. 

Syntax 

=IF(condiƟon1, result1, IF(condiƟon2, result2, IF(condiƟon3, result3,...(default_result)))) 

• condiƟon1: A first logical statement. 

•result1: The value to return if condiƟon1 is TRUE. 

•If condiƟon1 is FALSE then the next IF statement is checked, etc. 

• default_result: The result to be returned if none of the condiƟons are TRUE. 
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Example: Student Grading 

=IF(A2>=75, "DisƟncƟon", IF(A2>=50, "Pass", "Fail")) 

• When the value in A2 is more than or equal to 75, the answer is “DisƟncƟon.” 

• If A2 is 50 or more but not greater than or equal to 75, the result is “Pass.” 

• If A2 is below 50, return “Fail.” 

Business ApplicaƟons of Nested IF 

Scenario Formula Example 

Employee Performance 
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RaƟng 

=IF(B2>=90, "Excellent", IF(B2>=75, "Good", IF(B2>=60, "Average", "Poor"))) 

Sales Commission Slabs =IF(C2>=100000, "20% Commission", IF(C2>=50000, "10% 
Commission", "Noulsion! 

Commission")) 

Customer SegmentaƟon =IF(D2>50000, "PlaƟnum", IF(D2>20000, "Gold", IF(D2>5000, 
"Silver", if(OR(E$12="CSalesman1",E$12="salesman 1"),"plaƟnum") bs"))))) 

"Bronze"))) 

Retail Discounts =IF(E2>=50000, "25% Discussion", IF(E2>=20000, "15% Discount", 
IF(E2>=10000, 

"10% Discount", "No Discount"))) 

They are applied, for example in cross-department classificaƟon and decision-making 
processes. 

as HR, sales, and CRM. 

Advantages of Nested IF 

• Facilitates the tesƟng of mulƟple condiƟons in one formula. 

• Can integrate mulƟ-level decision rules. 

• Enables flexible, logic-based categorizaƟon across mulƟple types of business and 
academic seƫngs. 

LimitaƟons of Nested IF 

• Hard to read and maintain, parƟcularly with more than three or four levels of nesƟng. 

• Total debug Ɵme is becoming bigger with the complexity. 

• Other methods could be more efficient and easier to read in modern Excel setups. 

AlternaƟve – The IFS FuncƟon (Excel 2016+) Instead we use the =IFS( funcƟon and specify 
more than one condiƟon. 

Newer versions of Excel (Excel 2016+) feature the IFS funcƟon, which is even beƩer and 
more readable than nesteds. 

Danny K0225 05/26 way to evaluate many cases without a really deep nested formula. 

Syntax: 

=IFS(test1, value1, test2, value2, …) 
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• Each condiƟon is then followed by the result to be returned if that condiƟon evaluates to 
TRUE. 

• The funcƟon checks the supplied condiƟons in order, and returns the result for the first 
TRUE condiƟon. 

Example (Student Grading): 

=IFS(A2>=75, "DisƟncƟon", A2>=50, "Pass", A2<50, "Fail") 

This technique is a more clear and the recommended approach if there are more than 2 
condiƟons. 

 

Did You Know? 

“Before Excel 2016, nested IF statements were the only opƟon to handle mulƟple 
condiƟons, but modern versions of Excel introduced the IFS funcƟon, which simplifies 
complex formulas by eliminaƟng the need for mulƟple nested IFs.” 

 

“AcƟvity: Student Grading with Nested IF” 

A university wants to categorize student results using the following rules: 

• Marks ≥ 75 → “DisƟncƟon” 

• Marks ≥ 50 and < 75 → “Pass” 

• Marks < 50 → “Fail” 

Task InstrucƟons: 

1. Create an Excel sheet with two columns: Student Name and Marks Obtained. Enter data 
for at least 12 

students. 

2. Use a Nested IF formula to create a third column called Result Category that classifies 
students as 

“DisƟncƟon,” “Pass,” or “Fail.” 

71 

3. Highlight the “DisƟncƟon” students using condiƟonal formaƫng for beƩer visualizaƟon. 

4. Submit the completed Excel file and write a short note (150 words) on how such 
automated grading 
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improves efficiency in academic evaluaƟons. 

 

3.2.3 PracƟcal Business Use Cases 

The complexity of logical funcƟons such as IF & Nested IF is not just a theoreƟcal aspect but 
an everyday reality for anyone working as a business analyst. 

to automaƟcally decide on criƟcal cases, categorize files and indicate interesƟng situaƟons 
in the data. This secƟon explores three 

applicaƟons: data classificaƟon, condiƟon flagging and decision rule. 

Categorizing Data 

In business, data frequently needs to be bucketed in order to provide for beƩer reports and 
decisions. The IF 

funcƟon easily allows us to automaƟcally form these categories. 

Example: Student Grades 

=IF(B2>=75, "DisƟncƟon", IF(B2>=50, "Pass", "Fail")) 

• When marks are 75 or above → “DisƟncƟon.” 

• If marks are 50-74 Sentences connectorsIn school, I study for at least two hours every day. 

• Otherwise → “Fail.” 

Example: Customer SegmentaƟon 

=IF(C2>=50000, "PlaƟnum", IF(C2>=20000, "Gold", IF(C2>=5000, "Silver", "Bronze")))} 

• Loyalty Ɵers are determined automaƟcally based on annual spending. 

Business Impact: 

ClassificaƟon: Apply classificaƟon to target ads at premium clients while offering discounts 
to. 

encourage lower-Ɵer customers. 

Flagging CondiƟons 

Logical funcƟons to flag excepƟons or records that saƟsfy a certain condiƟon. 

Example: Late Deliveries 

=IF(D2>E2, "Delayed", "On Time") 
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• If actual delivery date (D2) is later than promised delivery date (E2), the order says 
“Delayed”. 

Example: AƩendance Monitoring 

72 

=IF(F2=50000, H2>=700), "Approved", "Rejected") 

• Only approves a loan if income is at least ₹50,000 and credit score above 700. 

Example: Sales Commission 

=IF(I2>=100000, "20% Commission", IF(I2>=50000, "10% Commission", "NoCommission")) 

• Offers commission rates based on the sales made. 

Example: Inventory Alerts 

=IF(J2<50, "Reorder", "Stock OK") 

• Alerts managers when products in stock goes below the threshold of 50 pieces. 

Business Impact: 

By embedding decision rules into Excel, consistency and speed of reporƟng are increased, 
and human bias in. 

applying company policies. 

Key Takeaway 

• Data Grouping helps to organize and report values if you want to see data in chunks. 

• Flagging CondiƟons calls aƩenƟon to excepƟons or risks. 

• Decision Rules: Decisions can be made easier by automaƟng business logic and applying 
company policies consistently. 

As a result, the logical funcƟons turn Excel into more than just a spreadsheet; they make it a 
decision-making apparatus. 

 

3.3 Logical Operators 

The logical operators are the essence of the decision making process in Excel. They build 
upon the capability of formulas such as IF. 

, as it permits the simultaneous evaluaƟon of several condiƟons. Instead of just tesƟng one 
rule, and logic gates are used to . 

combine or invert condiƟons to make formula more flexible and pracƟcal for business use. 
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3.3.1 Understanding Logical Operators – AND, OR, NOT 

There are three important logical operators provided in Excel: AND, OR and NOT. These type 
phrases can also be sort orders: =And This sortlist-arguments "Excerpt *" (note we are 
combining sort funcƟons here by ANDing the fields, which looks like: "{'type': 'group', 'and':[} 
], That's good for a situaƟon but what about for 2 different situaƟons and you link the orders 
with ORs eg. 

formulaƟon that describes actual business logic. 

The AND FuncƟon 

DefiniƟon: 

The AND funcƟon tests several condiƟons and returns TRUE only if all the condiƟons are 
true. If any condiƟon 

is not true, the result is FALSE. 

Syntax: 

=AND(condiƟon1, condiƟon2,...) 

Example: 

=AND(A2>=50, B2>=60) 

• Is TRUE only if A2 is 50 or greater, and B2 is 60 or greater. 

Business Example: 

Loan approval: 

=IF(AND(Income>=50000, CreditScore>=700), "Approved", "Rejected") 

• Loan is sancƟoned if income≥₹50,000 and credit score ≥ 700. 

The OR FuncƟon 

DefiniƟon: 

OR checks if mulƟple condiƟons are met and returns TRUE if at least one is true. It returns 
FALSE 

otherwise all the condiƟons are false (if and only if). 

Syntax: 

=OR(condiƟon1, condiƟon2,...) 

Example: 

=OR(A2>=50, B2>=60) 
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• TRUE if A2 is more than or equal to 50, or B2 is greater than or equal to 60. 

Business Example: 

Sales target incenƟve: 

=IF(OR(Sales>=100000, NewClients>=10), "Bonus", "No Bonus") 

• Bonus given if a salesman exceeds the sales of ₹1,00,000 or has not less than 10 new 

clients. 

The NOT FuncƟon 

DefiniƟon: 

The NOT funcƟon negates the output of a logical test. It returns FALSE if the condiƟon is 
TRUE that NOT. If the 

condiƟon is FALSE, NOT does not return TRUE. 

Syntax: 

=NOT(condiƟon) 

Example: 

=NOT(A2>100) 

• TRUE if A2 is not greater than 100. 

Business Example: 

Inventory control: 

=IF(NOT(Stock>0), "Out of Stock", "Available") 

If stock is not bigger than 0 the formula will give “Out of Stock.” 

Comparison of Logical Operators 

Operator TRUE WhenIt Returns FALSE 

When 

Business Use Case 

AND All condiƟons are Any one condiƟon is true true. 

false 

Income and credit needed for loan approval 

score criteria 
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OR At least one condiƟon is 

true 

All condiƟons are falseIncenƟves on sales OR new clients 

NOT The tested condiƟon is 

false 

The tested condiƟon is 

true 

Flagging out-of-stock products 

Key Insight: 

• AND = All of the condiƟons must be met. 

• OR = If one there, that’s enough. 

• NOT = And simply inverts the logical result. 

As part of IF, these operators give analysts a way to model nontrivial business logic easily in 
Excel. 

 

3.3.2 Combining Logical Operators with IF 

Where Excel's logical funcƟons really take off is when you couple them with such using 
logical operators (AND, OR, NOT). 

with the IF funcƟon. This supports running mulƟple tests at once and provides a more 
flexible. 

decision-making rules. Rather than lengthy Nested IFs, the use of operators and IF produces 
cleaner, compact results. 

easier-to-manage formulas. 

IF with AND 

DefiniƟon: 

When you do that, using IF with AND means something will only happen if all of the 
condiƟons you specify are TRUE. 

Syntax: 

=IF(AND(condiƟon1, condiƟon2), value_if_true, value_if_false) 
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Example (Loan Approval): 

=IF(AND(Income>=50000, CreditScore>=700), "Approved", "Rejected") 

• It returns “Approved” only if income is greater than or equal to ₹50,000 and credit score is 
at least 700. 

• Otherwise, returns “Rejected.” 

Business Use Case: 

Claims approval with Mutual CondiƟon (valid documents AND claim amount to be less than. 

a limit). 

IF with OR 

DefiniƟon: 

Fill IF/OR condiƟon It is also possible to use both OR and IF in a single condiƟon. This adds 
the flexibility that if any one of the 3 criteria are met, then its TRUE else FALSE! 

Syntax: 

=IF(OR(condiƟon1, condiƟon2), value_if_true, value_if_false) 

Example (Sales Bonus): 

=IF(OR(Sales>=100000, NewClients>=10), "Bonus", "No Bonus") 

• It will be “Bonus” when both the sales is more than ₹1,00,000 and minimum 10 new client 
has been acquired. 

• Otherwise, returns “No Bonus.” 

Business Use Case: 

2 Rewarding scholarships based on sport achievement or academic performance. 

requirement. 

IF with NOT 

DefiniƟon: 

IF and NOT As for combining IF with NOT, this has the effect of turning a logical test around, 
so it is good to remember if you are looking at differenƟate an excepƟon to what you do 
want. 

Syntax: 

=IF(NOT(condiƟon), value_if_true, value_if_false) 
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Example (Inventory Check): 

=IF(NOT(Stock>0), "Out of Stock", "Available") 

• Returns “Out of Stock” if the stock is NOT greater than 0. 

• Otherwise, returns “Available.” 

Business Use Case: 

ProacƟve customers who haven’t bought in last 12 months should be tagged as In CRMs 
‘inacƟve’. 

Complex Example: Combining MulƟple Operators 

Logical operators may be used to make more complex decisions. 

Example (Employee PromoƟon Eligibility): 

=IF(AND(PerformanceScore>=80, OR(Experience>=5, TrainingCompleted="Yes"))," Eligible"," 
Not Eligible") 

• If Performance score is 80 or more and either Experience is at least 5 Years or Training is at 
least, then the funcƟon will return “Eligible”. 

completed 

Otherwise, returns “Not Eligible.” 

Business Impact: 

Such a formula mimics the actual HR decision rules where an eligibility criterion has 
mulƟple determinants. 

Key Takeaway 

• Employ AND within IF when all of a number of condiƟons must be true. 

• Employ OR along with IF if one condiƟon can saƟsfy the rule. 

• Pair NOT with IF to test for excepƟons or contrary condiƟons. 

• Using operators eliminates lengthy Nested IF statements and makes the formula logical, 
easy to comprehend and maintain. 

aligned with business rules. 

 

3.3.3 Examples of Complex Logical CondiƟons 

Few for-profit organizaƟons make decisions in just one dimension. They tend to be based on 
mulƟple condiƟons and they fall in. 
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immediately or ”either/or” rules. IF use in combinaƟon with Else, ElseIf Excel lets analysts 
do this with IF and. 

logical operator( ) (AND, OR and NOT) to combine more complex logical condiƟons. 

Tax Slab CalculaƟon 

Problem Statement: The requirement is to calculate income tax according to the rules for a 
company. 

• Above ₹10,00,000 Pay the tax of “30%” 

• Income from ₹5,00,000 to ₹10,00,000 → “20% Tax” 

• Income less than ₹5,00,000 → “10% Tax” 

Formula: 

=IF(A2>1000000,"30% Tax",IF(AND(A2>=500000,A2 AND AƩendance >= 95% → “Excellent” 

• Score ≥ 75 AND AƩendance ≥ 85% → “Good” 

• Score ≥ 60 → “Average” 

• Otherwise → “Needs Improvement” 

Formula: 

=IF(AND(B2>=90,C2>=95),"Excellent", 

IF(AND(B2>=75,C2>=85),"Good", 

IF(B2>=60,"Average","Needs Improvement"))) 

ExplanaƟon: 

This formula contains mulƟple criteria is wriƩen to check if the employee meets score and 
aƩendance requirement or not. 

for higher raƟngs. 

Loan Approval Decision 

SituaƟon: A bank has the following policy regarding its approval of loans: 

• Approval if income ≥ ₹50,000 AND credit score ≥ 700. 

• If Applicant has guarantor OR collateral, accept even lower income. 

• Otherwise → Reject. 

Formula: 

=IF(AND(Income>=50000,CreditScore>=700),"Approved", 
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IF(OR(Guarantor="Yes",Collateral="Yes"),"Approved","Rejected")) 

ExplanaƟon: 

This is a compound use of an AND and OR clause in the same formula to create a more 
flexible, real-world banking requirement. 

Discount Strategy for Retailers 

Use case: A retail chain that offers discounts on products depending upon purchase amount 
and customer type. 

• Premium customers of purchase value ≥ ₹50,000 → “25% Discount” 

• VVIP customers with transacƟon of ₹50,000 or more → “15% Discount” 

• "No Discount" for any customer having purchase =50000),"25% Discount", 

IF(AND(CustomerType="Regular",Purchase>=50000),"15% Discount","No Discount")) 

ExplanaƟon: 

This makes sure that premium customers get more discount, but is sƟll considering 
purchasing Ɵer for actually both customer types 

types. 

Inventory Alerts 

Scenario: Service flags for Products- Warehouse needs to establish flags against the 
products. 

• If the stock = 0 → “Out of Stock” 

• If stock 200 → “Overstock” 

Formula: 

=IF(A2=0,"Out of Stock", 

IF(A2=50,A2<=200),"Sufficient Stock","Overstock"))) 

Key Insight 

Through the use of complex logical condiƟons in Excel, businesses are able to: 

• Consistently use mulƟple decision rules. 

• Automate categorizaƟon of documents (tax brackets, performance, discounts). 

• Minimize human-induced decision-making errors. 

• Reflect policies in the real world by equaƟons in structured form. 
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By adding IF to AND/OR/NOT, analysts construct formulas that appear like the true business 
logic they represent, if costly since then. 

how detailed 

 

3.4 Error Handling in Excel 

While working with large datasets and formulas, it is common to encounter errors in Excel. 
These errors appear as codes (e.g., #DIV/0!) and indicate problems with formulas or data. 
Understanding these errors is essenƟal for data analysts because misinterpreƟng them can 
lead to incorrect conclusions. 

3.4.1 Common Excel Errors (#DIV/0!, #N/A, #VALUE!, etc.) 

Excel has error codes to indicate where things have gone wrong and how to fix them. Below 
are the most frequently 

encountered ones: 

#DIV/0! (Division by Zero Error) 

Cause: 

That happens when dividing by zero or by an empty cell. 

Example: 

=100/0 

Result: #DIV/0! 

Fix: 

• Verify a number >0 in the denominator cell. 

• Use error handling (=IF(B2=0,"Error",A2/B2)). 

#N/A (Value Not Available Error) 

Cause: 

What happens when a value is not available/missing/not found for a formula (john, mostly) 
parƟcularly in lookup funcƟons like: 

VLOOKUP or HLOOKUP). 

Example: 

=VLOOKUP(“X”, A2:B10, 2, FALSE) 

Excel returns #N/A if “X” is not in the array. 
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Fix: 

• Make sure the value to be looked up exists in the data set. 

• UƟlize IFNA() or IFERROR() to give your own message. 

#VALUE! (Invalid Data Type Error) 

Cause: 

It happens when you don’t have a match of data types (for example, text to number). 

Example: 

=10 + "Hello" 

Result: #VALUE! 

Fix: 

• Validate that all values are numeric when doing calculaƟons. 

• Leverage text funcƟons like (VALUE(), TEXT()) as per the requirement. 

#NAME? (Unrecognized Text or FuncƟon Error) 

Cause: 

It happens when Excel is unable to recognize text in a formula. Typical reasons: misspelling a 
funcƟon name, referencing an 

undefined range, or by omiƫng quotaƟon marks" with text. 

Example: 

=SUMM(A1:A5) 

(Misspelled SUM → returns #NAME?) 

Fix: 

• Verify spelling of funcƟons. 

• QuotaƟon marks should be used for text values ("text"). 

• See if Named Ranges Are Present. 

#REF! (Invalid Reference Error) 

Cause: 

Triggers when a cell reference is bad and points to an invalid locaƟon, such as deleted cells. 

Example: 
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If there is a formula =A1+B1, then B column has been removed so the formula changes to 
=A1+#REF!. 

Fix: 

• Restore the deleted cell/column. 

• Replace formulas that contain valid references with the calculated result. 

#NUM! (Invalid Numeric CalculaƟon Error) 

Cause: 

When you aƩempt a math operaƟon that won't work, like trying to take the square root of a 
negaƟve number or billion-digit divmod-ing. 

large results. 

Example: 

=SQRT(-4) 

Result: #NUM! 

Fix: 

• Verify that your calculaƟons make mathemaƟcal sense. 

• Test invalid inputs (eg negaƟves when not expected) 

#NULL! (Invalid Range Error) 

Cause: 

Occurs when one uses an invalid range operator, or references a pair of ranges that do not 
intersect incorrectly. 

Example: 

=SUM(A1:A5 C1:C5) 

(Missing comma/colon between ranges) 

Fix: 

• Use correct token delimiters (comma for union, colon for range, space for intersecƟon). 

Key Takeaway 

• Errors like #DIV/0!, #N/A, and #VALUE! are not mere anomalies, but indicaƟons that 
formulas or inputs 

need correcƟon. 

Page 24 of 39 - AI Writing Submission Submission ID trn:oid:::3618:127424873

Page 24 of 39 - AI Writing Submission Submission ID trn:oid:::3618:127424873



• OpƟon to quickly locate this error saves Ɵme and eliminates misreporƟng. 

 

3.4.2 Error Handling FuncƟons – IFERROR, ISERROR, ISNA 

Errors in Excel can get in the way of analysis and leave reports looking like a mess. While 
error codes (like #DIV/0!, #N/A, or 

#VALUE!) wiring difficulƟes, most business reporƟng needs niŌy, digesƟble reports, rather 
than ugly error codes. 

Excel includes error-handling funcƟons like IFERROR, ISERROR and ISNA to handle and 
customize 

responses when errors occur. 

IFERROR FuncƟon 

DefiniƟon: 

IFERROR funcƟon is used to return a custom result when a formula generates an error. If no 
error occurs, it 

returns the normal formula result. 

Syntax: 

=IFERROR(value, value_if_error) 

• value : The expression or formula to evaluate. 

• value_if_error – The value that will be returned if an error is found. 

Example: 

=IFERROR(A2/B2, "Invalid CalculaƟon") 

• If B2 = 0 → instead of #DIV/0! the funcƟon should be "Invalid CalculaƟon." 

• B2 > 0 → It does division as it is usually understood. 

Business Use Case: 

In financial reporƟng, use IFERROR to zero the value out or return “Data Missing”, creaƟng 
cleaner and ore organized dashboards 

easier to interpret. 

ISERROR FuncƟon 

DefiniƟon: 
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The ISERROR funcƟon returnstrue if a formula generates an error (#N/A, #VALUE!, #DIV/0!, 
#REF!, #NUM!, 

#NAME?, #NULL!). if error returns TRUE, otherwise FALSE. 

Syntax: 

=ISERROR(value) 

• value: The expression to be tested. 

Example: 

=ISERROR(A2/B2) 

• If B2 = 0 → returns TRUE. 

• If B2 ≠ 0 → returns FALSE. 

Business Use Case: 

Flag error-causing transacƟons or formulas for analysts to invesƟgate and repair, rather than 
abandoning 

hidden mistakes in reports. 

Example with IF: 

=IF(ISERROR(VLOOKUP(D2, A2:B10, 2, FALSE)), "N/A", VLOOKUP(D2, A2:B10, 2, FALSE)) 

• VLOOKUP failure returns “Not Found,” not #N/A. 

ISNA FuncƟon 

DefiniƟon: 

The funcƟon ISNA is employed to test whether a formula will generate the #N/A error. It 
returns TRUE if the result 

is #N/A, otherwise FALSE. 

Syntax: 

=ISNA(value) 

Example: 

=ISNA(VLOOKUP("X", A2:B10, 2, FALSE)) 

• If “X” doesn’t exist in the lookup table → TRUE. 

• If “X” is present → returns FALSE. 

Business Use Case: 
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For lookups, ISNA can return missing products, customers, or employees in lookup tables. 

This feature is parƟcularly helpful for CRM as well as inventory systems. 

Example with IF: 

=IF(ISNA(VLOOKUP("Laptop", A2:B20, 2)), "Item Not Found", VLOOKUP("Laptop", A2:B20, 2, 

FALSE)) 

• If the product “Laptop” doesn’t exist in the list of items →returns “Item Not Found”. 

If found → would return the proper price or value. 

Comparison of Error Handling FuncƟons 

FuncƟon Purpose Return Business Use Case 

IFERROR Replaces an error with a 

custom value 

Normal return on no error, else 

custom message 

Financial dashboards, clean 

reports 

ISERROR Tests for any formula errorcells containing an error value. 

error 

TRUE/FALSE Flagging problemaƟc data 

ISNA Checks specifically for #N/A 

errors 

TRUE/FALSE DetecƟng missing lookup 

values 

Key Takeaway 

• Clean up outputs with IFERROR for more user-friendly text or numbers in place of error 
codes. 

• Use ISERROR if you want to check for any error before implemenƟng addiƟonal logic. 

• For lookup value errors that are specific to ISNA, use it to locate the missing data. 

These funcƟons help analysts combat errors, professionalism and readability of reports924 
which is criƟcal to the communicaƟons process912. 
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don’t distract from the insights. 

 

3.4.3 PracƟcal Scenarios of Error Handling in Data Analysis 

Real-world business analyƟcs seldom have perfect, cleaned data. 16 but can have missing, 
invalid 

calculaƟons, or unsuccessful lookups that return errors such as #DIV/0!, #N/A, or #VALUE!. 
If leŌ unhandled, these errors 

can be decepƟve to decision makers or informal-looking in reports. With the Excel error 
handling funcƟons 

(IFERROR, ISERROR, ISNA) where analysts can simply handle such cases. 

Division by zero in financial raƟos 

Scenario: 

A financial analyst is compuƟng the profit margin in the following way, what will be a value 
of If? 

=Profit / Sales 

If sales = 0 then Excel will return #DIV/0!. 

SoluƟon with IFERROR: 

=IFERROR(Profit/Sales, "Not Applicable") 

• If sales = 0 then return “Not Applicable.” 

• Otherwise → give back the correct margin. 

Business Impact: 

Appearance of financial reports will be taken to the next level -no more absurd error codes 
("No Data", etc.) whenever sales data happens to be missing. 

Lookup values not showing in product lists 

Scenario: 

A store uƟlizes VLOOKUP in order to look up prices of goods. If there is no product code, 
instead of a number Excel gives #N/A. 

Formula prone to error: 

=VLOOKUP(ProductID, A2:B100, 2, FALSE) 

If the item is not available in the list → returns #N/A. 
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SoluƟon with IFNA: 

=IFNA(VLOOKUP(ProductID,A2:B100,2,FALSE)," No Item Found") 

Business Impact: 

Instead of an ambiguous error, sale staff now receive “Item Not Found,” assisƟng them to 
rapidly pinpoint missing products. 

Data Type Anomaly in Employee Database 

Scenario: 

A typical HR analyst would compute a year’s salary as follows: 

=MonthlySalary * 12 

When MonthlySalary is text such as "N/A", Excel displays #VALUE!. 

SoluƟon with IFERROR: 

=IFERROR(MonthlySalary*12, 0) 

• If MonthlySalary is null → it goes to 0. 

• Otherwise → computes right annual salary. 

Business Impact: 

No more crashes in payroll analysis due to data that isn't what you expected it to be. 

Error Metric as a Proxy for ValidaƟons of Data Quality 

Scenario: 

A data quality officer would like to mark all rows having errors in totals before reports are 
shared. 

SoluƟon with ISERROR: 

=IF(ISERROR(CalculaƟonCell), "Check Data", "OK") 

• If there is an error → mark as “Check Data”. 

• Otherwise → shows “OK.” 

Business Impact: 

"Provides for problems to be brought to the aƩenƟon of review rather than see bad data 
get inserted into our final reports. 

Combining Error Handling in Dashboards 

Scenario: 
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A sales dashboard gets data from several sheets. When wrong values are missing or don't 
match, errors can be thrown. To avoid 

cluƩer, you include error handling in all your formulas. 

Example Formula: 

=IFERROR(VLOOKUP(Region, SalesData, 3, FALSE), "No Data") 

Business Impact: 

Builds dashboards that are clean, trustworthy and user-friendly so managers can trust the 
analysis. 

Key Insight 

• Use IFERROR to replace any error with a clean result or message. 

• ISERROR can help you flag and track errors when validaƟng. 

• ISNA is great to use as an Internet explorer on lookup failure/#N/A. 

All data sources have error handling, so we provide completely accurate and acƟonable 
reports to your table even if your raw data is. 

incomplete or imperfect. 

Knowledge Check 1 

Choose the correct opƟon: 

1. Which funcƟon in Excel returns one value if a condiƟon is TRUE and another if FALSE? 

A) AND 

B) OR 

C) IF 

D) NOT 

2. Which of the following best describes Nested IF statements? 

A) Using IF with error handling 

B) MulƟple IF funcƟons placed inside each other 

C) IF combined with VLOOKUP 

D) IF used with text funcƟons 

3. Which logical operator will return TRUE only if all condiƟons are true? 

A) OR 
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B) AND 

C) NOT 

D) IFERROR 

4. Which formula correctly assigns “Pass” if marks ≥ 50, otherwise “Fail”? 

A) =IF(Marks>=50,"Fail","Pass") 

B) =IF(Marks>=50,"Pass","Fail") 

C) =IF(Marks<50,"Pass","Fail") 

D) =IF(Marks=50,"Pass","Fail") 

5. What does the NOT operator do in Excel? 

A) Checks if all condiƟons are true 

B) Returns the opposite of a condiƟon 

C) Returns TRUE if at least one condiƟon is true 

D) Handles errors in formulas 

 

 3.5 Summary 

 

❖ In this chapter you learned about logical funcƟons in Excel and how to use these as 
robust business analyƟcs decision support tools. The significance of logic funcƟons was 
emphasized in how>'); These are; _ GGt+1, or   Vϊ (Gxi... Gksi_ \{Gxsi_. 

 

automate common operaƟons, classify data, issue alerts and support complex business 
rules. The IF 

 

notaƟon was presented as the basis of logical funcƟons having its applicaƟons in electronic 
sorƟng, flagging, 

 

and applying decision rules. Learners were also introduced to “nested” IF statements, which 
increase the capabiliƟes of a funcƟon by means of and/ or/not AND/OR. 
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tesƟng mulƟple condiƟons in sequence. 

 

❖ The chapter then considered logical operators (AND, OR, NOT), that permit analysts to 
link several 

 

not require as stringent condiƟons or regulaƟons. The use of logical operators with IF was 
largely demonstrated to be simplify 

 

formulae as opposed to long nested ifs. Instances of such complex condiƟons—tax slabs, 
employees 

 

risky to peƩy or narrow transacƟonal sales from AI systems through machines’ black box 
gambit in these contexts 34 business pracƟce such as car performance raƟngs or loan 
approvals—illustrated how business policies can be applied immediately 

 

in Excel formulas. 

 

❖ Finally, the chapter covered how to handle errors in Excel. Learners reviewed common 
errors (#DIV/0!, #N/A, 

 

#VALUE!, etc.) that focused on what had already been done in Excel error trapping funcƟons 
like IFERROR, ISERROR, and ISNA. 

 

We demonstrated a few pracƟcal scenarios where division by 0, missing look up values and 
invalid data were handled. 

 

types for keeping your reports clean, trustworthy, and professional. In general, the chapter 
demonstrated that logical 

 

funcƟons and error-handling are crucial in order to create robust, automated and business-
ready analyƟcal 
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models in Excel. 

 

3.6 Key Terms 

 

Logical FuncƟon: A funcƟon that tests a condiƟon and returns either TRUE or FALSE. 

 

IF FuncƟon: It returns one value if the specified condiƟon is TRUE and another if FALSE. 

 

Example: =IF(A1>50, "Pass", "Fail") 

 

Nested IF: When one IF funcƟon is nested inside another to test a sequence of condiƟons. 

 

Example: =IF(A1>=75, "DisƟncƟon", IF(A1>=50, "Pass", "Fail")) 

 

IFS FuncƟon (Excel 2016 & beyond) - A new approach to Nested IF, which could tackle 
several ifs and else combineReducers filter method on the Go! I try not to end sentences 
with an "if"! 

 

be confirmed in a less dirty way. 

 

Example: =IFS(A1>=75, "DisƟncƟon", A1>=50, "Pass", A150, B150, B150) is TRUE if A1 is less 
than or equal to 50. 

 

#DIV/0! : Excel Formula Does Not Work: Division By Zero or Blank Cell. 

 

#N/A: Implemented when a value is not available – typically used in lookup funcƟons such 
as VLOOKUP. 
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#VALUE! : Only occurs when the formula references incorrect data types, like aƩempƟng to 
add text and 

 

numbers. 

 

#REF! : Occurs when a re-using formula refers to an invalid or deleted cell reference. 

 

#NUM! : Undefined due to nonsensical numeric operaƟons, e.g. the square root of a 
negaƟve number. 

 

IFERROR: A formula that returns a custom value if the formula calling it generates any error, 
and if not gives back the original formula. 

 

result. 

 

Example: =IFERROR(A1/B1, "Error") 

 

ISERROR: Returns TRUE if the result of a formula is any error type (#DIV\\ 0!, #N/A, etc.). 

 

ISNA: Another check on the #N/A error, it returns TRUE if found. 

 

3.7 DescripƟve QuesƟons 

 

What is the significance of logical funcƟons in business analyƟcs? 

 

a) Write the syntax of IF and describe its arguments through an example. 

 

What is the difference between a nested IF statement and an usual IF Statement. 
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Excel Logical operators in Excel — What are they? Explain AND, OR, and NOT. 

 

What are two ways you can use logic operators with the IF funcƟon? 

 

Provide three examples of actual commercial situaƟons which Nested IF can be used. 

 

Give 5 common Excel errors and their probable causes. 

 

How IFERROR and ISERROR and ISNA funcƟons are useful for error handling in Excel? 

 

Provide an instance of when error handling increased the accuracy of reports in a real 
scenario. 

 

Why is error handling important in business analyƟcs dashboards? 

 

(Excel Lab-Based) Using the Nested IF and IFS funcƟons in Excel develop a spreadsheet that 
will grade students. 
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3. Albright, S. C., & Winston, W. L. (2015). Business AnalyƟcs: Data Analysis and Decision 
Making. Cengage 
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4. MicrosoŌ Excel DocumentaƟon – MicrosoŌ Support 
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Answers to Knowledge Check 

Knowledge Check 1 

1. C) IF 

2. B) MulƟple IF funcƟons placed inside each other 

3. B) AND 

4. B) =IF(Marks>=50,"Pass","Fail") 

5. B) Returns the opposite of a condiƟon 

 

3.9 Case Study 

“Using Logical FuncƟons and Error Handling to Improve HR Decision-Making” 

IntroducƟon: 

 

XYZ CorporaƟon was looking to streamline the process of HR reporƟng. The company 
wanted to assess the performance of its 

 

performance and aƩendance in determining who receives bonuses or promoƟons. The HR 
department was using Excel, but wasn’t sure if it would scale. 

 

erroneous calculaƟons (#DIV/0!, #N/A) made reports unreliable. 

 

Problem 1: Who Gets a Bonus? 

 

HR had to find the employees who were successful for bonus: sales more than ₹2,00,000 
AND aƩendance above 90%. 

 

SoluƟon: 

 

Formula: 
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=IF(AND(Sales>=200000, AƩendance>=90%), "Bonus Eligible", "Not Elibigle") 

 

MCQ: 

 

Which boolean works for both the sales and aƩendance condiƟon? 

 

A) OR 

 

B) NOT 

 

C) AND 

 

D) ISNA 

 

Answer: C) AND 

 

Problem Statement 2: PromoƟon ShortlisƟng 

 

Employees should be promoted if performance score ≥ 85 OR years spent in a division ≥5. 

 

SoluƟon: 

 

Formula: 

 

=IF(OR(Performance>=85, Experience>=5), "PromoƟon", "No PromoƟon") 

 

MCQ: 
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What is the operator to check if any one of the condiƟon is true? 

 

A) AND 

 

B) OR 

 

C) NOT 

 

D) IFERROR 

 

Answer: B) OR 

 

Problem 3: ExcepƟon Handling for AƩendance Data 

 

Some of the aƩendance data of employees was NAN, resulƟng in #DIV/0! in formulas when 
averages were 

 

calculated. 

 

SoluƟon: 

 

Formula: 

 

=IFERROR(TotalDaysPresent/TotalDays, "Data Missing") 

 

MCQ: 

 

What is error funcƟon that replace the error code to user friendly text? 
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A) ISNA 

 

B) IFERROR 

 

C) ISERROR 

 

D) NOT 

 

Answer: B) IFERROR 

 

Conclusion: 

 

Using logical funcƟons (IF, AND etc.) and error handling funcƟon (IFERROR, ISNA) XYZ 

 

CorporaƟon automated its HR decisions. Bonus eligibility, promoƟon shortlist and errorless 
aƩendance 

 

in order to more rapidly and reliably communicate the new managers could concentrate on 
decision-making Council Adopted Budget INTRODUCTION Departmental Budget submission. 

 

correcƟng reports. 
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*% detected as AI
AI detection includes the possibility of false positives. Although some text in 
this submission is likely AI generated, scores below the 20% threshold are not 
surfaced because they have a higher likelihood of false positives.

Caution: Review required.

It is essential to understand the limitations of AI detection before making decisions 
about a student’s work. We encourage you to learn more about Turnitin’s AI detection 
capabilities before using the tool.

Disclaimer
Our AI writing assessment is designed to help educators identify text that might be prepared by a generative AI tool. Our AI writing assessment may not always be accurate (i.e., our AI models 
may produce either false positive results or false negative results), so it should not be used as the sole basis for adverse actions against a student. It takes further scrutiny and human 
judgment in conjunction with an organization's application of its specific academic policies to determine whether any academic misconduct has occurred.

Frequently Asked Questions

How should I interpret Turnitin's AI writing percentage and false positives?
The percentage shown in the AI writing report is the amount of qualifying text within the submission that Turnitin’s AI writing 
detection model determines was either likely AI-generated text from a large-language model or likely AI-generated text that was 
likely revised using an AI paraphrase tool or word spinner.
 
False positives (incorrectly flagging human-written text as AI-generated) are a possibility in AI models.
 
AI detection scores under 20%, which we do not surface in new reports, have a higher likelihood of false positives. To reduce the 
likelihood of misinterpretation, no score or highlights are attributed and are indicated with an asterisk in the report (*%).
 
The AI writing percentage should not be the sole basis to determine whether misconduct has occurred. The reviewer/instructor 
should use the percentage as a means to start a formative conversation with their student and/or use it to examine the submitted 
assignment in accordance with their school's policies.

What does 'qualifying text' mean?
Our model only processes qualifying text in the form of long-form writing. Long-form writing means individual sentences contained in paragraphs that make up a 
longer piece of written work, such as an essay, a dissertation, or an article, etc. Qualifying text that has been determined to be likely AI-generated will be 
highlighted in cyan in the submission, and likely AI-generated and then likely AI-paraphrased will be highlighted purple.
 
Non-qualifying text, such as bullet points, annotated bibliographies, etc., will not be processed and can create disparity between the submission highlights and the 
percentage shown.
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Unit 4: Statistical & Mathematical Functions 

Learning Outcomes 

1. Explain the importance of statistical functions in Excel and their role in summarizing, 
analyzing, and 

interpreting business data. 

2. Apply descriptive statisticsfunctions such as AVERAGE, MEDIAN, and MODE to 
calculate measures 

of central tendency. 

3. Use variability functions like STDEV.S, STDEV.P, VAR.S, and VAR.P to measure data 
dispersion and 

variability. 

4. Implement other statistical functions such as LARGE, SMALL, PERCENTILE, and 
QUARTILE to 

identify rankings and distributions in datasets. 

5. Understand counting functions and their significance in handling numeric and non-
numeric data. 

6. DiƯerentiate between basic counting functions (COUNT, COUNTA) and conditional 
counting 

functions (COUNTIF, COUNTIFS) to filter and count data based on specific conditions. 

7. Demonstrate practical applications of counting functionsin real-life 
businessscenarios,such as customer 

segmentation or sales analysis. 

8. Use mathematical functions such as SUM, PRODUCT, and QUOTIENT to perform 
basic arithmetic in 

Excel. 

Content 

4.0 Introductory Caselet 

4.1 Statistical Functions in Excel 

4.2 Counting Functions 

4.3 Mathematical Functions 
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4.4 Summary 

4.5 Key Terms 

4.6 Descriptive Questions 

4.7 References 

4.8 Case Study 

 

4.0 Introductory Caselet 

“Anita’s Excel Evolution: From Manual Chaos to Data Clarity” 
 

Anita, a 28-year-old financial analyst at a fast-growing logistics and delivery company 
in Pune, was swamped. Every month, she 

is to gather fuel costs, route eƯiciency statistics and then driver overtime logs in Report 
Format designed for 

management. Her spreadsheets, however, frequently housed varying entries of data, 
hand-entered formulas and 

same file been saved in diƯerent formats. 

Her biggest challenge was accuracy. And yes, there were some months where mis-
estimation of average fuel usage resulted in the over-provisioning of budget for fuel 
reimbursements - costing hundreds and thousands to company. Her supervisors began 

doubting her reports. 

Anita believed she had to do something diƯerent. She realized the power of from taking 

a hands-on Excel workshop. 

and counting and calculator functions with Excel. Her first couple of posts started 
right where one would expect: swooped down to the depths of SUM() and AVERAGE() 

enabled her to rapidly determine how much she would be spending both in total and on 
overage fuel. Then she turned to COUNTIF() to tally how many trips 

and STDEV., runs out of fuel. P() for analyzing fuel usage variations among multiple 
drivers. 

She also utilized other simple functions, such as ROUND() to tidy up messy decimals 
on her reports, and INT() for some hard figuring on overnight shifts. 

journies, and MOD() to determine if shifts are not regular. She placed COUNTA() to 
make sure none of the data entries are left. 
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blank. 

In a matter of weeks, Anita’s monthly reports were cleaned up, accurate and insightful. 
Her managers 

appreciated the increased clarity of purpose, and decisions were made more quickly 

and based on evidence. 

Anita's story illustrates the real-world value of mastering Excel functions that are built 
for finance—not such as: 

professionals, but also anyone handling structured data. Here are several ways you can 
streamline your business spending, from predicting budgets and addressing wasteful 
spending. 

these functions are the workhorses of any data-centric world. 

Critical Thinking Question: 

If you were Anita, which function would you learn first to make sure the report makes 
sense: COUNTIF() for a) or VLOOKUP for b)? 

filtering key metrics, STDEV. P() for variance, or ROUND() for financial rounding? Explain 
your 

choice. 

 

4.1 Statistical Functions in Excel 

For the business analytics use case, raw data typically has to be aggregated and 
analyzed before useful information can be 

drawn. Excel statistical functions give the capability to interpret data by computing 
averages, variances and 

correlations, and probabilities. These are function that make it easier to work with big 
data and more pleasurable for analysts 

make evidence-based decisions. 

 

1.1 Introduction to Statistical Functions 

What are Statistical Functions? 

Function Descriptions are the built-in equations in Excel that can be used for 
calculations to summarize, analyze and extrapolate data. 
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quickly. They are developed to sum-marize central tendency (mean, median, mode), 
dispersion (variance, standard 

deviation), and relationships (correlation, regression). 

Statistical functions replace tedious manual calculation of formulas with automatic 

calculations, thereby combining mathematical operations which would need to be 
performed at diƯerent steps. 

both faster and less error-prone. 

Significance of Statistical Functions in Business Analytics 

• Summarizing Large Datasets: Makes it possible to summarize thousands of rows of 
data as a few key summaries, such as means 

sales or customer age. 

• Decision-Making: OƯers data-driven insights for strategic decisions (e.g., ARPA 
[average revenue per palace]). 

customer). 

• Risk Analysis: Computations such as standard deviation can be used to showcase 
variation in financials. 

• Predictive Trends: Based on factors like correlating and predicting the y that include 
predictive capabilities. 

flow variables (for example, advertising outlay and sales). 

• Quality Control: Inconsistencies or deviation from normal in [] the data. 

production or operations. 

Statistical Functions in Excel 

Measures of Central Tendency 

o AVERAGE(): Calculates the average of a set of data. 

o MEDIAN(): Get the middle value. 

o MODE(): Returns the value that appears most frequently. 

98 

Measures of Spread/Dispersion 

o VAR() / VAR. P(): Variance of a dataset. 

o STDEV() / STDEV. P(): Standard deviation: a measure of how spread out values are. 
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Counting and Probability Functions 

o COUNT(): Counts numeric values. 

o COUNTA(): Count everything not blank. 

o COUNTIF(): Counts cells based on specific criteria. 

Relationship and Correlation 

o CORREL(): Tells you how one variable relates to another. 

o FORECAST(): Method that predicts a future value from known values. 

Example in Practice 

• A retailer applies AVERAGE() to compute the average daily sales of its shops. 

• The STDEV() function is used by managers to measure sales predictability across 

branches. 

• With CORREL (), analysts examine the link between advertising expenditures and 
monthly sales. 

Key Insight 

Number-crunching functions are what elevate Excel from a data-keeping tool into an 

analytics engine. They allow 

businesses to condense, compare and interpret data for the basis of sound decisions. 

4.1.2 Descriptive Statistics Functions – AVERAGE, MEDIAN, MODE 

Descriptive statistics are essential for interpreting the data. They condense vast 
datasets into elegant statistics 

which act as measure of central tendency for the data. naïve in Excel, the three most 
popular functions for descriptive statisti- publique généraliste dans le Nord-Europe. 

are AVERAGE, MEDIAN, and MODE. 

AVERAGE Function 

Definition: 

AVERAGE function finds the arithmetic mean of a range of values. It is the middle 

value when 

calculating the total of all the numbers and then dividing it by their count. 

Syntax: 

=AVERAGE(number1, [number2], …) 
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Example: 

If we have sales amounts for five months as A1:A5: 

=AVERAGE(A1:A5) 

This is the average sales for the five months. 

Business Use Case: 

The average monthly revenue is used by a company to observe performance trends and 

check whether the sales are 

consistently improving. 

MEDIAN Function 

Definition: 

Returns the median of a set of numbers, which is the number that appears in the 
middle of the list (middle value) when sorted in ascending or descending order. 

If the promoted length is even, it returns the average of the two middle values. 

Syntax: 

=MEDIAN(number1, [number2], …) 

Example: 

For 45, 55 →the median is also 60. 

=MEDIAN(A1:A5) 

Business Use Case: 

That’s an easy question to answer – for salary comparisons, median salary is often 
more accurate than average because it isn’t influenced as much by 

Data for one country extreme values (outliers), e.g., excessively high executive 
remuneration. 

MODE Function 

Definition: 

The MODE function returns the most common value or values in a dataset. 

Syntax: 

=MODE. SNGL(number1, [number2], …) 
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( For Excel 2010 and newer, find MODE. ABS in the dropdown) In Image: This function 
gives us all diƯerent values we have for a range of cells. the syntax for SNGL is adopted; 
previous versions used MODE.) 

Example: 

For sales data: 10, 12, 12, 15, 18 → 

=MODE.SNGL(A1:A5) 

There are 12, because that happens most often. 

Business Use Case: 

In retail, the mode can be useful to determine the quantity of items that are most often 
sold (e.g., most people buy 2 bottles of shampoo at a time). 

units). This knowledge can be used to make inventory and packaging decisions. 

Comparing the VALUE of AVERAGE, MEDIAN and MODE 

Function Meaning Ideal Use Case Example Business Use 

MEAN(Number) Arithmetic average To get Mean # of data values Data Distribution is 
Uniform Consider a month's Average Sales from Jan 1995 to Dec 2001 

MEDIAN Middle value in a set of numbers Data have Outlier or skew Median salary of A 
company 

MODE Most common value Finding the most frequent occurrences Most sold product 
units 

Key Insight 

• AVERAGE produces the center of balance. 

• MEDIAN is more tolerant to skewness and outliers. 

• MODE brings forward the most usual or popular answer. 

These three functions, in combination, oƯer complementary perspectives on central 
tendency in a data fest. 

decision-making. 

 

4.1.3 Variability Functions – STDEV.S / STDEV.P • VAR.S / VAR.P 

Discriptive functions such as AVERAGE, MEDIAN, and MODE perform summarization 
of central values in data. 
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show anything about the spread or variability of the data Fill in with lists to get a better 
idea of what boxplots show but that list individual outcomes They do. "Variability is a 
fundamental component in business analytics." The reason why variability matters to a 
student of business analyticss is because 

by emphasizing reliability, risk taking, and consistency in performance. 

Excel has functions like STDEV. S, STDEV. P, VAR. S, and VAR. P values for quantifying 
the variation in data sets. 

Standard Deviation (STDEV. S and STDEV. P) 

Definition: 

No, the standard deviation is a measure of how far each individual value in the dataset 
varies from the mean. A small 

standard deviation that small mean values are close to the arithmetic average 
(consistent data), and if a large standa rd de viation, then the opposite is true. 

values are less condensed (inconsistent). 

a) STDEV. S (Sample Standard Deviation) 

When the data is a snapshot of the population. 

Syntax: 

=STDEV. S(number1, [number2], …) 

Example: 

Supposing you have daily totals of every individual day in column A from 1 to 7, such 

as: 

=STDEV.S(A1:A7) 

This measures the extent to which sales diƯer from the average in that sample week. 

Business Use Case: 

A sales analyst uses STDEV. S wave to quantify sales variability at the sample of store 
level prior to scaling insights for the  

entire company. 

b) STDEV. P (Population Standard Deviation) 

Applied when the data is the provided with complete set of population. 

Syntax: 
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=STDEV. P(number1, [number2], …) 

Example: 

If your sales data are in A1:A50 for each of 50 branches: 

=STDEV.P(A1:A50) 

This is a measure of how much sales values diƯer among all branches. 

Business Use Case: 

To determine whether an HR manager can use the standard deviation of all employee 
salaries in the company to find 

pay equity. 

Variance (VAR.S and VAR.P) 

Definition: 

Variance is another measure of how spread out the data are. It computes the mean of 
square deviations to the mean. 

The square root of the variance is known as standard deviation. 

a) VAR.S (Sample Variance) 

When dealing with a sample of the population. 

Syntax: 

=VAR.S(number1, [number2], …) 

Example: 

For the test scores of 10 students -- one from each class out of a total 50: 

=VAR.S(A1:A10) 

Business Use Case: 

A market researcher uses VAR. S to assess the variability in survey answers derived 
from a sample population of 

customers. 

b) VAR. P (Population Variance) 

Used when the data set includes the whole population. 

Syntax: 

=VAR.P(number1, [number2], …) 
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Example: 

For all customer ratings (no sampling): 

=VAR.P(A1:A200) 

Business Use Case: 

A manufacturing firm calculates VAR. P, where was growth) at al l pr oduct in defect r a t 
es ing P periods of time. 

production quality. 

Comparison of Variability Functions 

Function Use Case Formula Example Ideal For 

STDEV. S =Standard deviation of a sample =STDEV. S(A1:A10) Estimating the spread of 
a sample 

STDEV. P Population standard deviation =STDEV. P(A1:A100) Spread in the entire data 
set 

VAR. S Variance of a sample =VAR. S(A1:A10) Measuring sample variability 

VAR. P Variation in population =VAR. P(A1:A100) Variability of entire population 

Key Insight 

Standard Deviation is intuitive as it has the same units as the data (e.g. rupees, sales 

units etc.). 

• Variance also oƯers the squared amount of variation, good for more sophisticated 
statistical models. 

• Use. S items (C sample)) when operating on subsets, and. By population p ≪ P 

(plant) when data cover the 

entire group. 

Example in Practice: 

Variability of loan repayment times compared by a bank: 

• STDEV. The test of \(S\) is based on 200 respondents. 

• STDEV. P is applied to the repayment time per 10,000 customers. 

The results are used to evaluate the stability of repayments and general levels of risk. 

 

“Activity: Financial Decision-Making Simulation” 
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“In this activity, you will analyze a small dataset of student exam scores to understand 
how statistical functions in Excel can be used to draw meaningful insights. You will be 
provided with scores of 10 students in a specific subject. Begin by using the AVERAGE() 
function to calculate the class average. Then, apply the MAX() and MIN() functions to 
identify the highest and lowest scores in the dataset. Next, use the STDEV.P() function to 
determine the variation in student performance. Finally, interpret the results: Are most 
students performing close to the average, or are there major diƯerences in scores 
indicating outliers? Based on this analysis, write a short paragraph summarizing the 
overall class performance. Submit your Excel file with formulas and a brief written 
interpretation of your findings.” 

 

4.1.4 Other Statistical Functions – LARGE • SMALL • PERCENTILE • QUARTILE 

Besides measures of central tendency and dispersion, Excel provides other useful 
statistical functions which. 

assist analysts to induce ranks, positions and distributions from data. These features 
are particularly helpful in 

performance analysis, customer segmentation or detecting outliers. 

LARGE Function 

Definition: 

The LARGE function simply gives us the k-th largest value from a range of data. 

Syntax: 

=LARGE(array, k) 

• array: Range of values. 

• k: The order (1 for largest, 2 for second largest, and so on). 

Example: 

=LARGE(A1:A10, 2) 

Returns the 2nd highest number within the range A1:A10. 

Business Use Case: 

A sales manager wants to find the top 3 monthly debts for one of its branch by using 
LARGE. 

SMALL Function 

Definition: 
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The SMALL function provides the k-th smallest value in a range. 

Syntax: 

=SMALL(array, k) 

• array: Range of values. 

• k: The rank (1 smallest, 2 second smallest etc.). 

Example: 

=SMALL(A1:A10, 1) 

Outputs the minimum value in range A1:A10. 

Business Use Case: 

An HR manager generates a SMALL to identify the bottom 5 salaries in a department for 
investigation of dissimilar pay. 

PERCENTILE Function 

Definition: 

The output of the PERCENTILE function is the number below which a percentage of 
values in a data set fall. 

(Excel now uses PERCENTILE. INC and PERCENTILE. EXC; PERCENTILE is provided for 
backward compatibility.) 

Syntax: 

=PERCENTILE(array, k) 

• array: Range of values. 

•k: The percentile value (0 ≤ k ≤ 1). 

Example: 

=PERCENTILE(A1:A100, 0.9) 

The 90th percentile, the value below which 90% of the data fall. 

Business Use Case: 

A bank relies on percentiles to recognize the top 10% of credit scores customers for 
premium oƯers. 

QUARTILE Function 

Definition: 
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The QUARTILE function divides a range into four bins (quartiles). 

• Q1 = 25th percentile 

• Q2 = 50th percentile (median) 

• Q3 = 75th percentile 

• Q4 = Maximum value 

Syntax: 

=QUARTILE(array, quart) 

• array: Range of values. 

• quart: Quartile to which the number corresponds (0 = min, 1 = Q1, 2 = median, 3 = Q3, 
4 = max). 

Example: 

=QUARTILE(A1:A20, 3) 

Returns the Q3 of the distribution. 

Business Use Case: 

In the context of performance management, employees are often ranked into quartiles: 

• Top 25% → High Performers 

• Middle 50% → Average Performers 

• Bottom 25% → Low Performers 

Comparison of Functions 

Function Goal Example Use Case within Business 

LARGE Finds the k-th largest 

value 

=LARGE(A1:A10, 1) → Max 

value 

Top sales or revenue figures 

SMALL Finds the k-th smallest 

value 

=SMALL(A1:A10, 2) → 2nd 
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lowest 

Identifying lowest costs or 

salaries 

PERCENTILE Finds value below a 

certain percentage 

=PERCENTILE(A1:A100,0.75) Customer segmentation 

QUARTILE Divides data into four 

equal parts 

=QUARTILE(A1:A20,1) Employee ranking / 

performance review 

Key Insight 

• LARGE/SMALL These identify the leaders and laggards. 

• PERCENTILE is an eƯective to the thresholds, which distinguishes elite or at-risk 
populations. 

• QUARTILE: splits the data into comparable portions. 

These all broaden Excel's statistical scope beyond the assessment of only means to 
include, as well, rankings, 

cut-oƯs, and performance tiers. 

 

Did You Know? 

“Excel provides two standard deviation functions: STDEV.P() for population data and 
STDEV.S() for sample data. Many users unknowingly use the wrong one—STDEV.S() is 
better when you're working with a sample of data (e.g., a few days’ sales from the 
month), while STDEV.P() is ideal for full population data (e.g., all 30 days of the month). 
Using the wrong one can lead to incorrect conclusions in data analysis.” 

 

4.2 Counting Functions In business analytics, one of the most frequent tasks is 
counting data—whether it is the number of transactions, customers, employees, or 
defective items in production. Excel provides counting functions that allow analysts to 
quickly quantify values in large datasets. Unlike statistical functions that measure 
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averages or variability, counting functions help determine frequency and occurrence, 
which is often the starting point for deeper analysis. 

4.2.1 Introduction to Counting Functions 

What are Counting Functions? 

Excel count functions are a set of built-in functions that are very convenient for 
counting things. 

certain criteria in a dataset. They are incredibly useful for summarizing information, 
and for creating dashboards and 

files where you need fast counts. 

Relevance of Counting Functions in Business Analytics 

• Data Validation: Useful to verify that a dataset is complete (e.g. number of entries 
filled vs left blank). 

• Performance Tracking: Tally sales over a certain threshold or staƯ at 

performance goals. 

• Quality control: Determine how many defective items or error entries there are. 

• Customer Analysis: Determine the number of customers in certain segments. 

• Ease of use: Allows automation of manual counting, thus saving time when dealing 
with big data. 

Categories of Counting Functions 

Basic Counting Functions 

o COUNT: Counts the numbers in a range. 

o COUNTA: Counts all the non blank cells(numeric, text or date). 

Conditional Counting Functions 

o COUNTIF: Counts Once in response to a Single Condition. 

o COUNTIFS: Counts how many cells do meet multiple conditions at once. 

Example in Practice 

• A sales manager COUNTs how many months had reported sales. 

• An HR manager uses COUNTA to find out how many employees’ names are listed on 

a roster. 
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• A retailer employs COUNTIF to tally digits in a column that represent orders over 
₹10,000. 

• A bank uses COUNTIFS to count customers less than 30 years of age with savings at a 
high level 

₹50,000. 

Key Insight 

The use of counting functions is crucial in the processing and validation of data prior to 
any further statistical or mathematical 

analysis. They are the workhorses of data-driven dashboards, so analysts and 
managers can always see 

how many records have certain characteristics. 

“Activity: Inventory Insights: What's In, What's Out?” 

“This activity is designed to help you apply Excel's counting functions to manage 
inventory eƯectively. You will be given a product inventory list that includes item names, 
categories, and stock status marked as either “In Stock” or “Out of Stock.” Your task is 
to use the COUNTIF() function to count how many products are currently marked “Out 
of Stock.” Then, use the COUNTA() function to count the total number of products 
listed. Using these values, calculate the percentage of products that are unavailable. 
Additionally, apply conditional formatting to highlight rows where products are “Out of 
Stock” in red, making it easier to visualize stock shortages. Submit your completed 
Excel sheet along with a short note explaining how these functions and visual cues can 
support better stock management decisions.” 

4.2.2 Basic Counting Functions – COUNT • COUNTA 

The easiest and most stylist excel counting is counting how many values are in various 
data spans. 

There are two primary functions in Excel that are used to count things: COUNT and 
COUNTA. While both functions deal with 

they diƯer in what values they accept. 

COUNT Function 

Definition: 

The COUNT Function counts the number of numeric values in a range. It does not 
count blank cells, text, or logical values. 

(TRUE/FALSE), or errors. 
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Syntax: 

=COUNT(value1, [value2], …) 

• value1, value2, … = range or reference to values. 

Example: 

If A1:A6 has the following values:10 20 30 "Apple" (blank) 40 > > then, > =IFERROR((A5-
ROUND(A3,.01))/(A3),0). 

=COUNT(A1:A6) 

Answer: 4 (only the numbers are taken into account). 

Business Use Case: 

A sales manager counts the number of months that have sales > 0 within a dataset. 

COUNTA Function 

Definition: 

COUNTA counts the non-blank cells in a range. This includes numbers, text, dates, 

TRUE, FALSE), and errors. 

Syntax: 

=COUNTA(value1, [value2], …) 

• value1, value2, … = range or reference to the range containing values. 

Example: 

For example, if your data A1:A6 is: 10, 20, 30, “Apple”,,(blank), 40 → 

=COUNTA(A1:A6) 

Outcome: 5 (read numbers + text “Apple”). 

Business Use Case: 

EXAMPLE A Human Resources manager needs to know how many employees’ names 
are filled in on a roster, irrespective of the number of characters in each employee’s 
name. 

whether salary data is missing. 

DONT MISS: The diƯerence between COUNT and COUNTA 

Feature COUNT COUNTA 

Numbers All filled cells Only non-empty cells 
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disregards Text,blank,logicals,err Only blank. 

Ideal for: Analysing numeric datasets (e.g., sales) Verification of data completeness (eg 
Filled in employee names) 

Example in Practice 

A company keeps sales records of all the sale months in 12(months) sheet of excel like: 

• Some months are all text entries — “Data Missing” or something like that. 

• There are blank cells in some months. 

• Other months include actual sales numbers. 

With COUNT(A1:A12) → gives you the count of months with sales in numbers. 

• COUNTA(A1:A12) → dirty: How many months where any data was entered – numbers 
or text. 

Key Insight 

• COUNT will work best when you have only numeric data sets (such as revenues, 
quantities). 

• COUNTA is more responsible in checking the integrity of your data as it records all 
entries that have something simply. 

Combined, these two features oƯer a way to eƯiciently administer and validate 
business sets of data. 

 

4.2.3 Conditional Counting Functions – COUNTIF • COUNTIFS 

While COUNT and COUNTA return general counts, business scenarios call for 
conditional counting— 

for instance, “What was the number of sales above ₹50,000?” or “How large is the 
Marketing department?” 

and earn more than ₹60,000?” 

Excel oƯers two useful functions for this: COUNTIF (for a single condition) and 
COUNTIFS (multiple conditions). 

conditions). 

COUNTIF Function 

Definition: 
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The COUNTIF function returns the number of cells in a range that satisfy a single 

condition you designate. 

Syntax: 

=COUNTIF(range, criteria) 

• range:he set of cells to verify. 

• Criteria: The criteria to use (a number, expression or text). 

Example: 

If your sales are in A1:A10, for example: 

=COUNTIF(A1:A10, ">50000") 

Find out the count of sales that have more than ₹50,000. 

Business Use Case: 

Retailer uses COUNTIF to count the transactions more their threshold value to find 
high-value or high ticketing. 

customers. 

COUNTIFS Function 

Definition: 

The COUNTIFS function is designed to count the number of cells that meet one or 
more criteria. 

simultaneously. 

Syntax: 

=COUNTIFS(range1, criteria1, [range2, criteria2], …) 

• range1,range2: The ranges to be considered. 

• criteria1, criteria2 – Each condition to be applied to the ranges. 

Example: 

If A1:A10 is department and B1:B10 is salary: 

=COUNTIFS(A1:A10,"Marketing",B1:B10,">60000") 

Find the count of employees in Marketing department with more than 60K salary. 

Business Use Case: 
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For example, an HR analyst counts the number of employees who belong to a particular 
department and whose performance is high. 

or salary criteria. 

Practical Business Examples 

Sales Monitoring (COUNTIF): 

=COUNTIF(SalesData, ">100000") 

Number of times sale amounts have exceeded ₹1,00,000. 

Customer Segmentation (COUNTIF): 

=COUNTIF(Region,"North") 

Which Customers are from the North, Counts#+#+.counts() counts how many 

customers are from "North". # which regions have more than two customer? 

Performance Evaluation (COUNTIFS): 

=COUNTIFS(Department,"Finance",Performance,">80") 

Counts the number of employees of Finance department who has Performance scores 
greater than 80. 

Inventory Alerts (COUNTIFS): 

=COUNTIFS(Product,"Laptop",Stock," 50,000 Sales count>50000 in the ‘North’ region 

Key Insight 

• COUNTIF works well when you need only one condition, such as counting sales above 
a certain level. 

• You employ COUNTIFS for complex conditions, such as filtering employees based on 
more than one criterion. 

Combined, they give analysts the ability to derive countsof interest from dataand turn 
Excel into a tool that enables decisionmaking in business analytics 

 

4.2.4 Practical Applications in Data Analysis 

Counting functions aren’t solely a mathematical tool -- they’re decision support for 
businesses to use when making the call as to who and how. 

users monitor performance, verify data, and find patterns. Applying COUNT, COUNTA, 
COUNTIF and Counting in Excel. 
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yond counting with COUNTIFS, analysts are turning raw data sets into actionable 
intelligence to add strategic and operational value to any business. 

decisions. 

Sales Performance Monitoring 

Scenerio: Retail manager would like to know how many sales transactions occurred 
over ₹1,00,000 in the month. 

Formula: 

=COUNTIF(SalesData,">100000") 

Application: 

This formula immediately brings to focus the number of high-value sales taking place, 
enabling management to separate their top-performing sales periods or regions. 

HR Analytics – Employee Segmentation 

Example: HR needs to know how many employees there are in the Marketing 
department, How many people earn more than 

₹60,000. 

Formula: 

=COUNTIFS(DepartmentRange,"Marketing",SalaryRange,">60000") 

Application: 

If you work in HR, you can automatically segment employees as part of the appraisal 
process or for bonus eligibility, without having to do this manually. 

filtering thousands of records. 

Inventory Management 

Example: A warehouse manager wants to know how many products are in stock less 
than 50, to establish a stock shortfall. 

reorder list. 

Formula: 

=COUNTIF(StockRange,"500000") 

Application: 

This assists in discovering high-risk borrower groups and leads to better decisions on 
credit and loan policies. 
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Quality Control in Manufacturing 

Use Case: A quality oƯicer at a factory needs to check the number of products that 
didn't pass inspection because of defects. 

Formula: 

=COUNTIF(ResultRange,"Fail") 

Application: 

Through prompt counting of faulty pieces the personnel can analyze quality problems 
and develop better production methods. 

Key Insight 

•Ensuring data completeness: COUNT & COUNTA 

• COUNTIF streamlines 1-condition checks (e.g., great sales, low stock). 

• COUNTIFS It allows for the analysis of multiple conditions (for example, employees 
filtered by department and salary). 

Together, these processes that make your data ready for analytics. This is what makes 
business faster and discover more accurate insights. 

smarter decisions. 

 

Did You Know? 

“In addition to COUNT() and COUNTA(), Excel has a lesser-known function called 
COUNTBLANK() which counts only the empty cells in a range. It's extremely useful for 
cleaning data and identifying missing entries before analysis begins—especially in 
survey or attendance data.” 

 

4.3 Mathematical Functions While statistical and counting functions help in 
summarizing and categorizing data, business analysis often requires direct 
mathematical calculations. Excel provides a wide range of mathematical functions that 
simplify everything from basic arithmetic to advanced modeling. These functions are 
the foundation of most financial reports, forecasting models, and operational 
dashboards. 

4.3.1 Introduction to Mathematical Functions 

1. What are Mathematical Functions? 
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Excel math functions are pre-defined calculations that you can use to perform diƯerent 
numerical operations. They range from basic mathematics (addition, multiplication, 
division) to more advanced operations like square roots, exponentiation and random 
number generation. 2. Significance of Mathematical Functions in Business Analytics • 
Financial Analysis: Totals, product cost, margins and ratios are some common 
calculations which function solves. • Operational eƯiciency: Allow to estimate 
operational capacity, stock level and consumption rate. • Forecasting & Modeling: New 
and advanced functions such as POWER and RAND help you perform complex 

analyses for forecasting. • Accuracy of Data: Rounding methods allow values to be 
displayed to the precision level desired (e.g. 2 decimals for currency). • Automation: No 
need to manually calculate for thousands of entries, saving time and ensuring 

reliability of outputs. 3. Types of Mathematical Functions in Excel 1. Simple Arithmetic 
Functions o SUM(): Adds pairs of values. o PRODUCT(): Multiplies values. o 
QUOTIENT): Returns the integer quotient of a division. 2. Rounding Functions o 
ROUND(): Rounds to specified decimal point. o ROUNDUP(): Always rounds up. o 
ROUNDDOWN(): Always rounds down. 3. Advanced Mathematical Functions o 
POWER() : Raises a number to the specified power. o SQRT(): Calculates square root. o 
ABS(): Value with removal of minus sign from the number. o RAND(), RANDBETWEEN(): 
Create random numbers for simulations. 4. Example in Use • A financial analyst 
employs SUM to sum total sales by all regions. 

• A production manager uses PRODUCT to calculate total number of units produced per 
day (machines × hours × 

units/hour). 

• A supply planner uses RANDBETWEEN(1000,5000) to simulate the range of possible 
order volumes for his business unit  

chain planning. 

Key Insight 

Functions are an essential element of data analysis in Excel. They enable companies 

to automatically close routine 

calcuclations, validate accuracy and utilize sophisticated numeric modeling for making 

decisions. 

 

Did You Know? 

“The MOD() function is often used in real-world scenarios like scheduling rotating shifts. 
For instance, when assigning workers in a loop every 4 days, MOD(day_number, 4) helps 

Page 25 of 40 - AI Writing Submission Submission ID trn:oid:::3618:127424872

Page 25 of 40 - AI Writing Submission Submission ID trn:oid:::3618:127424872



decide which worker is scheduled. It’s a simple math function that quietly powers many 
time-management systems.” 

4.3.2 Basic Arithmetic Functions – SUM • PRODUCT • QUOTIENT 

The base of almost all calculations in business is arithmetic. You could do really basic, 
yet useful things in Excel with some of their palateable functions. 

Great. Then you could do addition, multiplication and division lickety-split and pretty 
accurately. Three of the most traditional arithmetic functions 

are SUM, PRODUCT, and QUOTIENT. 

SUM Function 

Definition: 

The SUM function adds numbers or ranges, or references cell containing numbers. It is 
one of most common functions 

in Excel. 

Syntax: 

=SUM(number1, [number2], …) 

• number1, number2, …: These are the actual numbers, cell references or ranges. 

Example: 

=SUM(A1:A5) 

Sums the values in A1 to A5. 

Business Use Case: 

• A financial analyst who is summing up the total revenue for a quarter. 

• A HR department will use SUM to roll-up the salary cost of all employees. 

PRODUCT Function 

Definition: 

The PRODUCT function is multiplying any numbers, ranges or cell references you give 
it. 

Syntax: 

=PRODUCT(number1, [number2], …) 

Example: 
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=PRODUCT(5,10,2) 

Returns 100 (5 × 10 × 2). 

=PRODUCT(A1:A3) 

If A1=2, A2=3, A3=4 → 24 (because 234). 

Business Use Case: 

• A factory computes the production output as (lines * hours worked * units per hour). 

• In e-commerce, sum all cost of an order as price*quantity. 

QUOTIENT Function 

Definition: 

The function QUOTIENT() divides values but does not allow fractional results. 

remainder. 

Syntax: 

=QUOTIENT(numerator, denominator) 

Example: 

=QUOTIENT(10,3) 

Returns 3 (for 10 ÷ 3 = 3 remainder 1). 

Business Use Case: 

• Logisticians use data analytics to estimate the number of truckloads of products that 
can be shipped in full (with no partial. 

loads). 

A Retardation and an ADVANCEMENT to 14 QUOTIENT to find whole years of service for 
employees. 

by 365. 

Comparison of Functions 

Function Operation Example Business Use 

SUM Add numbers together =SUM(A1:A5) Total sales, total salary 

PRODUCT Multiplies the numbers =PRODUCT(A1:A3) Production, out-put, order value 

QUOTIENT Division (entire numbers just) =QUOTIENT(10,3) Truckloads, long periods of 
administration 
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Key Insight 

• SUM is perfect for the fast aggregation of many numbers. 

• PRODUCT makes multi-value multiplication a single formula. 

• QUOTIENT is good if all you want are the whole numbers, not the fractions. 

Together they provide the foundation for these common business calcs in Excel. 

 

4.3.3 Rounding Functions – ROUND • ROUNDUP • ROUNDDOWN 

o Positive = number of digits to the right of the decimal. 

o Zero = round to nearest whole number. 

o Negative = round to tens, hundreds, etc. 

=ROUND(123.456,2) 

Result: 123.46 (rounded to 2 decimal places). 

Business Use Case: 

A finance manager rounds currency values to two decimal places for invoices and 
reports. 

2. ROUNDUP Function 

Definition: 

The ROUNDUP function always rounds a number up, regardless of the decimal value. 

Syntax: 

=ROUNDUP(number, num_digits) 

Example: 

=ROUNDUP(123.456,2) 

Result: 123.46 (rounded up to 2 decimals). 

=ROUNDUP(123.001,0) 

Result: 124 (rounded up to nearest whole number). 

Business Use Case: 

An event manager calculates required buses: 123 participants ÷ 50 seats = 2.46 → 

=ROUNDUP(123/50,0) 
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Result: 3 buses (since partial buses are not possible). 

3. ROUNDDOWN Function 

Definition: 

The ROUNDDOWN function always rounds a number down, ignoring the decimal part. 

Syntax: 

=ROUNDDOWN(number, num_digits) 

Example: 

Business analytics is about having control over the precision with which you 
manipulate data. Numbers, percentages or measures – Get all those numbers out of 
your bullet points. 

may require rounding for reporting purposes. Excel provides built-in rounding 
functions—ROUND, 

ROUNDUP and ROUNDDOWN to round numbers to the level of precision you want. 

ROUND Function 

Definition: 

The ROUND function rounds a number to a certain number of decimal places, either up 
or down, and does it based on the value following the decimal. 

Syntax: 

=ROUND(number, num_digits) 

• To round a number: The number to be rounded. 

• num_digits: The number of digits after the decimal point. 

=ROUNDDOWN(123.456,2) 

Result: 123.45 (rounded down). 

=ROUNDDOWN(123.999,0) 

Outcome: 123 (rounding down to a whole number). 

Business Use Case: 

A bank totals full years from regular months works not considering a partial year. 

Comparison of Rounding Functions 

Operation Action Example Result Business Purpose 
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ROUND Rounds normally (up 

or down) 

=ROUND(123.456,2) 123.46 Financial reporting 

ROUNDUP Rounds up a number =ROUNDUP(123.001,0) 124 Planning (extra 1 
quantities)-- page 2 + Wedding costs calculator you can use before meeting with your 
vendors Input Number_Book of Continuous Load Line_Granted Freeboard_Interval. 

capacity) 

ROUNDDOWN Rounds down at all times =ROUNDDOWN(123.999,0) 123 Service 
years,truncation 

Key Insight 

• Use ROUND to be generally accurate in reporting. 

In situations where you need to guarantee a margin or capacity (such as resources, 
vehicles or stock) use ROUNDUP. 

• Use ROUNDDOWN when you want to exclude rounding errors (for example, for full 
years or units). 

These two functions combined give analysts complete control of numerical precision 
in Excel. 

 

4.3.4 Advanced Mathematical Functions – POWER • SQRT • ABS • RAND / 
RANDBETWEEN 

In addition to basic arithmetic and truncation, Excel includes powerful mathematical 
functions designed for specialized 

calculations and simulations. These functions—POWER, SQRT, ABS, RAND and 
RANDBETWEEN—are 

often used in finance opeations, risk analysis and forecasting. 

POWER Function 

Definition: 

The POWER function returns a number raised to a power. 

Syntax: 

=POWER(number, power) 

• number: The base number. 
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• power: The number to which the base is raised. 

Example: 

=POWER(5,2) 

Result: 25 (5²). 

Business Use Case: 

A finance analyst would apply POWER to compute and compound growth like 
investment growth over time with interest. 

compounding. 

SQRT Function 

Definition: 

The SQRT function returns the square root of a number. 

Syntax: 

=SQRT(number) 

Example: 

=SQRT(49) 

Result: 7. 

Business Use Case: 

In quality control, an expression like SQRT is necessary in formulas to compute the 

standard deviation and variance of data. 

product consistency. 

ABS Function 

Definition: 

The Function ABS returns the magnitude of a number excluding negative sign. 

Syntax: 

=ABS(number) 

Example: 

=ABS(-150) 

Result: 150. 

Business Use Case: 
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Thus an accountant who only wants to know the absolute profit/loss diƯerence without 
caring about its sign (plus or minus_rgaming\e#chat-and.archives) uses ABS. 

negative). 

RAND Function 

Definition: 

The function RAND creates a decimal number between 0 and 1. 

Syntax: 

=RAND() 

Example: 

=RAND() 

May be 0.5283 (value can change on re-calculation). 

Business Use Case: 

Business risks under uncertainty are tested in Monte Carlo simulations by operations 
managers using RAND. 

RANDBETWEEN Function 

Definition: 

The RANDBETWEEN formula gives a random number between two values. 

Syntax: 

=RANDBETWEEN(bottom, top) 

• bottom: The smallest integer. 

• top: The largest integer. 

Example: 

=RANDBETWEEN(10,50) 

And returns a random number between 10 and 50. 

Business Use Case: 

• A store models the daily arrival of customers ranging from 100 to 200. 

• A logistics planner simulates random demand scenarios to assess supply chain 
capability 

Comparison of Advanced Mathematical Functions 
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Function Purpose Example Business Use 

POWER Raises a number to an 

exponent 

=POWER(5,3) → 125 Growth/compound 

interest 

SQRT Returns the square root of a number =SQRT(81) → 9 Quality control, statistics 

ABS A1 Absolute value =ABS[-250] → 250 Change in P/L Block 
ABS(Value)ISC_ABSamount_absA$17.38. 

RAND Random decimal between 0– 

1 

=RAND() → 0.62 Risk simulations 

RANDBETWEEN Random integer between 

range 

=RANDBETWEEN(100,500) Demand forecasting 

Key Insight 

• The operators POWER and SQRT are useful for mathematical modeling (section 3-11) 
and financial modeling. 

• ABS is necessary as we need the absolute distances, regardless of direction. 

• RAND and RANDBETWEEN go a long way in simulations, estimation models, scenario 

testing. 

These functions combined push the calculations in Excel beyond mere basic modeling 
and analysis to business and. 

forecasting. 

 

Knowledge Check 1 

Choose the correct option: 

1. Which Excel function is used to calculate the standard deviation for an entire 
population? 

A) STDEV.S() 
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B) STDEV.P() 

C) VAR.P() 

D) STDEVA() 

124 

2. If you want to count all cells that are not empty in a range, which function should you 
use? 

A) COUNT() 

B) COUNTIF() 

C) COUNTA() 

D) COUNTBLANK() 

3. Which function in Excel can be used to round a number down to the nearest whole 
number? 

A) ROUND() 

B) ROUNDUP() 

C) MOD() 

D) INT() 

4. What is the purpose of the MOD() function in Excel? 

A) To find the middle value in a data set 

B) To calculate average deviation 

C) To return the remainder after division 

D) To modify values using conditional logic 

5. You are asked to count the number of products labeled "Out of Stock" in a list. Which 
function is most 

suitable? 

A) COUNTA() 

B) COUNTIF() 

C) COUNTBLANK() 

D) COUNT() 

4.4 Summary 
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• Microsoft Excel provides a rich multimedia functions to meet various types of 
multicast formats. 

 

analytical tasks. These comprise statistical, counting and mathematical functions 

considered to be essential for the users 

 

who must analyze, interpret and act upon information in professional and academic 
contexts. 

 

Excel statistical functions get a workout as users try to learn what their data is doing 
and how it's behaving. Functions like AVERAGE() 

 

calculate the average on a group of values, MEDIAN() returns the middle value and 
STDEV. P() measures 

 

the sharing or uniformity of data within a population. These are also useful in areas like) 
market research, 

 

educational measurement, budgeting and quality control. 

 

• The counting functions oƯer insights into the size and frequency of data. ◌ׂCOUNT() 
is used to count numeric. 

 

contents within the selected range, whereas COUNTA() counts all non blank cells 
regardless of content type. 

 

COUNTIF() takes it a step further and counts only the cells that satisfy a particular 
condition—helpful for finding the number of items in your organization’s budget. 
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working with data in accordance to criteria such as region, sales goal and performance 
measures. 

 

• Core arithmetic and numeric capabilities, the group of mathematical functions. 

 

computational tasks. SUM() returns the sum of numbers, ROUND() rounds values to a 
specified number 

 

accuracy, INT() returns the integer part of a decimal, and MOD() provides the quotient 
from dividing one number by another. 

 

remainders —which are utilized for data classification or to detect patterns such as 
even/odd sequences. 

 

• Any use of these functions are basic of everyday data working, the budgeting and 
here. 

 

” from inventory control to academic experimentation and engineering simulations. 
They also reduce manual labour. 

 

calculation) and facilitate complex analysis that is easier to replicate. 

 

• Users who become proficient in these functions will be better equipped to analyze 
trends, identify outliers, prevent bribery and other incorrect behaviors, and even 
discover otherwise undetectable fraud. 

 

projections, and support data-driven decision-making. Whether you're managing 
business reports, 

 

financial auditing, or scientific data processing these tools provide the E$Ëœ also read 

$:DPSUHVVDQG precision of traditional techniques 
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required in modern data handling. 

 

4.5 Key Terms 

 

AVERAGE() – Returns the average of a range of numbers. 

 

MEDIAN() – The median value in a list of numbers. 

 

STDEV. P() – Calculates the Standard deviation based on whole population. 

 

COUNT() – Count how many numbers are in a range. 

 

COUNTA() – Count items that are not blank in a range. 

 

COUNTIF() – Counts the number of cells that meet a criterion. 

 

SUM() – Adds all of the numbers in a specified range. 

 

ROUND() – Rounds a number to specified decimal places. 

 

INT() – Rounds number down to the nearest whole number. 

 

MOD() – Calculates the remainder of a number divided by another. 

 

4.6 Descriptive Questions 

 

What is the distinction between COUNT(), COUNTA(), and COUNTIF() operations? 
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How AVERAGE(), MEDIAN() and STDEV. P() be applicable in a sales dataset? 

 

What are the uses and applications of round, int and mod in financial reporting? 

 

Provide an example in which statistical and mathematical functions are used together 
to make a decision. 

 

How do STDEV. P() and STDEV. S(), and when should you use every one of them? 

 

Where can MEDIAN() be more useful than AVERAGE()? 

 

What are time-based scheduling tasks that MOD() can be used for? 

 

What is the significance of rounding methods for financial reporting? 

 

Use AVERAGE(), MEDIAN(), and STDEV. P() based on retired or released regional sales 
data and explain the interpretation. 

 

Use COUNTA(), MOD() and INT() with employee attendance and performance to 
determine bonuses. 

 

Round and clean financial data Utilize ROUND(), INT(), and MOD() functions in Excel to 
present comparisons. 

4.7 References 

1. Microsoft Support. (n.d.). Excel functions (by category). Retrieved from 
https://support.microsoft.com 

2. Walkenbach, J. (2013). Excel 2013 Bible. Wiley. 

3. Kumar, R. (2021). Data Analysis with Microsoft Excel. Cengage Learning. 
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Answers to Knowledge Check 

Knowledge Check 1 

1. B) STDEV.P() 

2. C) COUNTA() 

3. D) INT() 

4. C) MOD() 

5. B) COUNTIF() 

 

4.8 Case Study 

“Automating Monthly Sales Reporting Using Excel Functions” 

Introduction 

In contemporary retail management, correct and timely sale information are necessary 
for deciding. A mid-sized retail chain with over 3,500 employees and 63 stores across 
the United States would like to automate its monthly sales performance reports in 
Microsoft Excel’s statistical formula functions. 

and mathematical functions. The aim is to minimise human error, simplify data 
processing and oƯer 

quick insights to regional managers. 

Background 

tore in the concession hires out changes at cashier workdays. 

transactions, and refund cases. In the past, the calculations were done by hand with 

compacted air tables. 

spreadsheets, combined with the discrepancies of reporting and often delay. 

In order to have a more accurate and quicker working, management has decided to 
introduce the eƯect of Excel functions as and_format( condition 1,condition 2(condition 
n) possible for output in diƯerent cells. 

Show More Let's Do Excel With Clinton Collins: Formula Fridays 97 – AVERAGE(), 
COUNTIF() and ROUND() to create a dynamic template with automatic refresh through 
GETPIVOTDATA! 
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new entries. 

Problem 1: Lack of Reporting Among Regions 

The formats and structures of sales reports were so diƯerent that it was diƯicult to 
consolidate them. 

Solution: An Excel formated template with default formulas namely SUM(), AVERAGE() 
})). 

conditional formatting. All our regional managers are now inputting their reporting data 
in the same sheets so we have some kind of parity. 

consistency across reports. 

Problem 2: Miscalculation by Hand 

The reports were subject to human errors as they required manual and repetitive 
calculations. 

Solution: The company used ROUND(), MOD(), and INT() to do all calculations 
automatically. 

For instance, total sales figures were rounded to two decimal places. 

Problem Statement 3: Absence of Analysis Based on Criteria 

Managers were not able to easily track sales trends that could help them, like days with 
low foot traƯic. 

Solution: COUNTIF() and STDEV etc. P() were utilized to define days with sales of less 
than 

average and sales variance. This learning translated into smarter timing of promotions. 

Conclusion 

Excel's built-in statistical, counting and mathematical functions made the sales 
position more automated. 

reporting, enhancing accuracy, eƯiciency, and insight. This case highlights the 

need of learning excel formulas for business data analysis and decision making 

contexts. 

 

 

 

Page 40 of 40 - AI Writing Submission Submission ID trn:oid:::3618:127424872

Page 40 of 40 - AI Writing Submission Submission ID trn:oid:::3618:127424872



ATLAS SkillTech University

AI Tools and Excel for Decision Making_BBA_1

AI Tools and Excel for Decision Making_BBA_1

ATEDM__V3_Unit 5.docx

 

Document Details

Submission ID

trn:oid:::3618:127431560

Submission Date

Feb 3, 2026, 12:29 PM GMT+5:30

Download Date

Feb 3, 2026, 12:34 PM GMT+5:30

File Name

ATEDM__V3_Unit 5.docx

File Size

77.4 KB

50 Pages

9,348 Words

55,000 Characters

Page 1 of 52 - Cover Page Submission ID trn:oid:::3618:127431560

Page 1 of 52 - Cover Page Submission ID trn:oid:::3618:127431560



*% detected as AI
AI detection includes the possibility of false positives. Although some text in 
this submission is likely AI generated, scores below the 20% threshold are not 
surfaced because they have a higher likelihood of false positives.

Caution: Review required.

It is essential to understand the limitations of AI detection before making decisions 
about a student’s work. We encourage you to learn more about Turnitin’s AI detection 
capabilities before using the tool.

Disclaimer
Our AI writing assessment is designed to help educators identify text that might be prepared by a generative AI tool. Our AI writing assessment may not always be accurate (i.e., our AI models 
may produce either false positive results or false negative results), so it should not be used as the sole basis for adverse actions against a student. It takes further scrutiny and human 
judgment in conjunction with an organization's application of its specific academic policies to determine whether any academic misconduct has occurred.

Frequently Asked Questions

How should I interpret Turnitin's AI writing percentage and false positives?
The percentage shown in the AI writing report is the amount of qualifying text within the submission that Turnitin’s AI writing 
detection model determines was either likely AI-generated text from a large-language model or likely AI-generated text that was 
likely revised using an AI paraphrase tool or word spinner.
 
False positives (incorrectly flagging human-written text as AI-generated) are a possibility in AI models.
 
AI detection scores under 20%, which we do not surface in new reports, have a higher likelihood of false positives. To reduce the 
likelihood of misinterpretation, no score or highlights are attributed and are indicated with an asterisk in the report (*%).
 
The AI writing percentage should not be the sole basis to determine whether misconduct has occurred. The reviewer/instructor 
should use the percentage as a means to start a formative conversation with their student and/or use it to examine the submitted 
assignment in accordance with their school's policies.

What does 'qualifying text' mean?
Our model only processes qualifying text in the form of long-form writing. Long-form writing means individual sentences contained in paragraphs that make up a 
longer piece of written work, such as an essay, a dissertation, or an article, etc. Qualifying text that has been determined to be likely AI-generated will be 
highlighted in cyan in the submission, and likely AI-generated and then likely AI-paraphrased will be highlighted purple.
 
Non-qualifying text, such as bullet points, annotated bibliographies, etc., will not be processed and can create disparity between the submission highlights and the 
percentage shown.
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Unit 5: Advanced ManipulaƟons – Strings, Dates, Cross-sheet FuncƟons & StandardizaƟon 

 

Learning Outcomes 

Master and apply Cuts (Data manipulaƟon) skills in Excel’s naƟve funcƟons, including 
operaƟons. 

on strings, dates, and Ɵme. 

Drag from the character or replace it using any of these funcƟons: LEFT() RIGHT() MID() 
LEN() FIND() and the. Android Power Rangers MysƟc Force Allenta SUPER X-Men Animated 
Series Magical Wings Wardenclyffe Superfanon ThunderCats As Some Guy! 

Playing with CONCATENATE() for text data cleaning, filter and reformat. 

Dynamic: Use date and Ɵme funcƟons such as TODAY(), NOW(), DATEDIF(), EDATE() TEXT() 

documentaƟon, deadline review, and calendar work. 

Work on mulƟple sheets with ease by referencing, linking, and consolidaƟng data using 
Cross-sheet formulas. 

Discover and maneuver through Excel menus to be more efficient in your workflow (for 
example, data validaƟon, etc..). 

condiƟonal formaƫng, sort, filter and the Formula audiƟng tools. 

Normalize and cleanse data, extracƟng inconsistencies and changing formats to be 
consistent across all records. 

by means of formulas and the specialized tools that excel provides. 

Combine mulƟple features for cases and use in solving real world problems via hands on 
exercise and case studies applicaƟons. 

Content 

5.0 Introductory Caselet 

5.1 IntroducƟon to Advanced ManipulaƟons 

5.2 String ManipulaƟons 

5.3 Date and Time ManipulaƟons 

5.4 Cross-Sheet FuncƟonaliƟes 

5.5 Exploring Excel Menu OpƟons 

5.6 Data StandardizaƟon 
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5.7 Summary 

5.8 Key Terms 

5.9 DescripƟve QuesƟons 

5.10 References 

5.11 Case Study 

 

5.0 Introductory Caselet 

"Karan’s Cleanup Crisis: From Messy Spreadsheets to Reliable Reports" 

 

Credit...“Karan, a 27-year-old junior analyst at a mid-size logisƟcs company in Pune, had just 
been given an important task. 

Task: Produce a cost analysis report for producƟon, based on 15 warehouses. The data was 
sourced from 

regional teams — and every spreadsheet was in a different format. Some had mulƟple 
spaces in products 

names, some used alternaƟve date paƩerns, and a few had inconsistent capitalizaƟon (e.g., 
“south zone,” 

“South Zone”, and “SOUTH ZONE”. 

As deadlines loomed overhead, Karan resorted to “cleaning” data by hand, ediƟng 
misspellings, manually changing date types and so on. 

formats and aƩempƟng to combine informaƟon from several sheets.” Despite hours of 
work, he sƟll didn’t know if the 

data was accurate. He knew there was no room for error that could affect math that would 
drive major budget decisions. 

So his manager suggested they dig into advanced Excel funcƟons and data manipulaƟon 
tools. Karan 

quickly learned how to: 

• Trim, Proper and clean text as well as date fields using the TRIM(), PROPER() & TEXT() 
funcƟons 

• Count ‘em up easily with COUNTIF() and ROUND() to score them without the grunt work 

Cross-Sheet Formulas You can make references across sheets. 
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• Clean, fill in blanks and organize data using Excel’s own tools 

He’d been using MOD() and INT() to scrub down, er, consolidate worker shiŌ schedules. 

‘When they turned in the final report, not only was it accurate and ready to audit, but 
completed in half the Ɵme '). 

to get prepped than in the months before. His boss was impressed — and Karan was 
relieved that he could finally feel confident in his data. 

This experience gave Karan a larger view of data manipulaƟon: It’s not just technical work 
but foundaƟonal. 

of good analyƟcs. The fact remains that without clean, consistent data that’s well structured 
the best reporƟng is just as flawed as “fake news.” 

CriƟcal Thinking QuesƟon: 

For example, you are working on a mulƟ-sheet monthly report for various departments. If 
so, how would you prepare first to make sure 

consistency: 

• Begin employing formulas in your calculaƟons? 

• Want to apply some formaƫng? 

• Standardize data entries, such as names, dates and codes? 

Explain your reasoning. 

 

 

5.1 IntroducƟon to Advanced ManipulaƟons 

The Significance of Feature ExtracƟon in Business AnalyƟcs 

With the world becoming increasingly data centered, businesses create and gather 
enormous amounts of data – be it the customer details, or internal records. 

transacƟons to the logs of social media interacƟons or logisƟcs data and sales records. 
Unfortunately, this raw data is 

typically incomplete, unstructured or otherwise not directly analyzable. This process of 
transforming the raw The resulƟng Preprocessed a document-term matrix from a microtext 
corpus a Document-term Matrix (DTM) is shown in Figure 1 and requires: Figure 1 depicts 
the enƟre Pipeline. 
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valuable domain knowledge, data pre-processing for cleaning, transformaƟon and new 
feature deriv aƟon—a skillset oŌen referred to 

collecƟvely as advanced data manipulaƟon. 

What is Feature DerivaƟon? 

Feature creaƟon is the procedure of producing new variables or aƩributes (known as 
"features") from current features (contents). 

data to enhance analyƟcal outcomes. It is an elementary method in businessanalyƟcs, 
datamining and machine 

learning. Derived features make the hidden paƩerns visible, the data more structured and 
increase predicƟve... 

power of analyƟcal models. 

For example: 

• One could also extract the day of the week, week number or season from a transacƟon 
date. 

• Using a customer’s email address to extract the domain to see if they are corporate 

or personal. 

• Spending levels could classify a purchase from low-to-high thresholds. 

Those features are not readily available in the raw data, but can deliver criƟcal business 
value when engineered. 

thoughƞully. 

Why is feature derivaƟon necessary in Business AnalyƟcs? 

Improves AnalyƟcal Accuracy 

Derived features someƟmes provide more suitable dimensions than the original raw 
features. For instance, a 

customer’s ”days since last purchase” is a much beƩer predictor of churn than only the last 
purchase. 

Enhances Model Performance 

For predicƟve modeling (à la forecasƟng sales or predicƟng customer churn), well 
engineered features would have to be a step 1. 

contribute more to the accuracy of models than even numbers of raw data. 

Enables Business-Specific Insights 

Page 6 of 52 - AI Writing Submission Submission ID trn:oid:::3618:127431560

Page 6 of 52 - AI Writing Submission Submission ID trn:oid:::3618:127431560



Feature derivaƟon enables the data to be tailored for the specific business problem 
Business problem at hand. For example, a retail 

chain could use Ɵme-of-day and store locaƟon to generate fooƞall categories for staffing 
opƟmisaƟon. 

Supports BeƩer VisualizaƟon and ReporƟng 

Dashboards and reports are beƩer when they show derived metrics, like “average order 
value.” 

per region” or “growth rate compared with last quarter,” as opposed to raw tables of 
transacƟons. 

Facilitates Data StandardizaƟon and Consistency 

Secondary features are what you generate by puƫng your inputs through some kind of 
transducƟon process. 

(e.g., spliƫng full names into first and last) or resolving month. 12/4/2012 5 

from dates). 

Advanced ManipulaƟons in Excel 

• Date and Time FuncƟons (TODAY(), DATEDIF(), MONTH(), WEEKDAY) 

• Logical FuncƟon and Lookups (IF(), VLOOKUP(), INDEX(), MATCH()) 

• Inter-sheet references and formula-based combinaƟons 

Such transformaƟons can be complicated, and data analysts can avoid wriƟng code in 
languages such as Python or R for these tasks. 

The fact that Excel is accessible has made it an oŌen-favored tool for business users & 
analysts to start their analyƟcs journey. 

feature engineering. 

A PracƟcal Example 

Let’s say we have a data set with Customer Names, Order Dates & Total Amounts. Through 
advanced manipulaƟon in Excel, 

you can: 

• Extract the first name using LEFT() and a FIND(" ", …) combo. 

• Determine the days since last order (TODAY() - OrderDate). 

• Class order amounts into spending ranges with TRY(). 

Page 7 of 52 - AI Writing Submission Submission ID trn:oid:::3618:127431560

Page 7 of 52 - AI Writing Submission Submission ID trn:oid:::3618:127431560



• VLOOKUP() each transacƟon to its applicable sales region on another worksheet. 

New capabiliƟes From now on, you will be able to segment users and find trends in 
purchasing behavior as well as generate insights. 

that were not visible in the raw data. 

Conclusion 

Advanced data manipulaƟon and feature engineering are not nice-to-have’s but core 
competencies for anyone 

involved in data analyƟcs, reporƟng, and decision-making. Excel provides a with its 
numerous funcƟons and formulas. 

useful way of learning these skills. By acquiring the skills to turn directly into dis-
ambiguated data into derived, structured and interpreted representaƟons. 

descripƟve reporƟng, into the realm of predicƟve, acƟonable insights. 

diagnosƟc, and prescripƟve analyƟcs. 

Learning such manipulaƟons enables students not only to understand the data they 
manipulate: It also helps them ucfirst themselves by, for example, compleƟng data that are 
collected as strings of incomplete informaƟon. 

drive smarter, data-driven decisions in real business scenarios 

5.2 String Manipulations 

In business analyƟcs and in data processing one oŌen comes across with text as we do, 
numbers. Customer Name, product code, e-mail address,feedback comments and invoice ID 
are some of the examples of string data. But in many cases, raw strings are unstructured, 
not formaƩed in a consistent way, or scaƩered somewhere deeply among other data types 
and values, so it is quite hard to analyze them directly. 

Excel has a wide range of text funcƟons that can be used to manipulate, extract and clean 
up strings. These string handling capabiliƟes are essenƟal in data preparaƟon, parƟcularly 
when preparing datasets for reporƟng, filtering or importaƟon to data visualizaƟon or 
machine learning tools. 

5.2.1 Text Functions Overview 

Excel Txt FuncƟons Excel funcƟons for the manipulaƟon of Text strings. These features can 
be very useful if you are cleaning up a dataset, transforming informaƟon, or creaƟng new 
features from text input. All Excel Text FuncƟons Here is the list of all Excel text funcƟons: 

LEFT(text, num_chars) 
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Extracts a given number of characters starƟng from the leŌ side of a text( string). 

Example: 

=LEFT("Product123", 7) → returns "Product" 

RIGHT(text, num_chars) 

Returns the last characters from a text string, based on the number of characters you 
specify. 

Example: 

=RIGHT("Product123", 3) → returns "123" 

MID(text, start_num, num_chars) 

Extracts a specific number of characters from a text string starƟng from any posiƟon. 

Example: 

=MID("Product123",8,3) → retrieves "123" 

LEN(text) 

Returns the length of the text string (count of characters). 

Example: 

=LEN("Customer Name") → returns 13 

FIND(find_text, within_text, [start_num]) 

Returns the start posiƟon of a text string in another text string (case-sensiƟve). 

Example: 

=FIND("x", "Excel") → returns 2 

SEARCH(find_text, within_text, [start_num]) 

Like FIND, but case-insensiƟve. 

Example: 

=SEARCH("e", "Excel") → returns 1 

CONCATENATE(text1, text2, …), or CONCAT() / TEXTJOIN() 

Concatenates two or more text strings into one text string. 

Example: 

=CONCATENATE("Hello", " ", "World") → Hello World 

Page 9 of 52 - AI Writing Submission Submission ID trn:oid:::3618:127431560

Page 9 of 52 - AI Writing Submission Submission ID trn:oid:::3618:127431560



=TEXTJOIN(" ", TRUE, "Mr.", "John", "Doe") → "Mr. John Doe" 

TRIM(text) 

Strips all excess spaces from a text, with only single spaces between each word. 

Example: 

=TRIM(" Hello World ") → press Enter key, then it will returns "Hello World" 

UPPER(text), LOWER(text), PROPER(text) 

Changes the case of text: 

• UPPER() → All uppercase 

• LOWER() → All lowercase 

• PROPER() → IniƟal leƩer in each word.capitalize the first character of words. 

Example: 

=PROPER("data analyst") → produces "Data Analyst" 

ApplicaƟon in Business AnalyƟcs 

These funcƟons are essenƟal in: 

• Cleaning names and addresses 

• Spliƫng full names or codes 

• Picking IDs or numbers out of mixed strings 

• Standardizing text for reporƟng 

• Are you trying to parse product SKUs or invoice numbers. 

As an illustraƟon, in a data table of sales with customers' linked names wriƩen down 
inconsistently will lead into making the dataset uniform and clean by uƟlizing PROPER() as 
well as TRIM(). In terms of analysing feedback, you might use FIND() or SEARCH() to flag 
when key words appear comments from customers. 

5.2.2 Common String Functions 

In Excel, string funcƟons are used to manipulate text in cells. They are especially handy 
when you have data in a string, like product codes, user Ids, customer names or date-Ɵmes. 
Here are four of the most commonly used string funcƟons: LEFT, RIGHT, MID, LEN. 

LEFT FuncƟon 

ObjecƟve: Get the characters from string by giving starƟng posiƟon and length. 
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Syntax: 

=LEFT(text, num_chars) 

• text: The string from which the characters are taken. 

• num_chars: The number of characters to take from the leŌ. 

Example: 

=LEFT("INV-2023-9876", 3) 

Output: "INV" 

This can be helpful if you are looking for invoice numbers, department codes, or any kind of 
fixed-format reference. 

Use Case: 

In logisƟcs we have a product code that starts with 2-leƩer region code, so LEFT() could be 
used to parse out the regional idenƟficaƟon. 

RIGHT FuncƟon 

Purpose Removes a specified number of characters from the end (right) of a text string. 

Syntax: 

=RIGHT(text, num_chars) 

Example: 

=RIGHT("EMP-ID-5678", 4) 

Output: "5678" 

This is oŌen used to hack out idiomaƟc numeric idenƟfiers from employee or customer 
codes. 

Use Case: 

In HR analyƟcs, the final 4 digits of an employee ID can be used as a unique idenƟfier by 
using RIGHT(). 

MID FuncƟon 

ObjecƟve: To take a mid string based on certain posiƟon. 

Syntax: 

=MID(text, start_num, num_chars) 

• start_num: The posiƟon of the first character that you want to extract. 
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• num_chars: The number of characters to retrieve. 

Example: 

=MID("ORD#2023-USA", 5, 4) 

Output: "2023" 

This pulls a year or a code snippet out of a longer string. 

Use Case: 

Helpful if you need to pull a part of a tracking number, invoice or coded id that the 'meat' is 
in the middle. 

LEN FuncƟon 

Purpose: Counts the number of characters that are in a text string including spaces. 

Syntax: 

=LEN(text) 

Example: 

=LEN("Customer123") 

Output: 11 

Use Case: 

• Looking for data wholeness or inconsistencies. 

• Checking the length of phone numbers, ID codes or postal codes to be valid. 

PracƟcal Tip: 

In many data validaƟon rules, it is used a lot. For instance, we might decide that all product 
codes should be a precise length of 10 characters. 

5.2.3 Cleaning and Combining Text 

It is common for textual data in real-world datasets (especially those collected from mulƟple 
sources, e.g., customer forms, surveys or manual entry) to be inconsistent, messy and not 
well formaƩed. Perhaps it has addiƟonal leading/trailing spaces, its capitalizaƟon is 
inconsistent with the record text, or is otherwise separated in some way. 

In Excel, there are plenty of features to clean, normalize and combine text data. These are 
parƟcularly helpful during the process of data preparaƟon, ensuring data is even more 
trustworthy for analysis, presentaƟon or export to other tools. 

TRIM FuncƟon 
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Intended use of this funcƟon: Strips so many spaces in a text string, that only one space is 
leŌ between words. 

Syntax: 

=TRIM(text) 

Example: 

=TRIM(" Rahul Sharma ") 

Output: "Rahul Sharma" 

Use Case: 

TRIM is commonly used when imporƟng data from the web forms or some other files where 
spaces need to be trimmed off to do further matching, filtering or calculaƟons. 

PROPER FuncƟon 

Purpose: Makes text proper case (First leƩer of each word in caps, the rest is lower). 

Syntax: 

=PROPER(text) 

Example: 

=PROPER("rahul sharma") 

Output: "Rahul Sharma" 

Use Case: 

Great for normalizing names, addresses, and Ɵtles following subscribers enter as ALL CAPS 
or all lowercase leƩers to give your list a more professional look. 

UPPER FuncƟon 

ObjecƟve: To convert any string to uppercase. 

Syntax: 

=UPPER(text) 

Example: 

=UPPER("invoice123") 

Output: "INVOICE123" 

Use Case: 
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Normalizing codes/abbreviaƟons/ids that need to be uppercased in order to meet 
compliance or for beƩer visibility. 

LOWER FuncƟon 

ObjecƟve: Make all the charcters of a text string in lowercase. 

Syntax: 

=LOWER(text) 

Example: 

=LOWER("Customer@Email.COM") 

Output: "customer@email.com" 

Use Case: 

Most commonly go to for normalizing email addresses, usernames, or log-ins etc. 

CONCAT FuncƟon (or CONCATENATE in old versions) 

Purpose: Combines two or more text values into one string. 

Syntax: 

=CONCAT(text1, text2,...) 

Example: 

=CONCAT(A2, " ", B2) 

In case of "=A2 & " "&B2" If A2 = "Rahul Tab 1 column49 Sharma then.. 

Output: "Rahul Sharma" 

Use Case: 

Combine the pairs of first + last names, add columns or generate a full ID. 

TEXTJOIN FuncƟon 

Purpose: Combines all the text strings provided containing a delimiter you specify (not just 
two). 

Syntax: 

=TEXTJOIN(delimiter, ignore_empty, text1, [text2], …) 

Example: 

=TEXTJOIN(", ", TRUE, A2:C2) 

If A2 = "Mumbai", B2="", C2="India". 
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Output: "Mumbai, India" 

Use Case: 

Useful for merging columns with standardized formaƫng together like creaƟng full 
addresses or list based values. 

Real-World ApplicaƟon 

Think about a company who exports data from various departments—one of which (or 
maybe all) use different capitalizaƟons, spacing habits, or field structures. This data needs to 
be scrubbed and de-duplicated before it’s used for mailing, analysis or reporƟng. 

With the use of TRIM, PROPER, UPPER and CONCAT analysts are able to present names, IDs 
and messages in a more professional legible manner that is consistent across their data. It’s 
a valuable first step in data uƟlity. 

5.2.4 Extracting and Searching Text 

In business analyƟcs, many Ɵmes the data is filled with strings which needs parsing or 
keyword detecƟon. For example, product codes might have embedded categories, customer 
feedbacks may require keyword annotaƟon and email addresses may require domain 
recogniƟon. There are individual EXCEL funcƟons, designed to find specific string part by 
posiƟon or matching the content of this or that kind. 

This is where we unleash four of the most potent text-processing weapons: FIND, SEARCH, 
REPLACE and SUBSTITUTE. FuncƟons like these are frequently used for substring searching, 
dynamic extracƟon or inserƟon of text, or replacement of characters and words within text. 

FIND FuncƟon 

FuncƟon: Returns the starƟng posiƟon of one text string within another text string. It is not 
wildcarded and it is case sensiƟve. 

Syntax: 

=FIND(find_text, within_text, [start_num]) 

• find_text: The substring to locate. 

• within_text: The string to search. 

• start_num (opƟon): Where to start searching. 

Example: 

=FIND("e", "Excel") 

Output: 2 

Use Case: 
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Use FIND when you require exact matches with case sensiƟvity—such as finding capital 
leƩers or pinning down the posiƟon of certain keywords or delimiters (like dash - or slash /). 

SEARCH FuncƟon 

Purpose: Similar to FIND but not case-sensiƟve and allows the use of wildcards such as? and 
*. 

Syntax: 

=SEARCH(find_text, within_text, [start_num]) 

Example: 

=SEARCH("e", "Excel") 

Output: 1 

Difference from FIND: 

• FIND("e", "Excel") returns 2 (finds the lower-case "e" case-sensiƟve) 

• SEARCH("e", "Excel") returns 1 (matches "E" or "e"). 

Use Case: 

Great when you need to search for terms in a case insensiƟve way (e.g. determining if a 
comment has the word "urgent" or "delayed", or anythingless). 

REPLACE FuncƟon 

ObjecƟve: Replaces some character of text on the basis of posiƟon. 

Syntax: 

=REPLACE(old_text, start_num, num_chars, new_text) 

Example: 

=REPLACE("Sales2023", 6, 4, "2024") 

Output: "Sales2024" 

Use Case: 

Use when replacing some parƟcular string (eg:- to replace version numbers, correct date 
fields or hide part of IDs) 

SUBSTITUTE FuncƟon 

Purpose: Replace one or more occurrences of a string with another value in a string, based 
on content not posiƟon. 
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Syntax: 

=SUBSTITUTE(text, old_text, new_text, [instance_num]) 

• instance_num (opƟonal): Replace only a specific instance. 

Example 1: Replace all 

=SUBSTITUTE("A-B-C", "-", "/") 

Output: "A/B/C" 

Example 2: Replace second occurrence only 

=SUBSTITUTE("A-B-C", "-", "/", 2) 

Output: "A-B/C" 

Use Case: 

SUBSTITUTE is beƩer for character replacement rather than needed to copy some data into 
another column and/or row other than replacing very standard repeats throughout the 
enƟre file where a repeaƟng format would not change from one row or cell to the next. 

 

 

“Excel’s SEARCH() function allows wildcard characters, which means you can 

look for patterns instead of exact words. For example, =SEARCH("cat*", A1) can 

match "category", "catfish", or "caterpillar". This makes it powerful for data cleaning, 

especially when dealing with inconsistent text labels.” 

5.3 Date and Time ManipulaƟons 

Date and Ɵme values are a criƟcal element of virtually every business applicaƟon – from 
employee aƩendance to invoice dates, customer purchase Ɵmes to project schedules. But 
doing date and Ɵme manipulaƟon in Excel needs an understanding of how Excel stores and 
calculates dates. 

MicrosoŌ Excel provides a plethora of date-related and Ɵme-based funcƟons to help users 
do things such as spliƫng dates into its individual parts, calculaƟng the difference between 
two Ɵmes or creaƟng schedules. It is important for analysts, managers, and administrators to 
be able to perform these manipulaƟons correctly so that decision-making is based on 
reliable Ɵme-based data. 

5.3.1 Excel Date & Time Basics 

Did You Know? 
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Decoding Excel’s Date and Time System 

Excel stores dates and Ɵmes as serial numbers, not text, so that you can perform 
calculaƟons with them. 

• In Excel, dates are just numbers starƟng with 1 for January 1, 1900. 

• Times are in fracƟons of 1/24 of a day. For example: 

o 12:00 PM (noon) = 0.5 

o 6:00 AM = 0.25 

o 6:00 PM = 0.75 

Enables Excel to calculate Ɵme and date funcƟons, including: 

• Finding the days between two dates 

•  Adding or subtracƟng number of days, months, and years 

• CounƟng hours, minutes or seconds between Ɵme records 

Entering and Formaƫng Dates 

For example, in Excel, if you're using English regional seƫngs on your computer you can 
input a date such as 12/10/2023 (the US default), or 10-Dec-2023 or even 2023-12-10. Excel 
will automaƟcally accept these as dates (if the cell format is Date or General). 

Common date formats include: 

• dd-mm-yyyy → 10-12-2023 

• mm/dd/yyyy → 12/10/2023 

• dddd, mmmm dd, yyyy → Sunday, December 10, 2023 

To format a cell: 

• Right click > format cells > Date > Select the format you like. 

Entering and Formaƫng Time 

Time can be entered as: 

• 14:30 → 2:30 PM 

• 9:15 AM 

• 23:59 → 1 minute to midnight 

Time formats in Excel can look like: 

• h:mm AM/PM 
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• hh:mm:ss 

• [h]:mm (for duraƟons over 24 hours) 

To use Ɵme values in calculaƟons, Excel changes them into a decimal fracƟons of a day: 

• 1 hour = 1/24 = 0.04167 

• 30 minutes = 0.02083 

Simple Date-Time OperaƟons 

OperaƟon Example Formula DescripƟon 

Date plus days =A2 + 7 Adds 7 days to the date in A2 

Subtract Date  =B2 - A2 Returns number of days between two dates 

Add hours =A2 + TIME(2,0,0) Increases the Ɵme in A2 by 2 hours 

Current date =TODAY() Returns the day of the month from the current system date. 

As of today @ now =NOW() Returns the system date and Ɵme 

PracƟcal Example 

For instance, assume you have a sales team who logs order dates and would like to: 

• To determine the number of days since an order was placed: =TODAY() - OrderDate 

• Predicted delivery Ɵme (5 days): =30-DAYS(OrderDate)+ 5 

• Track worked hours for employees: =EndTime – StartTime 

The basic manipulaƟons can be developed further by advanced funcƟons DATEDIF(), 
EDATE(), EOMONTH(), and TEXT() as in upcoming discussions. 

Why This MaƩers 

Poor date and Ɵme manipulaƟon can cause: 

• Misaligned reports 

• Faulty business insights 

• Errors in scheduling and forecasƟng 

A strong understanding of Excel date-Ɵme math will lead to perfectly accurate Ɵme-based 
calculaƟons, such as when calculaƟng employee length of service, monitoring delivery dates 
or creaƟng your own interacƟve dashboard. 

5.3.2 Date Functions 

TODAY, NOW, DATE, EOMONTH 
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Excel provides a plethora of built-in date funcƟons to work with dates, and today I'd like to 
dwell on the one that is, probably, most useful for creaƟng your dynamic template. These 
funcƟons come in handy when creaƟng the current date or Ɵme, puƫng dates together 
from parts and working out the number of days leŌ in billing month. 

Here we look at four of the most frequently used date funcƟons: 

TODAY() FuncƟon 

Purpose: Returns the current date of the system (w/o Ɵme). 

Syntax: 

=TODAY() 

Example: 

If the current date is August 29th, 2025, 

=TODAY() → returns 29/08/2025 

Use Case: 

• Refresh reports on-the-fly with the current date. 

• Calculate deadlines or expiry dates: 

=TODAY() + 30 → Date 30 days aŌer today 

• Determine employee tenure: 

=TODAY() - JoiningDate 

Note: Value updated daily current day when sheet is opened. 

NOW() FuncƟon 

Purpose: To retrieve the current system date and Ɵme. 

Syntax: 

=NOW() 

Example: 

When your US date and Ɵme is August 29, 2025, 10:30 AM, 

=NOW() → returns 29/08/2025 10:30 

Use Case: 

• Timestamping data entries 

• Tracking real-Ɵme logs 
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•CalculaƟng number of days from a dateƟme format in the past to "now" 

Note: Similar to TODAY(), this funcƟon will also update whenever the sheet is opened or 
calculated. 

DATE(year, month, day) FuncƟon 

Goal: Make a proper date out of year, month and day. 

Syntax: 

=DATE(year, month, day) 

Example: 

=DATE(2025, 12, 25) → output 25/12/2025` 

Use Case: 

• Generate dates from input fields or parts of it. 

• Do not allow corrupƟon of formaƫng when dates are input as text 

• Referred to frequently along with the YEAR(), MONTH(), and DAY() funcƟons, in order to 
process and reconstruct date data values 

EOMONTH(start_date, months) FuncƟon 

Purpose: Return the last day of the month, n months before or aŌer a given start date. 

Syntax: 

=EOMONTH(start_date, months) 

• start_date: The base date 

• months: Number of months to add (negaƟve can be used) 

Examples: 

=EOMONTH("10-Jan-2025", 0) → returns 31/01/2025` 

=EOMONTH("10-Jan-2025", 1) → returns 28/02/2025` 

Use Case: 

• AutomaƟcally calculates the due date at month end 

• Calculate monthly report periods 

• Set up recurring subscripƟons or billing cycles 
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Instruction to Student: 

You are managing dispatch dates for a logistics company. In a sheet, you're given: 

 Order Date (Column A) 

 Expected Delivery Lead Time in Days (Column B) 

 Holidays (listed separately) 

Perform the following tasks: 

1. Use WORKDAY() to calculate the expected delivery date, excluding weekends and 

the given holidays. 

2. Use TODAY() to calculate the number of days left until each delivery. 

3. Highlight deliveries that are due in less than 3 working days using conditional 

formatting. 

 

5.3.3 Extracting Date Components 

DAY, MONTH, YEAR, WEEKDAY 

In business analyƟcs, you oŌen don’t care so much that an event happened on a certain 
date as you want to tease apart the components of that date — for example, consider the 
day and month individually, or break down a full date into components such as the specific 
weekday. For example: 

• Retailers can parse sales by month or day of the week. 

• HR may record years of service according to year of joining. 

• MarkeƟng might also have Ɵmed promoƟons based on weekday behavior. 

Excel has easy and straighƞorward funcƟon to get each part of a date. Let’s go through 
them one by one. 

DAY() FuncƟon 

Use: The day of the month (1-31) given a valid date. 

Syntax: 

=DAY(date) 

Example: 

=DAY("15-Aug-2025") 
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Output: 15 

Use Case: 

Great for analyzing daily trends, finding number of invoice due days Ɵll a certain date or 
isolaƟng specific dates to look something up (ie. Great for doing holidays). 

MONTH() FuncƟon 

ObjecƟve: It returns the month from a specific date (1 to 12). 

Syntax: 

=MONTH(date) 

Example: 

=MONTH("15-Aug-2025") 

Output: 8 

Use Case: 

Great for month end reporƟng, forecasƟng, or just simply filter data in any given month 
(e.g., all sales in August). 

YEAR() FuncƟon 

ObjecƟve: Returns the year (as a scalar) shown by a date. 

Syntax: 

=YEAR(date) 

Example: 

=YEAR("15-Aug-2025") 

Output: 2025 

Use Case: 

Typically used for year-to-year comparisons, annual totals and change analysis. 

WEEKDAY() FuncƟon 

FuncƟon: Provides you the day of week in Excel as a number (1=Sunday, 7=Saturday) for any 
supplied date. You can also denote which day the week starts on with an opƟonal 
argument. 

Syntax: 

=WEEKDAY(date, [return_type]) 
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Example 1 (default): 

=WEEKDAY("15-Aug-2025") 

Output: 6 (Friday) 

Example 2 (week starƟng Monday): 

=WEEKDAY("15-Aug-2025", 2) 

Output: 5 (Friday, but Mon = 1) 

Return Types: 

• 1 = Sunday through Saturday (default) 

• 2 = Monday to Sunday (Monday returns 1) 

• 3 = Monday to Sunday (Returns 0 for Monday) 

Use Case: 

KEY APPLICATION Weekend day is important in operaƟons, logisƟcs and customer service 
analyƟcs where the weekday paƩern highly influences performance (e.g., less deliveries on 
Sundays, peak sales on Fridays). 

5.3.4 Calculations with Dates 

DATEDIF, NETWORKDAYS, WORKDAY 

Date-based arithmeƟc is frequently specified in a similar pageant of staff tenures, project 
duraƟons, delivery esƟmates and future schedules (even on weekends and holidays) that 
form the bedrock of business systems. 

There are many funcƟons in Excel that ease calculaƟons like those above. In this secƟon we 
will consider three useful date calculaƟon uƟliƟes: 

DATEDIF() FuncƟon 

Purpose: Differences between two dates given in days, months, or years. 

Note: Even if the DATEDIF() funcƟon deploys in Excel, it doesn't feature in the list of formula 
suggesƟons and has to be typed out manually. 

Syntax: 

=DATEDIF(start_date, end_date, unit) 

Units: 

• "Y" → Years 

• "M" → Months 
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• "D" → Days 

• "MD" → Difference in days (ignores months/years) 

• "YM" → Difference in months (without respect for duraƟon of years) 

• "YD" → Days difference (ignores leap year days) 

Example: 

=DATEDIF("01-Jan-2020", "29-Aug-2025", "Y") 

Output: 5 (years) 

Use Cases: 

• CalculaƟng employee tenure 

• Measuring age 

• Determining customer relaƟonship duraƟon 

NETWORKDAYS() FuncƟon 

FuncƟon purpose: returns the number of work days (MON-FRI), deducƟng the weekends 
automaƟcally and the opƟon to exclude certain holidays. 

Syntax: 

=NETWORKDAYS(start_date, end_date, [holidays]) 

• start_date, end_date: The Ɵme range for computaƟon. 

• holidays: (OpƟonal) A range of dates to exclude (e.g.pubic holidays) 

Example: 

=NETWORKDAYS("01-Aug-2025", "31-Aug-2025") 

Output: 21 (if there is no holiday in between this two date) 

Use Cases: 

• Determining real-Ɵme working Ɵme for projects 

• HR leave tracking 

• Net working periods under contracts 

Advanced Example with holidays: 

=NETWORKDAYS(A2, B2, HolidayList) 

**3. WORKDAY() FuncƟon 
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Purpose: Get the date for a given number of working days aŌer a start date (with opƟon to 
exclude holidays). 

Syntax: 

=WORKDAY(start_date, days, [holidays]) 

• start_date: The base date 

• days: Number of days to add 

• holidays : (OpƟonal) A sequence of dates comprising holidays to exclude from the count. 

Example: 

=WORKDAY("01-Aug-2025", 10) 

Output: 15-Aug-2025 (skips weekends) 

Use Cases: 

• EsƟmaƟng delivery or deadline dates 

• Determining due dates for employee training 

• Planning future tasks avoiding weekends/holidays 

5.4 Cross-Sheet Functionalities 

As the data set gets larger and more complex, it becomes necessary to manage your data 
over mulƟple worksheets. It’s common to use separate sheets inside a well-organized Excel 
workbook for different types of data: sales on one sheet, HR data on another, inventory 
somewhere else and so on. 

Cross-sheet funcƟons in Excel can help users to fetch, calculate and even summarize data 
from mulƟple worksheets of the same workbook. These are techniques that are essenƟal 
to master when creaƟng dynamic dashboards, departmental reports and consolidated 
summaries across mulƟple data sources. 

5.4.1 Referencing Cells Across Worksheets 

What is Cross-Sheet Referencing? 

You can have one sheet reference another if you wish to import data from it by using a 
reference to cells on different sheets. This makes it fully updatable — if the source value is 
changed, the linked value will also change automaƟcally. 

This is useful for: 

• Summarizing for departmental tabs 
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• ConsolidaƟng data from source input sheets to dashboards 

• Building mulƟ-sheet financial models 

Basic Syntax 

The general syntax for linking to a cell in another sheet is: 

=SheetName!CellReference 

Example: 

='Sales Data'!B2 

This gets the value from cell B2 WHERE sheet name is Sales Data. 

Note: 

• If the sheet name has an empty space, surround it with single quotes(' ') 

• Without spaces: =SalesData! B2 

Examples of Cross-Sheet Formulas 

Formula DescripƟon 

='Region A'! A1 Takes the value in cell A1 of sheet "Region A" 

=SUM('Q1 Sales'! B2:B10) Sum the sales from B2 to B10 in "Q1 Sales" page 

=AVERAGE(Sheet2! C5:C15) Average calculaƟon of C5:C15 in Sheet2 

=IF('HR Data'! D2="Yes", "Approved", "Pending") Decision based on cell in another sheet 

How to do an Cross-sheet Reference (Step by Step) 

Click on cell where you want the result to show. 

Type = 

Navigate to the target sheet. 

Just click on the cell you want (Excel will write your formula in). 

Press Enter. 

And Excel will write a formula like: 

='Employee Data'!E4 

Best PracƟces 

• Use short, no-symbols sheets' names to make it easier to reference. 

• Use named ranges to clarify formulas that reference ranges on other sheets. 
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• As you build dashboards, centralize formulas in a summary file and reference the raw data 
you need from other files. 

• Try to avoid linking across workbooks more than is necessary - links are easily broken if 
the file locaƟon or name is changed. 

Real-World Use Case 

In a company’s quarterly workbook: 

• Every department has its own worksheet: Sales, MarkeƟng, HR 

• One sheet named Summary refers to the totals on each sheet: 

='Sales'! B10 + 'MarkeƟng'! B10 + 'HR'! B10 

As department sheets get updated, the summary updates in an auto-way—no doubled 
work yet real-Ɵme glance. 

5.4.2 Using 3D Formulas 

The more advanced workbooks become the more you will find yourself working with similar 
data sets across a number of worksheets, such as sales figures for each 
month/year/region/department etc. You can reference each sheet directly in a formula, but 
Excel’s 3D formula feature provides one of the cleaner and quicker ways to do this. 

A 3D formula enables you to summarize something (like use SUM, AVERAGE, MAX) on the 
same cell or range on mulƟple worksheets using only a single formula. 

What Is a 3D Formula? 

3D formula is a term used to describe a formula in which the calculaƟon will be specified 
through; 

• A funcƟon (like SUM, AVERAGE) 

• A reference to the same cell on several sheets 

Syntax: 

=FuncƟon(Sheet1:SheetN! CellRange) 

Example Scenario 

Think of a workbook that has one sheet for each month: 

• Jan, Feb, Mar, … Dec 

In cell B2 there are monthly sales on each sheet. 

To accomplish that, we can calculate the total sales for the year: 
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=SUM(Jan:Dec!B2) 

This summarises B2 from each tabs Jan to Dec. 

How It Works 

•  Excel regards sheets as a range just like a cell range. 

• The formula begins and ends with the name of the first and last sheet joined by a colon. 

All the sheets should be structured in same manner ( cell ranges of each metric should be 
consistent ). 

Supported FuncƟons in 3D Formulas 

FuncƟon DescripƟon 

SUM() Adds values across sheets 

AVERAGE() Calculates average across sheets 

MAX() Finds the maximum value 

MIN() Finds the minimum value 

PRODUCT() MulƟplies values across sheets 

COUNT() Counts numeric entries 

Examples 

Total quarterly profit for all of the regional sheets: 

=SUM(North:South!D5) 

Sums cell D5 (All in a days work: profit) on all region sheets from North to South. 

Average customer saƟsfacƟon score: 

=AVERAGE(Sheet1:Sheet12!E2) 

It averages E2 from Sheet1 to sheet12 (for example the scores of monthly feedback). 

Best PracƟces for 3D Formulas 

• Standardize cell entries in layout across all sheets (same posiƟons of cells). 

• Add summary sheets outside of the range of sheets (above the first or below the last). 

• When using a 3D formula, before revoluƟonizing just gather all related sheets. 

• Use named ranges for readability if your workbook gets big. 

LimitaƟons 
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• Lookup and logical funcƟons (VLOOKUP, IF, etc.) are not compaƟble with 3D formulas. 

• You cannot actually refer to a non-conƟguous sheets (i.e., =SUM(Jan, Mar, May! B2) is 
invalid). 

• If the sheets are relabeled or relocated beyond the range, you will need to change your 
formula. 

Real-World Use Case 

An operaƟons manager tracks: 

• Monthly logisƟcs cost is displayed in B2 on each of the Jan, Feb, Mar... 

•They enter on a Summary sheet: 

=SUM(Jan:Dec!B2) 

What’s new is that the annual cost will update automaƟcally as you enter in new monthly 
figures. 

 

 

DID YOU KNOW  

“A 3D formula can span multiple worksheets at once, but the sheet names used must 

be consecutively placed in the workbook. If you rearrange your sheets or insert a new 

sheet in the middle of the range, it automatically becomes part of the 3D formula—

even if you didn’t intend it to!” 

 

5.4.3 Consolidating Data from Multiple Sheets 

In mulƟ-department, mulƟ-city or monthly tracking sheets you may want to store 

structured data on separate sheets. Yet, when it comes to analysis, reporƟng or 

presentaƟon, decision-makers are required to see one agile snapshot. Instead of 

manually searching and copying cell content from one worksheet to another, Excel 

has features and funcƟons that make the process much easier. 

There are two common approaches to consolidate data in Excel: 

Using Excel’s built-in Consolidate tool 
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Applying formulas across your sheets like SUM, VLOOKUP, or INDEX-MATCH 

Using Excel's Built-In Consolidate Tool 

Consolidate in Excel: Combine data from mulƟple sheetsसExcel समेत कई वकŊ शीटसेसे 

डाटा जोड़नाा The Consolidate funcƟon in Excel lets you double-up values from 

different worksheets into one summary worksheet. 

Use Cases: 

• ConsolidaƟng quarterly sales data from different sheets 

• Adding up the regional costs from several teams 

• Consolidate mulƟple sheets with the same structure into one report 

Using the Consolidate Tool (Step-by-Step): 

Now visit the sheet where you wish to consolidate this data. 

Click on an empty cell to start (1, 1, usually the top-leŌ). 

Navigate to: 

Data tab, Data Tools group, Consolidate 

You will now see a drop down for funcƟon Type of consolidaƟon, select how you 

want to consolidate: 

o SUM, AVERAGE, COUNT, etc. 

Click Add to pick a sheet and range (e.g., Sheet1! $A$1:$B$5, Sheet2! $A$1:$B$5) 

Check “Top row” and/or “LeŌ column” if you have labels. 

Click OK 

And your selected range of cell values will be inserted. Excel then will calculate the 

sum based on selected cells. 

Important Notes: 
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• Similar structure is required from all source ranges (column/row headings must 

exactly match). 

• The opƟon to consolidate with or without linking to the original data is a feature of 

the Consolidate tool: 

o StaƟc: These get copied and not updated 

o Dynamic: Link to unchanging data (Select the “Create links to source data”) 

Formula-Based ConsolidaƟon 

This is a common scenario in business seƫngs where users like to create their own 

consolidaƟon with formulas, as they can be more automated for reporƟng purposes. 

This is more flexible, and defaults to being dynamic. 

Technique A: SUM() with Other Workbooks References 

If for example, on every sheet, cell B2 has the total sales: 

=SUM(Sheet1:Sheet5!B2) 

Method B: VLOOKUP From a Different Sheet 

If you have tables set up between sheets, use: 

=VLOOKUP(A2, 'Jan Sales'! $A$1:$B$20, 2, FALSE) 

Repeat and sum for other sheets with funcƟons or named ranges. 

Method C: Dynamic Sheet Reference via INDIRECT() 

Enter formula in cell: 

=INDIRECT("'" & A1 & "'!B2") 

This references cell B2 on the sheet referred to in cell A1—so you can add sheets 

and consolidate rows without directly referencing them by name. 

Summary Table 

Method Tool Ideal For Dynamic Update Complexity 

Consolidate Tool Data → Consolidate Simple number crunching OpƟonal Easy 
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3D Formulas SUM(Sheet1:Sheet3! A1) Uniform data structure Yes Easy 

VLOOKUP/INDEX Formula-based Structured tabular data Yes Moderate 

INDIRECT Formula-based Dynamic referencing Yes Advanced 

Real-World Example 

A naƟonal sales workbook has: 

• Separate pages of each region: North, south, East,West 

• Each sheet has month by month sales starƟng in cell D10 

In a Summary sheet, say, something like: 

=SUM(North:West!D10) 

Gives the total naƟonal sales. 

Or if you want to create a complete table of sales for the regions with the 

Consolidate feature: select each region's range, then click and summarize by headers. 

5.5 Exploring Excel Menu Options 

MicrosoŌ Excel is more than a spreadsheet; it's a data analysis tool. The Ribbon The 

majority of its opƟons are neatly placed under the Ribbon Interface, which is comprised of 

tabs like Home, Insert, Page Layout, Formulas, Data, Review and View. 

Of these, one of the most essenƟal for analysts, accountants, researchers and business 

people is the Data tab. It assembles the core tools that all you need to: 

• Structuring data (arranging by categories), 

• Steps for data transformaƟon (text spliƫng, data validaƟon and Flash Fill), and 

• Data connecƟvity (import data from external sources such as databases, the web, and CSV 

files). 

And understanding how to handle the data tab well is what it takes to prepare cleaner, more 

robust, and more dynamic datasets.All of which are a must before one goes meta or vis. 
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And Excel’s menu choices are more than skin-deep; they make for efficiency of workflow, 

correctness of data and accuracy in analysis. 

5.5.1 Data Tab Functionalities (Sort, Filter, Data Tools) 

The Data tab has a number of useful tools divided into three secƟons many users find most 

useful in their daily work: Sort, Filter, and Data Tools. All of these teams are fundamental to 

the curaƟon and processing of datasets. 

Sort 

Features: Sort the order of data alphabeƟcally, numerically or by date either in ascending or 

descending manner. 

Access Path: 

Data → Sort & Filter → Sort 

Key Features: 

• Sort a single column 

• MulƟlevel SorƟngs (eg, sort by Dept, then by Name) 

• Filter by cell color, font color and custom list 

Example: 

First sort employee data by Department (A-Z), then Experience (Largest to Smallest) 

Business Use Case: 

Sort leads by potenƟal revenue, rank sales reps by performance, or arrange tasks based on 

when they’re due. 

Filter 

FuncƟon: Show on a temporary basis, only rows that meet certain criteria. 

Access Path: 

Data → Sort & Filter → Filter 

Key Features: 
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• Filter with number, text etc. condiƟons 

• UƟlise More than one filter at a Ɵme across columns 

• Quick filter with search and selecƟon checkboxes 

Example: 

Q2 filter sales transacƟons over ₹1,00,000. 

Business Use Case: 

See all outstanding invoices or under performing products, or bulk read your customer 

feedback. 

Data Tools 

The Data Tools group consists of several uƟlity features in the Data tab that allow users to 

clean, validate, and convert data with ease and accuracy. 

Key FuncƟons in Data Tools: 

Tool FuncƟon 

Remove Duplicates Finds and removes duplicate rows 

Data ValidaƟon Determines the type of data that’s allowed to be entered into a cell (such as 

drop downs). 

Flash Fill Fills in values with paƩern recogniƟon 

Text to Columns –It divides up a single column of text into mulƟple columns using delimiters 

What-If Analysis Any of a collecƟon of methods by which analysts or corporate decision-

makers can break down uncertainty, quanƟty possible outcomes named Scenario (aka 

simulaƟon). 

Merge Combines mulƟple sheets or ranges of data 

Real-World ApplicaƟon Example: 

Let’s say you are cleaning a product master list: 

• To remove duplicate product IDs, apply Remove Duplicates. 
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• Use Text to Columns on product codes such as "CAT-2345" in order to separate out the 

"Category" and "Item Number". 

• AutomaƟcally create SKUs that follow naming convenƟons with Flash Fill. 

• Use "Data ValidaƟon" to add drop down for "Product Category" and to avoid inpuƫng 

wrong category. 

These tools eliminate the majority of mundane tasks, guarantee data accuracy, while your 

dataset is "pre-processing" for analysis / reporƟng. 

Summary 

Feature Group Common FuncƟons Typical Use Case 

Order Sort A-Z/Z-A, Custom Sort Order employees, orders by. 

Filter Date, Number, Text Filters Segment your customers and idenƟfy paƩerns. 

Data Tools Remove Duplicates, Flash Fill, ValidaƟon Tidy and structure your raw data 

5.5.2 Insert Tab (Charts, PivotTables, Illustrations) 

Where the Data tab in Excel is about structuring and cleaning data, the Insert tab breathes 

life into it. With charts, PivotTables, and other visualizaƟons the Insert tab helps you display, 

summarize, and analyze your insights in a way that makes it easy to share results. 

The uƟliƟes in this tab are used to create a variety of exciƟng and simple-to-use 

presentaƟon, producƟvity work sheets for business professionals, researchers, analysts or 

students that need to present and summarize data. 

Charts 

FuncƟon: Generates graphical visualizaƟons for numeric data, for example bar charts, line 

graphs and pie charts etc. 

Access Path: 

Insert → Charts group 

Chart Types in Excel: 
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Chart Type Use Case 

Column / Bar Graph Compare values for categories (e.g., sales by region) 

Line Chart Indicate trends (such as monthly sales) over Ɵme. 

Pie Chart Depict proporƟons as part of a whole (e.g., market share) 

Combo Chart Mix two types of charts in one (e.g., sales by product line vs. growth rate) 

ScaƩer Plot Analyze correlaƟon or distribuƟon 

Map Chart Plot geographic data (available in newer versions of Excel) 

Steps to Insert a Chart: 

Highlight the range of your data (including labels). 

Select Chart from Insert → Choose chart type. 

Customize using the Chart Design and Format tabs. 

Use Case Example: 

If you are displaying customer acquisiƟon per month, then you would use a line chart or if 

you want to see a breakdown of expenses, we can use a pie chart. 

PivotTables 

FuncƟon: Generates an interacƟve summary table to demonstrate big data concepts 

without formulas. 

Access Path: 

Insert → PivotTable 

How It Works: 

• Drag Fields to Rows, Columns, Values and Filters 

• Inherits data automaƟcally (SUM, AVERAGE, COUNT) 

• Supports drill-down, grouping, and filtering 

Example: 
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4) From a Sales TransacƟons data set of 10,000 records, generate a PivotTable to: 

• Summarize sales by product category 

• Filter by region or year-range 

• Display average discount per salesperson 

Benefits: 

• No formulas required 

• Dynamic and quick to adjust 

• Supports mulƟple layers of summary 

IllustraƟons 

Purpose: To add that liƩle visual bling to your reports, or to put some context in your data. 

Access Path: 

Insert → IllustraƟons group 

OpƟons Include: 

• Shapes – Arrows/callouts, flowchart symbols 

• Icons – Custom professional icons (Excel 2019 and later) 

• SmartArt – OrganizaƟonal charts, process flows, cycle diagrams etc. 

• Pictures/Online Pictures – Add images from device or internet 

• Screenshots - Add screenshots to your presentaƟon from other windows 

Use Case Example: 

• Point to trends on a chart using arrows 

• Consider SmartArt to depict a sales funnel or workflow 

• Decorate with logos or seals in a professional report 

Summary Table 
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Feature Tool LocaƟon Typical Use Case 

Charts Insert → Charts Displaying data trends and comparisons 

PivotTables Insert → PivotTable Analyze massive datasets on the fly 

IllustraƟons Insert → IllustraƟons Add imagery to presentaƟons and dashboards 

Real-World ApplicaƟon 

For a markeƟng analyst, who needs to generate a monthly report on the performance, they 

could: 

• Summarize your campaign results by region with a PivotTable. 

•Add a column chart to express growth in leads. 

• Insert a SmartArt graphic to describe the markeƟng funnel. 

• Include a logo and screenshot from the CRM Dashboard. 

That combinaƟon transforms a data-laden spreadsheet into a polished, audience-friendly 

deliverable. 

5.5.3 Formulas Tab (Function Library, Name Manager) 

The Formulas Tab The Formulas tab in Excel is one of the most powerful features! It’s the 

place where raw data is converted to useful metrics, paƩerns, and business insights, through 

the means of formulas and funcƟons. 

Whether it’s a calculated field or an analyƟc that demands the most precise calculaƟons, 

Formulas tab is where users can do everything to create, audit and control their formulas. 

The two most important features here are the FuncƟon Library and Name Manager. 

FuncƟon Library 

FuncƟon Library organizes Excel’s built-in funcƟons by category so they’re easy to find and 

use the right funcƟon for your needs. 

Access Path: 

Formulas → FuncƟon Library 
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Primary FuncƟon Library Categories: 

Category Common FuncƟons Purpose 

Math & Trig SUM, ROUND, ABS, INT Perform operaƟons on numbers 

StaƟsƟcal AVERAGE, MEDIAN, STDEV. P, COUNTIF Analyze data trends 

Analysis operaƟonsIF, AND, OR, NOTConstruct decision rules 

Cell content LEFT, RIGHT, MID, TRIM, CONCAT Working with strings 

Date & Time TODAY, NOW, DATEDIF, EOMONTH Work with dates and Ɵmes. 

Lookup & Reference VLOOKUP HLOOKUP INDEX MATCH XLOOKUP Find informaƟon and 

select it 

AccounƟng PMT, NVP, IRR, RATE Solve Ɵme-value-of-money calculaƟons 

AddiƟonal features Contains engineering, staƟsƟcal and user-defined funcƟons 

How It Works: 

• Tap a category (Logical for instance) → SELECT the desired funcƟon. 

• You get argument prompts in a dialog box from Excel, which can prevent syntax errors. 

• ToolƟps and examples assist you in understanding the logic behind each funcƟon. 

Use Case: 

Rather than enter it as =IF(A2>50000, "Approved", "Review"), a user can add it using the 

Logical funcƟon group, step-by-step. 

Name Manager 

Purpose: The Name Manager gives the user a way of defining and managing named ranges 

as an alternaƟve to using cell references. 

Access Path: 

Formulas → Name Manager (group) → Defined Names 

Other related tools: 
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• Define Name 

• Use in Formula 

• Create from SelecƟon 

What is a Named Range? 

Named Range A named range is a represenƟve name of cell/s or range like: 

Sales2025 = Sheet1! $B$2:$B$100 

You can then write: 

=SUM(Sales2025) 

instead of: 

=SUM(Sheet1!B2:B100) 

Benefits of Named Ranges: 

• Formulas will be easier to read and maintain 

• Reduces errors in large workbooks 

• Supports dynamic linking for referring to other sheets 

Use Case Example: 

In a budgeƟng workbook: 

• Define Rent as B2 

• Define UƟliƟes as B3 

• Then, calculate total: 

=SUM(Rent, UƟliƟes) 

More UƟliƟes on Formulas Tab 

Tool DescripƟon 

AutoSum Instantly adds the numbers in a column or row 
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ForecasƟng Displace your chaƫng so shows precedents, dependents, and errors 

Evaluate Formula Displays formula breaks it down for troubleshooƟng. 

Watch Window Watches important cells in all worksheets. 

Real-World Example 

A financial analyst is creaƟng a cash flow model: 

• Calculates EMI using PMT() in Financial category 

• IF() and AND() funcƟons for applying loan eligibility criteria 

Uses range names such as InterestRate, LoanAmount and Tenure 

5.5.4 Review and View Options 

Excel also includes an array of features to help you work collaboraƟvely, review and secure 

your data, and manage how worksheets are displayed in a workspace. These funcƟonaliƟes 

are in the Review and View tab. 

Together, they help users: 

• Work with others at the same Ɵme 

• Comment or notes to provide feedback 

• Prevent unauthorized access to workbooks, worksheets or workbooks 

• You can format the display of the data for beƩer focus or prinƟng 

Let’s learn about the main features in each of these tabs. 

A. Review Tab 

Use case: Allow worksheet/workbook collaboraƟon, commenƟng and protecƟon. 

Access Path: 

Review Tab (Excel Ribbon) 

Key features of the Review tab: 

Feature DescripƟon Use Case 
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Spelling Spell check the sheet to ensure a professional look for your reports. 

Thesaurus Offers synonyms for chosen words Adds detail in descripƟons or headings, gives 

precision_REPLACE WITH: synonymousyours->作曲 10680 tureCatalan- Assistance 

TranslaƟon.githubusercontent\/vue-sentence-component- generator README md## 

Appdans"; ポジティブ・アース Alphadia Genesis [プレイ動画]」   Thesaurus Offers 

synonyms for the selected words *Add to and alter DescripƟons or Headlines. 

New Comment / Notes Insert a comment or note in cell feedback on entries in the 

worksheet 

Show Comments / NotesView all comments or notesReview feedback from collaborators 

Track Changes (Legacy) Keeps track of changes made to shared workbooks Previously used 

for audit trails in older versions 

Protect Sheet Limit the ediƟng of specific cells Lock formulas or important fields 

Protect Workbook Structure Prompt to lock each buƩon on the sheet from being changed. 

Example Use Case: 

• A team lead contributes comments on sales forecasts for the analyst to consider. 

• Special cells are locked and safeguarded so junior employees can’t alter crucial formulas. 

B. View Tab 

Purpose: Provides some flexibility in how the workbook is displayed, which can be helpful if 

you have a really large or complex worksheet. 

Access Path: 

View Tab (Excel Ribbon) 

Key Features in the View Tab: 

Feature DescripƟon Use Case 

Normal / Page Layout / Page Break Preview View worksheets differentLook how the sheets 

will print 
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Freeze Panes Lock rows/columns while scrolling Retain headers in a "table" view with lots of 

records 

New Window Second Window View a second view of the same workbook Compare 2 sheets 

side by side 

Arrange All Arranges all open Excel windows MulƟtask workbooks with Arrange All; For 

more informaƟon, see Compare and merge workbooks. 

split divisions of window into panesView large data sets in the Window and scroll for 

visualizaƟon. 

Gridlines / Headings Display row and column lines Ease of presentaƟon or prinƟng 

Zoom Changes the size of the sheet Makes it easier to read during review parƟes 

Macros Use macro recording to create access tools A go at automaƟng an access task 

techniques (advanced use) 

Example Use Case: 

• A user who is working in a financial model that has several sheets can freeze the upper 

row for headers and open a 2nd view to see AssumpƟons of the Sheet1 whilst updaƟng 

dashboard on Sheet3. 

5.6 Data Standardization 

Data standardizaƟon is more than just a technical maƩer in analyƟcs and business 

intelligence; it’s also a strategic imperaƟve. As companies gather and amalgamate data from 

various applicaƟons (spreadsheets, web forms, databases, APIs), the resulƟng datasets will 

commonly be in different formats or structures, with different naming convenƟons. These 

discrepancies create a serious problem for data accuracy, fusion and analyƟcs. 

Data standardisaƟon is a process involving the conversion of data into a common, consistent 

and homogeneous format to grant accuracy, reliability and comparability. This can involve: 

• Unifying date formats 

• Consistently capitalizing text entries 
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• Applying standardized codes or labels 

• AdjusƟng numeric values (i.e. rounding to 2 decimal places) 

• Removing duplicates and invalid entries 

StandardizaƟon plays a crucial role as pre-processing before analysis, and it is commonly 

only an intermediate step in data preparaƟon. Without structured data, analyses such as 

filtering, summarizing, comparing and graphing can result in incorrect or parƟal findings. 

This secƟon considers the significance of standardizing data correctly in Excel, as well as a 

variety of approaches and tools that will allow you to do so. 

5.6.3 Using Functions for Standardization 

• ROUND • TEXT • VALUE 

In addiƟon to manual methods, Excel has formula driven funcƟons that support the process 

of normalizaƟon by changing formats, rounding values or crossing data types. These pages 

are helpful when dealing with very minute numeric values, and may need to manually 

recalculate figures that have gone down due to things like approximaƟon going wonky e.g. 

decimal truncaƟons, mixed formats or even texted based number strings that can't be 

calculate from! 

In this sub-secƟon, we concentrate on three very useful data normalizaƟon funcƟons in 

Excel: ROUND, TEXT and VALUE. 

ROUND FuncƟon 

Purpose: to round a number to x places, aiding in ensuring numbers are consistent within 

datasets and calcs. 

Syntax: 

=ROUND(number, num_digits) 

• number: The number you want to round. 

• num_digits:Digits to round to. 

o 0 is rounded to the nearest whole number 
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o PosiƟve numbers round decimals 

o NegaƟve numbers are rounded to tens, hundreds etc. 

Examples: 

=ROUND(45.678, 2) → 45.68 

=ROUND(45.678, 0) → 46 

=ROUND(45.678, -1) → 50 

Use Case: 

We request you to standardize the financial value upto 2 decimal points (eg- ₹45.678 will 

become ₹45.68) before reporƟng finance values. 

Related FuncƟons: 

• ROUNDUP(): Always rounds up 

• ROUNDDOWN(): Always rounds down 

TEXT FuncƟon 

Purpose:String representaƟon of a number in the specific format. It is perfect for styling 

display formats such as dates, currency or percentages. 

Syntax: 

=TEXT(value, format_text) 

Examples: 

=TEXT(TODAY(), "dd-mmm-yyyy") → "29-Aug-2025" 

=TEXT(0.25, "0%") → "25%" 

=TEXT(1000, "₹#,##0.00") → "₹1,000.00" 

Use Case: 

Generate uniformly formaƩed date columns or prepare neat text outputs for import into 

other applicaƟons, reporƟng dashboards etc. 
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Important Note: 

The funcƟon TEXT() returns text and not a number — thus the results can’t be used in 

addiƟonal calculaƟons unless you switch it back. 

VALUE FuncƟon 

DescripƟon: Changes text numbers to real numeric values which can be used in calculaƟons. 

Syntax: 

=VALUE(text) 

Example: 

=VALUE("123.45") → 123.45 (as a number) 

Use Case: 

When you import data from external sources, such as webpages, PDFs and CSV files, many 

Ɵmes it treats the numbers as text. VALUE() enables you to recover them in order to do 

calculaƟons like totals and averages. 

Related Tip: 

You can also though that looks like a bit of overkill) use Paste Special → MulƟply by 1 to 

convert text to numbers. 

Real-World ApplicaƟon Example 

A financial analyst is given a data set that includes: 

Interest rates as text(e.g., 0.075) 

• Diverse Styled Dates ("29/08/2025", "Aug 29, 2025") 

• Values with varying decimal lengths 

SoluƟon: 

• Use VALUE() to turn rates given in text into numbers. 

• Use TEXT(date,"dd-mm-yyyy") to standardize date formaƫng 
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• You match up currency use by rounding – e.g., ROUND(value *) 2) 

This creates clean, consolidated data for reporƟng and analysis. 

Choose the correct option: 

 

1. Which function can be used to remove extra spaces between words in a text entry? 

A) TRIM() 

B) CLEAN() 

C) PROPER() 

D) LEFT() 

 

2. What does the WORKDAY() function do in Excel? 

A) Counts the number of days between two dates 

B) Adds working days to a start date, excluding weekends and holidays 

C) Returns the weekday name of a date 

D) Calculates employee working hours 

 

3. In Excel, which of the following is a valid 3D formula syntax? 

A) =SUM(January, February, March!B2) 

B) =SUM(January:March!B2) 

C) =3D(SUM!B2) 

D) =SUM(‘Jan-March’!B2) 

4. The TEXT() function is mainly used to: 

A) Extract text from the middle of a cell 

B) Convert a date or number into a specific text format 

C) Remove numbers from text 

D) Translate text into another language 

 

5. Which tool would you use to eliminate repeated rows from a dataset? 

A) Data Validation 

B) Text to Columns 
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C) Flash Fill 

D) Remove Duplicates 

 

5.7 Summary 

 exposed students to advanced data manipulaƟon skills in MicrosoŌ Excel necessary to 

work with raw unorganized data and turn them into a structured and analyzable format. You 

will begin with string operaƟons, then learn how to clean and transform text using funcƟons 

such as LEFT(), MID(), TRIM(), and PROPER(). The date and Ɵme manipulaƟons porƟon 

covered how to pull out parts (such as day/month/year), compute duraƟons via DATEDIF() 

or NETWORKDAYS, and format dates for reporƟng. 

 What's more the unit delved into inter-sheet capabiliƟes—an essenƟal tool when you’re 

working with mulƟ-sheet workbooks. Students pracƟced cell referencing between 

worksheets, 3D formulas and data consolidaƟon. The Insert and Formulas tab were 

discussed, which showed features to make charts, PivoƩables, as well as apply excel funcƟon 

library. 

 A unit learned in data standardizaƟon was highly ranked. In case you didn’t know, real 

world data is seldom clean and Excel has some handy tools for Ɵdying up inconsistencies. 

FuncƟons like ROUND(), TEXT(), and VALUE() can also help regulate the formats, and there 

are built-in tools to clean up duplicate data, correct cases, or even deal with blanks. 

 With proficiency in these advanced techniques, parƟcipants are prepared to take on more 

challenging, real-life datasets with improved accuracy and insight. 

5.8 Key Terms 

Term DefiniƟon 

TRIM() Removes extra spaces from text 

PROPER() Converts the first leƩer of a each word in a string to uppercase. 

DATEDIF() Computes the difference between two dates 

NETWORKDAYS() Output the number of WORKING days between two dates 

Page 49 of 52 - AI Writing Submission Submission ID trn:oid:::3618:127431560

Page 49 of 52 - AI Writing Submission Submission ID trn:oid:::3618:127431560



3D Formula A formula that refers to the same cell range, not on one sheet but on mulƟple 

sheets. 

PivotTable Used to summarize data in a large dataset. 

Name Manager A feature of Excel to manage named ranges 

Transfer + Remove Duplicates A tool that transfers and removes duplicate rows in a data set 

TEXT() Converts a number to text in the format you specify 

VALUE() Changes a text number into a number. 

5.9 DescripƟve QuesƟons 

Describe how text funcƟons such as LEFT(), RIGHT() and PROPER() are preparing datasets 

for analysis. 

Explain date funcƟons such as TODAY(), DATEDIF(), and NETWORKDAYS() in HR or project 

contexts. 

What is the formula in 3D Excel? How does this make it easier to merge data from mulƟple 

sheets? 

Explain how to use the Insert and Formulas tabs to build interacƟve dashboards. 

Why is standardisaƟon of data important prior to its analysis? Describe with an example 

the methods to normalize data inExcel. 

- Using the Name Manager To Enhance Formula Readability And Workbook NavigaƟon. 

Give an example when you would need to use the ROUND(), VALUE() and TEXT() funcƟons? 

5.10 References 

1. Microsoft Support. (n.d.). Excel Functions (by Category). Retrieved from 

https://support.microsoft.com 

2. Walkenbach, J. (2013). Excel 2013 Bible. Wiley. 
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Knowledge Check 1 

Q1 A) TRIM() 

Q2 B) WORKDAY() 

Q3 B) =SUM(January:March!B2) 

Q4 B) Convert a date or number into a specific text format 

Q5 D) Remove Duplicates 

 

5.11 Case Study 

 

IntroducƟon: 

A naƟonal logisƟcs company is provided with monthly performance measure datasets from 
each of its 4 regions; that is: North, South, East and West. Every office has their own Excel 
sheet with KPIs like delivery success rate, customer complaints, fuel consumpƟon and 
operaƟons costs. Before, analysts hand-wrote the clip into one report. This was a slow, 
error prone and non repeatable process. 

Problem Statement 1: Uneven Format Across the Sheets 

Every sheet used different ways to name fields, date formats and field sequences. 

SoluƟon: 

Use string and DATE manipulaƟon (PROPER(), TEXT()) funcƟons to normalize the names of 
the regions, transform all dates in monthly format. Use Remove Duplicates to do away with 
duplicate entries and TRIM() for erasing spaces. 

Problem 2: Delay due to manual consolidaƟon A pracƟcal problem the implementaƟon was 
experiencing was the amount of Ɵme required for the manual consolidaƟon. 

The key report mandated analysts to manually assemble monthly data. 

SoluƟon: 

Now, we’ll bring in a 3D formulas and A cross-sheet reference to connect the data on the 
monthly sheets right to our master sheet. Use =SUM(North:West! D10) in automaƟcally 
summing operaƟng expenses by areas. 

Answers to Knowledge Check 

"The Operations Dashboard: Automating Monthly Reporting for Multiple Regions" 
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Problem 3: Absence of Dynamic ReporƟng Tools A lack of dynamic reporƟng tools is another 
limitaƟon. 

Management require visual summaries and rapid insights during meeƟngs. 

SoluƟon: 

Generate PivotTables to aggregate performance by region and month. Include graphs of 
successful delivery rates and trends. Use range references with defined names to make the 
formulas easier in the dashboard. 

AcƟvity for Students: 

Create a workbook with 4 sheets (North, South, East & West) that report on performance by 
month. 

Clean and standardize entries with funcƟons such as PROPER(), TRIM() and TEXT(). 

Consolidate KPIs onto a Summary sheet with cross-sheet references and 3D formulas. 

Include PivotTables and charts to show trends in performance. 

Keep sheets safe and use freeze panes for beƩer access. 

Deliverable: Hand in the completed workbook and one-page report of the standardizaƟon & 
reporƟng methods. 
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*% detected as AI
AI detection includes the possibility of false positives. Although some text in 
this submission is likely AI generated, scores below the 20% threshold are not 
surfaced because they have a higher likelihood of false positives.

Caution: Review required.

It is essential to understand the limitations of AI detection before making decisions 
about a student’s work. We encourage you to learn more about Turnitin’s AI detection 
capabilities before using the tool.

Disclaimer
Our AI writing assessment is designed to help educators identify text that might be prepared by a generative AI tool. Our AI writing assessment may not always be accurate (i.e., our AI models 
may produce either false positive results or false negative results), so it should not be used as the sole basis for adverse actions against a student. It takes further scrutiny and human 
judgment in conjunction with an organization's application of its specific academic policies to determine whether any academic misconduct has occurred.

Frequently Asked Questions

How should I interpret Turnitin's AI writing percentage and false positives?
The percentage shown in the AI writing report is the amount of qualifying text within the submission that Turnitin’s AI writing 
detection model determines was either likely AI-generated text from a large-language model or likely AI-generated text that was 
likely revised using an AI paraphrase tool or word spinner.
 
False positives (incorrectly flagging human-written text as AI-generated) are a possibility in AI models.
 
AI detection scores under 20%, which we do not surface in new reports, have a higher likelihood of false positives. To reduce the 
likelihood of misinterpretation, no score or highlights are attributed and are indicated with an asterisk in the report (*%).
 
The AI writing percentage should not be the sole basis to determine whether misconduct has occurred. The reviewer/instructor 
should use the percentage as a means to start a formative conversation with their student and/or use it to examine the submitted 
assignment in accordance with their school's policies.

What does 'qualifying text' mean?
Our model only processes qualifying text in the form of long-form writing. Long-form writing means individual sentences contained in paragraphs that make up a 
longer piece of written work, such as an essay, a dissertation, or an article, etc. Qualifying text that has been determined to be likely AI-generated will be 
highlighted in cyan in the submission, and likely AI-generated and then likely AI-paraphrased will be highlighted purple.
 
Non-qualifying text, such as bullet points, annotated bibliographies, etc., will not be processed and can create disparity between the submission highlights and the 
percentage shown.
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Unit 6: Data Analysis using Charts & PivotTables 
 

Learning Outcomes 

1. Understand the purpose and importance of data visualizaƟon in the context of business 
analyƟcs and 

decision-making. 

2. IdenƟfy and apply appropriate chart typesin Excel (such as column, line, pie, and combo 
charts) to represent 

data accurately and effecƟvely. 

3. Create and customize PivotTables to summarize and analyze large datasets with dynamic 
filters and 

groupings. 

4. Develop PivotCharts to visually represent PivotTable data and support interacƟve data 
exploraƟon. 

5. Interpret visual data representaƟons to idenƟfy trends, paƩerns, outliers, and acƟonable 
business insights 

 

Content 

6.0 Introductory Caselet 

6.1 IntroducƟon to Data VisualizaƟon 

6.2 Charts in Excel 

6.3 PivotTables 

6.4 PivotCharts 

6.5 Deriving Business Insights 

6.6 Summary 

6.7 Key Terms 

6.8 DescripƟve QuesƟons 

6.9 References 

6.10 Case Study 
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6.0 Introductory Caselet 

"Ananya’s Dashboard Dilemma: Turning Data into Decisions" 

 

“Ananya, a 30-year-old sales operaƟons manager at a fast expanding e-commerce company 
in Hyderabad, was 

You’re looking at one more enormous spreadsheet. Working from her computer, she and 
her team had churned through more than 10,000 rows of order data for the most 

two quarters — on product sales, returns, delivery areas, customer raƟngs and revenue. But 
during 

review meeƟngs, senior leadership frequently posed simple quesƟons that she couldn’t 
quickly answer:” 

• “Which regions are underperforming?” 

• “What are our bestselling categories this month?” 

• “In any product line, are customer returns going up?” 

All of the informaƟon was in fact “in the data,” but it wasn’t visible. The team was sƟll 
visually scanning 

with tables and sorƟng columns, a man-hours-squandering account set-up task before every 
meeƟng. Stories were awash with numbers, but 

lacked clarity. Decisions were happening, in large part, based on assumpƟons. 

She first learned about PivotTables, PivotCharts and through a professional development 
day one aŌernoon. 

data visualizaƟon techniques in Excel. She found out how fast she could summarize 
thousands of lines, 

view trends, and filter data interacƟvely. She developed a sales dashboard in Excel that 
allowed team leads to choose 

regions, dates or product categories and get quick feedback in the charts. 

Now, instead of looking through sheets, her managers could just look at a dashboard and 
hear the story that the data was telling them. 

telling. 

And within the month, the regional team reprioriƟsed markeƟng spend by product and 
escalated a 
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increasing returns from one vendor.ExcepƟon: None. The alteraƟons had the company 
saving Ɵme and money. 

Ananya’s experience proved to be a wake-up call — not just for her team, but also to the 
way in which the company regarded data: no longer as 

something to manage, but something to exploit for strategic insights. 

CriƟcal Thinking QuesƟon: 

If you were in Ananya’s place, what is that one Excel feature which would be your #1 priority 
to target originally for faster and clear reporƟng: 

• PivotTables 

• Charts 

• Slicers 

CondiƟonal Formaƫng? 

Provide an example to support your answer. 

 

6.1 IntroducƟon to Data VisualizaƟon 

We live in the informaƟon age, with data produced at higher rates and volumes than ever 
before. However, just raw data inherently lacks some. 

unƟl it’s processed, analyzed and — criƟcally, here — visualized. VisualizaƟon VisualizaƟon 
is the process of 

presenƟng informaƟon with the use of graphical elements such as charts, graphs, and 
dashboards. It transforms complex datasets into 

a more human understandable, interpretable and acƟonable format. 

Excel itself is used by many professionals and analysts in working with data, so there will be 
powerful visualizaƟon built into that. 

that can improve understanding, guide decisive response, and convey key takeaways to 
technical and non-technical audiences alike. 

In this chapter we explain the importance and purpose of visualizaƟon techniques for 
business and how they are chosen strategically. 

contexts. 

 

6.1.1 Importance of Visualizing Data for Business Insights 

Page 5 of 27 - AI Writing Submission Submission ID trn:oid:::3618:127424870

Page 5 of 27 - AI Writing Submission Submission ID trn:oid:::3618:127424870



Data visualisaƟon is not just a reporƟng tool – it’s an essenƟal part of the analyƟcal process. 
It allows 

combine data, find unknown paƩerns, understand trends and detect unusual occurrences 
that may be unnoƟced by the public. 

raw tables or spreadsheets. 

Key Reasons Why VisualizaƟon MaƩers: 

Simplifies Complex Data 

Big data can be overwhelming even for simple lists with several thousand rows. Charts, 
dashboards, and visuals 

offer a brief, synthesized overview in formats that are accessible and easy to interpret”. 

Enables PaƩern RecogniƟon 

It is usually more visible in a picture than an equaƟon. A line chart can, for instance, show 
straight away what happens widespread shortages in producƟon and assumpƟons about 
them. 

seasonal fluctuaƟons or sales dips. 

Facilitates Quick Decision-Making 

In business, speed maƩers. Managers and stakeholders have rich, visual dashboards to see 
the most important performance. 

indicators (KPIs) in one view, allowing for immediate acƟon when necessary. 

Improves CommunicaƟon Across Teams 

VisualizaƟons are also a language. From reporƟng to execuƟve presentaƟons, for markeƟng 
and for engineering well-designed images minimize the risk of misinterpretaƟon. 

Drives Engagement and Storytelling 

Data-heavy stories work best when enhanced by visuals. is a bar chart depicƟng market 
share discrepancies. 

beƩer than a percentage table. 

Real-World Example: 

A markeƟng team has a system that tracks website traffic, conversion rates and campaign 
spend in Excel. By visualizing this 

data using line and pie charts, they are able to: 

• Monitor daily trends 
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• Discover which channels are not performing 

• Advocate for budget redirecƟon from top management 

 

6.1.2 Choosing the Right VisualizaƟon Technique 

Data visualizaƟon is important, but choosing the right chart or form of visualizaƟon really 
maƩers. The wrong 

choice may mislead the reader or mischaracterize the data. 

Things to Consider When SelecƟng a VisualizaƟon: 

• What kind of data is it (Categorical, numerical, Ɵme series…)? 

• What does the visualizaƟon try to accomplish: Comparison, distribuƟon, composiƟon, 
relaƟonship? 

• Audience: Technical or non-technical readers? 

• Data volume: Big datasets may need aggregaƟons. 

Types of VisualizaƟon Commonly Used and Their Purpose: 

VisualizaƟon Type Purpose Example Use 

Column / Bar Chart Compare values across categories Sales volume by region, revenue by 
product 

Line graph Trends over Ɵme Website traffic, stock prices 

Pie Chart Represent parts of a whole Market share or budget allocaƟon 

ScaƩer Plot RelaƟonships between variables AdverƟsing spend to revenue 

Combo Chart Compare a disƟnct metrics across varieƟes with different 

scales 

Sales and profit margin at one 

chart 

PivotChart See summarized PivotTable data InteracƟve and drillable reports 

Map Chart (Excel 

2019+) 

Geography Sales by country or state 

Tips for EffecƟve VisualizaƟon: 
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• Keep it clean — simplicity adds clarity. 

• Be wise with color: It should emphasize, not overpower. 

• Add axis labels, Ɵtles and legends for context. 

• Select visuals that map to your analyƟc goal (e.g., trend, distribuƟon, composiƟon). 

• Test the chart on others — if it takes too long to explain, you may have some rethinking to 
do. 

 

6.2 Charts in Excel 

Charts are a core component of Excel’s data visualizaƟon toolkit. They provide a graphical 
representaƟon of data, enabling users to idenƟfy paƩerns, compare values, and 
communicate trends at a glance. Excel makes it easy to create a chart from raw data, choose 
the appropriate chart type, and customize the appearance to suit the communicaƟon 
context. This secƟon introduces learners to the process of creaƟng charts, explores various 
chart types, and explains how to tailor chart elements for maximum impact. 

6.2.1 Basics of CreaƟng Charts 

It only takes a few steps to make a chart in Excel. You can with the right data and chart type 

visualize trends and comparisons. 

CreaƟng a Simple Chart: 

Select your data range 

Do not hesitate to include any header (like Months or Sales if possible). 

Go to 

Insert → Charts Group → Choose your Chart Type (e.g., Column, Line or Pie). 

Excel inserts the chart 

It can be presented as an in-place chart, or in a new chart sheet. 

Leverage Chart Design and Format tabs 

They show when chart is selected and are customizable (Ɵtles, styles, colors). 

Example: 

Given the data: 

Month Sales 

Jan 10,000 
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Feb 12,500 

Mar 9,800 

Click on this range and choose Insert → Column Chart to create a basic bar chart that shows 
the number of man-months. 

sales. 

 

6.2.2 Types of Charts 

Excel provides many different types of charts for various uses. What type of chart you use 
depends on what you 

are trying to communicate. 

Column & Bar Charts 

• Column charts: VerƟcal bars. Great for comparing values by categories. 

• Bar charts: Horizontal bars. The phw level tests work beƩer with very verbose category 
names. 

Use case If you want to compare your revenue/product one month among other months. 

Line & Area Charts 

• Line charts: Display trends over Ɵme with points connected by lines. 

• Area charts: Like line charts, but with shaded areas under the lines. 

Example: Following numbers for a period of Ɵme (month-to-month traffic/sales). 

Pie & Donut Charts 

• CoƩage pie: Indicates whether a food is made with ground meat. Good for small datasets 
(3–6 categories). 

• Donut charts: Like pie charts, but with an empty center. 

Use Case: Market share / budget presentaƟon. 

ScaƩer & Bubble Charts 

• ScaƩer plots: Display the relaƟonship between two numeric variables. 

• Bubble charts: Introduce a third variable through the size of the bubble. 

Example: View relaƟonships, groups or anomalies e.g. profit v revenue by product. 

Combo Charts 
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• Mix two types of charts (w89 line and column) on one chart. 

• Useful for comparing values with differing scales (e.g., units sold vs. profit margin). 

Use Case: Chart two-axis data eg. sales and rate of growth. 

 

Did You Know? 

“Excel supports a Combo Chart, which allows you to combine two different chart types (e.g., 
column and line) on the same visual, even with different axes. This is ideal when comparing 
values of different scales, like "Sales (₹)" and "Profit Margin (%)" on one chart. Example: Use 
Insert → Combo Chart and choose "Custom CombinaƟon Chart" to assign chart types and 
axes per data series.” 

 

6.2.3 Customizing Charts 

It's geƫng personal Personalising a chart enhances its legibility and power. Excel offers 
opƟons to as you format any chart 

element. 

Titles & Labels 

• Add Chart Title: Provide a clear descripƟon of what the chart presents. 

• Include Axis Titles: Describe what one measures on each axis. 

• Data Labels: Display values directly on bars, lines, or segments. 

Legends & Axes 

• Legend: Shows what each color or symbol represents. 

• Axes: Scale, units and labels are customizable for improved clarity. 

Colors & Styles 

• Select color themes according to your theme/brand. 

• Highlight key data with one of the pre-defined Chart Styles or manually apply formaƫng. 

Tips for Chart CustomizaƟon: 

• Don’t use too many colors—keep it clean and consistent. 

• Take away excess gridlines if they cluƩer the visual. 

• Devote bold or highlight hues to emphasize the important trends. 
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• PosiƟon Ɵtles and legends for readability and balance. 

Real-World Scenario: 

A Sales Manager builds a Combo Chart where: 

• The monthly revenue is in the columns 

• Profit margin is represented as a line on the secondary axis 

• Chart includes: 

o A headline: “Mo Revenue vs. Profit Margin – Q1” 

o Axis labels are given as: “Revenue (₹)” and,“Margin (%)” 

o Legends and data labels for rapid interpretaƟon. 

This well constructed chart informs leadership with quick acƟonable decision making. 

 

“AcƟvity: Make It Speak: Telling a Story through Chart 

InstrucƟon to Student: You are given monthly sales data for four product categories. Your 
task is to build a Column Chart and customize it for presentaƟon in a business meeƟng. 
Steps: 1. Insert a Column Chart from the given data. 2. Add a meaningful chart Ɵtle, axis 
labels, and data labels. 3. Format the chart using your chosen color scheme (avoid default 
colors). 184 4. Apply bold labels to highlight the highest and lowest performing categories. 5. 
Remove any elements that do not add value (e.g., unnecessary gridlines). Deliverable: 
Submit the Excel file with your customized chart and a 3–4 line explanaƟon on how your 
design choices enhance clarity and insight. 

 

6.3 PivotTables PivotTables are one of Excel’s most powerful features, enabling users to 
summarize, explore, and analyze large datasets dynamically without the need for complex 
formulas. They allow for interacƟve data exploraƟon and are essenƟal in reporƟng, business 
analysis, and decision-making. Whether you’re analyzing sales performance by region, 
reviewing product profitability, or creaƟng dashboards, PivotTables can quickly transform 
raw data into meaningful insights. 

 6.3.1 IntroducƟon to PivotTables 

A PivotTable is the summary tabulaƫon of all columns and or rows in an available data list 
that you can pivot any way you want. 

spreadsheet for a report or analysis. 

Key Benefits: 
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• Summarize large ranges of data with minimal data in just second 

• Calculate things such as sums, counts, averages 

• Reorder data without modifying your original dataset 

• Produce interacƟve reports for the non-technical user 

• Fast filtering and groupings allowed 

Real-Life Example: 

You have a table with 10,000 sales transacƟons. A PivotTable can instantly show: 

• Total sales per product 

• Sales by region or sales person 

• Average revenue per order 

 

6.3.2 CreaƟng PivotTables from Data Ranges 

Steps to Create a PivotTable: 

Select your data range 

ConƟnue to check that your data has unambiguous column headers. 

Go to 

Insert → PivotTable 

And do the following Select where you want to place the PivotTable 

o New worksheet (recommended) 

o ExisƟng worksheet (if preferred) 

Click OK 

You will get an empty PivotTable Field List and now you can start creaƟng your summary. 

Best PracƟces: 

• Do not leave empty rows or columns within your data range 

• Make sure each field is labeled with a unique and intuiƟve header 

• Make the Data range as Table (Ctrl + T) to get updates on fly. 

 

6.3.3 Using Rows, Columns, Values, and Filters 
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AŌer you build your PivotTable, you will use the Field List to create your summary by 
dragging and dropping fields. 

into four main areas: 

Area Purpose 

Rows Adds the groupings by row ( e.g., Product or Region) 

Columns Column-wise groupings (e.g., by Month or Category) are added. 

Values The data that you want to summarise (e.g. Sum of Sales, Count of Orders) 

ShuƩle Adds general report filter to refin results (such as: Year or Manager or...) 

Example: 

Given a dataset with these fields: 

• Product, Region, Dollars Sales Amount, Quarter 

You can create a PivotTable that: 

• Rows: Product 

• Columns: Quarter 

• Values: Sum of Sales Amount 

• Filters: Region 

This results in an interacƟve product sales by quarter, grouped and filtered by region. 

Did You Know? 

“In PivotTables, dragging the same field into both Rows and Values can help you count 
unique entries or analyze frequency by category. Example: Add the “Customer ID” field to 
both Rows (to list) and Values (to count), and Excel will instantly tell you how many orders 
each customer placed.” 

 

6.3.4 Summarizing Data with PivotTables 

• Totals & Subtotals • Grouping • SorƟng & Filtering 

AŌer you build your structure, PivotTables offer a number of ways to summarize. 

Totals & Subtotals 

• Excel will figure the subtotals for you in each category (total sales by region, say). 
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• Subtotals can be toggled on or off, and the numerical values (Sum, Average, Count, etc.) 
they display can be reconfigured 

Access Path: 

Right click on a row label > Subtotal, or go to the Design tab. 

Grouping 

Group data by: 

• Date: Group by Month, Quarter, Year 

• Numerical intervals: Categorize sales in ranges (0–10K, 10K–20K) 

• Manual: Select and group items by users themselves 

Example: 

Show quarter total orders in group order dates. 

SorƟng & Filtering 

• Sort by bestselling, A-Z or custom order 

• You can apply filter to any field using drop downs 

• Report Filter area to filter the enƟre PivotTable 

Advanced OpƟons: 

• Show Values As: % of Total, Running Total, Difference From and more. 

• Value Field Seƫngs: Switch that from Sum to Average, Count, Max or whatever. 

• Calculated fields: Add new metrics (eg, Profit = Revenue - Cost) 

Real-World Use Case: 

An HR manager would like to review informaƟon on leaves: 

• Rows: Department 

• Values: Number of Leaves Filed 

• Filters: Leave Type (e.g. Sick, Paid etc…) 

With one PivotTable, she can: 

• Which departments have the most leaves? 

• Filter by type of leave 

• Dive deeper on individual employees as necessary 
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6.4 PivotCharts 

PivotCharts are visual, dynamic expanded versions of PivotTables. Not only do they give you 
the full power of a PivotTable, but these calcs have the addiƟonal. 

advantage of interacƟve data visualizaƟon. For example, if you are presenƟng to 
stakeholders who prefer to see this informaƟon in chart form (which is oŌen the case), 
PivotCharts are your friend. 

must present data graphically so others dont just look at numbers. 

By drilling down, filtering and comparing between data, PivotCharts are one of the greatest 
pieces of warmth producing machinery around. 

most effecƟve shares in Excel for building dashboards and reporƟng to execuƟves. 

 

6.4.1 CreaƟng PivotCharts from PivotTables 

To create a PivotChart, you add a chart to a PivotTable. It's a direct representaƟon of the 
structure and filters 

for the underlying PivotTable, and if you make any changes to the PivotTable they are 
reflected in the chart. 

Steps to Create a PivotChart: 

Form a Pivot Table based on your data range. 

Click anywhere inside the PivotTable. 

Have you tried Insert → Charts Group → PivotChart? 

Choose the type of chart you want (for example, Column or Line or Pie). 

Click OK. 

A PivotChart gets created next to your PivotTable, and it's completely Ɵed to its data. 

Best PracƟces: 

• Select between Column, Line or Bar charts for group summaries. 

• Use Pie charts for only very simple breakdowns with only a few categories. 

• If you want to compare the visual appearance of more variables use ScaƩer or Combo 
charts. 

6.4.2 Linking PivotCharts with Data Filters 
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PivotCharts are linked to their source PivotTables, so when you filter a datePickerRanges 
filter on thecore date is also applied to any PivotChart based on that data. 

apply to the chart. Also, Excel has added the interacƟve filter controls of Field BuƩons on 
the 

PivotChart. 

Types of Filters You Can Use: 

• Report Filters (from the PivotTable) 

• Axis Filters (filter categories to be displayed on X axis) 

• Legend Filters (Filter the legend or data series items) 

• Slicers & Timelines (filters that you can use on-the-fly with more visual and added context) 

Using Slicers with PivotCharts: 

Click on the PivotTable. 

Go to Insert → Slicer. 

Choose the field(s) you wish to filter by (e.g. Region, Category). 

The slicer looks like a filter box that can be clicked. 

Upon usage, it will automaƟcally refresh the PivotTable and PivotChart. 

Tip: Use Timelines to seletect date-based field (such as year, month or quarter) upon which 
you can filter. 

Real-World Example: 

In a sales dashboard: 

• A PivotChart displays the sales total for each product category. 

• A slicer enables the user to slice the chart by sales region. 

• A Ɵmeline that allows users to switch between months or quarters in an effort to indenƟfy 
trends. 

This facilitates instantaneous interacƟon, and let users query the data from mulƟple views 
on the fly and without coding 

a single formula 

 

Did You Know? 
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“You can use Slicers and Timelines to control mulƟple PivotTables and PivotCharts at once. 
Simply right-click the slicer and choose “Report ConnecƟons” to link it to other PivotTables in 
the workbook. This is especially useful in dashboards to filter all visuals by one field like 
“Region” or “Year.” 

 

6.4.3 Customizing PivotCharts for EffecƟve Insights 

CustomizaƟon can help ensure your PivotChart is as effecƟve as possible. You can alter the 
appearance and format-offsetofExcel works well with the look and 

look and feel of the graph, making it easier to read and more professional. 

CustomizaƟon OpƟons: 

Feature Purpose 

Title: Title for the chart Chart Titles Put descripƟve Ɵtles to clarify the focus of the graph 

Data Labels Display actual numbers on chart bars or secƟons 

Axis Titles The Ɵtles describe what the axes are measuring 

Key Describe what the colors or symbols mean 

Color & Style Apply the same color schemes to your report 

Chart Filters Turn values on/off to clear up chart cluƩer 

Design Tips for PivotCharts: 

• Use crisp, straighƞorward Ɵtles (for example, “Q2 Sales by Region”). 

• Use data labels or callouts to emphasize trends. 

• Use the same colors for related charts. 

Cut out chart junk to stay focused. 

• Don’t rely too much on 3D effects or other showy visuals — simplicity serves clarity. 

Real-World ApplicaƟon: 

PivotCharts in HR Analyst An HR analyst might use a PivotChart: 

• Display mean days of leave by department. 

• Use slicers to filter by type of leave (paid, unpaid). 

• Personalize theme colors of charts for adapƟng to your company brand. 

• Introduce the chart in a monthly HR performance report. 
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This is a way of visually enabling senior managers to understand what is happening in the 
world of HR and use the informaƟon for making decision. 

6.5 Deriving Business Insights 

But that’s just the Ɵp of the iceberg when it comes to creaƟng charts and PivotTables. The 
real power of data vis is the powe to 

and draw insights—discovering paƩerns, spoƫng trends, detecƟng anomalies and making 
enlightened decisions. 

business decisions. 

In these secƟons learners will build more complex tools to apply insights across a broad 
range of applicaƟons. 

to: 

• Understand performance trends 

• Spot outliers or risks 

• Compare segment-wise results 

• EffecƟvely report findings to stakeholders 

That's the difference between keeping a lid on data and using data-driven decisions. 

 

6.5.1 Using Charts and PivotTables for Trend Analysis 

The process of trend analysis is the examinaƟon of historical data over Ɵme to idenƟfy 
relaƟvely consistent movements, cycles or other long-term phenomena. 

direcƟons. 

Key Techniques: 

• Line charts are best to illustrate Ɵme-series data (for example, monthly sales). 

• Use PivotTables to group and summarize long lists of data by Ɵme period (year, quarter, 
month). 

• Insert moving averages or trendlines into charts to filter short-term variaƟons. 

Use Case: 

A financial analyst observes a line graph of monthly expenditures over two years to idenƟfy 
seasonal peaks in uƟlity expenses, 

contribuƟng to smarter budgeƟng for the coming year. 
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6.5.2 CreaƟng InteracƟve Dashboards in Excel 

Dashboards are great instruments to collect, show and browse through important data 
metrics w ithout leaving a single page. 

InteracƟve dashboards, on the other hand, eliminate the need for manual updates and 
limited exploraƟon, which are associated with staƟc reports and enable users to: 

work directly with the data to filter views, compare variables, and see measurements 
update instantly. Excel, 

full-featured interacƟve dashboards without the need to write custom scripts or snippets. 

coding. 

Enjoy the videos and music you love, upload original content, and share it all with friends, 
family, and the world on YouTube. 

• 1. IdenƟfy Key Metrics (KPIs): 

Start with idenƟfying the objecƟve of your dashboard and choose appropriate KPIs 

(KPIs). These might be sales growth, revenue, % of saƟsfied customers or how efficient your 
process is. 

metrics. ObjecƟve – A goal clarifies the focusing and acƟonable scope of the dashboard. 

• 2. Prepare and Clean the Dataset: 

The quality of a dashboard is only as strong as its data. Structure your data in a formaƩed 
table format 

remove duplicates or mistakes and standardize the format of all data points. Use Excel tools 
like 

And finally, either Power Query or Text to Columns for further cleaning. 

• 3. Use PivotTables and PivotCharts: 

PivotTables offer the ability to do dynamic data summarizaƟon—filtering and grouping 
based on reasons. 

different fields. Combine these with PivotCharts to help you to see paƩerns, trends and 
comparisons. 

indicators. These charts will respond automaƟcally when interacƟng with filters or slicers. 

• 4. Add Slicers and Timelines: 

Slicers serve as visual filters that you can use so it's easier to narrow down a segment of your 
data (such and region, or product group), regardless of what set of columns this is on. 
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department). Timelines are dedicated slicers that can, by default, filter based on year, 
quarter, month of the year or day of the week. Together, they enhance 

first, interacƟvity that allows users to interact with the dashboard according to their analysis 
needs. 

• 5. Apply CondiƟonal Formaƫng: 

Apply Excel's condiƟonal formaƫng features to the most important paƩerns like top / 
boƩom performers 

deterioraƟons from the target. This enables user to visually idenƟfy problemaƟc areas or 
outliers with higher at a 

glance, enhancing decision-making speed. 

• 6. Design an IntuiƟve Layout: 

Organize visualizaƟons like charts, KPI boxes, and tables in a structured logical way. Group 
related 

components, be certain to include clear headers and make sure the dashboard fits on a 
single worksheet or screen. A 

a well-designed dashboard here is all about usability and avoiding visual noise. 

PracƟcal Example: 

For example, a sales dashboard could include visual representaƟons of trends in monthly 
sales, a map with regional performance and tables. 

lisƟng top-performing products. With slicers for region and sales reps, the manager can 
easily find 

a specific locaƟon and then take decisions about how to invest resources or change 
strategies. 

 

6.5.3 Benefits of InteracƟve Dashboards 

There is more to interacƟve dashboards than meets the eye. they convert raw data into 
acƟonable, real-Ɵme intelligence that enables faster, beƩer informed decisions. As the 
amount of data increases, the possibility of interacƟng with 

informaƟon rather than merely reside in it becomes crucial as businesses compete in the 
InformaƟon Age. 

Key Advantages of InteracƟve Dashboards: 

• Instant Comparisons and Live Search: 
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User can now compare departments, regions or Ɵme periods instantly by drilling across 
slicers or 

filters. This minimizes the requirement for many staƟc reports and increases the agility of 
analysis. 

• Early Error DetecƟon and PaƩern Matching: 

Dashboards visually illustrate when values seem inconsistent, have spiked or dropped in an 
unusual manner—a person realizes it. 

aided in idenƟfying data errors or business risks before the hourglass empƟes. 

• User CustomizaƟon and Accessibility: 

Various interested parƟes (e.g., finance, markeƟng operaƟons) may customize the 
dashboard view based upon 

their interests. For example, whereas a finance officer might concentrate on cost 
effecƟveness (McCarthy.and Stoker 2009) a markeƟng team may consider Figure. 

filter the dashboard to analyse campaign performance for it. 

• Time Efficiency and AutomaƟon: 

When configured, dashboards update automaƟcally as new data is entered. This eliminates 
the need for 

manual reports, saving Ɵme and ensuring that decision-makers always have the most 
current informaƟon. 

insights. 

Data Storytelling and CommunicaƟon: 

Dashboards are a mix of visual images, numbers and interacƟve tools: That is where the 
storytelling comes in—showing not just “what’s happening or has happened … but poin Ɵng 
to why—or perhaps more important, why not.” 

occurred,” but also via understanding “why” underlying the data. This facilitates more 
effecƟve 

presentaƟons, conferences and means to meeƟngs. 

Use Case Example: 

Here we have a markeƟng dashboard monitoring campaign performance across several 
channels: email, social media, 

and paid adverƟsing. With slicers, the markeƟng team is able to easily determine which 
campaigns are doing best in 
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specific regions or demographics. This enables them to pivot creaƟve approaches and 
budgets on the fly, leading to beƩer 

return on investment (ROI) and sensiƟvity to market condiƟons. 

6.5.4 PresenƟng Insights for Decision-Making 

And the last part of analysis is communicaƟng findings in compelling way. Data is only 
valuable if it 

can influence decisions. 

Guidelines for PresenƟng Insights: 

Build dashboards that include charts, PivotTables, and KPIs in one view. 

• Annotate or speak out to emphasize points on charts. 

• Make visuals minimalist and focused on business goals. 

• Personalize insights to the audience — for example, use summary visuals for execuƟves 
and detailed tables for analysts. 

Storytelling with Data: 

• Define the scope (What are we measuring?) 

• IdenƟfy the insight (What is the data telling us?) 

• Prompt acƟon (What do you want me to do?) 

Real-World Example: 

A retail manager creates a dashboard with PivotTables and charts: 

• Follows monthly sales, categorized by region and type 

• Notes persistent weakness in electronics in the South 

•Suggests promoƟonal pricing in Q4 to recover sales 

• Summarizes findings in a brief visual report for senior management 

This is an example of how data visualizaƟon helps shape business strategy 

Knowledge Check 1 

Choose the correct opƟon: 

1. What is the primary purpose of data visualizaƟon in business analysis? 

A) To replace data entry tasks 

B) To create decoraƟve reports 
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C) To simplify data interpretaƟon and uncover insights 

D) To store large volumes of data 

2. Which of the following is best used to show trends over Ɵme? 

A) Pie Chart 

B) Line Chart 

C) Column Chart 

D) ScaƩer Plot 

3. In a PivotTable, which area would you drag a field to in order to group your data 
verƟcally? 

A) Filters 

B) Values 

C) Columns 

D) Rows 

4. What is a benefit of using a PivotChart instead of a regular chart? 

A) It allows ediƟng of raw data directly 

B) It automaƟcally updates with PivotTable filters 

C) It can be created without any data 

D) It removes the need for Ɵtles and legends 

5. You want to compare the sales performance of three product categories across five 
regions. Which chart 

type is most suitable? 

A) Line Chart 

B) Stacked Column Chart 

C) Pie Chart 

D) Bubble Chart 

 

6.6 Summary 

❖ brought aƩenƟon on turning raw data into informaƟon graphics which make it easier to 
understand business and speed up process * Developed, Q/A tested both manual and 
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automaƟon test scripts for staƟc & dynamic web applicaƟon using Selenium Webdriver 2.0 / 
WebDriverBackedSelenium APIs(Language:Java). 

decision-making. StarƟng with data visualizaƟon, students learned how Excel 

enables data storytelling with charts, PivotTables and PivotCharts. 

❖ Students iniƟally learned the types and uses of various charts, then how to create 

and customize them. From there, they moved to PivotTables, a powerful way to summarise 
large datasets 

with the opƟon to group, filter and compute. PivotCharts introduced interacƟvity to 
visualizaƟon, making it possible for users to filter visualizaƟons interacƟvely. 

to filter and slice-and-dice data in an interacƟve manner. 

The last segment of the module was on how to make sense of trends,ently extracted from 
data?’ paƩerns and insights from such :‘ What can we learn ‘ ing with numbers?! ’previous 
discussion would take!? This gets us back to where did happen form? 

outliers and comparisons according to data interval. Students learned skills which were 
valuable both in creaƟng the visualisaƟon and 

and in communicaƟng analysis and findings to decisionmakers. 

❖ Armed with these skills, learners are ready to turn data into intelligence usi ng 

Excel’s visualizaƟon capabiliƟes. 

6.7 Key Terms 

Term DefiniƟon 

Data VisualizaƟon: The portrayal of data to reveal paƩerns that tells the story. 

Chart A visual representaƟon (e.g., bar, line, pie) for seeing trends in a data set or 
comparing range expenditures. 

PivotTable An interacƟve tool for summarizing large amounts of data with ease 

PivotChart A graphic representaƟon associated with a PivotTable that changes when you 
filter and modify it 

Trend analysis DetecƟng bends or curves in a data set to determine if trends are occurring 
over Ɵme. 

Outlier An observaƟon that differs greatly from the rest of the data. 

Slicer A graphic filtering tool that enables PivotTables and PivotCharts to be filtered 
interacƟvely. 
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Grouping Grouping data in PivotTables by date, number ranges, or manually-selected 
values. 

Dashboard A visual interface that brings together many charts, summaries and KPIs in a 
single view 

Insight A useful observaƟon or conclusion based on a processed bit of informaƟon. 

6.8 DescripƟve QuesƟons 

Data visualizaƟon: Explain what it is and why it's so important in business analyƟcs. 

How can an Excel Chart differ from a PivotChart? Give examples of when you would use 
each. 

Describe how you would create a PivotTable from the data set. How many secƟons are 
there in a PivotTable? 4 What four regions are found in the PivotTable? 

Explain how you might employ a PivotChart and slicers to create an interacƟve dashboard. 

How might trend analysis and outlier detecƟon be helpful in influencing business decisions? 

Give an example of how comparing groups (for example product segments) on a chart 
facilitated the idenƟficaƟon of one. 

business opportunity. 

Explain three methods for personalizing a chart to enhance clarity and communicaƟon. 

How to visualize and present data in a board meeƟng context using the tools that Excel 
offers you? 
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Answers to Knowledge Check 
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Knowledge Check 1 

Q1 C) To simplify data interpretaƟon and uncover insights 

Q2 B) Line Chart 

Q3 D) Rows 

Q4 B) It automaƟcally updates with PivotTable filters 

Q5 B) Stacked Column Chart 

 

 

6.10 Case Study 

“Visualizing Regional Sales to Improve Strategy” 
 

SoluƟon: 

Use a PivotTable to summarize total revenue and units sold by region. Then insert a 
PivotChart (Column 

Chart) to visually compare sales performance across regions. 

Problem Statement 2: No Clear View of Trends Over Time 

SoluƟon: 

Group the sales data by month and year in the PivotTable. Insert a Line Chart to idenƟfy 
seasonal sales 

trends and long-term growth. 

Problem Statement 3: Inability to Filter by Product Category 

SoluƟon: 

Add a Slicer for Product Category. This allows users to interacƟvely filter the PivotChart to 
view sales by 

category, enabling product-specific strategies. 

InstrucƟons to Learner (AcƟvity): 

You are provided with a dataset of regional sales containing fields like Region, Product 
Category, Sales 

Amount, Units Sold, Return Rate, and Date. 
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1. Create a PivotTable summarizing sales amount by Region and Product Category. 

2. Insert a PivotChart (Column or Line) to visualize performance. 

3. Use Slicers to allow filtering by product category and region. 

4. Add Trendlines or Data Labels to highlight key insights. 

5. Write a brief summary (5–6 lines) explaining which region is leading, any visible trends, 
and one 

recommendaƟon based on the data. 

Deliverable: Excel workbook with PivotTable, PivotChart, slicers applied, and a one-page 
summary 
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0% detected as AI
The percentage indicates the combined amount of likely AI-generated text as 
well as likely AI-generated text that was also likely AI-paraphrased.

Caution: Review required.

It is essential to understand the limitations of AI detection before making decisions 
about a student’s work. We encourage you to learn more about Turnitin’s AI detection 
capabilities before using the tool.

Detection Groups

0 AI-generated only 0%
Likely AI-generated text from a large-language model.

0 AI-generated text that was AI-paraphrased 0%
Likely AI-generated text that was likely revised using an AI-paraphrase tool 
or word spinner.

Disclaimer
Our AI writing assessment is designed to help educators identify text that might be prepared by a generative AI tool. Our AI writing assessment may not always be accurate (i.e., our AI models 
may produce either false positive results or false negative results), so it should not be used as the sole basis for adverse actions against a student. It takes further scrutiny and human 
judgment in conjunction with an organization's application of its specific academic policies to determine whether any academic misconduct has occurred.

Frequently Asked Questions

How should I interpret Turnitin's AI writing percentage and false positives?
The percentage shown in the AI writing report is the amount of qualifying text within the submission that Turnitin’s AI writing 
detection model determines was either likely AI-generated text from a large-language model or likely AI-generated text that was 
likely revised using an AI paraphrase tool or word spinner.
 
False positives (incorrectly flagging human-written text as AI-generated) are a possibility in AI models.
 
AI detection scores under 20%, which we do not surface in new reports, have a higher likelihood of false positives. To reduce the 
likelihood of misinterpretation, no score or highlights are attributed and are indicated with an asterisk in the report (*%).
 
The AI writing percentage should not be the sole basis to determine whether misconduct has occurred. The reviewer/instructor 
should use the percentage as a means to start a formative conversation with their student and/or use it to examine the submitted 
assignment in accordance with their school's policies.

What does 'qualifying text' mean?
Our model only processes qualifying text in the form of long-form writing. Long-form writing means individual sentences contained in paragraphs that make up a 
longer piece of written work, such as an essay, a dissertation, or an article, etc. Qualifying text that has been determined to be likely AI-generated will be 
highlighted in cyan in the submission, and likely AI-generated and then likely AI-paraphrased will be highlighted purple.
 
Non-qualifying text, such as bullet points, annotated bibliographies, etc., will not be processed and can create disparity between the submission highlights and the 
percentage shown.
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Unit 7: Lookup funcƟons 

Learning Outcomes 

1. Understand the purpose of lookup funcƟons in Excel and how they enhance data 
navigaƟon and retrieval 

from large datasets. 

2. Apply the VLOOKUP funcƟon to search for values verƟcally in a structured table. 

3. Use the HLOOKUP funcƟon to retrieve data from rows in horizontally organized data. 

4. Employ the MATCH funcƟon to return the relaƟve posiƟon of a value within a row or 
column. 

5. UƟlize the INDEX funcƟon to return the value of a cell based on its row and column 
posiƟon. 

6. Combine INDEX and MATCH to create flexible, dynamic lookup formulas that overcome 
the limitaƟons 

of VLOOKUP and HLOOKUP. 

7. Compare and select appropriate lookup strategies based on the structure and needs of 
the data. 

Content 

7.0 Introductory Caselet 

7.1 IntroducƟon to Lookup FuncƟons 

7.2 VLOOKUP FuncƟon 

7.3 HLOOKUP FuncƟon 

7.4 MATCH FuncƟon 

7.5 INDEX FuncƟon 

7.6 Combining INDEX and MATCH 

7.7 Summary 

7.8 Key Terms 

7.9 DescripƟve QuesƟons 

7.10 References 

7.11 Case Study 

Page 3 of 33 - AI Writing Submission Submission ID trn:oid:::3618:127424867

Page 3 of 33 - AI Writing Submission Submission ID trn:oid:::3618:127424867



7.0 Introductory Caselet 

“Ravi’s Data Dilemma: Simplifying Student Records with Lookup FuncƟons” 
 

“Ravi, a 28-year-old academic coordinator with a private management insƟtute in Pune, was 
drowning in My swimming pool when he asked for help through his mental notes. 

spreadsheets. Every semester he took all the students’ course registraƟons, their 
marksheets and aƩendance records, groveled on the floor. 

of reports on over 400 students. The data was entered into Excel such that the obtaining 

specific informaƟon?—say, a student’s grade in a parƟcular subject or their overall 
performance—was heartbreakingly 

slow. 

“Do you know the score of Aditya Sharma in Financial Management,” they would ask every 
faculty. 

or “Who got less than 40 marks in Business StaƟsƟcs?”, Ravi had been scrolling manually 
through rows of 

data, filter it and check for accuracy. (Despite being menial these jobs comprised a bulk of 
his. 

day and opened the door to human error. He had a habit of falling behind on deadlines and 
his reports occasionally included 

inconsistencies that resulted in frustraƟon among faculty and students.” 

That all changed, when during a digital skills event, where he encountered Excel’s lookup 
funcƟons— 

VLOOKUP, HLOOKUP, MATCH, and INDEX. He realized for the first Ɵme that Excel could be 
used to do more than just hold 

data—essenƟally it was able to go out and get, and compute for you, data live using the 
right formulas. 

Ravi started with learning VLOOKUP- to look-up the name of a student based on his roll 
numbers. Then, he 

played with INDEX/MATCH to make dynamic grade sheets which could be read both ways. 

He even created summary tables using HLOOKUP according to subjects. What once took 
him 

process that took hours could be done in seconds. 
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Leveraging these tools, Ravi automated many of the administraƟve tasks, minimized 
mistakes, and developed an on-demand.” 

dashboards for faculty. His efficiency increased, for the first Ɵme he felt empowered rather 
than. 

overwhelmed by spreadsheets. 

Ravi’s metamorphosis paves the way for this chapter on Lookup FuncƟons in Excel. In a 
world driven by data, 

professionals need to do more than key in data--they must be trained on how to harvest, 
connect and interpret data. 

efficiently using Excel’s built-in tools. 

CriƟcal Thinking QuesƟon: 

Imagine you were Ravi, so what Excel funcƟon should be the first one you need to know? 
VLOOKUP, HLOOKUP, 

or INDEX–MATCH? Explain your decision in terms of the type of data work you generally 
encounter. 

 

7.1 IntroducƟon to Lookup FuncƟons 

In large spreadsheets and databases, data is oŌen distributed across mulƟple tables, sheets, 
or structures. When 

working with such datasets, it becomes essenƟal to retrieve, compare, or cross-reference 
values quickly and 

accurately. This is where lookup funcƟons in Excel come into play. 

Lookup funcƟons are designed to search for a specific value in a dataset and return a 
corresponding value from a 

related column or row. They are foundaƟonal tools in business analyƟcs, especially when 
handling reports, building 

dashboards, reconciling data, or automaƟng tasks. 

This secƟon introduces the purpose, importance, and applicaƟon scenarios for lookup 
funcƟons in Excel — 

seƫng the stage for deeper exploraƟon of VLOOKUP, HLOOKUP, MATCH, INDEX, and their 
combinaƟons. 

7.1.1 Importance of Lookup FuncƟons in Business AnalyƟcs 
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In the world of business, the data is almost never dwelling in one place. Sales, customer 
informaƟon, pricelists and stocklist. 

lists, and account books are typically found in separate tables or sheets. So the manual 
inquiring is not only Ɵme-consuming but also error-prone. 

Lookup funcƟons enable professionals to: 

• Instantly access data without the need to scroll or filter 

• Automate common elements of a regular report from changes in source data. 

• Avoid redundancy - Using master tables as opposed to duplicaƟng the data 

• Ensure consistency and accuracy of reports and calculaƟons 

Why Lookup FuncƟons MaƩer: 

• ProducƟvity: Minimize Ɵme having to manually find your own that Pokémon Go expert. 

• Accuracy: Avoid making anyone match the numbers or physically copy them 

• AutomaƟon —formulas automaƟcally update as changes are made to input data and can 
be recalculated by pressing a single buƩon. 

• Scalable: Thousands of rows don't slow it down 

Example: 

The simple decision: A sales analyst wants to lookup price from a master price list whenever 
a new order is entered. Instead of 

copy and paste, with a VLOOKUP(), fetch the right price directly from product ID. 

7.1.2 Common Use Cases for Lookup FuncƟons 

• Searching Large Datasets 

• Cross-Referencing Data 

• AutomaƟng Reports 

Below are three of the most reality-temperature use cases where lookup funcƟons come in 
handy in analyƟcs: 

Searching Large Datasets 

If you have hundreds or thousands of entries (e.g., order numbers, customer IDs, employee 
records), use the lookup funcƟon instead. 

tools that quickly locate the row or column corresponding to a matched paƩern, and fetch 
associated informaƟon. 
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Example: 

IdenƟfy the customer name (Customer Name), which is linked to a customer Id in a data set 
of 20,000 records. 

FuncƟons commonly used: 

• VLOOKUP() 

• INDEX() + MATCH() 

Cross-Referencing Data 

Data for a small business is typically split across mulƟple sources — from employee names 
on one sheet to payroll 

data from another. Lookup funcƟons to help join these results together (without using 
database tools). 

Example: 

Just input the inventory code of a product in one sheet and find its supplier informaƟon on 
another menu. 

FuncƟons commonly used: 

• MATCH() 

• VLOOKUP() 

• HLOOKUP() 

• INDEX() 

AutomaƟng Reports 

The lookup formulas are able to dynamically retrieve the values from within a dashboard or 
template, so that when the source data is updated or changed. 

updates, the report updates its behavior on-the-fly. 

Example: 

In a monthly report, retrieve the sales numbers for the current quarter from a dynamic data 
source (without entering either the start or end date). 

changing anything. 

FuncƟons commonly used: 

• INDEX() + MATCH() 

• VLOOKUP() 
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• Named Ranges with MATCH() 

7.2 VLOOKUP FuncƟon 

The VLOOKUP funcƟon is one of the most widely used funcƟons in MicrosoŌ Excel. The 
name VLOOKUP 

stands for VerƟcal Lookup, which means it searches for a value verƟcally down the first 
column of a table and 

then returns a value in the same row from a column you specify. 

It's mainly used when you have a table of data and you want to find something in the table 
based on a known value. 
 

7.2.1 Syntax and Structure of VLOOKUP 

The VLOOKUP funcƟon has the following general syntax: 

VLOOKUP(lookup_value, table_array, col_index_num, [range_lookup]) 

Let’s understand each part: 

lookup_value: 

This is the value you're aŌer to find in the first column of your table. 

Example: Student ID, product name or other unique idenƟfier. 

table_array: 

This is where we put the actual data. 

Ensure the first column of this range contains the value you are looking for. 

col_index_num: 

This is the table column number that contains the value to be returned. 

For instance, to return a value from the second column in your range put 2. 

[range_lookup] (opƟonal): 

This is what tells Excel whether to find an exact match, or an approximate match. 

o Set to FALSE to get an exact match. 

o TRUE (or omiƩed) to find an approximate match. 

Example: 

=VLOOKUP(101, A2:C10, 2, FALSE) 
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This looks for the value 101 in column A of range A2:C10, and then returns the value on the 
same row from column B 

in the same row. 

7.2.2 Using VLOOKUP for Exact Match 

An exact fit is you want a figure that matches the value you provided exactly. 

You have to do this by having the 4th calculaƟon argument of the formula be set FALSE. 

Example: 

You have a list of employees with their departments: 

Employee ID Name Department 

1001 Alice HR 

1002 Bob IT 

1003 Charlie Finance 

If you need to decide a department for Employee ID 1002, then looking up would be 
accomplished with: 

=VLOOKUP(1002, A2:C4, 3, FALSE) 

ExplanaƟon: 

• The target number to hit: 1002. 

• A2:C4 is the data table. 

• 3 is the value you want which is coming out from column number 3 (Department). 

• FALSE is find an exact match. 

The result will be: IT 

If value 1002 is not there in the first column, excel will return an error: #N/A 

Steps: 

InstrucƟon to Learner: 

You are provided with a data of 10 students with the Roll Number, Name and Grade in an 
excel worksheet. 

Develop a basic search tool in which a user can enter a Roll Number in cell G2 and Excel will 
retrieve the results. 
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, you mean put the student Name and Grade based on VLOOKUP(cells "G3" & "G4") and 
exact match. 

To get the Student Name to cell G3 use a VLOOKUP formula. 

In G4, use VLOOKUP to display the student's grade. 

Make Sure The Formula Places FALSE For Exact Match. 

Check the tool with a few roll numbers to make sure it's right. 

Submission: 

Use printscreen on the the excel tool and paste it in Word. Provide 2 example input and 
output. 

 

7.2.3 Using VLOOKUP for Approximate Match 

An approximate match is handy when you’re using ranges of numbers, but not so much for 
text fields. For example, assigning grades based 

on scores or on rates of tax according to income. 

In this case you entered the fourth argument as FALSE, use TRUE (or leave it empty) here. 

But there’s one important rule: 

In order for approximate match to work, your table in the 1st column has to be sorted 
ascending. 

Example: 

You have the following table for grading students: 

Score Grade 

0 F 

50 D 

60 C 

70 B 

85 A 

FOr a score of 66, the grade is: 

=VLOOKUP(66, A2:B6, 2, TRUE) 

ExplanaƟon: 
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• Excel searches the Score column to find the nearest match that is less than or equal to 66. 

• It encounters 60, so the answer is the value in column 2, which is C. 

If the grade was 90, it would return A. 

If the score was 45, it would give back F (the lowest match to be found lower than 45 is 0). 

If the first column doesn't sort in increasing order the output will be garbage. 

 

7.2.4 Common Errors in VLOOKUP and How to Fix Them 

The VLOOKUP funcƟon is enormously warehouse but, unfriendlyly enough, if it's mis-
operated, there will have errors. Below are the most common 

mistakes folks make when working with VLOOKUP, including soluƟons to these issues. 

#N/A Error 

What it means: 

Excel was unable to locate the lookup value in the first column of the table. 

Common causes: 

• The value you’re looking for is not in the second column. 

• There are leading or trailing spaces in the cell; these can be removed with funcƟons such 
as TRIM. 

• You specify FALSE (an exact match), but the corresponding value isn’t found. 

How to fix it: 

• Make sure you’re looking for the right value. 

• Use the TRIM() funcƟon to eliminate extra spaces. 

• Make sure you’re searching in the right column. 

• If you want to prevent mistakes, work with the IFERROR() funcƟon: 

=IFERROR(VLOOKUP(1002, A2:C10, 2, FALSE), "No such user") 

#REF! Error 

What it means: 

You’re asking VLOOKUP to return a value from the nth-1 column number when your chosen 
table only includes n columns. 

Common causes: 

Page 11 of 33 - AI Writing Submission Submission ID trn:oid:::3618:127424867

Page 11 of 33 - AI Writing Submission Submission ID trn:oid:::3618:127424867



• The col_index_num (column number) argument is greater than the number of columns 
that you have in your table range. 

How to fix it: 

• Determine the number of columns in your table range. 

• Make sure your column index isn’t greater than that. 

Example of incorrect formula: 

=VLOOKUP(1002, A2:B5, 3, FALSE) → #REF! 

Because A2:B5 has only 2 columns, and you’re requesƟng the 3rd. 

#VALUE! Error 

What it means: 

You are doing something wrong in the arguments passing to it. 

Common causes: 

• The col_index_num isn't a valid number (for example, it's a text value). 

• An input to the funcƟon is invalid. 

How to fix it: 

• Ensure the col_index_num is a number, not text or an empty cell. 

Incorrect Results 

What it means: 

VLOOKUP provides a result, but not the one hoped for. 

Common causes: 

• Instead of FALSE, you accidentally used TRUE (which is an approximate match). 

• Your table is unsorted in the case of approximate match; it starts with “15.” 

• Duplicate values in the date column, which VLOOKUP helps you pull data from but will 
return only the first match. 

How to fix it: 

• Use FALSE on exact matches unless you're certain that's what you want. 

• Order the first column for TRUE. 

• Search for exact matches in the first column. 

Table Range Moves or Changes 
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What it means: 

Say in case you get your data updated and there are some new rows added, then VLOOKUP 
can't deliver those or will fail to add them if the range is hardcoded. 

Common cause: 

• You typed a fixed range like A2:C10 by hand, and new data arrives in row 11 or beyond. 

How to fix it: 

• Power Apps: Dynamic named range or Excel Table (Insert > Table) 
respondsToSelector.trigger.postMessage with the data being passed in as an argument. 

• Or employ a broader range like A2:C1000, which will include future data. 

Case SensiƟvity 

What it means: 

By the way, VLOOKUP is case-insensiƟve so "APPLE" and "apple" to it are idenƟcal. 

If you need case-sensiƟve lookup: 

• VLOOKUP won't work. You would have to use more complex fomulas like INDEX + MATCH 
+ 

EXACT. 

 

7.3 HLOOKUP FuncƟon 

The HLOOKUP funcƟon in Excel is similar to VLOOKUP, but instead of searching verƟcally in 
columns, it 

searches horizontally across rows. 

The "H" in HLOOKUP stands for Horizontal. This funcƟon is useful when your data is arranged 
in rows rather 

than columns. 

7.3.1 Syntax and Structure of HLOOKUP 

The generic formula for the HLOOKUP funcƟon is: 

HLOOKUP(lookup_value, table_array, row_index_num, [range_lookup]) 

ExplanaƟon of each part: 

lookup_value: 
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The value you want to return by looking up the corresponding value in the First table row. 

table_array: 

The complete span of cells that the data covers. That is, the funcƟon to look up a value in 
the first row of this 

range 

row_index_num: 

The number of the row in the table array from which to return a value. 

For example, if you are looking up values in B2:D11, then A3 would correspond to row 2. 

[range_lookup] (opƟonal): 

o FALSE to perform an exact match. 

o Use TRUE (or omit) to do an approximate match. 

Example: 

=HLOOKUP("Math", A1:D3, 2, FALSE) 

This will look for "Math" in the first row of A1:D3 and pull the value from the second row 
within the column. 

where "Math" is found. 

 

7.3.2 Using HLOOKUP for Row-Based Searches 

HLOOKUP is for when you have a horizontal data set arranged with labels in the top row and 
both of the start and lookup values run from top to boƩom down one column. 

corresponding data in rows below. 

Example: 

A B C D 

Math English Science History 

Marks 85 90 78 88 

Grade B A C+ B+ 

You wish to search for the grade of English. 

Formula: 

=HLOOKUP("English", A1:D3, 3, FALSE) 
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ExplanaƟon: 

• Find “English” in the first row. 

• And then, return the value from row 3 of that column (the Grade row). 

• Because we’re deploying FALSE, Excel searches for an exact match. 

Result: A 

If the value is not located in row 1, it will return #N/A 

 

7.3.3 PracƟcal Scenarios for HLOOKUP 

HLOOKUP is most helpful when your data are listed along rows and your labels are listed 
across columns or vice versa. 

the first row. Some pracƟcal uses include: 

Student Report Cards 

You've got subjects across the very first row; below are marks, grades remarks etc. 
HLOOKUP helps 

you pick informaƟon up by the subject name. 

Monthly Sales or Performance Data 

Jan Feb Mar Apr 

Sales 100 120 130 110 

Target 90 100 125 100 

Then to the sales in March, you can add: 

=HLOOKUP("Mar", A1:E3, 2, FALSE) 

In order to target in April use: 

=HLOOKUP("Apr", A1:E3, 3, FALSE) 

Survey Results 

The survey quesƟons are in columns and responses are in rows. A similar type of operaƟon 
can be performed with HLOOKUP to pull a 

response to a parƟcular quesƟon. 

Time-Based Data Tables 
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HLOOKUP can be used to pull data on some specific period, if the Ɵme intervals (for example 
Q1,Q2, Q3 ) are laid in the first row. 

Pricing Tables 

On the first row are listed products or services, from then on you can list with rows below 
prices, customer discount and stock levels. 

 

7.4 MATCH FuncƟon 

The MATCH funcƟon in Excel is used to find the posiƟon of a value in a row or column. It 
doesn't return the 

value itself—only the posiƟon number where the value appears. 

This is useful when you want to know the locaƟon of a value in a range, especially when 
used together with other 

funcƟons like INDEX. 
 

7.4.1 Syntax and Structure of MATCH 

Syntax The general syntax is: =MATCH( search_value , main_range,[ match_type ]).excuse 
me Sir. 

MATCH(lookup_value, lookup_array, [match_type]) 

ExplanaƟon of each part: 

lookup_value: 

The value you want to look for in the range. 

lookup_array: 

The range (row or column) you want Excel to find the value in. 

[match_type] (opƟonal): 

This is how we tell Excel to correspond that value: 

o 0 = Exact match 

o 1 Less than or equal (approximate match; must be sorted in ascending order) 

o -1 = Greater than or equal (Must work in descending order) 

If you omit it, Excel assumes a match lookup type of 1 (an approximate match with an 
ascending order). 
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Example: 

=MATCH(50, A1:A5, 0) 

So, if the figure 50 is in cell A3, this formula returns a result of 3 (since it’s the third value in 
A1:A5). 

 

7.4.2 Finding PosiƟon of Values in Rows/Columns 

The MATCH funcƟon is super useful for finding the relaƟve posiƟon of a value in a list–say, 
your weekly revenue or year-end sales by department. 

Example 1: Column Search 

Say you have a list of products in column A: 

A 

Apple 

Banana 

Orange 

Mango 

=MATCH("Orange", A1:A4, 0) 

Excel searches for "Orange" and find it on the 3rd locaƟon in the list. 

Example 2: Row Search 

If they are standing in a line: 

=MATCH("English", B1:D1, 0) 

Excel returns 2, because "English" is the second item in the range B1:D1. 

7.4.3 MATCH with Exact vs Approximate Match 

Exact Match (match_type = 0) 

Use this when you’re looking for the precise amount. 

=MATCH(75, A1:A5, 0) 

If 75 does not exist in the list, Excel would return #N/A. 

Use this when: 

• You're dealing with names, IDs or precise numbers. 

• You don’t want Excel to guess or round off to the nearest value. 
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Approximate Match (match_type = 1 or -1) 

match_type = 1 

Finds the maximum value that is less than or equal to the lookup value. 

The result list should be in ascending order. 

Example: 

A 

50 

60 

70 

80 

=MATCH(65, A1:A4, 1) 

Excel returns 2, because 60 is the highest value that does not exceed 65. 

match_type = -1 

Returns smallest value that is greater than or equal to lookup_value. 

The list is in descending order. 

Example: 

=MATCH(85, A1:A4, -1) 

Excel returns 2, because 90 is the first value that is greather than or equal to 85 

Steps: 

InstrucƟon to Learner: 

“Prepare a table of rate for various slabs in ascending order. Use the MATCH funcƟon with 

nearest tax bracket, where income is check into which bracket it falls.” 

In column A type : Income slabs: 0, 250000, 500000, 750000, 1000000. 

On column B, type corresponding tax percentages: 0%, 5%, 10%, 15%, 20%. 

Type 620000 (or any other income) in cell D1. 

Find the proper slab index by MATCH(D1, A1:A5, 1). 

Apply INDEX(B1:B5, result_from_match) to get the corresponding rate of tax. 

Submission: 
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Hand in the Excel file that demonstrates MATCH and INDEX with at least 3 test values 
(values of income). 

resulƟng tax brackets. 

 

7.5 INDEX FuncƟon 

In Excel, the INDEX funcƟon is used to return a value at a given posiƟon in an array or range. 

While VLOOKUP or HLOOKUP are used to search for the value, INDEX pulls out a content at 
specified locaƟon. 

locaƟon. It is powerful — especially when enhanced by funcƟons such as MATCH. 

7.5.1 Syntax and Structure of INDEX 

There are two types of INDEX funcƟon in general: 

Array form 

INDEX(array, row_num, [column_num]) 

• array: The range of cells you are operaƟng on. 

• row_num - The number of the row from which to return a value. 

• column_num: (opƟonal) the column number to extract from (if there are mulƟple 
columns in the array). 

Example: 

=INDEX(A2:C5, 2, 3) 

This means: 

• Look in the range A2 to C5. 

• Enter row 2 and column 3 in that range. 

• Return that cell’s value. 

Reference form 

INDEX(reference, row_num, [column_num], [area_num]) 

It's useful when you have several ranges and want to sample from a parƟcular one. 

The array form is what most people need and is far less complex to use. 

7.5.2 ExtracƟng Data from a Specific Row/Column 
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The INDEX formula enables you to lookup a value directly using row number and column 
number. 

 

Example 1: Single Column 

 

A 

 

Apple 

 

Banana 

 

Cherry 

 

=INDEX(A1:A3, 2) 

 

This will return “Banana” as it’s the 2nd item in your list. 

 

Example 2: MulƟple rows and Columns 

 

A B C 

 

ID Name Marks 

 

101 Alice 85 

 

102 Bob 90 

 

=INDEX(A2:C3, 2, 3) 
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This returns 90: 

 

• In the 2nd row of the range (Bob’s row), 

 

• 3rd column (Marks). 

Did You Know? 

“Did you know that the INDEX funcƟon can return an enƟre row or column—**not just a 
single value? By omiƫng the row_num or column_num parameter, INDEX can return full 
arrays. For example: =INDEX(A2:D5, 0, 2) This returns all values from column 2 in the range 
A2:D5. It’s useful for dynamic charts or condiƟonal formaƫng based on row/column data.” 

7.5.3 Examples of INDEX for Data Retrieva 

Basic Data Lookup 

 

Given the table: 

 

A B C 

 

ID Name Score 

 

201 Raj 78 

 

202 Simran 85 

 

203 Aman 92 

 

To Retrieve Name of 3rd Entry: 

 

=INDEX(B2:B4, 3) 
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Result: Aman 

 

To get Score of 2nd entry: 

 

=INDEX(C2:C4, 2) 

 

Result: 85 

 

Use with MATCH (dynamic lookup) 

 

To look up a student’s grade based on name with the INDEX and MATCH: 

 

=INDEX(C2:C4, MATCH("Simran", B2:B4, 0)) 

 

ExplanaƟon: 

 

• MATCH("Simran", B2:B4, 0) gives 2 (the row with Simran). 

 

• INDEX(C2:C4, 2) returns 85. 

 

Two-Dimensional Lookup 

 

A B C 

 

Math Science English 

 

John 80 85 78 
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Sarah 90 88 82 

 

To find Sarah’s Science score: 

 

=INDEX(B2:D3, 2, 2) 

 

• 2nd row → Sarah 

 

• 2nd column → Science 

 

Result: 88 

7.6 Combining INDEX and MATCH 

The INDEX–MATCH combinaƟon is a powerful alternaƟve to VLOOKUP. It allows you to look 
up values 

dynamically in any direcƟon (not just to the right like VLOOKUP) and is more flexible and 
robust for large or 

complex data sets. 

7.6.1 Why Use INDEX–MATCH Instead of VLOOKUP? 

Key advantages: 

Can look leŌ: 

VLOOKUP can only look up values to the right of the lookup column. INDEX– 

MATCH may search in any direcƟon —  leŌ, right, up or down. 

More efficient in large datasets: 

INDEX–MATCH performs faster than VLOOKUP, parƟcularly on larger sets of data. 

Less prone to breaking: 

Note that VLOOKUP uses column numbers, and that inserƟng/deleƟng columns can cause 
issues with the formula. INDEX– 

MATCH works with cell references so it will adjust automaƟcally. 
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BeƩer for dynamic ranges: 

INDEX–MATCH is more versaƟle if you want to do complex lookups (such as nested or two-
way). 

 

7.6.2 Syntax and Structure of INDEX–MATCH 

The construcƟon consists in the nesƟng of MATCH funcƟon into INDEX one. 

General Syntax: 

=INDEX(return_range, MATCH(lookup_value, lookup_range, 0)) 

ExplanaƟon: 

• lookup_value The value you are looking for. 

• lookup_range: The range in which Excel should look for the value. 

• return_range: The range that Excel will return. 

• 0: This indicates an exact paƩern. 

 

7.6.3 PracƟcal Examples of INDEX–MATCH for Complex Lookups 

Example 1: Simple Lookup (like VLOOKUP) 

A B C 

ID Name Score 

101 Alice 78 

102 Bob 85 

103 Charlie 90 

Aim: What is the score of "Bob". 

=INDEX(C2:C4, MATCH("Bob", B2:B4, 0)) 

• MATCH("Bob", B2:B4, 0) returns 2 (Bob appears in the 2nd row of that range). 

• INDEX(C2:C4, 2) returns 85. 

Example 2 – We Lookup to LeŌ (Facility is not available in VLOOKUP) 

You would like to retrieve the ID for "Charlie" based on Name. 

=INDEX(A2:A4, MATCH("Charlie", B2:B4, 0)) 
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This gives back 103, which is to the leŌ of the name column. 

Example 3: Lookup (Row and Column) in Two Dimensions 

B C D 

Math Science English 

John 80 85 78 

Sarah 90 88 82 

To find Sarah’s English score: 

=INDEX(B2:D3, MATCH("Sarah", A2:A3, 0), MATCH("English", B1:D1, 0)) 

ExplanaƟon: 

• MATCH("Sarah", A2:A3, 0) → 2 Note: In the above formulas: "Sarah" is the specific value 
you want to search for, and it's case-insensiƟve... A2:A3 is the column or row range where 
you want to search for value Sarah. 

• MATCH("English", B1:D1, 0) → Column 3 Example:=MATCH("English", B1:D1, 0) → column: 
3 

• INDEX returns value at posiƟon (2,3) in range → 82 

Example 4: Dynamic Column SelecƟon 

If the user chooses a subject in a dropdown (a drop-down for example is in cell F1 with 
“Math”), here’s how to get John’s score with this formula: 

=INDEX(B2:D2, MATCH(F1, B1:D1, 0)) 

This is part of the setup for "dashboards" or interacƟve reports. 

 

Knowledge Check 1 

Choose the correct opƟon: 

1. Which of the following funcƟons is best used to search for a value in a horizontal row of a 
table? 

A) VLOOKUP 

B) INDEX 

C) HLOOKUP 

D) MATCH 
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2. What will the following formula return? 

=MATCH(85, A2:A6, 0) 

A) The value 85 

B) The posiƟon of 85 in range A2:A6 

C) #N/A error if 85 is not found 

D) Both B and C 

3. What is the key reason for using INDEX–MATCH over VLOOKUP? 

A) It’s easier to write 

B) It can search in any direcƟon 

C) It only works with sorted data 

D) It can replace charts 

4. In the formula =VLOOKUP(102, A2:C6, 4, FALSE), what kind of error will this return? 

A) #NAME? 

B) #N/A 

C) #REF! 

D) No error 

5. Which of the following is not true about MATCH funcƟon? 

A) It returns the actual value from the range 

B) It can do both exact and approximate matches 

C) It returns the posiƟon of the matched value 

D) It is oŌen used inside the INDEX funcƟon 

 

7.7 Summary 

This lesson discussed different lookup funcƟons in excel which are very important for 
searching and geƫng the data 

efficiently. The funcƟons covered include: 

• VLOOKUP: Looks verƟcally in one table and returns a value from the same posiƟon in 
another. 

• HLOOKUP: Looks up horizontally, and finds a value in a row. 
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• MATCH: Locates the posiƟon of a value in a row or column. 

• INDEX : Returns the value at a parƟcular row and column within a range. 

• INDEX-MATCH:A combinaƟon which offers a more flexible and stronger alternaƟve to 
VLOOKUP or 

HLOOKUP. 

These features assist in sorƟng, analyzing and automaƟng data work to such an extent that 
excel becomes a very useful tool for data.engrainedsorƟng, analyzing and automaƟng the 
kind of grunt work it takes to be a real wizard. 

handling 

 

7.8 Key Terms 

Term DefiniƟon 

Lookup Value The value you want to find in a row or column. 

VLOOKUP FuncƟon to look verƟcally in a table to get the result from one column. 

HLOOKUP The funcƟon searches for a value in the top row of a table or an array of values, 
and then returns a value in the same column from a specified row. 

An Excel MATCH FuncƟon that Highlights the PosiƟon of a Value in a Row or Column. 

INDEX/Returns the value of a cell in a table based on the column and row number. 

Exact Match A search for a value that is exactly the same as the lookup value. 

Closest Approximate Match A type of match that returns the closest (less than or greater 
than) value, based upon 

sorƟng. 

Flexible Lookup A lookup that changes according to user input or as condiƟons change. 

222 

Two-Dimensional 

Lookup 

Quickly select the element in the dataframe both by row and column number. 

 

7.9 DescripƟve QuesƟons 
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What do lookup formulas in Excel do? Explain with examples. 

 

Compare VLOOKUP and HLOOKUP funcƟons. When would you use each one? 

 

Illustrate the syntax of MATCH and provide an example. 

 

How does the INDEX funcƟon differ from VLOOKUP and how does it work? 

 

Why is INDEX-MATCH beƩer than VLOOKUP? 

 

Create an Excel funcƟon with the /INDEX and MATCH funcƟons/ to get a student's grade 
based on his or her name. 

 

Describe the disƟncƟon between having an exact or approximate search in lookup 
funcƟons. 

 

Explain a situaƟon in the real world where INDEX – MATCH would be more appropriate to 
use than VLOOKUP. 

 

Why could VLOOKUP results in #N/A or #REF! error? How can it be resolved? 

 

Write a 2-D lookup formula by using the INDEX and MATCH funcƟons. 

7.10 References 

1. MicrosoŌ Excel Official DocumentaƟon – Lookup and Reference FuncƟons 

hƩps://support.microsoŌ.com/excel 

2. Excel Jet – Tutorials on VLOOKUP, INDEX, MATCH, and more 

hƩps://exceljet.net 

3. GCF Learn Free – Excel Formulas and FuncƟons 
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hƩps://edu.gcfglobal.org/en/excel/ 

4. TeachExcel – Advanced Lookup Formulas in Excel 

hƩps://www.teachexcel.com 

Answers to Knowledge Check 

Knowledge Check 1 

1. C) HLOOKUP – used for horizontal row searches. 

2. D) Both B and C – returns posiƟon or #N/A if not found. 

3. B) It can search in any direcƟon – unlike VLOOKUP. 

4. C) #REF! – column index exceeds table range. 

5. A) It returns the actual value from the range – this is incorrect; it returns posiƟon 

7.11 Case Study / PracƟcal Exercise 

 “Using Lookup FuncƟons to Streamline Student InformaƟon Systems” 

IntroducƟon 

“As educaƟon insƟtuƟons who handle students records, course data, etc.’s and permissions 
on large files volumes; it is very important to manage data efficiently. 

registraƟons, marksheets, and reporƟng. When managing hundreds or thousands of 
records, manual 

the searching for knowledge is not efficient, there are a lot of mistakes and it wastes Ɵme. 

Excel has a range of powerful lookup and reference funcƟons (LOOKUP, VLOOKUP, HLOOKUP, 
MATCH) 些4 that you can use to retrieve data based on criteria (for instance the least or 
highest value in a range of cells). 

INDEXes–that assist to automate data lookups. Also, using INDEX and MATCH:Is also useful 

more flexible and accurate than a tradiƟonal look up. This caselet discusses how these 
roles can 

streamline student informaƟon systems, featuring the problems of college administraƟon 
around manual data processing and providing 

Excel-based soluƟons using lookup techniques.” 

Background 

At a medium-size college, the administraƟon receives course outcomes for approximately 
~1,000 students every Fall. 
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semester. Data of individual students contains roll number, name, marks in all subjects and 
grade. 

In the beginning, all of this was done by hand or with crappy spreadsheets. Staff would 
search through large 

files in order to locate the grades of a student or calculate ranks. This frequently resulted in 
reporƟng delays, double counƟng and 69 

inconsistencies in data. 

To address this, the department started looking at Excel's lookup funcƟons to ease the 
process and 

reporƟng process. These were the funcƟon’s that fetches marks, grade or student etc 
directly on a roll number. 

serving the number of or subjects examined, hereby saving effort and reducing human 
mistake. 

Problem 1: Slow Return of Records of (Results and Payment) (a) The report states Delay in 
generated student’s result, it means that the data for each student are being sent to 
headquarters at different Ɵme which delays the processing. 

when you have more than thousand students and mulƟple columns of data (roll number, 
name, subject scores, grade) 

It would take a long Ɵme finding marks of a parƟcular student in percentage especially 
when we had rush at our peak Ɵmes, i.e result ment. 

announcements. 

SoluƟon: 

With the help of VLOOKUP funcƟon, the staff members can lookup for a student's record by 
wriƟng their roll in no Ɵme. 

number in a designated cell. The system retrieves the matching informaƟon including name, 
subject etc., automaƟcally. 

marks, and grade of the master table. 

Formula example: 

=VLOOKUP(101, A2:E1001, 3, FALSE) 

This brings us the 3rd column value (i.e., Math score) of the student whose roll number is 
101. 

MCQ 
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What is the best method to Get a student record based on rollno. 

A) SUM 

B) VLOOKUP 

C) COUNTIF 

D) CONCATENATE 

Answer: B) VLOOKUP 

ExplanaƟon:VLOOKUP searches for a value in the first column of a table and returns a value 
correspondnig to it. 

value from a specified column. 

Problem 2: VLOOKUP'S Drawback in LeŌ-to-Right Lookup 

The department might someƟmes need to look for the roll number based on student name, 
and there’s VLOOKUP 

only works on the right of the lookup column. This then led to a lack in dynamic 
searchability. 

SoluƟon: 

With INDEX MATCH this can even be done regardless of direcƟon (i.e. searching to the leŌ, 
right, etc.) with an array formula. 

and fetch data dynamically. 

Formula example: 

=INDEX(A2:A1001, MATCH("Alice", B2:B1001, 0)) 

This will return in home worksheet 1 the roll number (column A) for student having the 
name as Alice. 

MCQ 

Which combinaƟon of funcƟons does the trick: allows to look-up right-to-leŌ? 

A) HLOOKUP and IF 

B) MATCH and COUNT 

C) INDEX and MATCH 

D) SUM and VLOOKUP 

Answer: C) INDEX and MATCH 
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ExplanaƟon: You can use INDEX and MATCH together to return values from any column 
regardless. 

to the leŌ (whereas VLOOKUP can only look to the right). 

Problem Statement 3: CreaƟng Reports that are InteracƟve at the level of Subject Names 

Staff oŌen have to be able to filter data on subject names (which can get put in the wrong 
format), when preparing for results. 

first row), like all students' grades for "Science". 

SoluƟon: 

use HLOOKUP to look horizontally across the row of subject names and bring in their 
respecƟve scores for 

a student. 

Formula example: 

=HLOOKUP("Science", B1:E3, 2, FALSE) 

This locates the subject “Science” in first row and returns second row value – for example, 
Alice score. 

MCQ 

What funcƟon looks at data through rows and not columns? 

A) VLOOKUP 

B) INDEX 

C) HLOOKUP 

D) OFFSET 

Answer: C) HLOOKUP 

ExplanaƟon: HLOOKUP searches for a value in the top row and returns data from a row you 
specify. 

same column. 

Conclusion 

EducaƟonal establishments can easily control the data by using Excel’s lookup funcƟons. 
FuncƟons like 

Individual together or in combinaƟon, VLOOKUP and HLOOKUP with MATCH and INDEX 
provide powerful magic that could be slightly complex to effecƟvely understand. 
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dynamic data retrieval soluƟons. OrganizaƟons can Also, by subsƟtuƟng manual searches 
with lookup formulas,. 

minimize errors, accelerate workflow, and improve reporƟng. 

This is a caselet to show that with some simple Excel funƟons used appropriately, we can 
addimpse… 

efficiency and inject accuracy into huge data systems. 
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*% detected as AI
AI detection includes the possibility of false positives. Although some text in 
this submission is likely AI generated, scores below the 20% threshold are not 
surfaced because they have a higher likelihood of false positives.

Caution: Review required.

It is essential to understand the limitations of AI detection before making decisions 
about a student’s work. We encourage you to learn more about Turnitin’s AI detection 
capabilities before using the tool.

Disclaimer
Our AI writing assessment is designed to help educators identify text that might be prepared by a generative AI tool. Our AI writing assessment may not always be accurate (i.e., our AI models 
may produce either false positive results or false negative results), so it should not be used as the sole basis for adverse actions against a student. It takes further scrutiny and human 
judgment in conjunction with an organization's application of its specific academic policies to determine whether any academic misconduct has occurred.

Frequently Asked Questions

How should I interpret Turnitin's AI writing percentage and false positives?
The percentage shown in the AI writing report is the amount of qualifying text within the submission that Turnitin’s AI writing 
detection model determines was either likely AI-generated text from a large-language model or likely AI-generated text that was 
likely revised using an AI paraphrase tool or word spinner.
 
False positives (incorrectly flagging human-written text as AI-generated) are a possibility in AI models.
 
AI detection scores under 20%, which we do not surface in new reports, have a higher likelihood of false positives. To reduce the 
likelihood of misinterpretation, no score or highlights are attributed and are indicated with an asterisk in the report (*%).
 
The AI writing percentage should not be the sole basis to determine whether misconduct has occurred. The reviewer/instructor 
should use the percentage as a means to start a formative conversation with their student and/or use it to examine the submitted 
assignment in accordance with their school's policies.

What does 'qualifying text' mean?
Our model only processes qualifying text in the form of long-form writing. Long-form writing means individual sentences contained in paragraphs that make up a 
longer piece of written work, such as an essay, a dissertation, or an article, etc. Qualifying text that has been determined to be likely AI-generated will be 
highlighted in cyan in the submission, and likely AI-generated and then likely AI-paraphrased will be highlighted purple.
 
Non-qualifying text, such as bullet points, annotated bibliographies, etc., will not be processed and can create disparity between the submission highlights and the 
percentage shown.
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Unit 8:  Decision Making with Excel Tools 

 

Learning Outcomes 

1. Learn the why, what and how of a decision-making tools in Excel when you apply those to 

solving business critical and analytics problems. 

 

2. Use the Goal Seek feature to find input values necessary to achieve goals in formula-based 

models. 

 

3. Build and control a scenario with the Scenario manager to compare many 'what if?' view of 

table or range in an organized and automatic way. 

 

4. Use one and two-variable data tables to explore how different inputs affect various results 

in multiple scenarios. 

 

5. Interpret results of decision-making tools for planning, forecasting and strategic decisions. 

 

6. Embed decision tools in large Excel models to create an interactive, nonmanually calculated, 

user experience. 

 

Content  

8.0 Introductory Caselet  

8.1 Introduction to Decision-Making Tools in Excel  

8.2 Goal Seek  

8.3 Scenario Manager  

8.4 Data Tables  

8.5 Summary  

8.6 Key Terms  

8.7 Descriptive Questions  

8.8 References  

8.9 Case Study 

 

8.0 Introductory Caselet 

“Maya’s Forecasting Challenge: Turning Assumptions into Insights” 

Page 3 of 17 - AI Writing Submission Submission ID trn:oid:::3618:127429016

Page 3 of 17 - AI Writing Submission Submission ID trn:oid:::3618:127429016



Maya, a 32-year-old finance manager at an up-and-coming consumer electronics company in 

Hyderabad, had a quarterly problem. Her job: predicting sales, estimating marketing expenses and 

forecasting profitability for three new product lines. Maya had extensive Excel skills, but she was 

trapped in a cycle of trial and error — changing the numbers in one cell to see how totals moved in 

another, copying and pasting formulas, reworking her sheets whenever a new “what if” came from 

her leadership team. 

At a monthly strategy meeting, her CFO had posed the question: “What does it mean for our bottom 

line if we sell 15% fewer headphones but spend 20% more on marketing?” Maya wasn’t sure how 

to respond. Her spreadsheet model couldn’t efficiently accommodate multiple variables or changing 

inputs. She wanted a faster, more dynamic way to model business results across changes of 

variables without needing to update cells one-by-one. 

Learning Guide Maya, frustrated she hadn’t found it all, then began to investigate the built-in What-

If Analysis tools of Excel: Goal Seek, Scenario Manager and Data Tables. She discovered that these 

tools could enable her to set profit targets and allow Excel to determine the types of sales needed. 

They enabled her to create various market condition simulations, test and compare them in one 

click. She could even build a table, displaying how different values of two factors — maybe price 

and units sold — affected the profit margin. 

With these tools interwoven, Maya evolved her predictive model into an adaptive decision-making 

machine. Her leadership team found worth in her scenario reports and data tables that enabled 

them to instantly play with outcomes. Maya was finally free to think about strategy, not just 

spreadsheets. 

This case provides a tangible application for Excel’s decision support tools and establishes the 

groundwork for how they can be used to drive evidence-based planning, forecasting, and risk 

assessment in contemporary business settings. 

Critical Thinking Question: 

If you were Maya, which tool would you use first to help forecasting, Goal Seek, Scenario Manager 

or Data Tables? Explain your selection, using an example from work or the classroom. 

 

8.1 Introduction to Decision-Making Tools in Excel 

Microsoft Excel has proven to be much more than a spreadsheet tool for number crunching and data 

entry—it is also an invaluable decision-making support tool capable of helping users analysing 

alternative courses of action, measuring their potential consequences, managing uncertainty and 

making sound business decisions. One of the key facilities that facilitates this is What-If Analysis, 
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which allows users to play with variables, change inputs and see outcomes but without changing the 

basic data structure. 

8.1.1 Role of Excel in Business Decision-Making 

The role of Excel in business is very important as well planning, forecasting, budgeting and strategic 

planning. Through its decision-making aids, organizations are able to: 

• Model multiple scenarios using the estimate by plugging in the relevant variables (such as price, 

cost and sales volume). 

• Understand the optimal action given historical data trends and performance metrics. 

• Investigate what-if scenarios without re-creating entire models. 

• Improve teamwork by empowering stakeholders to explore alternative scenarios. 

For instance, a company might seek to understand the relationship between ad spending and sales 

revenue. But instead of guessing, Excel allows them to model this connection using built-in tools. 

8.1.2 Importance of What-If Analysis 

With What-If Analysis, you can respond to important business-related questions such as: 

• How do we respond if our cost of production rises 10%? 

• What quantity should we sell to realize a target profit? 

• If we drop our price by 5%, what will our revenue be? 

This type of analysis is useful because: 

• It supports data-driven decisions. 

• It minimizes uncertainty by showing us different scenarios. 

• It enables pre-risk and opportunity evaluation. 

• It’s flexible, so you can test new business ideas quickly without having to build new data 

structures. 

Put succinctly, What-If Analysis helps you work proactively rather than reactively. 

8.1.3 Types of What-If Analysis Tools in Excel 

You have three primary What-If tools in Excel each for a different decision-making function: 

Tool Purpose Example 

Goal Seek Determines the input required to produce a specified output What price do you need in 

order to make ₹1,00,000 profit? 

Scenario Manager Compare several sets of input values and the results they yield Best, worst, most-

likely case sales scenarios 

Data Tables Demonstrates the effect on output by changing few inputs at a time What is the impact 

of Interest rate and Tenure on EMI? 
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You can find these tools in Excel under Data → What-If Analysis and they are commonly used in 

corporate finance, operations, marketing and project management to model decisions and selecting 

the most efficient strategies. 

8.2 Goal Seek 

Goal Seek is one of Excel’s most practical What-If Analysis tools, used to find the right input 

value when the desired output is known. It is useful in situations where you know the result 

you want, but not the exact value that will get you there. 

 

8.2.1 Concept and Use of Goal Seek 

 

Spotting the Question Goal Seek can answer this type of question: 

“What do I put in this cell X such that the formula of this cell Y results in a value Z?” 

In other words: 

• You have specified a value to be reached by a cell that contains a formula. 

• Excel varies the input cell until the formula yields an answer of some kind. 

Key Features: 

• It runs from output back to input. 

• Only one variable is used at a time. 

• Simple to use - you don't have to be an expert in Excel. 

Example Concept: 

Suppose your formula is: 

=Price * Quantity – Cost 

Now you're asking what number must be sold to have a profit of ₹10,000. Goal Seek can do the 

math for you in no time. 

 

 

“Did you know that Goal Seek can work backward through formulas with nested functions and 

multiple references? 

“Even if your output cell includes complex formulas (e.g., =IF(A1*B1>50000, A1*B1*0.1, 

A1*B1*0.05)), Goal Seek can still trace through the logic to determine what input value will result in 

a specific outcome. It’s not limited to simple arithmetic.” 

 

8.2.2 Steps to Apply Goal Seek in Excel 

 

Page 6 of 17 - AI Writing Submission Submission ID trn:oid:::3618:127429016

Page 6 of 17 - AI Writing Submission Submission ID trn:oid:::3618:127429016



How to Implement Goal Seek: 

Prepare your worksheet with a formula that depends on some input cell. 

Go to the Excel Ribbon: 

Data tab → What-If Analysis → Goal Seek. 

In the Goal Seek dialog box: 

o Set cell: Pick the cell of the formula, which you want to obtain a certain result. 

o Value to: Type in the value/result you wish to achieve. 

o Change cell: Select the cell you input value of which Excel will change. 

Click OK. Excel will go through this values, test one by one until it finds the best solution. 

Click OK once more to keep the calculation result, or click Cancel to discard it. 

Note: You can use Goal Seek for only one changing input at a time. For more variables, use Solver. 

 

 

Instruction to Student: 

You are managing a product with the following financial structure: 

 Fixed Cost: ₹75,000 

 Selling Price per Unit: ₹500 

 Variable Cost per Unit: ₹300 

You want to find out how many units you must sell to break even (i.e., net profit is 

zero). 

Steps: 

1. Create the following formula in Excel: 

Net Profit = (Selling Price × Units Sold) – (Fixed Cost + Variable Cost × Units Sold) 

2. Use Goal Seek to set the Net Profit cell to 0, by changing the Units Sold cell. 

3. Record the result (break-even units) and submit a short explanation (2-3 lines) 

describing what the result means for business planning. 

 

8.2.3 Practical Business Applications 

 

Goal Seek is used in finance to plan, predict and make decisions. Here are two common 

applications: 

Break-Even Analysis 

Objective: Determine the number of units you need to sell to cover all costs (so, break even). 

Example Setup: 
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• Fixed Costs = ₹50,000 

• Cost of Sales per unit (Selling price/unit) = ₹ 500 

• The cost of the Variable per Unit = ₹300 

• Profit = (Price - Variable cost) × Quantity – Fixed cost 

The average quantity at which Profit = 0 is Solution: Use Goal Seek to set Profit = 0 by changing 

Quantity. 

Output: The smallest amount of units needed to make a profit. 

Profit Targeting 

Goal: Calculate the amount of sales required to meet a desired profit. 

Example Setup: 

• Target Profit = ₹25,000 

• Same cost structure as above 

Use Goal Seek, Profit = ₹25,000 by changing Quantity. 

Output: How many units you need to sell to reach the profit. 

8.3 Scenario Manager 

Excel’s Scenario Manager is a What-If Analysis tool used to create and compare multiple 

business scenarios by changing several input variables at once. It is especially valuable in 

financial planning, budgeting, and forecasting, where decision-makers need to examine how 

changes in assumptions affect the final results. 

8.3.1 Introduction to Scenario Manager 

Scenario Manager allows users to: 

• Pop out multiple model iterations by changing important inputs. 

• Save these versions as "scenarios" under given names, without changing the original worksheet 

data. 

• Automatic swapping between scenarios to see the effect on calculationalls. 

• Produce comparative summaries to describe results from varying inputs. 

This is a very handy feature to have for testing and sensitivity analysis of tactical choices. 

8.3.2 Creating Different Scenarios 

In order to effectively utilize Scenario Manager, the following are required: 

• Changing Cell: This is the input cell which will change between the different scenarios. 

• Scenario Names: Each scenario should have a unique name that is descriptive. 

• Value: Diverse values are specified for each scenario. 

Steps to create a scenario: 

Be ready to have your worksheet formulas and input values at hand. 
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Click on the Data tab > What-If Analysis button > Scenario Manager. 

Click Add to specify a new scenario. 

Call it the Whatever Case (Beswt/Worst/Whatever). 

Choose the cells that change (e.g., total cost, units sold and price). 

Replace them with the new values. 

Repeat to create additional scenarios. 

After you create it, you can view or switch between scenarios to see how outputs (for example, 

total revenue or profit) change. 

8.3.3 Comparing and Summarizing Scenarios 

Scenario Manager provides a function to create the Scenario Summary Report. This article contrasts 

all scenarios generated in a single table. 

Steps to generate a summary: 

Open Scenario Manager. 

Click Summary. 

(You could specify the result cells (net income, ROI) if you want.) 

Click OK. 

Excel creates a new sheet containing a table in which that information is reported: 

• Each scenario name. 

• The values of the cell’s being changed. 

• The calculated values in the result cells. 

User can virtually compare multiple assumptions and their impact simultaneously. 

 

 

“Did you know that Scenario Manager can summarize outputs from multiple 

formula cells at once—not just one? 

“You can define multiple result cells (like profit, tax, and ROI) and Excel will 

generate a summary comparing how all of them change under each scenario. This is 

particularly helpful for evaluating multi-dimensional outcomes in business models.” 

 

8.3.4 Applications in Financial Planning and Forecasting 

 

Scenario Manager is applied to a lot of business processes, notably those requiring projection and 

multi-condition analysis. Some key use cases include: 

Financial Planning 
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• Developing alternative budgets based on revenue or cost estimates. 

• Predicting the effects of cost changes — for materials, say, or salaries — on profit margins. 

• Predicting the cash flows in various funding scenarios. 

Forecasting 

• Comparing several pricing policies and their impact on profit. 

• Scheduling of inventory requirements in reaction to demand changes. 

• Prediction of future income, based on various economic scenarios. 

Strategic Analysis 

• Plotting business risks using best, worst and likely use case scenarios. 

• Assisting in investment decisions by predicting outcomes with varying levels of capital allocation. 

Through Scenario Manager companies can plan better, become ready for the unexpected and take 

decisions on data rather than assumptions. 

8.4 Data Tables 

A Data Table is one of Excel's What-If Analysis tools that allows you to see how changing one or two 

variables in a formula will produce different results. Applications include financial modeling, pricing 

and investment decisions, where a single model is evaluated at various input values (scenarios). 

Data Tables let you run scenarios that would otherwise involve re-writing formulas or copying and 

pasting. Excel computes the resultant for each of these combinations of input values and displays 

the result in a table. 

8.4.1 Concept of One-Variable Data Table 

You can use a One-Variable Data Table to see how values in a table change during recalculations as 

well. 

Use Case: 

You want to understand the relationship between varying sales volume with regard to revenue and 

profit. 

Structure: 

• Values you input (such as various sales volumes) are presented in either a column or row. 

•The formula (profit = revenue - cost, for that price) is typed at the top of the row or column next to 

it. 

• The next step is for Excel to determine the value of the formula applied to each of those input 

values. 

Steps to create: 

Instantiate the formula with a cell that is linked to an input (in this case, amount sold). 

Type different input values vertically or horizontally. 

Page 10 of 17 - AI Writing Submission Submission ID trn:oid:::3618:127429016

Page 10 of 17 - AI Writing Submission Submission ID trn:oid:::3618:127429016



Try using Data > What-If Analysis > Data Table. 

In the dialog box, select: 

o Column Input Cell (if values are horizontal), or 

o Row Input Cell (when values are in a row). 

Excel outputs a table that gives the answer for each input. 

8.4.2 Business Use Cases 

 

Data Tables are particularly effective under the following circumstances: 

Sensitivity Analysis 

• See to what extent a single output (e.g., net profit) depends on changes in one or more inputs. 

• Aids in evaluating the risk or impact of uncertain events such as a cost increase, price fluctuation, 

changes in interest rates. 

Pricing Models 

• Analyse the effect of various price levels and demand rates on total revenue or profit. 

• Aid decision making for marketing and product strategy. 

Investment Returns 

• Prospective Project IRRs at different interest rates and project lives. 

• Develop FV tables with varying outcomes in the future based on decisions. 

Example: 

A financial analyst employs a two-variable data table to construct a model for the behavior of 

investment returns in terms of: 

• Various annual rates of interest (5%, 6%, 7%, etc.) 

• Various investment periods (5, 10, 15 years) 

This aids in choosing their appropriate investment based on what the investor is trying to achieve. 

Choose the correct option: 

 

1. Which of the following tools helps you find the required input value to achieve a 

specific result from a formula? 

A) Scenario Manager 

B) Data Table 

C) Goal Seek 

D) Solver 
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2. Scenario Manager is best used when: 

A) You need to solve equations with constraints 

B) You want to test multiple inputs and compare outcomes 

C) You need to vary two inputs and track one output 

D) You want to sort and filter data 

 

3. Which of the following statements is true about a One-Variable Data Table? 

A) It can vary two inputs at a time 

B) It works only with financial models 

C) It can display multiple output values from a single changing input 

D) It creates pivot charts 

 

4. What does a Two-Variable Data Table require? 

A) Two separate formulas 

B) A fixed result cell and two changing input cells 

C) Two formulas and one changing cell 

D) Three changing variables 

 

5. In Scenario Manager, which of the following is not required while creating a new 

scenario? 

A) Scenario Name 

B) Changing Cells 

C) Output Cell 

D) Input Values 

8.5 Summary 

 

This chapter presented Excel’s dynamic tools (Goal Seek, Scenario Manager and Data Tables) which 

facilitate the functionality of What-If Analysis for organizational planning, forecasting and 

optimizing. 

 

A sheet like Goal Seek gives you the necessary input to get a certain output. 

 

• Integrating with the Manager, you can do scenario analysis of your business by changing more 

than one input and seeing summary reports. 
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• Data Tables allow for performing sensitivity analysis by changing one or two inputs to see how 

they impact important calculations. 

 

Together, these aids enable decisions to be data driven rather than based on guesswork and visibility 

of how changes in the variables impact results. They are particularly valuable in domains such as 

financial modeling, investment analysis, pricing strategies and resource planning. 

 

8.6 Key Terms 

 

Term Definition 

 

What-If Analysis A technique in Excel for adjusting input values to determine how outcomes may 

change. 

 

Goal Seek A feature that determines an input value based on what formula you want to obtain. 

 

What-if Analysis Feature that helps you create a set of values at the same time so that you can see 

how they affect one another Scenario Manager A feature used to create and compare different 

groups of input values and their effects. 

 

Table\TableA tool for computing and displaying a formula for values of one variable. 

 

One-Variable Data Table A table of data that shows how changing one input changes one or more 

outputs. 

 

Two-Input Data Table A table that displays the effect of two input variables on a single output. 

 

Sensitivity Analysis An investigation on the effect of changes in a model input on its outputs. 

 

8.7 Descriptive Questions 

 

What is What-If Analysis in Excel? Explain its relevance in decision-making. 

 

Page 13 of 17 - AI Writing Submission Submission ID trn:oid:::3618:127429016

Page 13 of 17 - AI Writing Submission Submission ID trn:oid:::3618:127429016



What s the Working of Goal Seek feature? Describe with a practical example. 

 

Explain the steps to create scenario with Scenario Manager in Excel. 

 

Describe how you can use Scenario Manager to compare various business dimensions. 

 

Explain the distinction between one-variable and two-variable data tables with examples. 

 

How can data tables be used for sensitivity in modelling? 

 

Prepare the steps to create a scenario summary report in Excel. 

 

Find actual business issues that could be potentially resolved with Goal Seek. 

 

What is the benefit of using Scenario Manager as opposed to comparing multiple models manually? 

 

Explain one circumstance when Data Tables might give more insight than using Goal Seek. 
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Knowledge Check 1 

1. Goal Seek 

2. Comparison 

Answers to Knowledge Check 
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3. Output 

4. Inputs 

5. Output 

 

8.9 Case Study 

Introduction 

When it comes to budgeting, estimating a profit or adjusting marketing strategies accuracy of 

forecast is very important for growing businesses. Excel includes several What-If Analysis tools that 

enable users to test assumptions, generate forecasts and budget scenarios, and perform data 

analysis by using your business models to visualize the impact of variables as part of making more 

informed decisions rather than relying on intuition. 

This single case study uses an exploratory approach to see how a finance manager in a medium sized 

maker of products used Excel's decision tools in the planning process to capture budgetary effects, 

do sensitivity analysis, and tie adrift projections back into the company picture. It also showcases the 

typical difficulties one faces when attempting to forecast outcomes manually, and how Excel 

solutions drive more accuracy, flexibility, and speed in decision-making. 

Background 

Maya was a finance manager at Orbiz Manufacturing Ltd., which conducted business in New York 

and manufactured promotional products, such as pens, pencils, umbrellas and bags. Maya's duties 

included generating quarterly forecasts for sales, profits and expenses. Her spreadsheets had cost 

breakdowns, pricing models and expectations of units sold under different market circumstances. 

Maya used to manually change input values (production cost, advertising spend, unit sales) in order 

to forecast outcomes. But that was cumbersome and to compare many versions of the same 

forecast instabil. Senior management often asked: 

• What is the break-even point for our latest product? 

• What will declines in ad spend mean for profit margins? 

• What if sales fell 20%? 

Maya saw that she could automate these analyses, and have it produce structured insights using 

Excel’s Goal Seek + Scenario Manager + Data Table outputs. She started recalibrating her financial 

model to incorporate these tools. 

Problem Statement 1: Difficulty in Recognizing the Point of No-Loss 

“Improving Financial Forecasting with Excel’s Decision-Making Tools” 
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Maya had to figure out how many of these the company needs to sell in order to cover its costs, 

both fixed and variable—the break-even quantity. However, doing all of this manually every time 

inputs change was unproductive. 

Solution: 

For this, she applied Goal Seek for the computational automation. 

• Formula: 

Net Profit = (Selling Price × Units Sold) – (Fixed cost + Variable Cost per Unit of Sale × Units Sold) 

• Goal: Set Net Profit to ₹0 

• Excel used its iteration feature to determine the Units Sold that gets me to break even. 

MCQ: 

What is an excel tool which helps in searching the input value required to get a desired output? 

A) Data Table 

B) Solver 

C) Scenario Manager 

D) Goal Seek 

Answer: D) Goal Seek 

Explanation: Goal Seek helps people to look for the input that get a specific result in a formula. 

Problem Statement 2: Analysis of Different Business Scenarios Comparing the HR systems to be 

used for one or more business scenarios. 

It is required by Maya to check profit for Best Case, Likely Case and Worst Case scenarios which can 

vary based on different values of advertising spend, unit price and sales volume. 

Solution: 

She created and saved several sets of input values, using the Scenario Manager feature to determine 

which produced the most profits by comparing them via a Scenario Summary Report. 

MCQ: 

What is the point of Scenario Manager in Excel? 

A) Predict historical sales 

B) Create dynamic pivot charts 

C) Multi-inputer TO Compare input pairs and their corresponding results 

D) Sort data based on color 

Answer: C) To consider several combinations of inputs and their respective output 

Explanation: Scenario Manager helps you create and analyze sets of what if? values in MS Excel. 

Problem 3: Testing Profit Sensitivity in a Multiple-Input Framework 
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Maya wanted to understand how the mix of advertising budget and sales volume influence on net 

profit that would help marketing people make decisions. 

Solution: 

She employed a Two-Variable Data Table, with: 

• Sales Volume in rows 

• Ad Spend in columns 

• Net Profit formula in top-left cell of the table 

Excel populated the grid, returning net profit for each combination. This made him recommend the 

best-cost marketing plan to Maya.” 

MCQ: 

What is a Excel tool that shows the effect of two input variables on one output? 

A) Goal Seek 

B) Two-Variable Data Table 

C) Scenario Manager 

D) MATCH function 

Answer: B) Two-Variable Data Table 

Reference: This is an 1-out-of-2 sensitivity tool where two inputs are varied and one output, 

measured. 

Conclusion 

Using Excel's scenario feature, Maya was able to reduce manual mistakes, save time and enhance 

the accuracy of her financial projections. Using Goal Seek, she was able to calculate break-even 

points on the spot. Scenario Manager I was helped her develop and compare various strategic 

business scenarios. Two-Variable Data Tables facilitated detailed sensitivity analysis. 

Using these instruments, Maya was able to report up the chain to senior management with 

guidance grounded in facts. Better decisions resulted in more effective budgeting, improved risk 

management and targeted marketing spend. 

This example shows you how to plug Excel’s What-If Analysis tools into a business model to produce 

true-to-life forecasts and develop strategic plans. 
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*% detected as AI
AI detection includes the possibility of false positives. Although some text in 
this submission is likely AI generated, scores below the 20% threshold are not 
surfaced because they have a higher likelihood of false positives.

Caution: Review required.

It is essential to understand the limitations of AI detection before making decisions 
about a student’s work. We encourage you to learn more about Turnitin’s AI detection 
capabilities before using the tool.

Disclaimer
Our AI writing assessment is designed to help educators identify text that might be prepared by a generative AI tool. Our AI writing assessment may not always be accurate (i.e., our AI models 
may produce either false positive results or false negative results), so it should not be used as the sole basis for adverse actions against a student. It takes further scrutiny and human 
judgment in conjunction with an organization's application of its specific academic policies to determine whether any academic misconduct has occurred.

Frequently Asked Questions

How should I interpret Turnitin's AI writing percentage and false positives?
The percentage shown in the AI writing report is the amount of qualifying text within the submission that Turnitin’s AI writing 
detection model determines was either likely AI-generated text from a large-language model or likely AI-generated text that was 
likely revised using an AI paraphrase tool or word spinner.
 
False positives (incorrectly flagging human-written text as AI-generated) are a possibility in AI models.
 
AI detection scores under 20%, which we do not surface in new reports, have a higher likelihood of false positives. To reduce the 
likelihood of misinterpretation, no score or highlights are attributed and are indicated with an asterisk in the report (*%).
 
The AI writing percentage should not be the sole basis to determine whether misconduct has occurred. The reviewer/instructor 
should use the percentage as a means to start a formative conversation with their student and/or use it to examine the submitted 
assignment in accordance with their school's policies.

What does 'qualifying text' mean?
Our model only processes qualifying text in the form of long-form writing. Long-form writing means individual sentences contained in paragraphs that make up a 
longer piece of written work, such as an essay, a dissertation, or an article, etc. Qualifying text that has been determined to be likely AI-generated will be 
highlighted in cyan in the submission, and likely AI-generated and then likely AI-paraphrased will be highlighted purple.
 
Non-qualifying text, such as bullet points, annotated bibliographies, etc., will not be processed and can create disparity between the submission highlights and the 
percentage shown.
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Unit 9: AI Tools 

Learning Outcomes 

1. Understand the role of ArƟficial Intelligence (AI) in enhancing decision-making and 
automaƟon within 

business analyƟcs workflows. 

2. IdenƟfy key conversaƟonal AI tools (e.g., chatbots, virtual assistants) and describe their 
applicaƟons in 

customer service, query resoluƟon, and internal operaƟons. 

3. Explore AI integraƟon in producƟvity suites such as MicrosoŌ 365 (Excel, Word, 
PowerPoint) and 

Google Workspace to streamline tasks like summarizing content, generaƟng insights, and 
automaƟng 

acƟons. 

4. Evaluate AI-powered Excel add-ins and features such as Ideas, Flash Fill, and Data Types 
that assist in 

data analysis and task automaƟon. 

5. Apply AI tools for data preparaƟon and cleaning, including duplicate removal, paƩern 
recogniƟon, and 

intelligent transformaƟon using natural language commands. 

6. Analyze how AI enhances data analysis and insight generaƟon, enabling predicƟve 
analyƟcs, trend 

detecƟon, and interacƟve dashboards. 

7. Discuss the future potenƟal and ethical consideraƟons of using AI in business analyƟcs, 
including humanAI collaboraƟon and responsible data use. 

Content 
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9.1 IntroducƟon to AI Tools in Business AnalyƟcs 

9.2 ConversaƟonal AI Tools 
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9.6 AI for Data Analysis & Insights 

9.7 Future of AI in AnalyƟcs 

9.8 Summary 
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9.10 DescripƟve QuesƟons 

9.11 References 

9.12 Case Study 

 

9.0 Introductory Caselet 

“Ayesha’s AnalyƟcs Upgrade: Embracing AI for Smarter Business Decisions” 

“Ayesha, a 30-year-old business analyst with a mid-sized logisƟcs company in Mumbai, was 
famous for her 

proficient in Excel and dashboard reporƟng. But, as the company grew its presence in more 
ciƟes, 

volumes of data grew and classified data became more complex. WriƟng reports, cleaning 
raw data, and coming up with insights 

took longer than expected. They would have had quicker decision-making in mind when they 

wanted it, yet Ayesha was there to keep and份支持内务官aYtoshe that shƟch. 

Formulas & Format charts” and “weekly updaƟng dashboards.” 

At a professional development workshop, Ayesha was exposed to AI-enabled tools on Excel 
such as 

Copilot, ChatGPT integraƟon, and AI add-ins such as ChatGPT for Excel. She came to the 
realizaƟon that as she’d been and was. 

is what the future of work in business analyƟcs looked like”) relied upon roll-up-able, 
explicit spreadsheets for this incredibly criƟcal analysis. 

assistant. 

Curious, Ayesha began experimenƟng. With Copilot, she could automate tasks she found 
repeƟƟve, like building charts and other graphs. 

Page 4 of 29 - AI Writing Submission Submission ID trn:oid:::3618:127424869

Page 4 of 29 - AI Writing Submission Submission ID trn:oid:::3618:127424869



updaƟng formulas, and generaƟng summaries. She leveraged ChatGPT to debug complicated 
equaƟons, glean 

suggesƟons on how to clean data, and even draŌ introductory paragraphs for reports. AI 
add-ins like 

With ChatGPT for Excel, she was able to auto-detect anomalies and instantly create 
dashboards without coding a single line 

of code. 

Within weeks, Ayesha  ’s enƟre workflow had changed. And so, instead of spending hours 
organizing spreadsheets, she 

spent that Ɵme analyzing trends, assessing business risks and advising management on 
strategy. Her 

The AI-boosted reports were faster, smarter and more understandable to non-tech 
managers. 

This shiŌ represents a larger trend in the world of analyƟcs: AI is ceasing to be an external 
technology — it’s geƫng integrated. 

a common feature of every business tool. Chapter 9 looks at the ways AI is transforming 
analyƟcs by enhancing 

producƟvity, providing instant insights and changing what is expected from the business 
analyst. 

CriƟcal Thinking QuesƟon: 

If you were Ayesha, what area would you choose to focus on for AI adopƟon -- data 
cleaning, reports / analysis. 

generaƟon, or dashboard creaƟon? Explain why you would make that decision in terms of 
how much Ɵme it saves and how much of an effect you think it will have. 

 

9.1 IntroducƟon to AI Tools in Business AnalyƟcs 

How ArƟficial Intelligence Powers Business AnalyƟcs: ArƟficial intelligence (AI) is changing 
the game for business analyƟcs, facilitaƟng faster, more accurate insights in many different 
forms. 

accurate data-driven decisions. AI tools, which range from automaƟng mundane tasks to 
idenƟfying hidden trends in data, have been helping researchers produce and analyze big 
scienƟfic data. 
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have now made their way into a number of business applicaƟons—parƟcularly spreadsheet 
programs, such as MicrosoŌ ExceL. 

So, in analyƟcs AI is not only about predicƟons. and machine leaningIt also includes natural 
processing, 

automaƟon, and smart recommendaƟon providing far richer ways for organizaƟons to derive 
insight from data and.Raise your hands if you enjoy dealing with external consultants. 

respond to changes. 

 

9.1.1 Role of AI in Modern Data Analysis 

AI is playing a game-changing role in how data is analyzed, interpreted and used in today’s 
business landscape.” 

environment. 

MAJOR USES OF AI IN DATA ANALYSIS : 

• More efficient means of sorƟng, tagging, and cleaning data. 

• ForecasƟng trends (e.g., sales, demand) with machine learning algorithms. 

• Natural language interfaces that allow‹users to ask quesƟons in raw English (eg: “What are 
this quarter’s 

top-selling products?”). 

• PaƩern and anomaly discovery to rapidly find outliers or significant deviaƟons in data. 

AI makes from this manual technical work a real-Ɵme and usable funcƟon that can even be 
used by non-specialist users.” 

 

9.1.2 Benefits of Using AI Tools with Excel & Business AnalyƟcs 

Business analyƟcs workhorse Excel now offers built-in AI capabiliƟes and is easier to use. 

AI-powered add-ins. AI combined with Excel greatly improves producƟvity and supports 
beƩer decision-making. 

Key Benefits: 

• Quick data insights with tools such as Excel’s “Analyze Data” (previously Ideas), a feature 
that offers suggesƟons on charts and PivotTables. 

automaƟc summaries, trends, and visualizaƟons. 
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• Flash Fill A new way to reformat and rearrange your data. Catches other mistakes in the 
meanƟme by using the smarts of paƩern matching. • Smart PaƩern RecogniƟon Advanced 
logic detects foreseeable paƩerns and makes it easy to start entering your data right away, 
as can be done with live.com registraƟon. 

• Natural language queries enable users to type quesƟons like “Show total revenue by 
region” without 

wriƟng formulas. 

• Time savings in training data cleaning with AI-powered data cleaning e.g. removing 
duplicates, converƟng formats or 

idenƟfying missing data. 

For business analyƟcs workflows, AI lightens the load of manual work and exposes 
advanced analysis to a. 

wider audience. 

 

9.1.3 LimitaƟons and Ethical ConsideraƟons of AI Tools 

Despite its great potenƟal, AI also has disadvantages and ethical implicaƟons that need to 
be miƟgated in the execuƟon of pracƟce. 

any business analyƟcs environment. 

LimitaƟons: 

• Context unawareness: AI can misinterpret data unless it understands the bigger business 
picture. 

• Reliance on data quality: Low-quality or biased data may result in misleading conclusions. 

• Limited adaptability: Certain AI tools thrive in structured, formulaic environment and may 
not 

cope with novel or unstructured tasks. 

Ethical ConsideraƟons: 

• Data privacy worries: Many AI tools need sensiƟve data to funcƟon. 

• Bias and fairness: Algorithms, when not carefully watched, can inadvertently perpetuate 
exisƟng biases. 

• Transparency and accountability: Understanding how AI models make decisions, 
parƟcularly in compeƟƟve seƫngs such as adversarial machine learning, is important; 
without this understanding it will be extremely difficult to miƟgate aƩacks. 
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high-stakes scenarios. 

Responsible deployment of AI in business analyƟcs is about that balance between 
automaƟon and human supervision, so there’s rigor. 

that decisions are kept ethical, transparent, and conform to organizaƟonal values. 

 

9.2 ConversaƟonal AI Tools 

ConversaƟonal AI is the science of the development of arƟficial intelligence systems that can 
interact with users using natural language. 

typically via text or voice. One of the most important development in this area is the 
emergence of Large language Model (LLM). 

Models (LLMs) such as ChatGPT, that able to perceive, process and produce human like 

answers to various quesƟons. 

For the business analyƟcs space, conversaƟonal AI tools like ChatGPT are on-demand virtual 

assistants to help users analyze data, clean up messy data and produce reports or even 
translate complicated 

dashboards in simple language. 

 

9.2.1 IntroducƟon to ChatGPT for Business AnalyƟcs 

He product ChatGPT is an OpenAI conversaƟonal AI that has potenƟal to do many tasks 
wregsoudij30ds File rtems_bspshell 4 Nodes = BNode TreeYou can also use this kind of 
literate programming with LaTeX (then you call it noweb style codes) recht 5 rects ansichten. 

language, logic, and reasoning. ChatGPT is being uƟlized more and more in business 
analyƟcs to: 

• Rapid data exploraƟon and analysis hints 

• Natural language quesƟon answering (e.g., “How to calculate compound interest in 
Excel?”) 

·Excel formula creaƟon, troubleshooƟng and logic explanaƟon 

• Summarize & interpret trends in data and generate reports 

ChatGPT funcƟons as a conversaƟonal aide to empower non-technical users to be more 
effecƟve with tools such as 

Excel, Power BI and Google Sheets by converƟng natural language to acƟonable responses 
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9.2.2 Using ChatGPT for Data Cleaning, Formula Help & AutomaƟon 

**ChatGPT improves business analyƟcs efficiency with support for common and uncommon 
quesƟons in real-Ɵme 

spreadsheet tasks. Here is how it influences in parƟcular: 

Data Cleaning 

• Detects inconsistent formaƫng, missing data and duplicate records. 

• Provides Excel or script soluƟons for cleaning raw data step by step. 

• Formulas or Power Query code generaƟon of transformaƟon jobs. 

Formula Help 

• Provides the right formulas for common business calculaƟons (e.g. CAGR, EBITDA or ROI). 

• Describes when and how to use certain funcƟons such as VLOOKUP, INDEX–MATCH, IF, 
SUMIFS, 

and others. 

• Debugs formula errors using logic and evidence/reasoning. 

AutomaƟon Assistance 

• Helps with wriƟng simple VBA macros or Google Apps Script to automate Excel or Sheets. 

• Aids users create logical workflows to automate report building, email noƟficaƟons and 
updates to dashboards. 

By delivering code or formula support in plain text, ChatGPT can help ease the 
communicaƟon between business users and 

technical requirements. 

 

Did You Know? 

Did you know that ChatGPT can write Excel formulas using plain language—and even explain 
them step by step? “For example, if you ask, “How do I calculate the number of days 
between two dates if the end date is in cell B2 and the start date is in A2?”, ChatGPT can 
generate the formula =B2–A2 and explain how it works. It can also troubleshoot errors like 
#VALUE! or suggest alternaƟves using DATEDIF.” 

9.2.3 PracƟcal Use Cases: GeneraƟng Insights, Report WriƟng, Dashboard 

ExplanaƟons 
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However, this is just the Ɵp of the iceberg of what ChatGPT can do in business analyƟcs and 
goes well beyond formulas and data manipulaƟon. 

Following are few use cases that are preƩy common and useful. 

Insight GeneraƟon 

• Users can paste raw data into ChatGPT and request trends, summaries or anomalies. 

• The model can produce bullet-point insights for presentaƟons or execuƟve briefs. 

Report WriƟng 

• Turns structured data into narraƟve reports, summaries or acƟon recommendaƟons. 

• Can write introducƟons, conclusions and key findings for business reports. 

Dashboard ExplanaƟon 

•liberate for explaining the elements of a dashboard (KPI, filters, graphs). 

• Responds to quesƟons in natural language: 

“Describe what the 'Net Sales Trend' chart on the dashboard displays for last 6 months?” 

 

“AcƟvity: Ask ChatGPT to Generate a Report Summary from Your Data” 

“You are working with a monthly sales report in Excel that includes columns for Region, 
Product, Sales 

Volume, and Revenue.” 

Task: 

1. Copy your dataset into ChatGPT and ask: 

“Can you summarize the key sales insights from this data?” 

2. Review the generated summary. Does it correctly idenƟfy top-performing regions or 
products? 

3. Ask ChatGPT a follow-up: 

“What should I highlight in a manager’s report for this dataset?” 

4. Copy the final version into your Excel workbook or Word document. 

Submission: 

Submit the summary paragraph along with your original Excel file. Highlight any suggesƟons 
or insights you used 
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in your report based on ChatGPT’s response. 

9.3 AI IntegraƟon in ProducƟvity Suites 

Modern producƟvity tools such as MicrosoŌ 365 are being transformed by the integraƟon of 
AI assistants. 

MicrosoŌ’s Copilot, powered by OpenAI’s large language models, brings intelligent features 
directly into Excel, 

Word, PowerPoint, and other Office apps. 

In Excel, Copilot acts as a smart analyst—helping users generate formulas, build summaries, 
create 

visualizaƟons, automate scenario analysis, and even explain complex paƩerns in natural 
language. This secƟon 

explores how Copilot is reshaping spreadsheet-based analyƟcs. 

9.3 AI IntegraƟon in ProducƟvity Suites 

Modern producƟvity tools such as MicrosoŌ 365 are being transformed by the integraƟon of 
AI assistants. 

MicrosoŌ’s Copilot, powered by OpenAI’s large language models, brings intelligent features 
directly into Excel, 

Word, PowerPoint, and other Office apps. 

In Excel, Copilot acts as a smart analyst—helping users generate formulas, build summaries, 
create 

visualizaƟons, automate scenario analysis, and even explain complex paƩerns in natural 
language. This secƟon 

explores how Copilot is reshaping spreadsheet-based analyƟcs. 

9.3.1 MicrosoŌ Copilot in Excel 

MicrosoŌ Copilot for Excel is an AI assistant integrated in Excel that allows users to converse 
with their data. 

using natural language commands. It’s designed to help users: 

• Understand complex data quickly 

• Automate repeƟƟve tasks 

• Analyze data and make more informed decisions without having to take the Ɵme to learn 
complex formulas 
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Key capabiliƟes include: 

• WriƟng and describing Excel formulas (e.g., “Write a formula to calculate year-over-year 
growth”) 

• Compiling everything to summarize great quanƟƟes of data 

• Answering quesƟons such as “What are the top 5 regions by profit this quarter?” 

• CreaƟng pre-made templates, tables and KPI summaries 

Copilot Is a free Add-In developed on the Excel plaƞorm, that will show up to the Right-hand 
side or InLine based on version and. 

update. Great for people who work with large data sets but do not possess advanced Excel. 

experƟse. 

 

“AcƟvity: Use MicrosoŌ Copilot to Simulate a Business Scenario in Excel” 

InstrucƟon to the Student: “You are analyzing product profitability using the formula: Profit 
= (Selling Price × Units Sold) – (Fixed Cost + Variable Cost × Units Sold)” 1. Set up this model 
in Excel with: o Fixed Cost = ₹50,000 o Variable Cost per unit = ₹300 o Create a cell where 
the Selling Price and Units Sold can be changed. 2. AcƟvate Copilot in Excel (if available) and 
ask: “What happens to profit if I increase the selling price by 10%?” or “Show three 
scenarios: low, average, and high sales projecƟons.” 3. Review the AI-generated outputs 
(tables, summaries, or visuals). 4. Adjust the values based on Copilot's suggesƟons and 
analyze the results. Submission: Submit your Excel file with the three scenarios created using 
Copilot. Add a short note (3–4 lines) summarizing what you learned from the AI-driven 
analysis. 

9.3.2 Leveraging Copilot for Charts, PivotTables & Dashboards 

Copilot also has improved the visual and reporƟng talent of Excel, enabling users to more 
easily create profession%%*/ 

dashboards without deep technical skills. 

Copilot can: 

• AutomaƟcally create charts from your data (for example, “Create a bar chart showing the 
trend of monthly sales”). 

• Create PivotTables that summarize data with ease by only using your words (“Summarize 
revenue by product and region”). 

• Describe what you see in the visuals (e.g., “What paƩern can be seen on this chart?”) 
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• Make suggesƟons for chart types or visualizaƟon enhancements 

• Enhance a dashboard with slicers, filters, and dynamic chart features 

Use Case Example: 

A user writes: “I want to know what region my sales were in Q1 and how they compare to 
Q2.” 

Copilot responds by creaƟng a dashboard layout and filling it with charts, tables, and 
summary insights—ready forPour le moment, Copilot: consuming. 

presentaƟon or analysis. 

This AInaƟve aid not only saves Ɵme and eliminates manual errors but also empowers users 
with insighƞul, data-driven stories. 

reports with minimal effort. 

 

9.4 AI-Powered Add-ins for Excel 

Even though current funcƟonality of Excel is very powerful, it sƟll can be improved by AI 
powered add-ins. These add-ins are plug-in tools which slip right inside Excel that use 
arƟficial intelligence 

to do doing automaƟc data analysis, predicƟng, scrubbing, sƟmulaƟng and reporƟng–– 

to bring visual analyƟcs to users of any skill level. 

They cut back on manual formulas being wriƩen and also improve the quality of your data 
while delivering faster insights – hugely important issues in a world of ever-increasing data. 

advantages in modern business analyƟcs. 

 

9.4.1 Overview of AI Add-ins for Excel 

AI add-ins are third-party or MicrosoŌ-built enhancements that incorporate machine 
learning, automaƟon, and producƟvity boosƟng features right within apps. 

natural language methodologies right into Excel, dramaƟcally transforming the way the 
applicaƟon is analysed and used for decision support agenda. 

funcƟons. 

Common Features: 

• AutomaƟc processing and summarizaƟon of heterogeneous data 

Page 13 of 29 - AI Writing Submission Submission ID trn:oid:::3618:127424869

Page 13 of 29 - AI Writing Submission Submission ID trn:oid:::3618:127424869



• Natural language query processing (e.g., “What is average sales for Q2?”) 

PredicƟve analyƟcs and forecasƟng tools 

• Smart chart generaƟon 

• AutomaƟc data cleaning (e.g., repairing data type mismatches, deduplicaƟon). 

Examples of AI Add-ins: 

• ChatGPT for Excel – Brings conversaƟonal AI into Excel to explain formulas, generate code, 

and natural language assistance 

• MulƟple AI – Enables advanced predicƟon, trend analysis and forecasƟng with the power 
of machine learning 

• MG-VisEx – Facilitates automaƟc data analysis, insights and visual abstracƟons 
development 

• Power BI Publisher – Enables you to integrate Excel data with Power BI dashboards for 
combined up-to-date analysi 

visualizaƟons 

• Arch for Excel – Checks your content in the cells with grammar and style. 

• Wolfram Alpha -Does high level math and staƟsƟc from online directly in Excel. 

In the aggregate, such tools enable users to gain more Ɵme in their day by working less on 
manual and repeƟƟve tasks so they can concentrate on. 

making sense of the results and data-driven decision making. 

9.4.2 Data Squirrel – Automated Analysis & VisualizaƟon 

Data Squirrel is a well known AI-driven Excel add-in that helps non-technical users to do 
data 

analysis and generaƟon of graphics by requiring very liƩle coding effort. 

Key Features: 

• Summarizes and processes datasets in an average way 

• Instant charts, tables and dashboards 

• Gives plain English explanaƟons of data takeaways 

• IdenƟfies outliers, missing value and trends 

Use Case Example: 
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User brings sales results into Excel, user opens Data Squirrel. The tool automaƟcally 
idenƟfies top-selling 

products, flags poor performers, and creates a dashboard—all without wriƟng a single 
formula. 

Data Squirrel is perfect for markeƟng analysts, small business owners and educators who 
need to do simple, yet powerful data slicing and dicing on the fly. 

reliable insights from their data. 

 

d You Know? 

Did you know that Data Squirrel can auto-generate enƟre dashboards with recommended 
charts 

based on your dataset—without requiring a single formula? 

“The tool reads your data, idenƟfies dimensions and measures (like “Product” and “Sales”), 
and offers 

pre-built visuals (bar charts, pie charts, KPIs) tailored to the paƩerns it detects—all within 
Excel.” 

9.4.3 Other AI Add-ins: Automated ForecasƟng, Cleaning & ReporƟng 

In addiƟon to Data Squirrel, there are severalAI add-ins that can help you do more with 
Excel in otherparts of the process. 

analyƟcs: 

Automated ForecasƟng Tools 

• Apply machine learning to forecast future values from historical data. 

• Offer seasonality detecƟon, along with confidence intervals and trend analysis. 

• Examples: XLMiner, Forecast Sheet AI, Time Series Analyzer 

Automated Data Cleaning Tools 

• Find and correct inconsistent data types, blanks, duplicates and errors. 

• Suggest d6xes (for, A+ddate format inconsistency) using @ acƟon) paƩern recogniƟon. 

• Examples: Clean Data AI, Tada Clean, DataRobot AI Prep 

Automated ReporƟng Tools 

• Produce canned reports from raw data sources. 
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Draw a visual summary and explain it in words. 

• Export reports in mulƟple formats (PDF, PPT, Word). 

• Examples: NarraƟve BI, Auto Insights, Zoho AnalyƟcs Excel Plugin 

These add-ins bring speed, scale and ease to Excel data tasks, enabling advanced analyƟcs. 

accessible to everyday users. 

 

9.5 AI for Data PreparaƟon & Cleaning 

Data preparaƟon and scrubbing is an integral part of any business analyƟcs soluƟon. Poor 
data quality leads to 

wrong analysis, false influences and unsound judgments. TradiƟonally, data cleaning in Excel 

requires human processing with filtering, sorƟng, formula applying etc. which may be Ɵme-
consuming and error-prone 

human error. 

And now, with AI-driven tools, Excel users have the ability to automate much of the data 
cleaning process— 

lessening work, increasing accuracy and making life easier for analysts, who can spend their 
Ɵme on insights as opposed to formaƫng. 

 

9.5.1 Using AI to Detect Duplicates, Errors & Missing Data 

AI tools are able to quickly process the datasets and idenƟfy several types of data quality 
problems including: 

• Duplicates: AI will idenƟfy exact and fuzzy duplicate records (i.e., “ABC Corp” vs “A.B.C. 
CorporaƟon”) 

using paƩern matching. 

• Errors: Highlight wrong values (numeric values in text fields, invalid formats) or spelling 
issues. 

• Missing Data: IdenƟfies null or empty cells and offers intelligent suggesƟons for possible 
imputaƟon (filling of missing values) such as using the mean, median i.e.. 13 

median, or predicƟon-based values). 

Benefits: 
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• Reduces manual inspecƟon Ɵme. 

• Enhances the robustness of the downstream analysis. 

• Finds hidden paƩerns in inconsistencies that regular Excel filters find difficult. 

Further, the use of tools like OpenRefine, Trifacta, Excel integrated AI plug-ins (e.g., Data 
Squirrel [38], Clean Data AI [39]) may honed. 

perform these tasks on its own with liƩle to no user intervenƟon. 

 

9.5.2 StandardizaƟon & Feature Engineering with AI Assistance 

StandardizaƟon is the process of making sure data has a level playing ground (same date 
formats, words spellings adequacy etc. 

capitalizaƟon, or naming convenƟons). 

Feature Engineering is the process of creaƟng new granular features from your exisƟng data 

that help improve预测 of a机器Learning model based on raw data. 

predicƟve models (e.g., where “Age” comes from “Date of Birth”). 

AI simplifies both processes: 

• AutomaƟcally idenƟfies inconsistent formats or spelling (eg, “Mumbai” vs mumbai vs 
Bombay”). 

• Recommends conversions such as from date parsing, unit conversion or combining 
mulƟple columns. 

• Suggests new variables (features) based on correlaƟons or business logic (e.g., “Revenue 
per Product 

= Net sales/Number of Products”). 

These features can be naturally incorporated into AI tools (e.g. AutoML plaƞorms, AI Excel 
Add-ins, Natural 

Language Query Assistants that parse direcƟves such as: 

“Inter-capitalize all customer names” or 

“Show the days between order and delivery as a feature.” 

 

9.5.3 Comparing Manual Excel Cleaning vs AI Cleaning 

Aspect Manual Cleaning from Excel AI-Powered Cleaning 

Page 17 of 29 - AI Writing Submission Submission ID trn:oid:::3618:127424869

Page 17 of 29 - AI Writing Submission Submission ID trn:oid:::3618:127424869



Speed Slow incremental or batch execuƟon 

Error checking Uses filters and formulas To find paƩers as well outliers 

If you need Duplicates Exact matching logic is required AdmiƩed into the club of fuzzy and 
semanƟc matching 

ImputaƟon Needs manual input (e.g., IF, 

AVERAGE) 

Recommends or automates intelligent 

imputaƟon 

Scalability Poor on big data Designed for big data processing 

User Skill 

Required 

Intermediate to advanced Excel 

knowledge 

CompaƟble with rudimentary training, AI manages 

complexity 

 

9.6 AI for Data Analysis & Insights 

Once data is prepared and cleaned, the next step is to analyze it and extract meaningful 
insights. TradiƟonally, this involves using formulas, staƟsƟcal methods, PivotTables, and 
visualizaƟons—tasks that require a fair amount of experƟse. However, AI is transforming this 
phase by enabling Excel and other analyƟcs tools to automaƟcally analyze data, detect 
trends, generate summaries, and recommend decisions—making analyƟcs more accessible, 
especially for non-technical users. 

9.6.1 AI-Assisted StaƟsƟcal Summaries 

AICS can provide automated staƟsƟcal summaries of datasets, such as: 

• DescripƟve staƟsƟcs: Mean, median, mode, minimum, maximum and range or standard 
deviaƟon. 

• Trend analysis: Spoƫng paƩerns that are going up or down over Ɵme. 

• Outlier detecƟon: IdenƟficaƟon of abnormality in the dataset (for example, who are the 
unusual sales). 
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• CorrelaƟon suggesƟons: Searching for variables that are potenƟally correlaƟve (e.g., 
revenue vs. 

adverƟsing spend). 

That feature in Excel is supported by: 

• “Analyze Data” (previously known as “Ideas”)—a new feature that generates rapid insights 
and visuals of your 

dataset. 

• AI add-ins, such as Data Squirrel or Zoho AnalyƟcs or NarraƟve BI , that create automaƟc 
narraƟves and 

charts. 

Example Use Case: 

A user imports into Excel customer feedback scores and sales. AI notes that areas of low 75 
DEM are mainly covered by 

feedback gain has richer returns—profitable for business enhancement. 

 

9.6.2 Automated CreaƟon of PivotTables, Charts & Dashboards 

Building PivotTables and dashboards in Excel is a Ɵme-consuming process. AI simplifies this 
by: 

• CreaƟng PivotTables on the fly from your natural language commands. 

Example: “Show sales by region and product category. 

• Recommending suitable graphics (charts, graphs, maps) according to the data paƩern. 

• Developing dashboards with KPIs, slicers, charts and summary tables with less or no 
contribuƟon from the 

user. 

AI assistants that include MicrosoŌ Copilot, integraƟon with Power BI, or Excel add-ins such 
as Klarity AI or Automate. io 

popularizeTHIS PROCESS interesƟng and customizable. 

Key Benefits: 

• Saves Ɵme 

• Reduces manual errors 
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• Enhances report presentaƟon quality 

9.6.3 AI for Business Insights & Decision-Making 

AI doesn’t just see data — it can understand it. However, the species and clinical 
significance of SANs has not been established. 

processing, AI tools can: 

• DisƟll complex data into specific conclusions (e.g., “The 15% growth in Q2 sales was 
driven by strong '/'); 

performance in the North region.”) 

• Recommend changes (e.g., “Raise inventory for Region A due to an upward trend in 
demand.”) 

• Create predicƟons, such as sales forecasts, risk of churn, recommending ads, or making 
opƟmal decisions. 

opƟmal pricing strategies. 

Such knowledge can be provided in either: 

• Dashboards with AI-generated recommendaƟons 

• WriƩen reports (summary reports such as execuƟve summaries or board reports). 

• ConversaƟonal interfaces (ChatGPT, Copilot) where the user submits: 

“What is the biggest cause of decreasing customer retenƟon during Q3?” 

AI-backed decision-making tools empower business leaders to make decisions more rapidly 
and with more convicƟon, perhaps. 

regardless of their knowledge of staƟsƟcs or data science. 

 

9.7 Future of AI in AnalyƟcs 

As AI tools advance, they’re no longer assistants—they’re collaborators. 

partners in business analyƟcs. The future of work in data will be human-AI collaboraƟon, 
where 

strategists are leŌ to focus on strategic thinking and decision-making, with AI serving 
automaƟon, insight generaƟon and other matching funcƟons. 

large-scale paƩern recogniƟon. 
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The ability to predict how AI will influence future work flows and what skills analysts need to 
culƟvate is crƟcal in order to keep.average Analyst. 

in an increasingly data-driven business world. 

 

9.7.1 AI as a Partner for Business Analysts 
Soon, AI will come to be viewed not only as a tool but also a thinking partner for analysts. It 
will assist in: 

• AcceleraƟng data exploraƟon and visualizaƟon 

• Offering a frame of reference that is informed by history 

• Recommending its own next step in the analysis based on user goals 

• EliminaƟng human errors and biases through imparƟal data presentaƟon 

• Enhancing CollaboraƟon by translaƟng analyses into natural language summaries for 
cross-funcƟonal 

teams 

AI “AugmentaƟon” Business analysts will depend increasingly on AI to make them more 
producƟve, creaƟve and decision-oriented. 

funcƟonality, parƟcularly in high velocity funcƟons like finance, markeƟng and operaƟons. 

 

9.7.2 EvoluƟon of Human + AI CollaboraƟon in Data Workflows 

The normal analyƟcs workflow was a largely manual one of clean, process, analyse and 
report. AI is 

now turning this into a collecƟve process, whereby: 

Phase Human Role AI Role 

Data PreparaƟon Structure integrity enforcementCleaning DetecƟon automaƟonAnomalies 
jadxdefine Assemble (DWH) datatype ids Annotate If you want to do something, you need to 
measure before. 

Ask quesƟons, make observaƟons and interpret data (Benchmarks 2.1-3) Create summaries 
and generalizaƟons and understand its relaƟonship to the original informaƟon Ask each 
other how did you know If I give this kind of data how would you represent a graph/chart? 
Can we come up with another way to organize these findings? 

Generate insights Apply business logic Provide acƟonable recommendaƟons 
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Report DraŌ stories, current findings Auto-populate graphical reports & summaries 

This collaboraƟon between the two makes it possible for companies to ramp up their analy 
Ɵcs without having to hire massive teams and removes o rganizaƟonal silos for data 
analysis. 

analysts concentrate on strategy and narraƟve. 

Future trends include: 

• Voice-acƟvated analyƟcs assistants 

• Auto-generated presentaƟons from dashboards 

• AI insights personalized by user role 

 

9.7.3 Skills for the Next-Gen Analyst in the AI Era 

With AI doing more of the grunt work, the role of analyst is moving from executor to 
interpreter, 

strategist, and decision-maker. Analyzing this kind of informaƟon in the future will require a 
hybrid skill set: 

Data Literacy 

• Understanding AI-generated outputs 

• Understanding how to validate and challenge data-driven recommendaƟons 

CriƟcal Thinking 

• Contextualizing insights within a business 90variety of impact areas including 
sustainability, corporate governance and other ESG related topics. 

• When human judgment should take over AI recommendaƟons 

Prompt Engineering 

• CommunicaƟng clearly to AI (e.g., asking quesƟons of sysntheƟc tools like Copilot or 
ChatGPT) 

Tool Agility 

Fine with AI-augmented tools such as Excel Copilot, Power BI AI Insights, Tableau GPT and 
AutoML 

plaƞorms 

Ethical Awareness 
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• InterpreƟng AI decisions 

• Fairness, transparency and privacy in AI-driven analyƟcs 

Those analysts that can marry technical experƟse to strategic thought and ethical judgment 
will be those most. 

best posiƟoned to take charge in the AI-based future of analyƟcs. 

Knowledge Check 1 

Choose the correct opƟon: 

1. Which of the following is an example of a conversaƟonal AI tool used in business 
analyƟcs? 

A) Solver 

B) ChatGPT 

C) PivotTables 

D) Flash Fill 

2. MicrosoŌ Copilot in Excel can: 

A) Only perform formaƫng tasks 

B) AutomaƟcally generate charts and summaries using natural language 

C) Replace all Excel formulas permanently 

D) Only detect duplicates 

3. Which AI add-in is specifically designed for automated analysis and visualizaƟon in Excel? 

A) Data Squirrel 

B) AutoSum 

C) Solver 

D) SmartArt 

4. Which of the following is a key advantage of AI-powered data cleaning compared to 
manual Excel 

cleaning? 

A) Takes more Ɵme 

B) Detects fuzzy duplicates and missing paƩerns 

C) Requires advanced coding 
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D) Works only on small datasets 

5. In the future of analyƟcs, what skill will be most important for the next-generaƟon 
analyst? 

A) Manual chart formaƫng 

B) Prompt engineering and criƟcal thinking 

C) Memorizing Excel formulas 

D) Avoiding AI tools altogether 

9.8 Summary 

This chapter discussed the growing significance of AI in business analyƟcs and how 

AI turns everyday tools like Excel into powerful decision-support systems. 

Key highlights include: 

• Tools such as conversaƟonal AI tools improve the interacƟon with data through natural 
language and help止 

users to clean, deliver formulas, generate reports and analyses. 

• IntegraƟon with producƟvity suites, parƟcularly MicrosoŌ Excel using Copilot, makes it 
easier to complete tasks like 

scenario analysis, creaƟng a chart, and PivotTables. 

• AI-driven add-ins increase automaƟon of forecasƟng, reporƟng, and data cleaning freeing 
up an analyst. 

analyƟcs accessible to non-technical users. 

• AI dramaƟcally enhances data preparaƟon and cleansing by eliminaƟng duplicates, 
standardising formats, 

and recommending transformaƟons. 

• Data analysis — AI gives instant summaries, insight generaƟon, visualizaƟon and 
dashboard 

explanaƟons, reducing manual effort. 

• Conclusion: AnƟcipaƟon AI is emerging as an aide in the analysis process and human–AI 
teamwork has arrived. 

norm. The discipline of criƟcal thinking, commitment to Ɵmely engineering and ethical 
consciousness are essenƟal in order for analysts to combine a mixture of Must accompagny 
analyƟcal vermouth. 
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prosper within the AI-assisted analyƟcs ecosystem. 

 

9.9 Key Terms 

ArƟcial Intelligence (AI) is the technology that imitates human intelligence in systems, so 
that it can make its own decisions. 

funcƟons including learning, reasoning, and decision-making. 

There, conversaƟonal AI refers to AI systems that are capable of interacƟng with users in the 
natural language, such asِ. 

as chatbots and virtual assistants such as ChatGPT. 

Copilot is Microsod't’s AI helper that resides in Office apps including Excei.With smart 

suggesƟons, automaƟon recommendaƟons and insights. 

AIAdd-ins are third-party add-ins that bring intelligence to Excel - data, methods etc.. 

analysis, forecasƟng, and visualizaƟon. 

Data Cleaning: The process of detecƟng and correcƟng (or removing) corrupt or inaccurate 
records from a record set, table, or database. 

misalignment of datasets to enhance data quality. 

Feature Engineering is the process of generaƟng new variables (features) from raw data to 
improve model выполнения задания The Buckeye State 

the execuƟon of data analysis or machine learning models. 

AI-Assisted Insights are findings or trends automaƟcally idenƟfied in the data based on 
paƩerns in the da, powered 

by machine learning algorithms. 

Human–AI CollaboraƟon refers to processes in which humans and AI agents collaborate to 

draw conclusions from data and make decisions. 

9.10 DescripƟve QuesƟons 

Advantages of incorporaƟng AI in Business AnalyƟcs workflow. 

How do you use ChatGPT to clean and analyze data in Excel? 

Describe how MicrosoŌ Copilot will be used to automate What-If Analysis and building of 
dashboards. 

Contrast the type of Excel based cleansing historically done, with AI-driven scrubbing tools. 
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What are some use cases of Data Squirrel as an AI based Excel add-in? 

How can AI help me create staƟsƟcal summaries or business insights? 

What are some ifs and buts of AI tooling in analyƟcs? 

Describe how AI is redefining a business analyst role. 

Enumerate the key skills that next-gen analysts need to have while operaƟng in AI-enabled 
homes. 

Share a use case for explaining dashboards or reports to non-technical stakeholders using 
AI. 

9.11 References 

266 

Answers to Knowledge Check 

“AI in AcƟon: RevoluƟonizing Sales ReporƟng at Horizon Electronics” 

MicrosoŌ Learn: hƩps://learn.microsoŌ.com/en-us/microsoŌ-365/ 

OpenAI ChatGPT DocumentaƟon: hƩps://plaƞorm.openai.com/docs 

Data Squirrel Add-in Overview: hƩps://www.datasquirrel.ai 

The future of AI: McKinsey & Company’s take – The AI OrganisaƟon 

Harvard Business Review – AI’s Role in the Future of Business Analysis 

 

Answers to Knowledge Check 

Knowledge Check 1 

1. ChatGPT 

2. Summaries 

3. Data Squirrel 

4. Duplicates 

5. Thinking 

9.12 Case Study 

“AI in AcƟon: Transforming Sales ReporƟng at Horizon Electronics” 

IntroducƟon: 
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The consumer tech company Horizon Electronics uses Excel to track sales reports for its 25 
regional offices. 

Company had delays in repor t processing, lack of reconc iliaƟon between dashboards and 
excessive dependence on 5'+$#+)the following})3 imperaƟveanguage'('502!75 /72 + ' I/ :; -
./62%'/%>1?./%AZC *12B)(47X=*2 *8IV4XP-.)OP-/())/(#o+IR.aD'%rBNLD6098 (a"CO0.’ 120 
imitaƟve language '(504E:=)I63))'48"]J#P-X.9QY[7. 

manual formulas. 

Their new business analyst, Ayesha was responsible for automaƟng and standardising the 
reporƟng. 

process using AI-powered tools. She brought in ChatGPT for help with formulas, MicrosoŌ 
Copilot for 

visual sumaries, and Data Squirrel for surfacing instant dashboards. 

Problem Statement 1: ReporƟng Manually ASSA ABLOY Now, you have learned how we went 
from a funcƟoning Excel report to an auƟmaƟc SQL ETL using EasyMorph conversion. 

The current reporƟng template in Excel needed several VLOOKUP’s, creaƟng chart manually 
and formularaising it etc. 

modificaƟons that also frequently introduced howlers. 

SoluƟon: 

267 

Ayesha employed MicrosoŌ Copilot to automate chart creaƟon, maintain formaƫng 
consistency, and produce 

region sales performance summaries. 

MCQ: What type of tool that creates the graphics for conveying specific types and shades of 
meaning to reflect on in their futures who not only help students understand, interpret 
visually, verbally? 

language? 

A) PivotTables 

B) Flash Fill 

C) MicrosoŌ Copilot 

D) Solver 

Answer: C) MicrosoŌ Copilot 
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Issue 2: Data Cleaning PracƟce Is Not Uniform Between Regions 

Sales informaƟon from various offices arrived in inconsistent formats, missing data and non 
:matching products . 

codes. 

SoluƟon: 

Ayesha wrote out cleaning formulas with ChatGPT and Data Squirrel auto-detected 
duplicates and 

missing fields across mulƟple sheets. 

MCQ: What is the name of a tool that uses AI to help users clean and visualize their Excel 
data automaƟcally? 

A) Solver 

B) Data Squirrel 

C) Match FuncƟon 

D) SmartArt 

Answer: B) Data Squirrel 

Problem 3: ExecuƟve Insight GeneraƟon 

ExecuƟves needed a monthly overview of the main trends, performance etc.. without having 
to look at big tables. 

SoluƟon: 

268 

Ayesha produced natural language summaries with Copilot and ChatGPT, and then inserted 
them into 

monthly reports. For AI recommendaƟons on growth trends and struggling areas. 

MCQ: AI COVID-19 funcƟon transforms complex data into wriƩen summaries or trend 
maps? 

A) Flash Fill 

B) Named Ranges 

C) AI-Assisted Insights 

D) AutoSum 

Answer: C) AI-Assisted Insights 
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Conclusion: 

With the power of Copilot which is AI chatbot, together with MS Excel integrated and 
external addins, Ayesha brought down her Ɵme to XSS requirements by 30% along control 
costs. 

creaƟon Ɵme and data reliability increase up to 60%. Most importantly, her reports 
cleared. 

dynamic, and acƟonable for leadership. 
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